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Chapter 1: Introduction to Fiorano
eStudio

1.1 Key Features

This section outlines some of the key new features added to the Fiorano eStudio:

1. Offline Event Process Development

In Offline Event Process Development mode, Event Processes development is done without
connecting to a server. The Offline perspective maintains its own repository of event processes
and services. Event Processes can be developed in Offline mode and can be deployed to any
Enterprise Server. A server connection is required only while deploying an Event Process.

2. EPLCM (Event Process Life Cycle Management)

EPLCM allows a user to move Event Processes in different labeled environments that is;
Testing, Staging, QA, and Production, all at the click of a button. Pre-created profiles for each
environment are automatically picked up by the Server at the deployment time. This allows
the user to specify properties for service instances in an Event Process for multiple
environments, rather than creating new event processes for each environment. With the new
EPLCM functionality, migration from one environment to another is simple.

3. Sub-Flows

A powerful new Sub-flow concept has been added. Sub-flow allows the user to insert an event
process into another event process, easing composition of large applications.

4. Improved Debugger Implementation
Message injection is added, together with a better set of views to simplify debugging.
5. Split File Development for Services and Application

The Servicebescriptor.xml and Application.xml are changed to split files, therby making
them more readable and reducing the memory footprint of eStudio.

To reduce the memory footprints, internally the application object now contains just details of
service instances while no longer holding any information of their configurations and schemas
associated. Configurations and schemas are now picked up on demand.

6. Service Descriptor Editor

The editor edits the Servicebescriptor.xml file, making the editing easier to perform than
when using a Text/Xml editor.
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7. Quicker Custom Property Sheet (CPS) launch

The CPS, when associated with a given component now launches significantly faster than
previous versions of the Studio.

The Save and Close options have been introduced in the CPS, allowing the user to save the
CPS in the middle of configuration and revisit it at a later point of time.

8. Dynamic Validations while Editing and Creating Services and Applications

Dynamic Validations point out errors at development time, while Event Processes are being
composed, or Services created; errors that had to previously wait until compilation or run-time
can now be detected earlier in the development/composition cycle.

9. UI crafted for Rich User Experience

Significant user feedback has been incorporated within eStudio to provide a richer user-
experience. Most common operations can now be performed with a single click and with much
less navigation than in previous versions.

10. Support for Version Control Systems

Users can now store applications in any Version Control System (SVN, CVS, or VSS) using
Fiorano eStudio.

11. The New Mapping Tool: eMapper

The eStudio incorporates a brand new mapping tool that is developed ground-up in Eclipse.
This new version fixes many more bugs as compared to past versions and has several other
enhancements.

12. Customization Possible as an Advantage of Eclipse Based Product

Since eStudio is developed over the Eclipse platform, users can now write their own plug-ins

or use existing ones. Users are now able to customize the eStudio the way they want. For
instance, a user can add a version control plug-in.
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1.2 Geftting started with Fiorano eStudio

To start Fiorano eStudio:
1. Navigate to $FIORANO_HOME/eStudio and run the eStudio executable file.

2. Workspace Selection dialog is shown prompting for the workspace directory.
Workspace is a directory where all the repositories (Event Processes, Services and
other metadata) are stored.

3. The default workspace is set to
$FIORANO_HOME/runtimedata/eStudio/workspace. It is recommended to use
the default workspace, but the user can change the workspace if required. The
Remember workspace option can be selected to save the workspace used and not to
show the dialog next time eStudio is launched.

Note: The workspace preferences are stored at
FIORANO_HOME/runtimedata/eStudio/WSprefs.properties

The following preferences are stored in workspace preferences:
wsLastUsedWorkspaces, wsRemember and wsRootDir.

If the user chooses a workspace and selects the Remember workspace option, and, if
later, the Workspace Selection dialog has to be shown, then this can be done by
changing the value of wsRemember to false in the workspace preferences.

When the Fiorano eStudio has completely launched, the user can switch between
different workspaces. The option to switch the workspace is present at File -> Switch
Workspace.

The current workspace selected is shown in Fiorano eStudio title bar.

4. By default, eStudio is launched in Offline Event Process Development Perspective
mode and the offline repository is populated when eStudio is launched for the first
time.

5. 1In Case, eStudio does not load properly, install XULRunner on your machine. Follow
the guide lines from:
https://developer.mozilla.org/en/Getting started with XULRunner to install and add
the following:

-Dorg.eclipse.swt.browser.XULRunnerPath=$XULRunnerHome/xulrunner to
$FIORANO_HOME/eStudio/eStudio.ini and restart eStudio.

Note: In Windows Server 2008, there are certain permissions settings that do not allow
standard eclipse to function normally if eStudio is not running as an administrator. This will be
resolved if eStudio is run as an administrator.

1.2.1 Launching eStudio using 64-bit JVM

By default eStudio is configured to launch using 32-bit JVM.

1.2.1.1 To install é4bit jars

1. Download eStudio 64bit JVM upgrade patch (javaupgradepatch.zip) from
www.fiorano.com/latest/soa.

This patch can be used to upgrade eStudio from 32bit JDK to 64bit JDK and vice versa.
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1.2.

Note 1: This patch can be applied only in Windows and Linux platforms.

Note 2: Please do not rename any files in FIORANO_HOME/eStudio folder before executing
these scripts. The patch takes care of files backup. If you need to backup in some external
location then copy the files to the external location.

Extract javaupgradepatch.zip. This contains a file Launching eStudio using 64.doc and
eStudio-delta-pack folder.

Copy the folder eStudio-delta-pack in FIORANO_HOME/antscripts/patch directory.

Open a console inside the folder FIORANO_HOME/antscripts/patch/eStudio-delta-
pack and execute the command shown below:

ant patch

The patch will be applied and 64bit jar files are copied to the installer and backup is
created in eStudio-delta-pack/backup and eStudio-delta-pack/launchers/backup
directories.

Make the following change in FIORANO_HOME/eStudio/eStudio.ini file.
Add/Edit

-vm

{JAVA_HOME}\bin

The option —vm has to be added above the "-vmargs" line and JDK_HOME should point to
a 64 bit JVM.

Note: -vm and {JAVA_HOME}\bin should be in two different lines.
In case of Linux, change the eStudio launcher executable permissions if required.
Now launch eStudio.

When eStudio is opened the JVM used can be checked from Help->About Fiorano eStudio-
>Installation Details->Configuration tab

1.2 To uninstall é4bit jars
Download the delta pack as mentioned in stepl in "To install 64bit jars” section.

Open a console inside the folder FIORANO_HOME/antscripts/patch/eStudio-delta-
pack and execute the command shown below:

ant unpatch

The patch will be applied and 32bit jar files are copied to the installer and 64 bit jars
backup is created in eStudio-delta-pack/backup directory.

Edit FIORANO_HOME/eStudio/eStudio.ini and change —-vm option to point to 32bit
JVM.

In case of Linux, change the eStudio launcher executable permissions if required.
Now launch eStudio.

When eStudio is opened the JVM used can be checked from Help->About Fiorano eStudio-
>Installation Details->Configuration tab
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Chapter 2: Offline Event Process
Development

The Offline Event Process Development (OEPD) perspective contains all the views and the
editors required for the offline event process development. The OEPD perspective maintains its
own repository of Event Processes and Services and no server connection is required to create
Event processes. This offline repository is populated when the user launches the Fiorano
eStudio for the first time. The default location of the Offline repository is
$FIORANO_HOME/runtimedata/eStudio/workspace/.repositories/Offline.

A Server connection is required only to export the developed Event Processes into the Server.
Similarly, Event Processes present in the Server can also be imported into the eStudio. Figure
2.1 illustrates the OEPD perspective.

@ eStudio File Edit View Window Help Tools  Run Search §§7‘,,,m $ & 4 (=1 (100% Tuez46PM Phani @ ©
r " Y
ene eStudio =)
— 5
|Eca] &5l =]+ Q-] woxy) -ESESEO -8
£ @ Online Event Process Development (%) Offline Event Process Development
8 Event Process Repository 52 =0 W = O || service Palette 53 mY=0
(] [; Select
v B Event Process Repository (1) | Route
¥ (= User Processes (1) CBidges
=3 Event Processl
(= Collaboration
(=DB
(= Error
[ __ DRI [ File
= = Flow
@y Service Repository 2% | o3 pg ¥ = 0O 5
MOMs
» O Bridges e
» @ Collaboration o Ferformance
» £ DB (= Samples
» 2 Error (= Seript
» P File (= Transformation
b O Flow oo
ti
> P voms e
» O performance (£ Web
b 2 samples (= WebService
b 2 script
» 2 systemLib
p £ Transformation la
> O il v
[ problems 52 I Q] Error Lﬂg‘ = Consu\e‘ ¥ = 8| E eroperties 53 v =0
0items —
| | Resource Path Location Type General  Name Event Process1
Application Context
Environment Properties) | GUid EVENT_PROCESS1
Version 1.0
Categories User Processes A4
™ Cache Component
Description: la
€ : BRI v

Figure 2.1: Offline Event Process Development perspective

The OEPD perspective comprises of various Views as explained in the following section.
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2.1 Fiorano Views

2.1.1 Event Process Repository View

The Event Process Repository view is one of the views of the Offline Application Development
Perspective, which is available under Window > Show View > Fiorano > Event Process
Repository.

Event Process Repository view shows all the event processes created in the offline application
development perspective, under various categories.

B8 Event Process Repository &3 =8

ES £
i 'EE Event Process Repository (3)
= [ User Processes (1)
l[E EwventProcessl
= =~ User Processes? (2)
l[E EventProcess2
I{E EventProcess3

Figure 2.1.1: Event Process Repository

2.1.2 Fiorano Orchestration

Offline and Online Event Process Development perspectives are comprised of an editor area
Fiorano Orchestrator.

When an Event Process is opened, the design of the event process is shown in the Fiorano
Orchestrator.
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Figure 2.1.2: Orchestration Editor

2.1.3 Service Palette

The Service Palette shows the services that are present in the eStudio repository. The Service
Palette contains all the Fiorano services grouped into various categories such as: Bridges,
Collaboration, DB, Error, File, and so on as shown in figure 2.1.3.

@ Service Palette 23 l

IEVI:IE

[ Select

} Route

I

Figure 2.1.3: Fiorano Service Palette
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2.1.4 Properties

The Properties view displays all the property names and values for any selected item such as:
a service instance, route, port, and so on. The Properties view is available under Window >
Show View > Other > General > Properties.

Placing the cursor on a property shows the property description.

= properties 52

General

Execution

Log Manager

Log Module Instances

Runtirme Arguments

Figure 2.1.4: Properties view

2.1.5 Problems

Marme:

Versian:

Short Desc:

Long Desc:

[+.0 ]

| c-l-';ati-

|4 Simple Chat Companert

- =28

When working in the Fiorano environment, the errors and warnings occurred are displayed in
the Problems view. For example, when an Event Process containing errors is saved, the errors
are displayed in the Problems view as shown in Figure 2.1.5.

The Problems view is available under Window > Show View > Other > General > Problems.

(£ Problems ¥ . @ Javadoc  [&, Declaration = Propertes| €] Error Log| % Debug

2 errors, 0 warnings, 0 others

Description

= @ Errors (2 items)

@ Configuration is mandatory for DBProc EventProcess. testEventProcess

@ Configuration is mandatory for SMTP1 EventProcess. testEventProcess

Resource Path

= =t

L]

Location Type

line 1

line 1

Fiorano Orchestration F

Fiorano Orchestration F

Figure 2.1.5: Problems view

Chapter 2: Offline Event Process Development

Page 18



Fiorano eStudio User Guide

By default the problems are grouped by severity level. The grouping can be selected using the
Group By menu.

Problems view can also be configured to show the warnings and errors associated with a
particular resource or group of resources. This is done using the Configure Contents option in
the drop-down menu. Additionally, you can add multiple filters to the problems view and
enable or disable them as required. Filters can either be additive (any problem that satisfies at
least one of the enabled filters will be shown) or exclusive (only problems that satisfy all of the
filters will be shown).

2.1.6 Error Log

The Error Log view captures all the warnings and errors logged in the Fiorano environment.
The underlying log file (.Tog) is stored in the .metadata subdirectory of the workspace. The
Error Log view is available under Window > Show View > Error Log.

El Properties @] Error Lag - B B R

Workspace Log

Message Plug-in Date se |[=
@1 null argument; org.eclipse.uinavigato 2008-12-11 11:13:09,341
@ Contributor com fiorano studio.common. org.eclipse.uiviews pre 2008-12-11 11:11:52.247
@ Plug-in 'com fiorano studio.esh.orchestrz org.eclipse.ui 2008-12-11 11:09:35.680
= & Warnings while parsing the key bindings f org.eclipse.ui 2008-12-11 11:08:58.436
& Cannot bind to an undefined comman org.eclipze.ui 2008-12-11 11:08:58.437
& Cannot bind to an undefined comman org.eclipse.ui 2008-12-11 11:08;58.437

& _rannnt hind ta an undefined comman_ara eclinse i 20NR-12-11 11'NR ‘58 437 (¥

Figure 2.1.6: Error Log view

2.1.7 Service Repository (Offline)

Fiorano eStudio provides a Service Repository view which is available under Window > Show
View > Fiorano > Service Repository. This shows a categorized list of all available services.
When the Fiorano eStudio is launched for the first time, the offline repository will be loaded
from the installer.

Services which are available only in the service repository can be used for composing event
processes in eStudio. Services can be imported from or exported to a file system or a Fiorano
ESB Server from the Service Repository.
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Figure 2.1.7: Service Repository

2.1.8 Project Explorer

The Project Explorer view lists all the projects in eStudio. The Project Explorer view is available
under Window > Show View > Project Explorer.

All the Event Process, Service and Mapper projects are shown in Project Explorer view.
Structure of the Event process is shown in Figure 2.1.8.

To use Version Control, corresponding plug-ins have to be added in drop-ins. If the drop-ins
are added, then the version control options will be available in the context menu of a project
in this view.
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=1 properties | Praject Explorer 33] O % ¥ =0

v = appl_EA-1.0@EnterpriseServer
B = config m
P = env
P = help
B = schemas
e{g EventProcess.xml
C1 bond_trading-1.0@EnterpriseServer
P = compositebc_demo-L.O@EEnterpriseServer
[C] database_replication-1.0@EnterpriseServer
b [=F Database Replication
C1 db_transaction_support-1.0@EnterpriseServer
C] eai_demo-1.0@EnterpriseServer
b =% event_process1-1.0
=1 hospitality_service-1.0@EnterpriseServer
b =F Hospitality Service
L1 mortgage_property_request_automation-L.O@EnterpriseServer
L1 order_entry-1.0@EnterpriseServer
C] portal_integration-1.0{@EnterpriseServer v

Figure 2.1.8: Project Explorer

The service projects are by default shown as closed projects. User can open a project by right-
clicking on a project and by selecting the Open Project option. For performance reasons it is
advised to close the service projects when they are not being used.

2.1.9 Service Descriptor Editor

Service can be edited using a Service Descriptor editor. To edit a service in the service
descriptor editor, right-click on the desired service in Service Palette or in Service Repository
and click the edit option from the context menu.

The properties of Service are divided into three categories:

¢ Overview - Contains general information about the Service like Name, GUID, version,
icon etc.

e Execution - Contains information about service ports, runtime arguments, launch
options and log configuration.

e Deployment - Contains information about service resources, dependencies and
general deployment information.
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L Offline Event Process Development - .editServiceProjecti/resources/serviceDescriptor.xmi - Eclipse Platform -l X

File Edit MNavigate Search Project Tools Service Editor Run  Window Help

-8 ds Q- | = 4~ ay [ F Offline Event.. >

'[2 EventProcess3 & ServiceDescriptorxml 33 =8

]
1]
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@——l General Information Display
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Name: chat Palette Icon: @ Browse... &
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Licensed

Overview  Execution Deployment

A Selected Mothing

Figure 2.1.9: Service Descriptor Editor

Note: Changes made to the Service will be saved to the repository only after the editor
associated with the Service is closed.

2.2 Event Processes

Event Processes are composite applications created as event-driven assemblies of service
components. They represent the orchestration of data flow across customized service-
components distributed across the ESB network. Event processes in Fiorano are designed to
connect disparate applications in a heterogeneously distributed SOA environment.

Fiorano eStudio enables intuitive visual configuration of all the elements of an event process
including the components of the process, the data flow or routes between components,
deployment, profile information, and layout. The event process metadata contains all required
information in XML format, which is stored in the repository.
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2.2.1 Creating New Event Process

To create a new Event Process, perform the following steps:

1. Right-click on the Event Process Repository node and select Add Event Process.
The Customize Event Process dialog box appears.

(SReentpocessfoposton 8|~ O [=G evenprocess1 53|

(B T

Event P Re . =
v 8§ Event Process «~ Add Event Process |
¥ [= User Proces

&1 Event Py dia Add Sample Event Process

siz Open Event Process... $O
txg Import Event Process
f23 Import Event Process (nStudio)

Refresh

& =)« >

[% Service Repository &4 ﬁ pag ~ T O

Figure 2.2.1: Creating new Event Process

2. Specify the name and category of the Event Process project and click Finish. The
specified Event Process appears under Event Process Repository node of Event
Process Repository view.

8ne Customize Event Process

Create an Event Process Project

Create an Event Process project in the Workspace.

Project Name: Event Process?

Version: 1.0
Category: User Processes L 4
Repository: Offline Event Processes Repository

( Cancel -:J G-HH

Figure 2.2.2: Customize Event process
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3. To see the graphical view of an Event Process, double-click the event process
node, which opens the Fiorano Orchestration editor. For information on
composing an Event Process, see Chapter 5: Composing an Event Process.

2.2.2 Opening Sample Event Process
Few pre-configured sample event processes are shipped with the Fiorano installation. To open
a pre-configured sample event process, perform the following steps:

1. Right-click on the Event Process Repository node and select Add Sample Event
Process. The Add Sample Event Process dialog box appears.

SREentprocesafopostony |~ D) [+Qevencrrocessi 33|

(B T

v 'Eﬂ Event Process Rer————"* -
v (= User Process Ui Add Event Process a2l

Uy o Add Sample Event Process

ofg Open Event Process... ¥O
gxg Import Event Process
gxg Import Event Process (nStudio)

Refresh

Figure 2.2.3: Add Sample Event Processes

2. Select the Event Process(s) to be opened by selecting the check box against each
entry and click Finish. The selected Event Process(s) appears under Event Process
Repository Node.
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Figure 2.2.4: Sample Event Processes

3. To see the graphical view of an Event Process, double-click the event process node
which opens in the Fiorano Orchestration editor.

Note: The samples that are added to the repository already will not be visible in the Add
Sample Event Process wizard.
2.2.3 Import and Export Event Processes

The following sections describe the procedure for exporting and importing an event process.

2.2.3.1 Exporting an Event process

Event Process can be exported to local disk or to a server from the Offline Event Process
Development perspective.
To export an Event Process onto a local disk, perform the following steps:

1. Right-click on the Event Process to be exported from the Event Process Repository
view and select Export from the menu (Figure 2.2.5).
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4 B Event Process Repository (1)
4 = User Processes (1)
o0 Event Processl

Team
Compare With
Restore from Local History...

Open
Delete

£ BB

Copy
Refrezh

Export... l,\\r-,

Export To File

C.

Save As...

Show Configuration Usages

Figure 2.2.5: Export Event Process to local disk

2. The Export Event Process dialog appears as shown in the Figure 2.2.6. The dialog
provides a list of all the Event Processes selected for exporting along with all the
Event Processes referred to by this Event Process and also the named
configurations used in those Event Processes. User can choose the artifacts to be
exported by selecting the check boxes next to their names.

f] Export Event Processes To Local Disk | (5] |

Export location and configurations

Export To
Ch\Users\Sai\Desktop'event_processl-1.0.zip [:]
Select configurations to be included in the export:

[¥] =g Event Processl
OutputPortConfiguration
Transformationl

[ Finsh || Cancel |

L )

Figure 2.2.4: Selecting Dependencies, Configurations to export
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If the exported Event Process has other Event Processes as dependencies and each of
those Event Processes in turn have dependencies then all these Event Processes are
exported along with their configurations in a chain manner into a single folder as that of
the exported Event Porcess and the dependency chain is saved in a metadata file

3. Specify the file name and location to save and click OK. The Event Process project
along with the dependencies and configurations chosen will be saved as a .zip file.

4 | configurations
* 4 ports
4 | transformations
» ) Transformationl
4 || event_processl-1.0
, config
| env
, help
. schemas

» | transformations

Figure 2.2.7: Contents of the exported ZIP file

To export an Event Process to Server, perform the following steps:

1. Click on Export Event Process to Server icon located on Event Process
Repository view tool bar as shown in the figure 2.2.8. The Select Event Process
To Be Exported dialog box appears listing all the Event Processes in offline
repository and shows the Servers list specified in Fiorano Preferences. For more
information on configuring servers please refer to Chapter 12: Fiorano
Preferences.

B Event Process Repository 2 (2 |PET = ¥ =0

|
[ Export Event Process to Server }

4 B Event Process Repository (4)
4 [ Samples (3)
» = Inventory (1)
: [= Retail (1)
®{g Simple Chat
a [ User Processes (1)
oy Event Processl

Figure 2.2.8: Export Event Process to Server

2. Select the Event Process and Configurations to be exported and the Server onto
which is to be exported and click Finish.

Note:

While exporting to a server, if an Event Process or a Configuration already exists on
the Enterprise server, it is shown in Red color. On clicking Finish, a confirmation
dialog will be shown asking if the conflicting artifacts are to be overwritten. Choose the
appropriate action.
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If a configuration used in an Event Process is missing from the Configuration
Repository, the missing configurations will be indicated by a Red Cross across the

conﬂguratlon icon (.) Such Event Processes cannot be exported to a server.

|1

ﬂ Export Event Processes To Local Enterprise Server | =] | 2

Select Event Process And Configurations

[¥] =S Event Processl
Transformationl
OutputPortConfiguration

[C]=1g Retail Television

[]e1S Sirmple Chat

"[E EAI Demao

[ Finish ] l Cancel ]

L -]

Figure 2.2.9: Select Event Process and Configurations to be exported

2.2.3.2 Importing an Event Process
Event Process can be imported from the local disk and from the Server.

To import an Event Process from local disk, perform the following steps:

1. Right-click the Event Process Repository node and select Import Event
Process from the menu as shown in figure 2.2.10.

Raenpoessieposion B8]~ O |+Gevencmocessy |

[T

v 'EE Event Process Repos
v (= User Processes | dig Add Event Process |

o0 Event Proce dig Add Sample Event Process

sz Open Event Process... ®0

. 1 Import Event Process

t23 Import Event Process {nStudio)

Refresh

Figure 2.2.10: Import Event Process from local disc
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2. Specify the location of Event Process zip file and click OK. A list of all Named
Configurations used in the Event Processes referred to by this Event Process and
the Named Configurations used in all these Event Processes is also provided. The
user can select the Event Processes and configurations to be imported along with
the Event Process in the Import Applications wizard (Figure 2.2.11). In the
absenece of any referred Event Process, import of the selected Event Process fails.

F | Import Event Processes |:|@

Import Applications

Select Event Processes and Configurations ko be importad

=-[#]={3 Event Process1
portConfiguration
Transformation
"[E Ewerlt Process2

Event Process Details

Display Mame:

Guid: | EVEMT_PROCESS]

Exists: | False

Cateqories: | User Processes I |

File Location: |D:'l,jars'l,eventjrocessZ—l.D@EnterpriseServer.zip [:]

[ Finish ] [ Cancel

Figure 2.2.11 Import Application Wizard

Note: Event Processes or Configurations that are already present in the repository are shown
in Red and the configurations which are used in the Event Process and are not found the

import ZIP file are indicated using a Red cross ().

To import an Event Process from the Server, perform the following steps:

1. Click on Import Event Process from Server icon present on Event Process
Repository view tool bar as shown in the figure 2.2.12.

= B ||™g Event Proc

e By

w B Event Process Reposil Import Event Process from Server
¥ [= User Processes (1) ™
"[E Event Processl

Figure 2.2.12 Import Event Process from Server

Select a Sever dialog box appears listing all servers specified in Fiorano ESB
Connection Preferences page.
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Figure 2.2.13: Select Enterprise Server

2. Select the Server from which Event Process has to be imported and click OK. The
Select Event Process To Be Imported dialog box appears which lists all the
Event processes deployed in the server as shown in Figure 2.2.14.

£= Select Event Processes To Be Imported - @E|

Select an item bo open (7 = amy character, ® = any string): -

|
Makching ibes:
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w{gPurchasing System
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©{2 Reverue Cortrol Packst
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o{2Smple Chat

e{gtest]Z34
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] Overvirite if exists

{3 BOND_TRADING-1.0{Cabegories : Samples. Finandal)

@ Lo J[ comcet |

Figure 2.2.14: List of Event Process in server

3. Select the Event Process to be imported and click OK. The Import Applications
wizard (Figure 2.2.11) is shown listing all the referred applications and
configurations of all these applications. Select the Applications and configurations
to be imported and click Finish.

2.2.4 Importing nStudio Event Processes

Event Processes that are developed and exported from nStudio can be imported into eStudio
using the Import Event Process (nStudio) option present on the context menu of Event
Process Repository node.
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Figure 2.2.15: Import nStudio Event Process

Selecting the import option opens an Import Wizard as shown in Figure 2.2.16.

x|

B Import nStudio Flows
Select the nStudio flows to be imported

(@ Click the Add button and select the files to be imported

File Name Location [ Add lE]

@ Cancel

Figure 2.2.16: Import nStudio Flows

The Event Processes to be imported can be added to the table by clicking the Add button. A
file chooser dialog appears where the nStudio flows can be selected. Multiple files can also be

selected at once.

To import all the Event Processes present in a particular folder, select the Add From Folder
option present in the drop-down button located on the right side of the add button. All the
supported flows present in the folder and all of its sub-folders will be added to the table.

The state of the wizard after adding the flows is shown in Figure 2.2.17:
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£ Import nStudio Flows x

Select the nsStudio flows to be imported
@ select files to be imported

' Flle Name Location - Add ]v]
(O EVENT_PROCESS1_1.0.xml Jjroot/Desktop/Flows/EVENT_PROCESS1_1.0.xml ' W
B EVENT_PROCESS2_1.0.xml Jroot/Desktop/Flows/EVENT_PROCESS2_1.0.xml —
O SIMPLECHAT_1.0.xml Jroot/Desktop/Flows/SIMPLECHAT _1.0.xml Select Al |
[ COMPOSITEBCDEMO1_1.0.xml  jroot/Desktop/Flows/COMPOSITEBCDEMOL_1.0.xml

O EventProcess.xml Jroot/Desktop/Flows/EventProcess.xml

[J DB_TRANSACTION_SUPPORT_1.0. jroot/Desktop/Flows/SubFlows/DB_TRANSACTION_SUPPORT_1.0.xml

@ [ cancel

Figure 2.2.17: Select nStudio flows to import

After adding the selected files to the table, the flows to be imported can be selected using the
check box against each entry present in the table. Click the Finish button to import the
selected flows to the current repository. If any of the selected flows already exist in the
repository, the user is prompted with a dialog box with the options to
overwrite/ignore/rename the flow. The imported flows can be viewed under the Event Process
Repository Node.
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2.3 Service Repository (Offline Event Process Development)

Fiorano eStudio has an independent service repository in Offline Event Process Development
perspective, which enables services to be configured offline (without connecting to the
Enterprise Server).

The service repository can be viewed by opening the Service Repository view, which displays
categorized services as shown in Figure 2.3.1.

O service Repositary &4 = B
B4y gdy

Bridges

Zollaboration

DE

Errar

File

Floy

MOMs

Performance

Samples

Scripk

Syskem Lib

Transformation

LIkl

WWeb

WebService

L e = R e Y R 3 R C R = R B
CooooOoOODODOODOODODOD

Figure 2.3.1: Service repository

2.3.1 Deploying Services to Server

A service can be deployed to an Enterprise server by right-clicking the component in Service
Repository view and selecting Export Service to Server from the context menu. The Export
Service To Server dialog box appears as shown in Figure 2.3.2.
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ene Export Service To Server

Server configuration and dependencies

Server:

Local Enterprise Server &

Select the dependent services, if any, which should be included in export:

(J

T, base64:4.0
1 » %% BCGateway:4.0
[ » %% dmlparser:4.0
» % jdbc4n
T log4j:4.0
Q{) xalan:4.0

OOal

| Overwrite if exists

r N
[ elect Al |

(i Cancel ) G—HH

Figure 2.3.2: Export service to server

The dependencies are shown in a tree format. This excludes the actual Service (which gets

exported by default). To export any dependencies of this Service, select the Dependency and
click Finish.

If the Overwrite If Exists checkbox is selected, the services in the server will be over-written

by the one in the Service Repository, otherwise conflicting services will not be export to the
server.

2.3.2 Fetching Services from Server

1. The services present on server can be imported into the service repository by
selecting the Import from Server option as shown in Figure 2.3.3.

O ServiceRe... &1 | [ Configurat.. — O

el B 7
> § Bridges [Impcrt From SEF‘.-'EF}
4 B Collaboration ol
» (&) chat:d.0

m

> ) csChat4.0
- () vbchat4.0
> &) veChat4.0
- A DB
> 4@ Error

Figure 2.3.3: Import from Server option
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This opens Import Service From Server dialog box as shown in Figure 2.3.4.

enNe Import Service From Server

| Service Import

Select the Server and the Services to import

Server: [ Local Enterprise Server I:] € Connect )
Name Id Version |

: Aggregator | Aggregator 4.0 m
[T |eccommen  |BCCommon 4.0 |
] BCEngine BCEngine 4.0
2 BCGateway BCGateway 4.0
™ | Beanshell BeanShell 4.0 .
: BinaryFileRead| BinaryFileReader 4.0 ¥
| - - “|r

"] Overwrite if exists

( Cancel ) G—Rwhh—)

Pa

Figure 2.3.4: Import service from server

2. Select the server from where services have to be imported and click the Connect
button. This displays all the available services in that server.

3. Select the services to be imported and click the Finish button to import the
service.

If the Overwrite If Exists checkbox is selected, service in the Service Repository will be
over-written by the one in the server, otherwise conflicting services are not imported from the
server.

2.3.3 Exporting Services to Local Disk

The Services in Service Repository can be exported to a local disk by right-clicking the Service
and selecting the Export Service To Local Disk option from the context menu. This opens
the Export Service To Local Disk dialog box as shown in Figure 2.3.5.
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®eNe Export Service To Local Disk

Export location and dependencies

Export To:

fUsers/phani/Desktop/chat_4.0.zip |
Select the dependent services, if any, which should be included in export:
| 2 cg BCCommon:4.0
| 2 cn cps:4.0
Qg jms:4.0
» %, studio:4.0
» % TifosilavaRTL:4.0

il

o0l

= =
| elect Al ) w

( Cancel :) ( Finish )
4

Figure 2.3.5: Export service to Local Disk

You can choose the export location, by default only the selected service gets included in the
export. Select other services from the tree to be exported if required, and click the Finish
button to export the service.

2.3.4 Importing Services from Local disk

The components can be imported from the file system. This can be done by clicking the
Import From Local Disk button as shown in Figure 2.3.6.

O Service Re... &1 | [ Configurat...| — O

Y N
- M Bridges -
4 D Collaboration [Impcrt From Local Disk }
- (&) chat4.0
. @) csChat4.0 3
. (B) vhchat4.0
. @) veChat4.0
. A DB
» A Error
- & File
- 2 Finance

Figure 2.3.6: Import from Local Disk button

This opens the Import Services file selection dialog box with which the zip file containing
services on the disk is selected. Upon selection a dialog box is shown in which the services in
the zip file are shown in the form of a dependency tree as shown in Figure 2.3.7.
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7 B
] Import Services l 5 |

Service selection

Select the service and dependencies that have to be imported:
4 [J](&) chatd.0
[#] %% BCCommoen:dd
% cpsd0
% jms40
1%, Studic:d.0
[[] %% TifosilavaRTL:4.0

[] Owerwrite if exists
[T] Edit chat:4.0

[ Finish l [ Cancel

.

Figure 2.3.7: Import services dialog box

Components that are already present are labeled in red, and those not present in the
repository are labeled in black.

If the Overwrite If Exists checkbox is selected, service in the service repository will be over
written by the one in the zip file, otherwise conflicting services are not imported from the local
disk.

If the Edit <Service> (For ex: Edit chat:4.0 in Fig.2.3.7.) checkbox is selected, after
clicking Finish an information dialog appears as seen in Figure 2.3.8.

) Service Import @

Service [chat:4.0] will be imported to repository only after the editor associated with
the service has been closed

[7] Do not show this next time

Figure 2.3.8: Service Import dialog box

Clicking OK opens ServiceDescriptor.xml in which the user can edit the service and save it.
Closing the ServiceDescriptor.xml finishes the import of service from Local Disk.
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ev—

Overview

General Information

Marne: kh at

Version: 40

Guid: chat

Tool Tip: A Simple Chat Component ™
Description: -

Display
PaletteIcon: &)

Display lcon: @
Category: Collaboration [_]

Metadata

Author Fiorano Software Technologies Pt Ltd,

Creation Date:  04-01-200512:00:00
Licensed

< m

O’verviewl Execution | Dap\oymentl

Figure 2.3.9: ServiceDescriptor.xml
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Chapter 3: Online Event Process
Development Perspective

To open the Online Event Process Development perspective, perform the following steps:

1. Click Windows on the menu bar, select Open Perspective and click on Others..
option from the drop-down menu. Or click the Open Perspective button from the
shortcut bar and select Other... from the drop-down menu. The Open Perspective
dialog box appears.

2. Select the Online Event Process Development to open online perspective. Click the OK
button.

Online perspective contains all the views and editors required for online application
development. During online Event Process development, event process development can be
done after logging into the Enterprise Server.

After switching onto Online Event Process Development mode, select the Enterprise Server
node, right-click and select Login to login into the Enterprise Server.

Logout

Duplicate

m Delete
—

Figure 3.1.1: Enterprise Server node

By default the configurations of the Enterprise Server running locally is set on the Enterprise
Server node. These can be changed from the properties view if required.

Each time during login, eStudio fetches the information of Services, Event Processes and Peer
Servers from the Enterprise Server and populates the online repository. The default location of
the online repository for a particular Enterprise Server is
$FIORANO_HOME/runtimedata/eStudio/workspace/.repositories/Online/ <Enterprise Server
name>. Screenshot of the Online Event Process Development mode is shown in Figure 3.1.2
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Fiorano Debugger
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Application Context

Environment Properties
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Version:
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Event Process1
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1.0
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# cache Component

Description:
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Figure 3.1.2: Online Event Process Development perspective

The Event Process Repository node contains a tree structure of various Event Processes in the

Enterprise Server.

The Peer Repository node contains the information of Peers connected to the Enterprise

Server.

3.1 Fiorano Views

All the views described in Offline Event Process Development mode are available in Online
mode. There are additional views specific to Online mode. These views are described in this

section.

3.1.1 Server Explorer

The Server Explorer view shows the Enterprise servers, which contains Event Process
Repository and Peer Repository nodes.

The Server Explorer view is available under Window > Show View > Fiorano > Server

Explorer.

The Event Process repository is centrally stored in the Enterprise Server. The Enterprise
Server provides API access to the event processes such as to save, view, export, launch,
debug, stop, and similar actions as required. The Fiorano eStudio provides an easy-to-use GUI
to manage event processes. The Peer Repository shows the peer servers connected to the

Enterprise Server.
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[\, server Explorer 52 WY =0

- % Enterprise Server

- Bﬁ Ewent Process Repostory (18)
~ B Samples(17)
I (= Financial (2)
= Inventory |3)
= Mortgage (1)
= Portals (1)
(= Retail (2)
= SalesForce (1]
= Travel (1)
(2= WorkFlow (2)
I[E CompositeBC Demo
l[E Database Replication
l[ﬁ DE Transaction Support
o3 simple Chat
P (= User Processes (1)
I T Peer Repository
% Enterprise Server_1

v v v v v v v

Figure 3.1.3: Server Explorer

3.1.2 Fiorano Debugger View

The Fiorano Debugger view shows the list of routes on which debugger is enabled and
messages trapped within each route. This gives users the ability to take action on debug
message.

21 probiems | 9 eror oo | B consoe =

Breakpoints: Messages:

() () (F) (2) (=) (W) (=) (W)

route2

(= L

1 Text : Application Context )

<ChatMessage> <Sender> <Name>FioranoESE Demo < /Name> <Email>fesb@fiorano.com</
Email> < /Sender> <Message>test< /Message> < /ChatMessage>

Figure 3.1.4: Fiorano Debugger view
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3.2 Service Repository (Online Event Process Development)

In Online Event Process Development perspective, the services present in the connected
enterprise server are shown in the service repository.

The service repository can be viewed by opening the Service Repository. This view which
display the categorized services as shown in Figure 3.2.1.

@ ServiceRe... 2 | Configurat.. — O

=i

=
Bridges
Collaboration
DB
Error
File
Finance
Flow
MOMs
Performance
Samples
Script
Systermn Lib
Transformation
Ltil
Web
WebService

CooooOoOO0ODODODODODODODODODO

Figure 3.2.1: service repository (Online Event Process Development perspective)

3.2.1 Exporting Services to Local Disk

The Services in Service Repository can be exported to local disk by right-clicking the service
and selecting Export to Local disk option from context menu. This opens a dialog box as shown
in Figure 3.2.2.
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eNe Export Service To Local Disk

Export location and dependencies

Expeort To:
fUsers/phani/Desktop/chat_4.0.zip —

Select the dependent services, if any, which should be included in export:

p ™, BCComman:4.0
> on cps:4.0
Q;_, jms:4.0
» % Studio:4.0
b ¥ TifosilavaRTL:4.0

CoooE

F P
| elect Al |

( Cancel ) ( Finish )
P

Figure 3.2.2: Export service to Local Disk

You can choose the export location by clicking the Browse button and specifying the location
to be exported. By default, the selected service gets included in the export. To export
Dependent services have to be selected from the tree as shown in Figure 3.2.2.

3.2.2 Importing Services from Local disk

Components can be imported from the file system. This can be done by clicking the Import
From Local Disk button as shown in Figure 3.2.3.

O Service Re... 23 | & Configurat..| — O

iy | 2]
gﬁzll::angZratmn IL§r11|3c:rt Frqu:lm Local Disk ]
(&) chat4.0
(Z) csChat4.0
(5 vbchat4.0
() veChat4.0
DE
Errar
File
Finance

m

Flow
MM
Performance 5

CoODODODODD

Figure 3.2.3: Import from Local Disk

This opens a file selection dialog box with which the zip file containing services on the disk is
then selected. Upon selection, the Import services dialog box appears where the services in
the zip file are shown in the form of a dependency tree, as shown in Figure 3.2.4.
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7 B
] Import Services l 5 |

Service selection

Select the service and dependencies that have to be imported:
4 [J](&) chatd.0
[#] %% BCCommoen:dd
% cpsd0
%% jms4.0
1%, Studic:d.0
[[] %% TifosilavaRTL:4.0

[] Owerwrite if exists
[T] Edit chat:4.0

[ Finish l [ Cancel

.

Figure 3.2.4: Import services dialog

Note: Components that are already present are labeled in red, and those not present in the
repository are labeled in black.

If the Overwrite If Exists checkbox is selected, the service in the service repository will be
over written by the one in the zip file, otherwise conflicting services are not imported from the
local disk.

If the Edit <Service> (For ex: Edit chat:4.0 in Fig.3.2.4.) checkbox is selected, after
clicking Finish an information dialog appears as seen in Figure 3.2.5.

E__] Service Import @

Service [chat:4.0] will be imported to repository only after the editor associated with
' the service has been closed

[] Do not show this next time

Figure 3.2.5: Service Import dialog

Clicking OK opens ServiceDescriptor.xml in which the user can edit the service and save it.
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%2 ServiceDescriptorxml £

Overview

General Information

Display

Mame: khat Palette Icon: (&)
Version: 40 Display lcon: @
Guid: chat

Category: Collaboration
Tool Tip: ASimple Chat Component i e S|
Description: a e

etadal

Author: Fiorano Software Technologies Put. Ltd.

Creation Date:  04-01-2005 12:00:00
[ Licensed

|

m 3
Overview | Execution | Deployment

Figure 3.2.6: ServiceDescriptor.xml

After closing the ServiceDescriptor.xml a dialog box appears in which the user can choose

either to stop the running instances of the service or not. Clicking OK finishes the import of
service from Local Disk.

F] Select an Option @
p

The service is about to be saved to the repository. How deo you
want to proceed?

(@) Stop instances

Stop all running instances of this service. The changes will
be reflected on synchronizing the Event Process.

(7) Do net stop instances.

Do not step running instances of this service, The changes
will be reflected only after disabling the component cache
followed by launch/synchronize action on the event

process, in case the component is already deployed to peer
SErVEr

Figure 3.2.7: Select an Option dialog

3.3 Fiorano Queue Manager

Fiorano Queue Manager tool provides a single view to see all the pending messages in an
Event Process.

3.3.1 Opening Queue Manager Tool

Login to Enterprise Server in Online Perspective -> Right click on Enterprise server node ->
Open Queue Manager as shown in figure 3.3.1.1.
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E\ Server Explorer &2 = B8
mEE
4 jfg EnterpriseServe|
4 B Event Process Login
5> (= Samples (1 Logout
» = User Proc
> i Peer Reposito Open Queue Manager Ié
g Security Duplicate
Delete
Shutdown
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Q% Service Re... 32 |B4 Export Logs..
View Logs...
O Bridges Activate
A i

Figure 3.3.1.1: Open Queue Manager

Queue Manager dialog is opened showing all the event processes in the Event Process
Repository in the left pane highlighting the running processes in bold letters. On the right
pane, a table is shown which displays the undelivered messages in the selected queue.

<

_F] Queue Manager Tool [Connected to tsp_tcp://192.168.2.21:1947] = | S |
a |" Queue Manager - Select a queue to display the undelivered messages
=D SalesForce_Integration
From Text Received Size

={Z EAl Demo

=D Bond Trading

=D Simple Chat
=0 Event Processl

=D Order Entry
=D Event Process2

=0 Event Process3

=0 Event Processd

a | [} |

=0 Hospitality Service

D WorkList_Manager
=0 WorkList Example

= RetailAutornation_Sport—
oD LeadsTolccounts

=Z DB Transaction Support
= Purchasing Systern

=D Mortgage Property Requ

T CrrnnnsiteR Memnn

m

3

[

Figure 3.3.1.2: Queue Manager Dialog

Figure 3.3.1.3 shows a sample running Event Process with 2 chat components. If chat2
component is stopped and messages are sent from chatl component, then the messages are
stored on the in-port queue of chat2 component.
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M2 Event Process2 i

chatl chat?

Figure 3.3.1.3: Sample Event Process

These Undelivered messages on the chat2 in-port queue can be seen by selecting the queue in
the left pane as shown in figure 3.3.1.4. Pagination feature is available at the bottom of the
table to navigate through the messages.

F] Queue Manager Tool [Connected to tsp_tcpif/192.168.2.21:1947] | B |
4 % Queue Manager ~ | B 3 No. of messages displayed : 6
o] SalesForce Integration [
{3 EAIDemo From Text Received Size
o] Hospitality Service chatl <ChatMessage> <Sender><Name>...  Wed Sep 12 17:44:21 15T 2012 784
={3 Bond Trading chatl <ChatMessage> <Sender><Name>...  Wed Sep 12 17:44:21 15T 2012 784
o{g WorkList_Manager chatl <ChatMessage> <Sender> <Name=...  Wed Sep 12 17:44:22 15T 2012 784
={3 WorkList Example chatl < ChatMessage> <Sender> <Name=...  Wed Sep 12 17:44:22 15T 2012 T84
={3 Simple Chat chatl <ChatMessage> <Sender> <Name>...  Wed Sep 12 17:44:22 IST 2012 784
=g Event Processl chatl <ChatMessage> <Sender> <Names...  Wed Sep 12 17:44:22 IST 2012 784
o] Order Entry
a ={g Event Process2

+m EVENT_PROCESS2_CHAT2_IN_PORT| |_
o] Event Process3 r
o] RetailAutemation_SportingGoods
o] LeadsTolccounts
o{J DB Transacticn Support

o{3 Purchasing System

={3 Mortgage Property Request Automation
o] Event Processd

={3 CompositeBC Demo

o{J Revenue Control Packet

=3 Retail Television

o] Event Process5

o] fef

s{a Portal Integration Page 1 of 1 100 Displaying Recerds 1-6 of 6
=12 Datahase Renlicatinn

Figure 3.3.1.4: Messages on selected queue

3.3.2 Document State Properties

To view Properties of the messages, Double-click on the message. If the message contains
any file attachments, go to Attachments tab, select the file attachment and use “Save As...” to
save the attachment on the local disk.
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E«. @ Mo, of messages displayed : 6

From Text Received Size
chatl = ChatMessage> < Sender> < MName> ... Wed Sep 12 17:44:21 IST 2012 T34
I
] Document State Properties ﬁ
General | Message Body | Properties | Attachments | Application Context
Property Value
LApplication Instance ID EVEMT_PROCESS2

Comment
Correlation ID
Document ID

Document is Redelivered MO

Document Type General Document
Entire Data Length 123 bytes

In Time MNOT SET

Is End of Service MNO

Qut Time MNOT SET

Port

Reply Channel

Service Instance Mame chatl
Source Mode Mame

Total Time MOT SET
Workflow Instance ID

Save As... Close

Figure 3.3.2.1: Document State Properties

3.3.3 Delete Messages

One or more messages can be deleted by selecting the messages and choosing the Delete
option using the right-click menu as shown in figure 3.3.3.1 or all the messages can be
deleted by clicking on Purge all messages button available at the top of the table as shown
in figure 3.3.3.2.

From Text Received Size
chatl < ChatMessage=> < Sender><MName>... Wed Sep 1217:44:21 I5T 2012 784
chatl < ChatMessage» < Sender> <Mame>...  Wed 5ep 1217:44:21 IST 2012 T84
chatl = ChatMessage» <Sender> <Mame=>...  Wed 5ep 12 17:44:22 [5T 2012 T84
chatl «ChatMessage= <5ender><Mame>.. Wed Sep 1217:44:22 I5T 2012 784
chatl <ChatMessage» <Sender> <Mame>...  Wed 5ep 1217:44:22 [5T 2012 T84
: chatl “hatMessages <Sender><Mame>... Wed Sep 12 17:44:22 IST 2012 784
...................... Delete

[

g

Figure 3.3.3.1: Delete Message
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=Y Q5 Mo. of messages displayed : 6

I'[ Purge all messages 1 Text

chatl = ChatMessage> <Sender= <Mam..
chatl = ChatMessage= < Sender: <Mam...
chatl = Chathessage» < Sender> < Nam...
chatl = ChatMessage> <Sender= <Mam..
chatl = ChatMessage= < Sender: <Mam...
chatl = Chathessage» < Sender> < Nam...

Recerved

Thu 5ep 13 09:56:38 I5T 2012
Thu 5ep 13 09:55:38 I5T 2012
Thu 5ep 13 09:55:39 I5T 2012
Thu 5ep 13 09:56:39 I5T 2012
Thu 5ep 13 10:05:57 I5T 2012
Thu 5ep 13 10:05:57 I5T 2012

Size
784
784
784
784
784
784

Figure 3.3.3.2: Purge all messages button

3.3.4 Refresh

Right-click on Queue Manager node and select Refresh to fetch all the newly added or
modified event processes and undelivered messages. Specific Event Process node can also be
refreshed by selecting Refresh on right-click menu of the event process node. This refreshes

the queues in the event process.

4 [T Queue Managper

a = Event Process?
By SalesForce Refresh E | +@ EVENT PRO Refresh

P Fvent Droeeced

=g EAl Demo
oy Hospitality Service

D Den ol Teardim e

Figure 3.3.4.1: Refresh

3.3.5 Search

“g TUED CIILY

m

[
by

The user can search messages by clicking on the Search button available at the top of the

table as shown in figure 3.3.5.1.

gr_ @\ND. of messages displayed : 10
From Text Received Size
chatl . =ChatMessage>» <Sender= <Ma...  Thu Sep 13 09:56:38 IST 2012 T84
chatl =ChatMessage» <5Sender> <MNa..,  Thu Sep 13 09:56:38 I5T 2012 T84
chatl =ChatMessage>» <Sender= <Ma...  Thu Sep 13 09:56:39 IST 2012 T84
chatl <ChatMessage» <5Sender> <Ma...  Thu 5Sep 13 09:56:39 IST 2012 T4
chatl =ChatMessage» «Sender> <Ma,.,  Thu Sep 13 10:05:57 I5T 2012 T84

Figure 3.3.5.1: Search bution

User can search messages based on message text and also based on the size of the message
by checking the Size button and giving the size in terms of bytes as shown in figure 3.3.5.2.
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Cancel

_F] Queue Manager Tool [Connected to tsp_tcp://192.168.2.21:1947] SR X

Search Messages Mo, of messages searched on EVENT_PROCESS2__CHATZ_IN_PORT: 7

. From Text Received Size

Containing Text: .

i chatl < ChatMessage> <Sender>=<M...  Thu 5ep 1311:30:42 [ST 2012 785

hi chatl < ChatMessage=><Sender><M..  Thu Sep 1311:30:43 IST 2012 785

[Clignore case chatl <ChatMessage> <Sender><MN..  Thu Sep 13 11:30:44 IST 2012 785

chatl < ChatMessage=><Sender><M..  Thu Sep 1311:30:44 [ST 2012 786

= chatl <ChatMessage> <Senders <M.  Thu Sep 13 11:30:46 IST 2012 785

787 =] bytes chatl <ChatMessage» <Sender»<N...  Thu Sep 13 11:30:46 IST 2012 785

chatl <ChatMessage= <5Sender><M..  Thu Sep 13 11:31:44 [ST 2012 787

L

Figure 3.3.5.2: Search Messages

User can stop the search by clicking on Stop Search button when searching large humber of
messages as shown in figure 3.3.5.3.

fj Queue Manager Tool [Connected to tsp_tcp://192.168.2.66:1947]

Search Messages

Containing Text:

tesﬂ

[ Size

[l1gnore case

Start Search Stop Search{g [ Cancel

[E=N EoR =3
Mo. of messages searched on EVENT_PROCESSS__DISPLAY1__IN_PORT: 945
From Text Received Size -
Feederl test message.., Thu 5ep 13 12:32:17 15T 2012 675 B
Feederl test message.., Thu 5ep 13 12:32:17 15T 2012 675
Feederl test message... Thu Sep1312:32:17 15T 2012 675
Feederl test message.., Thu Sep 13 12:32:18 IST 2012 675
Feederl test message.., Thu 5ep 13 12:32:18 15T 2012 G675
Feederl test message.., Thu 5ep 13 12:32:18 15T 2012 675
Feederl test message... Thu Sep1312:32:18 15T 2012 675
Feederl test message... Thu Sep 13 12:32:18 15T 2012 G675
Feederl test message... Thu 5ep 13 12:32:18 15T 2012 G675
Feederl test message.., Thu 5ep 13 12:32:18 15T 2012 675
Feederl test message.., Thu 5ep 13 12:32:18 15T 2012 675
Feederl test message... Thu Sep1312:32:18 15T 2012 675
Feederl test message.., Thu Sep 13 12:32:18 IST 2012 675
Feederl test message.., Thu 5ep 13 12:32:18 15T 2012 G675
Feederl test message... Thu 5ep 13 12:32:18 15T 2012 675
Feederl test message... Thu Sep1312:32:18 15T 2012 675
Feederl test message... Thu Sep 13 12:32:18 15T 2012 G675
Feederl test message... Thu 5ep 13 12:32:18 15T 2012 G675
Feederl test message.., Thu 5ep 13 12:32:18 15T 2012 675
Feederl test message.., Thu 5ep 13 12:32:18 15T 2012 675
Feederl test message... Thu Sep 13 12:32:18 IST 2012 675 &

Figure 3.3.5.3: Stop Search
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Chapter 4: Mapper Perspective

The eStudio incorporates Eclipse based Fiorano eMapper as a separate perspective. To open
Fiorano eMapper, perform the following steps:

1. Click the Open Perspective 1 button from the shortcut bar on the left-hand side of
the Workbench window.

2. Select Other... from the drop-down menu.

3. Select the eMapper Perspective to open Fiorano perspective. Click OK button. The
eMapper perspective containing Project Explorer and Funclet View appears.

More information on eMapper is present in Chapter 10 eMapper.

Chapter 4: Mapper Perspective Page 51



Fiorano eStudio User Guide

Chapter 5: Composing Event
Processes

Composition of Event Processes is based on component-based programming model. An Event
Process is composed of services (also known as Business Components) linked to each other by
Data Routes.

The Event processes are designed by drag-drop-connect function of service components. The
components are customized by configuration rather than by custom code. The routes between
components are drawn by visually connecting the component ports. Every component instance
in the flow can be configured so that it can be deployed on different ESB network nodes.

The following sections describe how to compose an Event Process, adding remote service
instances and adding external Event Processes. The sample Event Process illustrated below
connects Fiorano Chat Business Components with bidirectional Event Routes. The two
instances will be configured to run on different nodes in the network.

5.1 Adding Components

To add components, perform the following steps:

1. Open the Service Palette and click the Category tab (Collaboration) corresponding
to the service.

2. Drag and drop the business component icon (Chat) onto the Event Process editor.
Each icon in the Event Process editor represents an instance of the service. By default, the

name of each instance of the service is the service GUID followed by the instance ID count.
The Service instances can be renamed if required.

¥ Ve

[~ Bridges
= Collaboration

(&) chat

= DB

Figure 5.1.1: Adding components
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5.2 Connecting Routes

For the data to flow between two service instances, they need to be linked through Event
Routes. The Route represents the Brokered Peer to Peer data Route.

The Event Routes are unidirectional and always originate at output Event Port of the source
service and end at input Event Port of the target service.

Connect the Route from the output channel (OUT_PORT) of Chatl service icon to the input
channel (IN_PORT) of the Chat2 service icon and vice versa, as shown in the Figure 5.2.1. By
default, each Route is identified by an Event Route name such as; Routel and Route2. The
suffix represents the instance count of the Route. You can edit the Route name using the
Properties window.

|

routed

I

chatZ chatl

Figure 5.2.1: Connecting components through routes
5.3 Configuring Components

All the services contain configuration information that can be provided in the Custom Property
Sheet (CPS) dialog.

To review the custom property sheet associated with any component, double-click the
component in the event process editor.

A Sample Database component CPS is shown below, containing all the details of the Database
connection, SQL, and so on. Sample CPS is shown in Figure 5.3.1.
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ene DB1 [DB:4.0]

Managed Connection Factory
(D Configuration is Valid

D Show Expert Properties

Database oracle FH
Driver oracle.jdbc.driver.OracleDriver 5
URL jdbc:oracle:thin:@<hostname>:152 1:orcl |:J
User name scott
Password e
Connection Properties Click ... to edit =l
Auto Commit B8
Connection Pool Params Click ... to edit ==
e}
Query timeout (in seconds) 60 E_‘ TIWEEIE)
m
Fetch size 200 : (G 362
o
Connection ping sgl select * from dual
Enable JDBC Driver Logging B8
Description

Place cursor on a property to view its description

< Back ) Finish ) ( Cancel -_) CSaveandC}ose)

Figure 5.3.1: DB Custom Property Sheet (CPS)

During configuration, clicking the Test button provided in the CPS can also test the

configuration.

Components configurations are saved in EventProcess.xml file. This file is in a simple XML

format.

Service instances contain configuration information that is used for execution at runtime. The

data flows from service instances through connected routes.

Chapter 5: Composing Event Processes

Page 54



Fiorano eStudio User Guide

5.4 Configuring Component Properties

Apart from the component specific properties that can be configured using the CPS, there is a
set of properties associated with every component. These properties are shown in properties
view when a component is selected. The properties are categorized into various sections as
shown in Figure 5.4.1

m

] —I/I: o]

| O

CBR1 [k
E Properties 2 = NS

General Name: CBRI
Deployrment Guid: CBR D

Execution

Yersion: 4.0 =2

Log Manager
Log Medule Instances | Short Description: The CBR service filters data based on the an XPATH selection [ |

Runtime Arguments . - — -
Long Description: The CER service allows data filtering based on the given »

XPATH selection criteria. This service accepts XML data on
the input channel, performs XPATH selection and writes
data to the appropriate cutput port.

[T Use Separate Process CPS
Figure 5.4.1: Component properties

General: Contains the general information of the service like Name, GUID, Version Short
Description, and Long Description. In addition to these, the General tab also has an option to
launch the Custom Property Sheet (CPS) of the component in a separate JVM. This option can
be used when loading the default eStudio CPS is complex and takes up too much memory.

Deployment: Contains the deployment information of the component. The Peer Server node
on which the component has to be launched can be configured here.

Clicking on ellipsis button against the Nodes property opens the Select Nodes dialog box
where the Peer Server can be selected.

Chapter 5: Composing Event Processes Page 55



Fiorano eStudio User Guide

B properties £2 l
|
General | Nodes: fpsl
Deployment
Cache C t
= ache omponfn a |Yes
8enn Select Nodes
Log Manager
Log Module Instances Available Nodes Selected Nodes
Runtime Arguments (0 fps - (7 fpsl
Up
- \
Sl ol Down
<<
S
®

€ Cancel ) (-—en—-)

Figure 5.4.2: Component ports

Based on the selected Peer Server, the component color changes to give a visual clue as to
which Peer the component is configured to launch. As shown in Figure 5.4.3, the Feeder
component is configured to launch on fps Peer and CBR is configured to launch on Peer fps1.

Feederl

Figure 5.4.3: Components configured to launch on different Peer servers

By default, when a Peer Server is added to an Enterprise Server, a unique color is chosen. The
user can customize this color using colors from Peer properties by selecting the Peer Server in
Peer Repository.

A property called Cache component specifies whether component resources have to be re-
fetched each time when Connectivity and Resource Check (CRC) is done. When Cache
Component is set to yes, the resources are fetched for the first time when CRC is done. This
property is set to No only when the component resources have been updated.

This property is also available at the Event Process level.

Execution: The Execution section contains information about the launch type, connection
factory properties, and so on. Components can be launched in Separate Process (separate JVM
for each service instance), inMemory (launches in Peer Server JVM), Manual (manual launch
mode where the user has to launch the service instance manually) and None (no launch
mode) modes.

Log Manager: Contains logging information like the type of Logger Handler, log directory,
and so on.

Log Module Instances: Log Module Instances: Log levels for various loggers available for
the service can be configured in this section.
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By default the log level is set to SEVERE. This can be changed to the desired level. For
example, the log level can be set to CONFIG when working on the Development environment.

E Properties 2 Y = O
General Mame Value Append Service
Deployment All Levels = Different Values> Yes
Bl ol com.ficrano.services.display.DisplayService  WARMNIMNG Yes
T—— c0m.ffu:uranu:u.senr!ces.dfsplay.tran.sport.Jms WARMIMG Yes
Loa Module I com.ficrano.services.display.engine WARMIMG Yes

og Module Instances | ¢pp HANDLER SEVERE Ves
Euplme dmuments OUT_HANDLER INFO Ves

Figure: Component log module instances

When the component is launched all the component log module instance names are modified
to include Event Process name, Service Instance name and Service GUID to maintain
uniqueness.

For example, if the log module instance name of a component is
com.fiorano.services.display.DisplayService, when the component is launched some extra
information is included and is changed to
EVENT_PROCESS1.COM.FIORANO.SERVICES.DISPLAY.DISPLAY1.DISPLAYSERVICE and the
logger is created with the changed name.

In the above example the log module instance name has the service guid name Display.

If the original name doesn't have Service GUID name, then Application Name, Sevice GUID
and Service Instance name is pre-pended to the log module name.

For example if the log module instance name is
org.apache.ws.security.processor.SignatureProcessor, when the component is launched then it
is changed to
COMMUNICATIONS_IN.WSSECURITY.WSSECURITY1.0RG.APACHE.WS.SECURITY.PROCESSOR.
SIGNATUREPROCESSOR and the logger is created.

Changing the log module instance names at component startup is required to maintain
uniqueness of components logs especially when multiple instances of a component are running
in the same JVM.

However, this does make logging from 3rd party jars difficult to manage when working with
custom components. To avoid this the property Append service Info is useful for controlling log
levels of loggers used by third party libraries, since the handlers for such loggers will be
created without appending service info to the logger names used by them.

Note: This property should not be set to yes for default loggers used by Fiorano pre built
components and loggers generated by default in custom components.

Runtime Arguments: Contains the information about the runtime arguments for the service.
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JVM_PARAMS section contains the JVM parameters that are used while launching the
component. Whenever a change is made in JVM PARAMS section, the Update all Service
Instances dialog box appears asking whether the change has to be updated for all the service
instances in all Event Process having the same JVM PARAMS value.

enn Update all Service Instances

1 Do you wish to update Service Instances from all the Event Process with Jvm
Arguments value ' -DLOG_TO_STREAM=true -Xrs' to ' -DLOC_TO_STREAM=true -
¥rs -Xmx128m'? Selecting no will update the Jvm Arguments value of currently
selected Service Instance(s).

Figure 5.4.4: Update all Service Instances dialog

If No option is selected, then it updates to the current service instance. If Yes option is
selected, a dialog listing the service instances with same JVM PARAMS value appears and the
required service instances can be selected for an update.

|nn Select Service Instances

v =5 APPL X
Q{s chatl
Qg chat2
. DB1
| "[‘: Event Processl

OO

( cancel (-—en—-j

Figure 5.4.5: Select Service Instances

5.5 Adding Remote Service Instance

The Fiorano SOA Platform allows you to compose an Event Process with Business Component
instances from other Event Processes. The Remote Service instance is one of the available
options for communication between different event processes. If the producer component is in
a calling event process, then the producer component needs to send messages to the
consumer component in a called event process, then a remote instance of the consumer
component can be used in the calling event process.

The imported service instance is the reference to the service instance in the parent Event
Process. Any changes made to the imported service instance in the parent Event Process are
reflected in the current Event Process. Current Event process can be launched only when the
Event Process of the remote service instance is running.

To add a remote service instance, perform the following steps:

1. Click the Insert Element into Event Process < icon and select Insert Remote
Service instance option (or) right-click on orchestration editor and select Insert
Remote Service instance.
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2LEEG

Insert Service Instance

Insert Remote : Inskance

Insert Event Process

Figure 5.5.1: Insert Remote Service Instance option
The Select Remote Service Instance wizard starts, as shown in Figure 5.5.2.

This dialog box lists all the Event Processes and their service instances.

enNe Select Remote Service Instance

type filter text

(= Bond Trading W
b [= CompositeBC Demo
¥ [ Database Replication
EApannext_DracleDut
£ crm
M CRM_AppContext
£ pracleln
Q OraclelnResult
E: OracleOut
& sqLServerin
Q 5QLServerinResult
b [= DB Transaction Support
b (= EAl Demo
B = Hospitality Service
B [= Mortgage Property Request Automation
B = Order Entry
- (= Portal Integration
b [= Purchasing System &/
= RetailAutomation_SportingGoods
b [= Retail Television
b = Revenue Control Packet
B = SalesForce_Integration

f: Cancel :J ( oK )

Figure 5.5.2: Select Remote Service Instance dialog

2. Select the service instance you want to add as Remote Service Instance and click the
OK button.

The Remote service is added to your Event Process with a satellite like icon in the
component as shown in the Figure 5.5.3.

-
O = o
un
DATABASE_RE
PLICATION.Or
aclelnl

Figure 5.5.3: Remote service added
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A Remote Service instance can be used in a similar manner to normal a service instance.
Routes can be created between other service instances in the Event Process and the ports of
the Remote Service instance.

Note: While using Remote Service instance with Event Process Life Cycle Management
(EPLCM), and if a component is running in a configured mode (say Testing) in the parent
Event Process and if this component is used as a Remote Service instance in a caller Event
Process, then changing the mode in the caller Event Process will not have any effect. It still
uses the mode used in parent Event Process.

5.6 Adding External Event Process (Subflow)

Subflow concept is used to ease the Event Process development when composing large Event
Processes. When an Event Process B is copied into another Event Process A, all the data
(service instances, routes etc) in B is copied and shown as a single entity (icon) in A. By
default, the icon takes the name of the added Event Process (that is, B). When we double-click
on the icon it shows all the service instances/routes and so on. The ports of the inserted Event
Process B can be exposed for communication with Event Process A.

The External Event Process is explained with an example. Steps to add EAI_DEMO Event
Process in Simple Chat Event Process are explained below:
1. Open an Event process (Simple Chat) and click the Insert Element into Event

Process < icon and select the Insert Event Process option from the drop-down
list (or) right-click on the Orchestration Editor and select Insert Event Process.

PLEEGE O -
Insert Service Instance
Insert Remoke Service Instance

Insert Event Process

Figure 5.6.1: Insert Event Process option

2. The Select Event Process dialog box appears as shown in Figure 5.6.2. Select the
Event Process from the list and click the OK button.
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8086 Select Event Process

Select an item to open (7 = any character, * = any string): b

?

Matching items:

e{] APPL_t 2 -
"[‘: Bond Trading

"[: CompositeBC Demo
"[E Database Replication
"[‘: LB Transaction Support
e{g EAl Demo

"[‘: Hospitality Service

"[2 Mortgage Property Request Automation e
"[‘: Order Entry

"[: Portal Integration

"[E Purchasing System

"[‘: RetailAutomation_SportingCoods “
M3 Retail Television b |

Filter Criteria: (") Name () Guid:Version [ ) Categories (@) Any one

|"[E EAI_DEMO-1.0(Categories : Samples.lnventory) |

! 1: Cancel 31 ( oK ) |

Figure 5.6.2: Select Event Process dialog

3. The Event Process instance representation appears on the Event Process editor, as
shown in Figure 5.6.3.

8{Z *Simple Chat 32 |

-
route L
-~ chat2

@

routed

EAI Demo

Figure 5.6.3: Inserted Event process

Note: This concept is different compared to the Remote Service Instance. In the Remote
Service Instance, remote instance will refer to the original instance but in this case a copy of
the selected Event Process is made and used in the Event Process. This is basically a visual
representation that makes the composition easier when working with large event processes.
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4. Double clicking the EAI Demo icon shows all the service instances and routes inside as
shown in Figure 5.6.4.

% simele Chat - EAIDemo ¢ |

/_':ancted Orde

Rejection_Ewent

R

Acceptance_Event

|
\—-D O—Mail_Event—s0] o

Xslt_Tranform SMTP_Bridge

Figure 5.6.4: Component ports

By default, no input and output ports are shown for an inserted Event Process instance. The
user can expose the required input and output ports of service instances present in the Event
Process instance from the Properties tab as shown in Figure 5.6.5.

[-=- Samples
= Script
ol & 1o
== Transformation
EAl Demo (= Wil
[ Web
[ WebService
i El properties £3 ¥ =0
1
General Name: EAl Demo
Description :
Components:
Service Instances: Parts:
Rejected_Orders ™ n_poRT
ERP W ouT_PoRrT
CRM [ ON_EXCEPTION
Xslt_Tranform
SMTP_Bridge

Figure 5.6.5: Properties tab
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5. Routes can be connected between other service instances in the Event process and
subsequently inserted into the Event Process. This allows the connected service
instances to communicate with each other.

5.7 Document Tracking

A workflow in Fiorano terminology consists of an entry point, an intermediary points and an
end point. The entry and intermediary points are defined as Workflow Items and the end point
is defined as a Workflow End.

To track the documents going through the Service Instances, document tracking can be
enabled on service instance ports. If tracking is enabled, the documents that pass through
that port are stored in a database. By default these documents are stored in the H2 database
that runs inside the Enterprise Server. It is recommended to use an external database for
document tracking. An external database can be configured for document tracking by
providing the database configuration details in sbwdb.cfg file located in the Enterprise Server
profile .

A workflow starts with Workflow Items and ends at Workflow End. A workflow is defined within
an Event Process scope through which a large number of documents pass. Whenever a new
document enters into the workflow, a new workflow instance is generated. Each workflow
instance has a unique ID assigned by the Fiorano SOA environment. In a state enabled
workflow, all the states that these workflow instances traverse are stored for tracking
purposes.

Each workflow instance contains information about documents that pass through. Each time a
document passes through a trackable state, a state event is generated and the document is
given a new Document ID by that trackable state. Information related to the documents can
be viewed in the Fiorano Web Console.

eStudio provides a state-based workflow view that enables tracking and monitoring of
documents from one state to another.

To enable document tracking in an Event Process, perform the following steps:

1. Select the Service Instance Port on which document tracking has to be enabled. The
Properties pane appears (if the Properties pane does not appear, go to Window->Show
View-> Others-> and select Properties).

2. To enable the Enable Document Tracking, select Workflow Item/Workflow End
option in the Workflow property drop-down list as shown in Figure 5.7.1.
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= Script
#——routel—>»0 O—route2—eO [+] [= Transformation
. = Util k)
Feederl SMTP1 Displayl %, UECO M piESSIcmmm—m
£} Decryption
(A Niclel | ST
= Web
= WebService
Bl | =2 B~ £+ = O|(E Properties 53 = =5
|
General Name: OUT_PORT
IMS Destination
——— Workflow: Workflow Item
M"“L No WorkFlow
Workflow Data Type: Workflow Item
Workflow End

Figure 5.7.1: Enabling Document Tracking

3. In the sample Event Process shown below, the workflow starts at Feeder Output port.
The SMTP Output port is marked as an intermediary point and the workflow ends at
Display Input port.

o—route]—»0 C—routel2—eE (o]

Feederl SMTP1 Displayl

Figure 5.7.2: Event Process with Document Tracking enabled

4. Workflow items are filled in with the color green and Workflow End is shown in the
color red.

In the Event Process, the state tracking is enabled for Feederl output port, SMTP1 output port
and Display1l input port. All the messages which pass through these are tracked.

The default Workflow data type is set to Message Body. This implies that only the JMS
message body is tracked. This can be configured by clicking on ellipsis button against the
Workflow Data Type property to track Message Header, Message Body, Attachments,
Application Context or all of these items.
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8eoo Doc Properties Dialog

Select the item(s) which are applicable:

ClAl |
[ Message Header

E Message Body

[ Attachments |

1 Application Context |

| -

(: Cance| :,I f OK }

Figure 5.7.3: Document Tracking Properties

5.8 Defining Route Transformations
In addition to XSLT component, transformations can also be defined on routes having schema
mismatch. In the example shown below, there is a schema mismatch between Feeder output
port and CBR input port and hence the route is shown as dotted line.
A route transformation can be defined in any one of the following ways:

e Defining a Mapper Project,

e Providing a Custom XSL,

e Using a Named Configuration, or

e Import from a Zip file

Defining a Mapper Project allows the user to define mappings between the source and target
port schema using Fiorano eMapper.
To define the transformation using eMapper, perform the following steps

1. Right-click on the route and select Mapper Project option in
Configure Transformation sub menu.
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=il -I/I: <o
- —|
" CBRL
oo Edit >
P ] Properties Ctrl+ Alt+V, P
Feederl Save Selection As...

<2 Undo Route creation

Redo

Clear Transformation

Configure Transformation 4 Mapper Project %

Save Configuration As... 4 Custom X5L

Use Named Configuration

Irnport From Archive File [ Zip]

Figure 5.8.1: Route Transformation

2. Route transformation editor will be opened which automatically

picks up the schemas on connected ports.
Transformations can be defined on the schemas by connecting elements from input
structure with output structure elements. Additional computations on elements can
also be made by using functions present in Funclet view.

"[E *Event Processl * =g

H 4% CIRAR S

¥ <R» Application-Context ¥ <R} IN_PORT

[E] Context v [E YZKFamilyReunion
v <’ OUT_PORT

v [E] Participants
w >=1 [ONE MANY]
— [] Name

w [E] BookStare
v =1 [ONE MANY] -
v [E] Book > —

[€] Title —
(8] Author————— ——
[E] Date
[=] 1seN
[E] publisher

Figure 5.8.2: Route transformation editor

Note: While the editor is open for defining transformations, the Event Process editor
will be in non-editable state to prevent further changes till the transformation editor is
closed. This becomes editable when the transformation editor is closed.

Once the transformation is defined and closed, transformation
will be set on the route and the route is shown as bold.
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ﬁo_'—_‘_mutﬂl—'——-—m a0

Ll
Feederl
eeder CBRL

Figure 5.8.3: Route with fransformation set
To provide a Custom XSL, perform the following steps:
1. Right-click on the route and select Custom XSL from Configure Transformation menu.

2. The Custom XSL Dialog is opened. Provide the XSL in the first tab and XSL for the JMS
Message (if any) in the second tab. Click OK to set the transformation on the route.
The XSLT Engine to be used (Xalan / Saxon / XSLTC) can be specified from the drop-
down in the top right corner.

3. The XSL provided can be tested by clicking the Test button.

B3| Custom XSL @
Metalata ASLT Engine

%L | M waL
ekg

<7xml version="1.0" encoding="UTF-5"? >
<xshstyleshest version="1.0" xmins:math="http: /fexsl. org/math" xmins:xalan="http: /fxml. apache, orgfxslt”
wmlnsiset="http:/fexslt, orgisets" xmins:java="http: fxml. apache orgfxslt fjava"
swrmlnssxsi="htbp: v w3, orgf2001 EMLSchema-instance” xmins:bxslt="http: {/xml. apache.orgfxslt"
wmins:datetime="http: /fexsl, orgfdates-and-times" xmins:csl="http: fhwe, w3, orgf 19990250 Transform”
exclude-result-prefixes="xalan java lxslt" xmins:ns3="http:{ jww, books, org"
wrmlns:ns4="http: /v w3, orgf2001 EMLSchema” xmins:ns 1="http: v, fiorano, comjfesb)activity fSMTP fsmbp/in®
wmins:dateConversion="ext1" xmins:myext="ext2" xmins:strings="ext3" extension-element-prefixes="datetime sat
math dateConversion myext strings" =
<xshoutput method="xml" indent="no" encoding="UTF-&" xalan:indent-amount="2"
omit-zmi-declaration="no" = <fxsl output >
<xslvariable name="document" seleck=""=<fxs|:variable =
<xshvariable name="document_OUT_PORT" select="document{"OUT_PORT"Y" = < fxslvariable =
<xsl:kemplate match=""=
<ns3:BookStore >
<ns3iBooks
<ns3:Title
<xslivalue-of select="¢document_OUT_PORT/ns1:EmailfSubject” = < fxslivalue-of =
<Ins3iTitle =
<ns3:Author =
<xshivalue-of select="¢document_OUT_PORT/ns1:EmailfFrom" = < fxslivalug-of =
<Ins3Author =
<ns3:Publisher =
<xslivalue-of select="¢document_COUT_PORT/ns1:EmailiHeadersiHeader /@value" = < fxslvalue-of =
< Ins3:Publisher =
<fns3:Book =
</ns3:BookStore =
<fxslitemplate =
=fxslistyleshest =]

Test ] [ oK ] [ Canicel

Figure 5.8.4: Custom XSL Dialog

Transformations can also be saved in the Configuration Repository as Named
Configurations and can be used wherever needed. Creating a transformation Named
Configuration is explained in detail in Section 15.8.

To Use a Named Configuration as a route transformation, right click on the route and select
Use Named Configuration. Choose the configuration to be used from the list of available
named configurations.
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Users can also import previously exported transformations from a .Zip file by selecting the
Import from Archive File [.Zip] from the Configure Transformation menu.

To save the transformation defined on a route as an archive file, right click on the route on
which the route transformation is defined and select Save Configuration as.. -> Archive
File.

The transformation defined on route is executed inside the Peer server. So it is advised to not
to define complex mappings (involving huge schemas and mappings) using Route
Transformations since it may affect the Peer server performance. For complex transformations
XSLT component can be used.

The transformation defined on route can be cleared by selecting Clear Transformation
option in the right-click menu option on the route.

Route transformation can be changed on the route at both configuration time and runtime.
During runtime if the transformation is changed, the changes are automatically deployed to
the server. The user need not explicitly synchronize the event process for the changes to take
effect.
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5.9 Configuring Selectors on Routes

eStudio allows you to define Selectors for the data flow through an event route. The Selectors
can defined based on

¢ the Sender of the message

e the value of a JMS property in the message

e using an XPath defined on the incoming xml message or
¢ an XPath defined on the Application Context (if any).

When a selector is defined on a route, a filter icon is added next to the route’s name as a
visual indication (Ref Figure 5.9.1).

5.9.1 Sender

Take an example of an Event Process containing two instances of a Chat service and an
instance of a Display connected through routes as shown in Figure 5.9.1.

O\ S oroute?
chatl routel
routed Displayl
O_/ S oroutel
chat?

Figure 5.9.1: Out-port of chat1 and chat 2 to display in-port, out-port of display to in-port of Chat1
and chat2
In the above event process, the event routes exist as defined below:

¢ Routel: Connects OUT_PORT of Displayl to IN_PORT of Chat2

¢ Route2: Connects OUT_PORT of Displayl to IN_PORT of Chat1l

¢ Route3: Connects OUT_PORT of Chatl to IN_PORT of Display1l

¢ Route4: Connects OUT_PORT of Chat2 to IN_PORT of Display1l

Chapter 5: Composing Event Processes Page 69



Fiorano eStudio User Guide

When the Event Process is launched, if a message is sent from Chatl component, it is received
by Display component and the message is sent back to both Chatl and Chat2 components
from Display output port.

Now, let’s define conditional data flow from the Display business component instance. Assume
that Displayl has to send only those messages on Routel which are sent from Chat2. Similar
conditions should also apply to Chatl that it should also receive only those messages that it

sends to Displayl.
To define conditional data flow through routel, perform the following steps:
1. Select Route 1, the properties of this route is displayed in the Properties tab.

2. In Selectors tab, choose the option chat2 from Sender properties as shown in Figure

5.9.2.
E properties E@l =0
]
General Sender: chat2 _
= <MONE=> Add a new Sender Selector
Messaging .
Q IMS: chatl r
Selectors
DCisplayl

Figure 5.9.2: Configuring Selectors on route

This ensures that data sent only by Chat2 will travel through this route. Similarly, set this
value to Chatl for Route2. This ascertains conditional flow of data. After the changes, if the
event process is launched, messages sent by Chatl are received only by Chatl and messages
sent by Chat2 are received only by Chat2.

5.9.2 IMS

Apart from Sender selector, a JMS selector can also be defined which checks for a particular
value for a JMS message property and routes the message.

As an example consider a flow with a feeder and a display connected by a route. A selector
can be defined on the route which allows only those messages which have a property
testProperty set to the value chk.

To create this selector, click on the route, in the Selectors property tab, provide
testProperty='chk’ in the text box next to JMS and save the event process.
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C-. o ? I.CU:El_ —.ﬂ G

Feederl Displayl

[ Propertes 11

General Configuration: | <Mones=
Messaging Sender: |

Selectors

Transformation MS: | testProperty="chk

Figure 5.9.3: Configuring JMS Selector on route

Add the testProperty property to the input message sent from Feeder, the message will be
sent or filtered based on the value.

l EVENT_PROCESS]_ Feederl . - .'—| ,

History( last 0 0f 2} (Select a row to Ioad the message)
# I Sent | Message

Body Headers&mtachment5|

Header Properties Attachments

Name Type Walue Name Size
chk
Agd || Deete || Deletean | Add.. || Deete || Deetear |

|  Load Default Message | | Send ] | Send-N times | Clear ]

Figure 5.9.3: Setting property value on a message from Feeder

Similarly to select all the messages whose value of the testProperty is not chk, create a JMS
selector with the expression testProperty<>’‘chk’
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5.9.3 Message Body XPath

XML Messages going through a route can also be selected based on XPath. To define the
XPath, select the route and click Edit button in the Message Body XPath section in Selectors
property tab. This will launch an editor showing a list of namespaces and their prefixes (Figure
5.9.4). User can add/edit namespace prefixes from the table here.

i "

ﬂ Customize XPath of selector @
Specify the prefix -> namespace mapping to be used in XPath evaluation:

Prefix LIRL Add

ns2 http:/fwww.w3.org/2001 XMLS5chema
nsl http:/fwww.books.org

XPath:

LJ

Figure 5.9.4: Dialog showing namespace prefixes and the XPath launcher

Clicking the ellipses (...) button launches an XPath editor displaying the message body
structure on the left and a canvas to build XPath on the right (Figure 5.9.4). A brief description
on building an XPath using the XPath editor is provided in below

5.9.3.1 XPath Editor

XPath Editor %]

E|.|'
Em

[=--=ns1:BookStore =

=1 <ns1:Book>+

sl Title =
~znsl:Author =

----- <nsl:Dake=

----- zns] ISEM = |,|' ns1:Bookstore [ nsliBook [ onsliTitle |R|

L 2ns1:Publisher =

ZPATH

Dacument LF‘aIette I

[ Ol H Cancel ]

Figure 5.9.4 Xpath Editor
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XPath Editor can be used for specifying path expressions to identify nodes in an XML document
and for specifying conditions. The list of elements from schema provided are shown in the left
panel of the editor. An XPath Editor with sample schema is shown in Figure 5.11.4.

XPath Editor X

=
B- .
SR — |,|' nsl:BookStare || nsl:Book [ |nsl:Title |R|
Z-<ns1:Book>+
-<ns 1 author s BB Paste -+
-=nsl:Date T Select Al Chrl+a
-zns1ISEN s
- 2ns1:Publisher = = | Add Constant s String Yalue. .. Ctrl+Alk+5
Add Function. .. Chrl+F Humneric Yalue. ., Chrl+alk-+N
Add Operator. ., Chrl+0 Boolean Yalue. ., Ctrl+alt+E
Add xPath... ChrlNumPad + Date-Time Value..,  ChrH-al+T
Edit. .. Enter Curation Walue. .. Chrl+-ak+D
ﬁl Laynut Chrl+R
&h Prirt... Chr+p
[ — [Z Print Preview. .. Chrl+Shift-+P
Tesk. .. Chrl+FS -
=

Figure 5.9.5: Adding a constant in XPath Editor

An element can be selected by simple drag and drop onto the right panel. An XPath expression
may consist of different constant values, functions or/and operators. These can be added
easily by right clicking on the right panel and selecting the option based on the requirement as
shown in Figure 5.9.5.

Adding a Function: A function can be added either by right clicking on the right hand side
panel --> Add Function or by selecting from the list available in the palette tab which is
present in the left panel as shown in figure 5.9.6.

XPath Editor X]

[+l Date Time and Duration FS

ﬁ Agagregate Functions
(B Accessors |,|' nsl:Bookstore | nsl:Book [ nsl:Title |R|

E ii# Sequence Functions R
I_:_Iﬁ String Functions

-l Assemble and Disassemble
-l Substring Matching

=i Pattern Matching

P e

F replace makches( xs:skring? , |xsiskring )|><s:bou:-lean|

Lo F tokenize

| €

Figure 5.9.6: XPath Editor - Palette containing different XPath functions
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A string function matches which takes two arguments and returns a boolean value is shown
in the Figure 5.9.6.

Adding a Constant value: Supported types of constants are String, Boolean, Numeric, Date-
Time, and Duration.

Example: Addition of a boolean value can be done as described below

o Right-click on the right panel. Select Add Constant -->Boolean Value.

o Select the value as shown in Figure 5.9.7.

Customize Boolean Value @

Boolean Yalue:
kruel) W

krued)

[ Ok H Cancel ]

Figure 5.9.7: Adding a boolean constant

Addition of a Operator:

Operator [z|
D Operakor:
</ L 3
+ .8
* -
div =
idiv
mod
I= v
Figure 5.9.8: Adding an operator
o Right-click on the right panel. Click on Add Operator.
o Select the operator as shown in Figure 5.9.8.

40|r

fargl | + 4$argz ||R
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fargl | + %$argz ||R

Figure 5.9.9: Add(+) operator

Figure 5.9.9 illustrates a sample Xpath expression using a '+' operator. It contains two
numeric constant values which are passed as arguments to the operator.

Click OK in the XPath editor and an new selector will be added to the route as shown in Fig
5.9.10
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E Properties i3 T
T Configuration: <Nonex -
Messaging Sender: -
Selectors —
Transformation IMS: u
Message Body XPath: matches(/nsl:BookStore/nsl:Book/ns1:Title,'Java') Remove @
Application Context XPath: Remove E
Figure 5.9.10: A Message Body XPath Selector as seen in the route’s properties.
5.9.4 Application Context XPath
Similar to the message body structure, an XPath can also be defined on the structure of
the Application Context, if any, defined on the Event Process. Clicking the Edit button will
launch an XPath editor as described in the previous section but with the Application
context structure. Configuring the application context for an event process is described in

Section 5.10

5.10 Configuring Application Context

There are times when a target Event Port needs information that was produced by a

service instance that occurred earlier in the workflow. Consider an event process

representing a ten-step business process. Each step is implemented using a service
instance. By using application context, a service instance representing the tenth step in
the process can use the information generated by the service instance in the second step.

Application context is set as a JMS Message Property on the message and is available

throughout the function.

To define Application Context for an application, perform the following steps:

1. In the Event Process project, click on the Orchestration Editor and open the

Properties view.

2. Click the Application Context tab in the Properties view.

3. To define an Application Context for the Event Process, enable the Application

Context option.
4. Select DTD/XSD option and provide the schema content.

5. Click the Save Content button to save the changes.

6. Select root element from the list of available roots in the Root drop-down list. Now

the application context schema is defined for the Event Process.
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| Properties &% |

General

|
| gApplication Context

Application Context

Value:

Enviranment Properties

[

oTD

L

Schema:

® xsp

<?xml version="1.0"7>
<usd:schema xmins:xsd="http:/ /www.w3.org /2001 /XMLSchema”
targetNamespace="http:/ /www.binary.org"
Content of Schema mv.blnarv:qrg_
revemremrossa Ll U= "q Ul ifled"™>
<xsd:element name="hinary-string">
<xsd:complexType>
<xsd:choice minDccurs="0" maxOccurs="unbounded™>
<xsd:element name="zerg" type="xsd:unsignedByte" fixed="0"/>
<xsd:element name="one" type="xsd:unsignedByte” fixed="1"/>
< /xsd:choice>
</xsd:complexType>
< /xsd:element>

e

Save Content Root: [{hitp://www.binary.org}binary-string v

Figure 5.10.1: Application Context option

7. The default value of Application Context defined can be provided in the Value
section. If not provided here, this can be defined in the context menu on the
Output port of a component or using an XSLT component.

8. To define from Output port option, Right-click on the Output port and select
Application Context option.

o @ ; —
| Subscribe/Receive Messages [

chatl Browse Messages

View Schema Structure...

Edit

Browse Routes
] Properties

Run As

Debug As

Team

Compare With
Replace With

Application Context

Clear Application Context

NEVP

ave Selection As...
< Undo Move
Redo

yFYyYwvywyy

Figure 5.10.2: Application Context on output port

9. The Mapper editor opens up where the mapping for the Application context can be
defined. Save the mappings. The port figure will be shown in bold font to give a
visual representation.
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3 *Simple Chat il2 *projectfmp 53

ISER g
v <F* Application-Context v <R Application-Context
v [E] binary-string v [E] binary-string
v =0 [ZERD MANY] ¥ >0 [ZERD MANY]
¥ OR [Choice] ¥ OR [Choice]
[e] zero [e] zero
[€] one [&] ane

¥ <F» OUT_PORT
v [=] ChatMessage
v [E] sender
[&] Name
[] Email
[=] Message

Figure 5.10.3: Mapper editor

10. Once Application Context is configured at one of the out ports, the value is
propagated in the message flow.

11. The application context can be used anywhere in the event process using Xslt
component or Route Transformation.

5.11 Configuring Port Properties

General: Contains the general information about the port like the name and the
configuration used to configure it if any; none otherwise. In addition it also contains the
workflow information about the messages sent through that port thereby enabling tracking
of these messages by the Event Process Manager. Specific part(s) of the message can be
tracked by selecting the workflow data type.

JMS Destination: The message destination can be configured here.

e Destination Type: The type of the destination or the message target can be
selected here. By default the input destination type of any service is QUEUE and
the output destination type is TOPIC.

e Custom Destination: This option enables the target to be specified by the user.

e Destination Name: The custom destination that the user wants to should be
specified here if the above option is enabled.

e Is Encrypted: If this property is enabled, the messages sent through that port will
be encrypted using a specified encryption algorithm.

e Encryption Algorithm: If the above property is enabled, the user can select from
the list of available encryption algorithms to encrypt the messages.

e Encryption Key: The encryption key used in the algorithm should be specified here
if encryption on the messages is enabled.
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= propartes £ | [2 problems Qerrorlog Bl console #®7 =0

-] Destination Type: | Quete ¥ | =

WS Destination . Desnain: | o

Messaging

Destination Name:

Ts Encrypted: “(35 v ‘

Encryption Algorithm: ‘DES 3 ‘

Enarypton key: | OFETATEATGETERCARc |

Alow Padding to Key: “ﬂes - ‘

Figure 5.11.1: JMS Destination Configuration
Messaging:

The message specific properties like message configuration, transaction size (if
transacted), no. of sessions, acknowledgement mode, durable subscription (for TOPIC
destination types), subscription name (if durable), message selector(as in selectors for
routes in section 5.9), time to leave, message priority etc can be defined here.

= propertes 3 (51 Problems OError Log | B Console # 7 =0
Generd Configuration: | <Hone> L] |
M3 Destination Transacted: | o v |
Messaging
Transaction Size: | D‘
Humber of Sessions: | 1 D‘
Acknowledge Mode: | Dups OK L] |
Durable Subscription: | |
Subscription Mame: | D‘
Message Selector: | D‘

Figure 5.11.2: Messaging Configuration

5.12 Check Resource and Connectivity

Fiorano enables the deployment of an event processes over a distributed peer-to-peer grid
of infrastructure servers (known as “peer servers”) at the click of a button. A developed
event process contains a set of configured components connected via routes. The
configuration for these components also includes the names of the grid-nodes (Fiorano
Peers) on which the components are to be deployed.

To do a connectivity and resource check, perform the following steps:

e Select the Event Process. Click the Check Resource Connectivity button from
the tool bar as shown in Figure 5.12.1.

e All the resources required by the component at runtime will be deployed to the
configured Peer Server.
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¥+ | G (B0 @ 0% [v) - EELE T,

Dffline Event Process Development

|42 simple Chat &3 |

|

— @
o____,_.drcuutel
chat2  route2
chatl J

Figure 5.12.1: Check Resources and Connectivity

During the development process, some components might have external resources added.
Also, for custom-built components the source files might be updated from time to time. To
reflect the changes for such components across the peers at runtime, eStudio has an
option; Cache Component in its Properties view, a deployment configuration at both the
Event Process as well Component levels, that optionally force the resources of the
component to be re-fetched each time a Connectivity and Resource Check is done.

5.13 Running Event Process

To run the event process, perform the following steps:

e Select the Event Process. Click the Launch Event Process @ button as shown in
Figure 5.13.1.

¥+ | G | 840 - | @ 00% W) i

Dffline Event Process Development

||=1a simple chat 22 |

——a|(&)
o_.___._.droute 1
chat?2  royte2
chatl J

Figure 5.13.1: Launching an Event Process

When the Event Process is launched successfully, all the service instances label names
turn green in color.

5.14 Stopping an Event Process

To stop the event process, perform the following steps:

e Select the Event Process. Click the Stop el button on the toolbar; all running
component instances in the Event Process are stopped and the Event Process is

stopped.
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Offline Event Process Development

i ={p Simple Chat EE]
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(-:‘ — chatZz  royte2
chatl J
1

Figure 5.14.1: Stopping an Event Process

Stop button can also be used to stop selected service instances or all service instances
without stopping the Event Process. When a component is stopped, its hame turns to red
in the orchestration editor.

5.15 Synchronizing an Event Process

Fiorano has the capability to modify existing running applications on the fly. For example,
launch the Simple Chat event process and once the event process is successfully launched,
add another component-instance to the event process from the component palette.
Configure the component and connect the routes. The application then needs to be
synchronized to reflect the changes.

To synchronize event processes, perform the following steps:

e Select the Event Process. Click the Synchronize Event Process button. Now the
newly added component starts and turns green in color and the synchronize button
is in a disabled state.

7 | Q- | OGDE- | ook B - %REE 0
fline Event Process Development

e{g *Simple Chat 33]

o| (&) -
.0 _'___,_.aroute].
chatz  royte2
chatl J

DO

Figure 5.15.1: Event Process Synchronization
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Chapter 6: Event Process Life Cycle

Management

The Event Process Life Cycle Management refers to deployment of an Event Process in
various environments like Development, Testing, Staging, and Production. The user does
not have to create different Event Processes for different environments; instead the user
can simply specify the properties for service instances comprising Event Processes for

various environments in a single Event Process.

6.1 Setting Properties of Service Instances for Different Environments

When a Service instance is dragged and dropped in the Orchestration editor, the default
environment is set to development. To configure a different environment, select the
Target Environment in the Environment Properties tab of the Event Process comprising
the service instance. Hereafter, the environment dependent service properties will be
written to the corresponding env.xml file and will be picked up from that file when Event

Process is launched in that particular environment.

You can specify these properties for more than one environment by switching the Target
Environment label in the properties of an event process. Configuring service instances for
different environments is made easy, since the configuration properties of the service
instance in a new environment will be picked up from the previously configured

environment when the CPS is opened.

This way service instances can have different set of properties while running on different
environments. For example a File Reader instance can be configured to read from a dev.txt
file in a Development environment and from a test.txt file in a Testing environment.

! Properties &2

General Target Environment: dzvelopmentjiis

Application Context
Environment Properties Property
Configuration Properties :

Value

(=]
E

. ) File Name dev.txt
Environmen...operties:

Post Processing Action
Pre Processing Arguments
Relative Directory

Figure 6.1.1: Environment Properties Tab

NO_ACTION

froot/Desktop/EPLCM |[+]
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6.2 Defining Named Configurations for Different Environments

While defining a named configuration, the environment in which the configuration should
appear can be defined in the Configuration details page. Different versions of the
configuration can be defined for different environments.

In addition to defining configurations manually, when the target environment of the Event
Process is changed, a dialog is displayed where the user can choose to copy configurations
from the old environment if they are missing in the new environment.

In the figure below, the environment of the event process is changed from Development to
Testing. A pop-up is shown asking the user if any missing configurations should be copied
to the new environment. If the user chooses Yes, the configuration used in the event
process, here test(Port) and ConnectionConfig(Resource) are copied to Testing
environment.

o* Jo
B Sareica B [ Configue .
. ISl
Gt~ EE .
Connection Factoey o F| Lopy missing confiquestions @
= Parl

= Inpit Sami ol the cenfagurabons in The cumenl efmaronment could Be snang the new

| — ensionment. Do you wish bo copy sy missing cosfigurtion

[ et
Resourcy Remember my decition
= Demlopment

'.:.'l.w-"lccn:.:-'v‘--; e My

Faus
Fyntime drqument;

7 Froblems | Progerties 21 | 9] Ener Leg | [E) Comole
5 Target Enviprment: Testng

Epphcatizn Costent Py Vil I3 sricen [ Canfiger.. 1]
[mssrcnment Froper e 3

4 = hpst
4 | Development

sx BEil
Pl Testing

Configurations copied to % e

4 & Rdouson
Testina Environment =D | ¢ oo
e Lonnection onfig
a Tt
T'.. Conmpciononfig
-

Figure 6.2.1: Message dialog pop-up when changing the target environment of an event
process

6.3 Running Event Process on an Environment

To run an Event Process on a particular environment, follow the steps as mentioned in the
example below:

1. Take a flow containing File Reader and Display components. Configure the File Reader
providing different inputs in different environments as mentioned in the above section.
Select the Target Environment in the Environment Properties tab of the Event
Process. The environment specific properties for the service instances in the flow can
be viewed from the Environment Properties table view present below the Target
Environment section.

2. Do the CRC and launch the flow. When the flow is launched in development
environment, the contents from the dev.txt will be read and these messages can be
viewed in the display. Similarly when launched in testing environment the contents
from the test.txt will be read and these messages can be viewed in the display.
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ext
roperties

History( last 4 of 4

Target Environment:

development]

Property

Value

FleReaderl
Configuration Propert

File Name

EPLCMTEST_Displayl
Gelect a row to load the message) [ |Select message when received

dev.txt

#| Receiver | Message I
1 Tue Aug 04 11:57:32 IST 2009 Cantents from dewtxt -
2 Tue Aug 04 115742 15T 2009 Contents from dewtxt =
3 Tue Aug 04 115752 15T 2009 Contents from dewtxt
A Tuoa A A TT-EQ-MT ITT 20n0 Tantante Froea Sone tat =
8
Target Environment: v F
it
roperties Property Value =
HIeReadelﬂ
Configuration Properti L
File Name test.txt

EPLCMTEST_ Displayl

History(last 3 of 3): Gelect a row ta load the message) [ |Select message when received

# | Recepved

Message

1 Tue dug 04 12:00:18 5T 2009  Contents from test.IxL
2 Tue Aug 04 12:00:28 15T 2009 Contents from Test.IxL
3 Tue Aug 04 12:00:38 15T 2009 Contents from test.txt

Figure 6.2.1: Display showing messages received from file reader in different environments

Note: These properties cannot be edited from the table provided. But they can be edited
from the CPS of the specific service instance and form the deployment tab of the service
instance in the properties view.
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Chapter 7: Debugging Event
Process

Fiorano’s unique Event Process orchestration model enables the debugging of live Event
Processes in real time. The debugging model gives a view of the current state of executing
service instances within Event Processes and also provides a mechanism to setup event
interceptors to capture, view, modify and discard messages flowing between service
instances on the same or different machines across the network.

Note: Breakpoint can be added in Online Event Process Development perspective only.

7.1 Adding Breakpoint

Breakpoint can be added from context menu present on the route or from the Fiorano
Debugger view.
7.1.1 Context Menu option

Right-click on the route on which breakpoint has to be added and select the Add
Breakpoint option.

When the breakpoint is added, the route color is changed to Red.

Y [ ] P,
c-—----'m”t Edit [
Interceptor & View Fiorano Debugger N3V D

[ Properties "3V P

= Add Breakpoint

. . ) 5 Remove Breakpoint
Save Selection As... = : :

< Undo Delete Send All
Redo Discard All

Run As » |

Figure 7.1.1: Adding breakpoint from context menu
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7.1.2 Debugger View

To add a breakpoint to a route, perform the following steps:

1. Go to Fiorano Debugger pane and click the Add BreakPoint button as shown in
Figure 7.1.1. All the available routes in the Event Process are listed as shown in

Figure 7.1.2.
] pratiems | ) rror Log | B consote ==
Breakpoints: Messages:

) Ca) (B =) (@ i

IAdd BreakPoint

[-Te)ﬂ | Application Context |

Figure 7.1.2: Adding break point from debugger view

& Select Route |:||E|[z|

Select an ikem to open (* = anv character, * = any string): -

E |
Matching items:

routez

chatl,OUT_PORT -= chat2. IM_PORT

(2 (0] 4 l [ Cancel

Figure 7.1.3: Select route to add breakpoint

2. Select the route on which the breakpoint has to be added and click OK to add the
breakpoint.

When a breakpoint is added on a route, at runtime the messages passing through the
route are intercepted by the breakpoint. The intercepted messages can be viewed, edited
or forwarded to the next service instance.

Message body, message properties and the application context can be viewed in the

debugger view. When an intercepted message is selected, the properties are shown in the
Properties view.

The Application context is shown in the Application Context tab.
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7.2 Viewing Messages at Breakpoint

All the messages sent to a route having breakpoint set on it are visible in the breakpoint
view when clicked on that particular route as shown in Figure 7.2.1.

When the messages are intercepted on the route, the route blinks and the message count
will be appended to the route name.

» 2 Collaboration w
» O DB ___—=0
> O Error ()__.-—-—P"mumlwJ
[ 3 \9 File chat2 route?
» O Flow e chat].
» O MOMs £
L rosems 0 eror o | B console -
Breakpoints: Messages:
() o) (H) (=) (=2) (@) (=) (i)
route2 <ChatMessage> <Sender...
route 1(3) <ChatMessage > <Sender...
<ChatMessage > <Sender...
(&) Jalw

I T, ]

| Text |

Application Context ]

<ChatMessage> <Sender> <Name>FioranoESE Demo</Name> <Email>fesb@fiorano.com</
Email> < /Sender> <Message>simple message < /Message> <,/ ChatMessage>

Figure 7.2.1: Message at breakpoint in Fiorano Debugger

7.3 Editing Messages at Breakpoint

To edit a message at debug time, perform the following steps:

e Select the message to be edited and edit it in the Text section as shown in Figure
7.3.1.

e The message is saved.

. raviems | @) error o 5 consore

Breakpoints: Messages:

(b)) () (&) (2) (=) (@) (=) (@)

<ChatMessage> <Sender...

route2

route1(3)

<ChatMessage> <Sender...

e

f
| Text |

Application Context |

<ChatMessage> <Sender><Name:>FioranoESB Demo< /Name><Email=fesb@fiorano.com</
Email> < /Sender> <Message>edited| message</Message> < /ChatMessage>

Figure 7.3.1: Edit message in Fiorano debugger
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7.4 Inserting Messages into Breakpoint

New messages can be inserted into breakpoint at debug time without the message being
sent by the source component.

To insert messages into breakpoint, perform the following steps:

1. Click the Create button in the Messages pane as shown in Figure 7.4.1.

2L ronlems 9 eror o | B console

Breakpoints: Messages:

(O ) (B &®E @ & 4

Create..

route2 <Chaiviessage><Sender...

route 1(3) <ChatMessage><Sender...
<ChatMessage > <Sender...
e

{—Tex‘t | Application Context |

Email> < /Sender> <Message>edited message </Message> </ChatMessage>

Figure 7.4.1: Create message in Fiorano debugger

2. Choose the type of message to be created (either XML or Text message) as shown
in Figure 5.4.2 and click OK .For a Text type, a default message is inserted, which

can be edited in the Text section. For XML type, the XML schema of the message

is shown and the user can click on Generate Sample button to generate a sample

XML data and can edit the data in the Text section.

& Create Message E'

Message Type: (%) Text

Rl

Ok H Cancel ]

Figure 7.4.2 select type of new message

<ChatMessage> <Sender><Name>FioranoESE Demo</Name:> <Email>fesb@fiorano.com</
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7.5 Releasing Messages from Breakpoint

The messages present on a breakpoint can be released anytime so that they reach their
destination.
To release messages from the breakpoint, perform the following:

1. Select the message to be released and click the Send button shown in Figure
7.5.1. The message will be sent to the next service instance in the event process.

nsole | &' Fiorano Debugger &% | -=

Messages:

(=) (&) (@) () ()
C

<ChatMessage><Sender...
<ChatMessage> <Sender...

This is the messaqe ... )
Y4lr

%—Tmrt—| Application Context 1

<ChatMessage><Sender><Name>FioranoESE Demo< /Name> <Email>=fesb@fiorano.com«</
Email= < /Sender> <Message>edited message< /Message> < /ChatMessage=

Figure 7.5.1: Send message in Fiorano debugger

2. All messages on Breakpoint can be released at a time by clicking on the Send All
button as shown in Figure 7.5.2.

nsole | & Fiorano Debugger £ | =

Messages:

(=) (=) (&) (=) (|)
.

<ChatMessage><Sender...
<ChatMessage><5Sender...

This is the message ... )
I

{T:m | Application Context j

<ChatMessage> <Sender> <Name=>FioranoESE Demo< /Names> <Email=fesb@fiorano.com</
Email> < /Sender><Message>edited message</Message> < /ChatMessage>
Figure 7.5.2: Send all messages in Fiorano debugger

All the messages can also be sent at a time from route context menu by right-clicking on
the route and by selecting the Send All option.
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7.6 Discard Messages from Breakpoint

To discard the messages from the breakpoint, perform the following:

1. Select the message to be discarded and click the Discard button shown in Figure
7.6.1. The discarded message will be removed from Breakpoint.

nsole | &" Fiorano Debugger 52 l = O

Messages:

(=) (=) @ (=) )

. <ChatMessage><Sender... m
rFy
L 4

<ChatMessage> <Sender...
<ChatMessage><5Sender...
This is the message ...

Jal»
Figure 7.6.1: Discard message in Fiorano debugger

2. All messages on Breakpoint can be discarded all at a time by clicking on the
Discard All button as shown in Figure 7.6.2.

nsole | &" Fiorano Debugger &2 l =0

Messages:

= & @ & @

<ChatMessage><Sender... m
ry
v

<ChatMessage><Sender...
<ChatMessage> <Sender...

This is the message ... )
Al

Figure 7.6.2: Discard All messages in Fiorano debugger

All the messages can also be discarded at a time from the route context menu by right-
clicking on the route and by selecting the Discard All option.
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7.7 Remove Breakpoint

To remove the breakpoint set on a route, perform the following:

1. Select the route on which the breakpoint has to be removed and click the Remove
Breakpoint button shown in Figure 7.7.1. The breakpoint will be removed on that
route.

E_L, Problems |@ Error Log | El console [*' Fiorano Debugger &3 l

Breakpoints: Messages:

() C) () () (=) (@ (=) )

routez <ChatMessage><Sender...
route 1(4) <ChatMessage><Sender...

<ChatMessage><5Sender...

This is the message ...

{T-u" | Application Context |

Figure 7.7.1: Remove Breakpoint in Fiorano debugger

Note: When removing a breakpoint an input dialog box comes up asking whether to
send the messages or discard the messages. The user can choose the appropriate
option.

Breakpoint can also be removed from context menu options on the route.

2. Breakpoints on all the routes can be removed by clicking on the Remove All
Breakpoints button as shown in Figure 7.7.2.

& Problems @ Error Log | El Console W

Breakpoints: Messages:

(&) (% =) (=) @) C i

. Remove All BreakPoints
route? dim

route 1(4)

[ Text | Applicati

Figure 7.7.2: Remove All BreakPoints in Fiorano debugger

All the messages can also be discarded at a time from route context menu by right-clicking
on the route and by selecting the Discard All option.

Chapter 7: Debugging Event Process Page 91



Fiorano eStudio User Guide

Chapter 8: Services

8.1 Service Descriptor Editor

A service can be customized using the Service Descriptor Editor. To customize a service,

perform the following steps:

1. Right-click the service in the Service Palette or in the Service Repository view

and select the Edit.. option as shown in Figure 8.1.1.

Qv =cC

s Service Palette 53

[,‘\3 Select

] PRoute

[ Bridges
[= Collabaration

(&) chat

Details

(F) csChe
@? vbche Delete g

() veChe Help
= DB Layaut
Use Large Icons
[== Errar
Settings...
[~ File
[:=% Flows
[ MOMs

Figure 8.1.1: Edit option

2. The ServiceDescriptor.xml of the selected service is opened in the Service

Descriptor Editor as shown in Figure 8.1.2.
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- ServiceDescriptor.xml &3 = B8
Overview
General Information Display
Mame: [ that Palette Tron: (&)

|
Version: | 4.0 | Display Tron: @
GUID: [ chat |

Taool Tip: | & Simple Chat Component

Descripkion:
Metadata
Authar; | Fiorano Software Technaologies Pt Lk
Creation Date: | 04-01-2005 12:00:00
[Licensed
< | ¥

Cwerview | Execution | Deployment

Figure 8.1.2: ServiceDescriptor.editor

The Service Descriptor Editor has three sections:
e Overview
o Execution
e Deployment

These sections are further divided into sub-sections. A brief explanation of these sections
and subsections is provided below.

The sections can be accessed using the tabs provided at the bottom left corner of the
editor as shown in Figure 8.1.3.
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D[E *hhhhj & ServiceDescriptorxml 3

Execution

Ports Information

Input Ports:

Mame Descripkion

IN_PORT Accepts data which is in the format sp. ..

Oukpuk Ports:
Marne Descripkion
QUT_PORT Sends the chat message

<
Overview Execu%ﬂ Deployment

Fiorano Debugger

Figure 8.1.3: Sections under Service Descriptor

8.1.1 Overview Section

The Overview section has three sub-sections — General Information, Display, and
Metadata.

The information used to identify the service is shown under the General Information
section. The user can change the Name, Version, GUID, Tool Tip, and Description of the
component in this section. Figure 8.1.4 illustrates the General Information section.

Overview

General Information

Mame: chat

Wersion: +.0

GUIE chat

Taol Tip: & Simple Chat Component
Description:

Figure 8.1.4: General Information

In the Display section, icons used to represent the service and the categories under which
the service are provided. Categories can be selected using the Category Selection dialog
box, which is similar to the one used during Service Creation (Figure 8.1.5).

In the Metadata section, the information about authors of the service, creation date and
time of the service and licensing mode are provided (Figure 8.1.5).
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Note: The Creation Date field cannot be changed manually.

Display

Palette Icon: @
Cisplay Icon: @D

Cakeqgory: Collabor ation [:]

Metadata

Authar: Fiorano Software Technologies Pwt, Lkd.

Creation Date: | 04-01-2005 12:00:00
[ Licensed

Figure 8.1.5: Display and Metadata sections

8.1.2 Execution Section

The Execution section has following subsections - Port Information, Support, Launch
Configuration, Log Modules, and Runtime. A brief explanation of these subsections is
provided below.

8.1.2.1 Port Information

Each Asynchronous Service Component (also referred as Event Driven Business
Component) can have any number of inputs and outputs as determined by the developer
of the component. The input and output ports can be added or removed in the Service
Descriptor Editor as applicable to the component in the Port Information section (Figure
8.1.6).

The Add, Remove and Edit Schema buttons can be used to add, remove and/or edit the
ports of services. Name and Description of any port can be modified from their respective
columns in each table.
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Ports Information

Inpukt Ports:

rame Descripkion add
IN_PORT Accepks daka which is in the farmat sp...

Outpuk Ports:

rame Descripkion add
QUT_PORT Sends the chat message

Figure 8.1.6: Port Information section

8.1.2.2 Support

In the Support section, Failover Supported and Transaction Supported options are
available as shown in Figure 8.1.7.

Support

E Failowver Supported
z Transaction Supported

| Component Control Protoco

Figure 8.1.7: Support section

Failover Supported

If the Failover Supported option is selected, then during the component's runtime
if the Peer Server on which component is running goes down, the component

keeps running on the next available Peer Server.

If this option is not selected at the component's runtime, if the Peer Server on which
component is running goes down, the component stops.

Transaction Supported

Transaction Supported is used to specify whether the service allows transacted session or
not.
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Component Control Protocol

¢ Checked - Component listens, understands and responds to control events from
Peer Server. Using this option allows components launched as separate process to
cleanup when stopping

¢ Unchecked - Component does not handle control events from the Peer Server.
The Peer Server will not send any control events to the component. Component
launched in separate process is issued a destroy command to stop and the
component process will be killed instantly without any cleanup.

8.1.2.3 Launch Configuration

In the Launch Configuration section, information about the type of component and the
different launch type supports (None, Separate Process, In Memory, and Manual) are
provided.

Launch Configuration

Supported: [ ]Mane Separate Process
Manual C11In Mermory

Preferred: |SeparateProcess W

Figure 8.1.8: Launch Configuration section

8.1.2.4 Log Modules

In the Log Modules section, logging options of the service are provided. Loggers which are
used to log messages during service runtime can be added or removed.

To add a new logger, click the Add button and specify log module hame and the log level
at which logging has to be performed. Messages logged at levels which are lower than the
selected log level will not be written to the log files.

Log Modules

com. fiorano,edbe, chat SEYERE b
ERR_HAMDLER [
QUT_HANDLER.

Remove

Mame Level

£

Figure 8.1.9: Log Modules section

8.1.2.4 Runtime

In the Runtime section, configurations required to launch services are provided. Executable
specifies the Java class to be used to launch the service when it is launched in a Separate
Process.

In Memory Executable specifies the Java class to be used when the service is launched in
in-memory mode.
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The Working Directory specifies the directory which will serve as the service's runtime
directory when launched in a separate process.

A component while executing, might require parameters to execute different requests or
details for handling different request. There are two ways of passing this information to the
component: by configuring the details in the Configuration Property Sheet of the panel or
by defining the command line arguments that can be passed to the component at the time
the component is launched. These command line arguments are captured as runtime
arguments in this panel.

Run Time

Executable: com.fiorano.be.chat, ChatService
In Memory Executable:

Warking Direckory '
Funtime Argurments:

Marme Type Mand... | “alue
WM_PARAMS  String v False DLOG_TO ...

Remove

£ >

Figure 8.1.10: Runtime section

8.1.3 Deployment Section

The Deployment section contains subsections related to the deployment information of the
component. The Resource/Service Dependencies required by the component can be
configured in this section.

D[E *hhhhj & ServiceDescriptor.xml 52 =g

Deployment
General Information Resource

Label: Mame Far Confi... Add, .
@ Production O Qa ) Developement estudio-chat.jar true

Supparted 03 Fesh-comp-chat.jar true
wersion, propetties false
Cuinuz [ windows [ Macintosh
[ solaris alos

awtoInstalable < 5

service Dependencies

Dependency Name AddfRemove. ..

Qg cps

P s

%, Studio

Qﬁ BCCornmon

% TifosilavaRTL

COrverview |Execution | Deployment

Figure 8.1.11: Deployment page
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8.1.3.1 Resource

The resources required by the service (either during configuration time or runtime) can be
added in this wizard. Resources can be any files which are used by the component.
Typically resource files are - dll, zip, jar, so, and exe.

e To add a resource, click on Add and select required resource for the service.
e To remove a resource, select the resource and click Remove.

e To change the order of resources, select the resource and click the Up or Down
button. The order is used to determine the classpath of the service.
8.1.3.2 Service Dependencies

Dependencies are predefined. Each component or system library registered can be added
as a dependency.

Click the Add/Remove button to open the Add Dependencies dialog box. This contains a
list of all available dependencies.

& Add Dependencies

Bridges ﬂ;:. cps:4.0

Collabor ation ﬂ;:. jms:<.0

OB T studio:4.0

Errar ﬂ;:. BCComman:4.0
File T4y TifosidavaRTL:4.0
Flow

MOMs
Performance
Samples
Scripk
Swstem Lib
Transformation
il

Web
WebService

A,
M,

e R B R R 3 R B = R M =
COoDODOOODODODOODOODODDO

Ik ] [ Cancel

Figure 8.1.12: Service Dependencies section

e To Add: Select the dependency on the left side table and move it to the right side
table.

¢ To Remove: Select the dependency on the right side table and move it to the left
side table.
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Chapter 9: Service Creation

Apart from the exhaustive list of pre-built services, custom services can be written, built,
and deployed into the Fiorano SOA Platform by developers. To aid developers in service
creation, the platform provides a template engine to generate the skeleton code for
custom services in Java, C, C++, C# (.Net). User can create a component in any
language, add the business logic and deploy it in the Fiorano environment.

9.1 Service Generation

To create a new service, goto Tools -> Create Service Component to open the Service
Creation Wizard. All the details related to the creation of a new service must be specified in
this wizard. Various steps in service creation are illustrated below.

9.1.1 Service Location

The destination folder in which the component source code and other required files to be
generated has to be specified.

Note: A new folder name has to be specified here. If the folder name provided already
exists, then the wizard does not allow proceeding to the next page.

SETVICENETESLOTTZaTd" @I
Service Location
Specify Service Location [| l |Browse|
@ Cancel

Figure 9.1.1: Specific Service Location
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9.1.2 Basic Details

The Basic Details of the service like Service Guid, Name, Version, Category, and so on

have to be provided here.

Service Creation Wizard

806

Basic Details

Information required to identify service

Service Guid: SampleComponent
Name: Sample
Version: 1.0
| Category:  New Category =

8 Cenerate Source O Assemble From Binary

Source Language: MS

"lis CCP enabled

Package Name: com.fiorano.esb.service

( < Back )( Next > ) ( Cancel ) ( Finish ) I

i

Figure 9.1.2: Service creation wizard

In the Category field, a new Category name can be provided for the component or an
existing Category can be selected from the available categories. Existing Categories can be
viewed by clicking the ellipsis button that appears against the Category field. On clicking
ellipsis, the Category Selection dialog box appears as shown in Figure 9.1.3. Multiple
Categories can also be selected in the Category Selection dialog box.

=

CHLEOOTY Sl ECLI D1

Select a category from existing ones

Existing Categories -

Bridges

Collaboration

[]=]

Error

File

Flow

MOMS
Performance
Samples

Script (=
Create a new category

oooooooooag

MNew Category l

(separate multiple categories with a comma)

[ oK ] | Cancel |

Figure 9.1.3: Category Selection dialog box

The option Generate Source is used to generate sources for various languages and the
option Assemble From Binary is used to create System Libraries.
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Is CCP Enabled

e Yes - Component listens, understands and responds to control events from
Peer Server. Using this option allows components launched as a separate
process to cleanup when stopping.

e No - Component does not handle control events from the Peer Server. The
Peer Server will not send any control event to component. Component
launched in separate process is issued a destroy command to stop and the
component process will be killed instantly without any cleanup.

This property will not be editable while editing the service from Studio.

For additional details on the Component Control Protocol refer to section 3.12 in Fiorano
SOA User Guide

9.1.3 Ports Information

The input and output ports of the service can be configured here.

A new port can be added by clicking the Add button. By default Port Type is Input Port.

The Port Type and other port properties can be changed in the Service Creation Wizard as
required.

] Service Creation Wizard [ E] ﬁ]
Ports Information
Specify input & cutput event ports
Port Type MName Description Add
Inport Portl A new port for this Ser...
Remowve
: Outport Port2 A new port for this Ser...
Edit
<Back || Met> || Finsh || Cancel

Figure 9.1.4: Ports Information

To provide schemas for the component ports, select the port and click the Edit button. A
dialog will be launched where the schemas and external schemas (if any) can be provided.

Provide the schema and click the Save button. Select the root element and click Ok.

Note: Root element can be selected only when the schema provided in the text area is
saved by clicking the Save button.

To provide external schemas, right-click on the Schema node and select Add External
Schema option.
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- M
] Structure ﬂ
1
Sch y
Add External Schema ﬁ ] b—:
< Txml version="1.0"7> -
<xsdischema xminsisd="http://www.w3.0rg/2001/XMLSchema” N
targetNamespace="http://www.books.org”
xmlns="http:/ /www.books.org"
elementFormDefault="qualified"> L
<xsd:element name="BookStore"» T
<xsdicomplexTypes
<xsdisequence>
<yschelement name="Book" maxOccurs="unbounded"> i
<xsdicomplexType>
<xsdisequence>
<xsd:element name="Title" type="xsd:string"/>
<xsdielement name="Auther" type="xsd:string"/>

<xsd:element name="Date" type="xsd:string"/>

«xsdielement name="I3BN" type="xsd:string"/> B
4 3
Root Element  {http://www.books.orgiBookStore -
[7] Generate XML Beans
[ oK ] [ Cancel [
L.

The option Generate XML Beans can be used to generate model objects based on the port
schemas.

9.1.4 Resources

The resources required by the service (either during configuration time or runtime) can be
added in Service Creation Wizard. Resources can be any file types which are used by the
component. Typically resource files are of types - dll, zip, jar, so, exe. However, there is
no strict restriction on this; a file of any type can be added as a resource.

The server makes a local copy of these files in the component’s folder. Resources can be
added or removed using Add and Remove buttons.

SETVICENGTEET DA T ZETd |
Resources
Specify resources for the service
Name For Configuration For Execution Add
bec jar Yes Yes
@ | < Back || Next > | | Einish | | Cancel

Figure 9.1.5: Resources section
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9.1.5 Dependencies

Dependencies are predefined. Every component or system library registered can be added
as a dependency. The dependencies are referenced from the existing location and are not
copied locally into the component's folder.

Note: Dependencies are loaded only once when the components are launched in-memory
of same peer server, there by reducing the memory footprint.

e To Add: Select the dependency on the left-hand side of the page and move it to
the right-hand side.

e To Remove: Select the dependency on the right-hand side of the page and move
to the left-hand side.

SENNCEGTeaten Zand| =
Add DependenciesPage
Move Dependencies to the Right to add to Service being created
e JGI_IIPIW (] & TifosilavaRTL:4.0
P @ script )
) &7 jms:4.0
= ¥ System Lib )
) & EDBCEngine:4.0
b &% addressing:4.0 & 20
+ cpsi4,
b antlr4.0
b & axis:d.0 —
>
P &% base4:4.0
()
@ | < Back | Finish l | Cancel

Figure 9.1.6: Dependencies
e Click the Finish button after adding the dependencies.
When the wizard is finished, sources are generated under the src directory in the directory

specified in the Service Location Page. It also creates necessary files to build and deploy
the components.

9.2 Building and Deploying Services

By default, the build.properties file contains the URL of the Enterprise Server running on
the machine on which the sources are generated. If the service has to be deployed to an
Enterprise Server running on a different machine, then the property server has to be
changed in the build.properties file.

To register the service, perform the following steps:

1. Open the command prompt at the location where the sources are generated and
execute the command ant register.

Terminal Tabs Help
an-desktop:~/Desktop/new$ ant register|:|

Figure 9.2.1: Registering the service
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2. This builds the service's sources and registers the service with the Enterprise
Server.

3. The service is now available in the eStudio Service Palette and can be used in
composing Event Processes.

@ Service Pale & &~ Fiorano Deb | — O
[} Select
} Route

|~ Bridges

[~ Collaboration

(= DB

[ Errar

== File

[ Floa

(= MOMs

= Mew Category 42
& Sample

Figure 9.2.2: Service Palette
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Chapter 10: eMapper

The Fiorano eMapper is a high-end graphical tool that presents the user with both source
document structure and target document structure side-by-side and lets the user define
semantic transformation of data by simply drawing lines between nodes, elements, and
functions.

The Fiorano eMapper uses standards based XSLT (Extensible Stylesheet Language for
Transformations), which is a language for transforming documents from one XML structure
to another.

Additionally, Fiorano eMapper ensures that the source and target document structures
conform to the DTD (Document Type Definition) standards.

10.1 Key Features of Fiorano eMapper

The Fiorano eMapper performs a variety of operations including:

Transforming one or more XML, XSD or DTD files.

Generating XML, XSD or DTD as output of the transformation.
Option to convert a FIX message to any XML and viceversa.
Using Funclets to define complex mapping expressions.
Validating the transformation.

Defining the transformation (mapping) with simple drag-and-drop actions.

10.2 Fiorano eMapper Environment

The Fiorano eMapper tool consists of the following interface elements:

eMapper Projects Explorer
eMapper Editor

o Map View

o MetaData
Funclet View
MetaData Messages View
eMapper Console

Node Info View

The interface of the Fiorano eMapper tool is displayed in Figure 10.2.1.
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& Mapper, - MapperDemo/MapperDemo.fmap - Eclipse Platform
File Edit Mawigate Search Project Tools Run window  Help

| T EHE  Arsh i B-0-Q B A Y ) | Mapper | 7

: 8 E
= 0O

{EF Mapper Project Exp &2 = B |2z MapperDemo.fnap £
p—
92 |8 - x B - X

=F MapperDemo

E Map Yigw E MetaData

:]-l Funclet Wiew 23 Metalrata Messages | ] Mapper Console | ] Mode Infa

|UserDeFined Functions |

[ Select

|§| myext:compute
5] myext:replace

|§| strings:multiCon. ..

Figure 10.2.1: eMapper Perspective

10.2.1 eMapper Projects.

This view serves as an explorer for the eMapper Projects created by the User.

To create a new eMapper project, perform the following steps:

1. Right-click on the Mapper Projects node in eMapper Projects view and select New.
The New eMapper Project Wizard is opened.

2. Provide a valid name for the project and click Finish. A new eMapper project is
created.
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{E+ Mapper Project Explorer &2 =h=3

Fi Mapper Projects
sl-= MapperDem Mew L\}
Import

Refresh

Figure 10.2.2: eMapper Projects
The eMapper Projects view also provides options to Import, Export, Rename and Delete
mapper projects.

10.2.2 eMapper Editor

The eMapper Editor is a tabbed editor containing two tabs, Map View and MetaData.

10.2.2.1 Map View

The Map View shows the Input and Output Structures and the mappings defined in the
pane. This view allows users to load the input and output structures and create mappings
between them.
This view consists of the following panels:

e Input Structure Panel

e Graph Panel

e  Output Structure Panel
Input Structure Panel
This panel shows the input specification structure in a tree format.
Graph Panel
The middle panel in Map View is the Graph panel. It shows the mappings defined by lines
(called Mapping lines). A Mapping can be selected by selecting one of the mapping lines in

the line panel.

A Function icon at the end of a mapping line indicates that mapping uses that particular
function(s) as shown in Figure 10.2.3.
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Figure 10.2.3: Map View

Output Structure Panel

This panel shows the output document structure in a tree format.

10.2.2.2 MetaData tab

The MetaData tab shows the transformation XSL generated from the mappings defined in
the Map View for the selected output structure.

10.2.3 Funclet View

The Funclet view contains the Visual Expression Builder that provides a graphical view for
the mappings defined in the Map View, as shown in Figure 10.2.4. It also shows the

functions and their links with the input and target nodes/elements.

Note: The Funclet view is explained in detail in the Visual Expression Builder section later

in this chapter.
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Figure 10.2.4: Funclet View
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10.2.4 eMapper Console

The eMapper Console is used to display the various error and warning messages generated
by the tool while parsing the input and output structures and while testing the generated
XSL.

10.2.5 MetaData Messages View

Error or Warning Messages (if any) thrown while generating the transformation XSL are
displayed in the MetaData Messages View. The view is shown in Figure 10.2.5.

& Mapper Perspective - MapperDemo/MapperDemo.fmap - Eclipse Platform

File Edit Mavigate Search Project Tools Run  ‘Window Help

TR + 0_0 o=-0 ‘ . 4 = ol 4 e
] L_ﬁ'['ﬁ‘] 1 E B é "Bﬁr ] 3&*'0'%' = =) < ﬁ|EMapperPersp...|
{Er Mapper Projects &2 = O | |3 *MapperDema.fmap 52 =0
e o=
S Select Dukput Struckure: | Oubputl L
=l =+ MapperDemo
A

B resources <7xml version="1.0" encoding="UTF-8"? >
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=& schemas wrilns datetime="http://exsk. org/dates-and-times" xmins:set="http:/}exslt.orgfsets" xmins :math="http: //exslt.orgfmath"
@ Inputl.DTD exclude-result-prefixes="xalan java bslt" xmins:besl="http:/fxml. apache .orgfxslt" xmins:xalan="http: /fxml.apache.org/xslt"
[0] output1.oTD smins:dateConversion="gxt1" xmins:myext="ext2" xmins:strings="ext3" extension-element-prefixes="datetime set math dateConversion
E MapperDemo, fmap myext strings" >
' <xsloutput methad="xml" indent="yes" encoding="UTF-58" xalan:indent-amount="2" omit-xml-declaration="na" = <xsl:output >
<xslvariable name urment” select="{"><xsl:variable >
<xsl:template match="}">
<Admissions
<xsl:for-each select="Admissions/Applicant" =
=xslisort select="./Marks" arder="ascending" data-type="text"></xsl:sort >
=xslisort select="./Age" order="ascending" data-tvpe="text"><fxslsort>
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«xsl: attribute name="name" >
<xslivalue-of select=",/@name" > < fxsl:value-of »
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sL2 Map View | %, MetaData
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Figure 10.2.5: Meta Data and MetaData Messages view

10.2.6 Node Info View

The Node Info View shows the information about nodes in the Input and Output
Structures. The view is shown in Figure 10.2.6. It has two panels that provide the data
type and cardinality information about the selected input and output structure
node/element.
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Figure 10.2.6: Node Info View

10.3 Working with Input and Output Structures

10.3.1 Loading Input/Output Structure
1. An Input/Output Structure can be loaded in one of the following ways:

e Click the Add Structure button from the tool bar in the Input/Output
Structure Panel and choose the structure type from the drop down list. Or,

¢ Right-click on the Input/Output Structure Panel and select Add Structure
and choose the structure type from the sub-menu.

2. The drop-down list or the sub-menu has the following options
e XSD For loading an XSD document
e DTD For loading a DTD document
e XML For loading an XML document
e FIX For loading a FIX message

10.3.1.1 Load Input/Output Structure From an XSD document

Select XSD from the Add Structure menu. The Load Input/Output XSD Structure Wizard
appear as shown in the Figure 10.3.1. The wizard contains two pages, Structure Selection
page and External XSDs page.
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Figure 10.3.1: Structure Selection Page
Structure Selection Page

The name of the structure can be specified in the Structure Name text field at the top of
the page.

Note: The structure name cannot contain special characters. Only alphabets, numbers and
'_"are allowed in a structure name. Two structures with the same name are not allowed.

The XSD content can be defined in the text area provided in this page.

The schema can also be loaded from an existing file using the Load from File button.
Clicking this button will open a file dialog through which you can browse through the file
system to choose an existing file. Modifications, if any, to the schema are loaded from the
file from this page.
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Figure 10.3.2: Adding External XSDs

Any external XSDs used by a structure can be added from this page. Figure 10.3.2 shows
the External XSDs Page. External XSDs can be added by performing the following steps:

Click the New button to add a new external schema. A context menu will appear as shown
in the Figure 10.3.2. The user can either add a New XSD or use an Existing Schema that is
already present in the eMapper Project.

Adding a new XSD

e Click New XSD. This will enable the Schema Content Area where the content of
the schema can be entered.

e A valid file name should be provided in the Schema File field. The provided XSD
will be saved with the name specified in the PROJECT_HOME/resources/schemas
directory.

e The content can also be loaded from a file using the Browse button. Click this
button and browse through the file system and select the required file.

e After providing the XSD, it can be saved as an external XSD for the structure by
clicking the Save button. As specified earlier, the XSD will be saved in the
PROJECT_HOME/resources/schemas folder with the name specified in the Schema
File field.

e The target name space of the schema is added to the list of Referenced URIs
present on the left end of the page.
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Adding an existing schema

e To use an XSD which is already present in the eMapper Project, click Existing
Schema in the New context menu. A list of all the XSD present in the
PROJECT_HOME/resources/schemas directory is shown. Choose an XSD and it will
be saved as an external schema to the current structure.

Note: As target name space is used in referring to these schemas, therefore
saving an XSD without a target name space is not allowed. Two schemas with
same target name space cannot be added.

e External schemas can be removed by selecting the namespace of the structure to
be deleted and clicking the Delete button.

10.3.1.2 Load Input/Output Structure from a DTD document

Select DTD from the Add Structure menu. The Load Input/Output DTD Structure wizard
appears as shown in the Figure 10.3.3. The DTD content can be specified from the
Structure Selection Page present in this wizard. Similar to the Structure Selection Page in
Load Input/Output XSD Structure Wizard, this page allows the user to enter the structure
content directly or by loading it from an existing file. To load content from an existing DTD
document, click the Load From File button.

& Load Input DTD Structure |Z|@@

Structure selection page

Skruckure Mare Inputl |

DTD conkent Load from File

ZIELEMEMNT female [ name ) =
ZIELEMENT male [ name ) =

<IELEMENT name { #PCDATA ) =
<IELEMEMT school { male+, Female+ ) =

(7} Finish l [ Cancel

Figure 10.3.3: Load Input DTD Structure

10.3.1.3 Load Input/Output Structure from an XML document

Select XML from the Add Structure menu. The Load Input/Output XML Structure wizard
appears as shown in the Figure 10.3.4. The dialog contains two panes: XML Content and
Generated DTD.
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The name of the structure can be specified in the Structure Name field. The structure
name cannot contain special characters. Only alphabets, numbers and '_' are allowed in a
structure name. Two structures with the same name are not allowed.

The XML can be provided in the text area present in the XML Content pane. This text area
has a tool bar with two buttons, Load From File and Generate DTD. The content can be
loaded from an existing file by clicking the Load From File button. Click the Generate
DTD button to generate a DTD from this XML document. The DTD is shown in the text
area present in the Generated DTD pane. This DTD document is used to load the structure.
Modifications, if needed, can be made to this DTD.

The structure can be saved and loaded in the Input/Output Structure panel by clicking the
Finish button. The content is saved in a file with name <Structure_Name>.<Mime_Type>
in the PROJECT_HOME/resources/schemas directory. If the schema is not valid an
exception is logged in the Error Log view.

& Load Input XML Structure

Specify XML for which schema has to be generated

Enter the Mame of the Structure: | Inputl

#ML Conkent Generated DTD
Generate OTD button
e |<IELEMENT Admissions { Applicant+ ) =
<IELEMENT Age { #PCDATA T =
m ~ <IELEMEMNT Applicant { Age, Marks ) =
<Applicant name="tony" = ZIATTLIST Applicant name MMTOKEN #REQUIRED =
“hge=25</hge= ZIELEMENT Marks { #PCDATA ) =
<Marks =90 < Marks >

</applicant =

<Applicant name="scott" >
<hge=Z3<lAges
<Marks =95 Marks =

<fapplicant =

<Applicant name="ayrtan" =
<hgex24<lage=
<Marks =90 </Marks =

</ Applicant =

<Applicant name="schumac" =
“hge=24 <l hge "

() Finish ] [ Cancel

Figure 10.3.4: Load Input XML Structure

10.3.1.3 Load a FIX message as an Input/Output Structure

Select FIX from the Add Structure menu A list of different FIX versions and message
types is displayed where the messages to be loaded can be chosen. Select the message
types and click the Load button to load the messages types in to the workspace. Click
Finish in the Add Structure wizard and the FIX message structure is loaded in Mapper.
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More information on FIX-XML transformation is provided in section 10.11

10.3.2 Delete Structure

A structure can be deleted from the Input/Output Structure Panel by clicking the Delete
Structure panel present in the structure panel's tool bar. This will delete the selected
structure and will clear all the mappings associated with this structure.

10.3.3 Edit Structure

To edit Input/Output Structure:

1. Right-click the structure and click the Edit Structure option. The Edit Structure
dialog is opens as shown in Figure 10.3.5.

2. The selected structure is shown in the text area. A drop-down in the top lists all
the imported schemas added to the structure. Selecting a schema from the drop-
down will populate its content in the text area. Modifications to the structure can
be done here. The = (Load From File) button can be used to load structure from a
file And the = (Save) button to save the modifications in the current schema.

3. Click the OK button to save the modifications to the structure and to refresh the
tree structure in the mapper with the modified structure.

If the new structure is valid, it gets saved and loaded in its corresponding panel.
Otherwise, an error dialog box is shown and the modifications are ignored.
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Upon editing a structure, mappings defined to the affected elements/attributes are

discarded.
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Figure 10.3.5: Edit Structure Dialog

10.4 Working with the Visual Expression Builder

Fiorano eMapper provides an easy to use graphical user interface - the Visual Expression
Builder, used for building simple or complex expressions using several predefined
functions. All this can be done by performing simple drag-n-drop of required functions,
input nodes and connecting them visually.

The Funclet View provided in the Fiorano eMapper Perspective consists of the Visual
Expression Builder. The Visual Expression Builder is shown automatically upon clicking on
any node in the Output Structure.

The Visual Expression Builder consists of two areas:

Function palette: A palette listing various functions that can be used while defining
mappings between input and output nodes.

Funclet easel: A canvas where the user can define mappings by adding functions from
the palette and nodes from the input and output trees.

The Funclet View displaying a mapping is shown in the figure 10.4
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Figure 10.4 Funclet View

The mapping shown in above figure concats the values of two nodes from the input

structure (‘m‘ 0 T |Nth{ and ‘lst‘ c ‘Nth{) with some constants () using pre-

defined string functions ( H concar ) to obtain the value of a node in the output structure
1] e |
( g ).

A mapping usually has

a) Destination node
b) Function nodes (optional)

c) Source nodes (optional)

10.4.1 Funclet Easel

The Funclet Easel is the basic work area for creating expression based mappings. The user
can place the Function nodes as well as the Source or Destination nodes on this area and

make the required mappings.

The Funclet easel appears as shown in Figure 10.4.1.

:]-ﬂ Funclet Yiew &3 5-| Messages | [ Mapper Consale
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”
[é Select |15I: ||1| Marks |15t¢>—
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¥
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Figure 10.4.24: Funclet easel

10.4.2.1 Source Node

The Source node corresponds to a node in the Input Structure Panel. A Source node is
shown in Figure 10.4.2.

|15I: |Iﬂ Marks |15t#

Figure 10.4.2: Source Node
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10.4.2.2 Destination Node

The Destination node corresponds to a node in the Output Structure Panel. A Destination
node is shown in Figure 10.4.3.

% [e| Marks

Figure 10.4.3: Destination Node
Add Link between two Nodes

To make a link between two nodes placed on the Funclet easel, follow the steps below:

1. Click on the gray box on the source building block. A small circle appears, as
shown in Figure 10.4.4. This represents the starting point of the link and the
output box of the building block.

|15t||i| Marks |15t¢)

Figure 10.4.4: Source node

2. Now drag-and-drop the mouse to the Destination node’s input point, which is again
represented by a gray box. A big circle appears on the destination node, as shown
in Figure 10.4.5.

|15I: ||i| Marks |15I: |—|— I
:|2 %IEI Marks

Figure 10.4.5: Linking the Source and the Destination node

3. Release the mouse. A link between the two nodes is created.

Add Source node to Funclet easel

1. Drag-and-drop the source node from the Input Structure Panel to the Funclet
easel, as shown in Figure 10.4.6.

:]-ﬂ Funclet Yiew &3 5| Messages | (] Mapper Console
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J Constant
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Figure 10.4.6: Adding Source node to Funclet easel

Add Function node to Funclet easel
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1. Click the Function node on the Function palette that is to be placed on the
Funclet easel, as shown in Figure 10.4.7.

String Functions
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Figure 10.4.7: Selecting the Function node

2. Now, move the mouse onto the Funclet easel. This changes the mouse to a?+?
'+’ sign, representing that the corresponding function node is selected.
Now click on the Funclet easel.

4. This places the corresponding function node building block on the Funclet
easel.

Alternatively,
1. Drag-and-Drop the function node from Function palette to the Funclet easel, as shown
in Figure 10.4.8.

il Lo
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n;udels ] Filter |Loa
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15t | (2] Attachrment Loo
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Figure 10.4.8: Funclet easel

Add Link between two nodes

To make a link between two nodes placed on the Funclet easel, follow the steps below:

1. Click on the gray box on the source building block. A small circle appears, as shown in
Figure 10.4.9. This represents the starting point of the link and the output box of the

building block.

|15t [ (=] Marks [1ste>

Figure 10.4.9: Source node
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2. Now drag-and-drop the mouse to the destination node’s input point, which is again
represented by a gray box. A big circle appears on the destination node, as shown in

Figure 10.4.10.

|15t||1| Marks lstl 1 1
:|2 %El Marks

Figure 10.4.10: Linking the Source and the destination node

3. Release the mouse. A link between the two nodes is created, as shown in Figure
10.4.11.
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Figure 10.4.11: Linking Source and Destination nodes
Delete link between two nodes

To delete a link between two building blocks,

1. Click on the ending point of the link and drag it to an empty area in the Funclet easel,
as shown in Figure 10.4.12.

|15I: ||i| Marks |15ts{i—|_ T
:]-ﬂ Clear Funclet

(?) Help !

Figure 10.4.12: Deleting link

2. Now, release the mouse. This removes the link between the corresponding nodes.

Delete node from Funclet easel

Select the corresponding building block and right-click on it. The shortcut menu appears as
shown in Figure 10.4.13.
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1st |[2] Marks [1st]

:]-1 Clear Funclet
=| Copy
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Figure 10.4.13: Pop-up menu

e Click Delete to delete the selected building block.

Open Function Help

The description for a predefined function can be viewed by clicking Help in the right-click
menu of a Function node.

10.4.2 Function Palette

The Function palette contains all the functions logically grouped into different categories:

Arithmetic Functions
String Functions
Boolean Functions
Control Functions
Advanced Functions
JMS Message Functions
Date-Time Functions
NodeSet Functions
Math Functions
Conversion Functions
Look-up Functions

User defined functions

Fiorano eMapper provides several Arithmetic functions to work with numbers and nodes.

This section describes these functions.

Addition

Visual representation +

Description: This function calculates and returns the sum of two nodes or numbers.

Input: Two number constants or input structure nodes.

Output: Number
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Subtraction

Visual representation J
Description: This function subtracts the values of two numbers or nodes.
Input: Two number constants or input structure nodes.
Output: Number
Division
Visual representation J

Description: This function obtains and returns the quotient after dividing the values of
two nodes or numbers.

Input: Two number constants or input structure nodes.
Output: Number

Modulo

Visual representation _I

Description: This function returns the remainder after dividing the values of the two
nodes or numbers.

Input: Two number constants or input structure nodes.
Output: Number

Multiplication

Visual representationJ

Description: This function multiplies the values of two nodes or humbers.
Input: Two number constants or input structure nodes.

Output: Number

Floor

Visual representation;l

Description: This function rounds off the value of the node or humber to the nearest
lower integer.

Input: A number constant or an input structure node.
Output: Number

Example: The number 3.3 is floored to 3.
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Ceiling

Visual representationJ

Description: This function rounds off the value of the node or number to the nearest
higher integer.

Input: A number constant or an input structure node.
Output: Number
Example: The number 25.6 is ceiled to 26.

Round

Visual representationJ

Description: This function rounds off the value of the preceding node or a number to the
nearest integer.

Input: A number constant or an input structure node.
Output: Number
Example: The number 4.8 is rounded off to 5 and 4.2 is rounded off to 4.

Number Function

Visual representation'_l

Description: This function converts the input to a number according to the XPath
specifications.

Input: A number constant or an input structure node.

Output: Number based on the following rules:
e Boolean true is converted to 1, and false is converted to 0.

e A node-set is first converted to a string and then converted in the same
way as a string argument.

e A string that consists of optional whitespace followed by an optional minus
sign followed by a number followed by whitespace is converted to the IEEE
754 number that is nearest to the mathematical value represented by the
string; any other string is converted to NaN.

e An object of a type other than the four basic types is converted to a
number in a way that is dependent on that type.
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10.4.1.2 Math Functions

Absolute

Visual representationﬁ
Description: This function returns the absolute (non-negative) value of a number.
Input: Number
Output: The absolute value of the input
Sin
Visual representationm
Description: This function returns the Sine value of the input. The input is in radians.
Input: A number in radians.
Output: The Sine value of the input.

Cos

Visual representationﬁ
Description: This function returns the Cosine value of the input. The input is in radians.
Input: A number in radians
Output: The Cosine value of the input

Tan

Visual representationﬁ
Description: This function returns the Tan value of the input. The input is in radians.
Input: A number in radians.
Output: The Tan value of the input.

Arc sine

| -
Visual representation L

Description: This function returns the Arc Sine value or the Sine Inverse value of the
input. The output is in radians.

Input: Number

Output: The Sine Inverse value of the input in radians.
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Arc cos

Visual representation &£El

Description: This function returns the Arc Cosine value or the Cosine Inverse value of the
input. The output is in radians.

Input: Number
Output: The Cosine Inverse value of the input in radians.

Arc tan

e
Visual representation

Description: This function returns the Arc Tan value or the Tan Inverse value of the input.
The output is in radians.

Input: Number
Output: The Tan Inverse value of the input in radians.

Exponential

Visual representationﬂ
Description: This function returns the exponential value of the input.
Input: Any number
Output: The exponential value the input.

Power

Visual representationﬁ

Description: This function returns the value of a first input raised to the power of a
second number.

Input: Two numbers: the first number is the base, and the second number is the power.

Output: A number that is the result of the above described calculation or NaN in case the
value could not be calculated.

Random

Visual representationm
Description: This function returns a random number between 0 and 1.
Input: No input

Output: A number between 0 and 1.
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Sqrt

Visual representation
Description: This function returns the square root of the input value
Input: A number
Output: A number that is the square root of the input value.

Log

Visual representationm

Description: This function returns the natural logarithm (base e) of a numerical (double)
value.

Input: A positive numerical value.
Output: The natural logarithm (base e) of the input - a numerical (double) value.

Special cases:
e If the argument is NaN or less than zero, the result is NaN.
e If the argument is positive infinity, the result is positive infinity.

e« If the argument is positive zero or negative zero, the result is negative infinity.

10.4.1.3 String Functions

Fiorano eMapper has several string functions. All the functions accept Unicode strings and
are case-sensitive. This section covers the string functions.

XPath

Visual representationJ

Description: This function evaluates the specified XPath expression and returns the
result.

Input: For elements within the first structure of the document, specify the XPath as:

/<root element>/<child element>
Example/school/student

For elements within the second structure onwards, specify the XPath as:

document('<structure name>')/<root element>/<child element>
Example: document('input2')/school/student

Output: Result of the XPath expression.
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Concat

Visual representationJ

Description: This function accepts two or more string arguments and joins them in a
specified sequence to a form a single concatenated string.

Input: Two or more string constants or input structure nodes.
Output: A concatenated string.
Example: Concat ("abc", "xyz") returns "abcxyz".

Constant

Visual representationJ
Description; This function creates a constant building block with a string literal.
Input: String
Output: String

Length

Visual representationJ
Description: This function returns the length of a string.
Input: A string constant or an input structure node.
Output: Number
Example: Length ("abcd") returns 4

Normalize_Space

Visual representationJ
Description: This function accepts a string as an argument and removes leading, trailing,
and enclosed spaces in the specified string. The unnecessary white spaces within the string
are replaced by a single white space character.
Input: A string or an input structure node.
Output: String with no whitespace before, after, or within it.

Example: Normalize_Space(" eMapperTool ") returns "eMapper Tool".

White spaces before and after the string is removed and the white spaces between
"eMapper" and "Tool1" are replaced by a single blank space.
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SubString-After

Visual representationJ
Description This function accepts two strings as arguments. The first string is the source
and the second input string is the string pattern. It returns that part of the first input
string that follows the string pattern.
Input: Two string constants or input structure nodes.
Output: String

Example: substring-After(‘abcde’, ‘bc’) returns "de"

SubString-Before

Visual representationJ
Description: This function accepts two strings as arguments. The first string is the source
and the second is the string pattern. The function returns that part of the first input string
that precedes the string pattern specified as the second argument to the function.
Input: Two string constants or input structure nodes.
Output: String

Example: substring-Before(‘abcde’, ‘cd’) returns ‘ab’

SubString-Offset

Visual representationJ
Description: This function accepts two string constants as argument. The first string is
the source and the second string is a numerical value that specifies the offset. The output
is that part of the source string which starts from the offset specified as the second
argument to the function.
Input: Two string constants or input structure nodes.
Output: String

Example: SubString-offset(‘abcde’, 3) returns "cde"

SubString-Offset-Length

Visual representationJ

Description: This function accepts three arguments. The first argument is the source
string, the second and third arguments are numerical that specify the offset and the size of
the output substring respectively. The output is a substring which starts from the offset
specified as the second argument to the function. The number of characters that need to
be obtained is specified as the third argument.

Input: Two string constants or input structure nodes and a number.
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Output: String

Example: substring-offset-Length(‘abcde’, 2, 3) returns "bcd"

10.4.1.4 Control Function
The following Control functions are available in Fiorano eMapper:

If-Then-Else

Visual representationJ
Description: This function accepts an input value. The first input is a Boolean value and
the second and third are string constants. Based on the Boolean value, the function
returns the output. If the Boolean value specified in the first input is TRUE, then the
function returns the second input string else it returns the third input string.

Input: Boolean value and a string, an optional string in the same sequence.

Output: The second input string or third input string (if present) depending on the first
input Boolean value.

Sort Function

Visual representationJ
Description: This function accepts two inputs. The first input is a set of nodes and the
second input is the value of the nodes. The function sorts the nodes in its first input based
on the second input.
Input: Sort (nodes, value)

Output: Sorted nodes as Loop Source

Filter Function

Visual representationJ
Description: This function accepts two arguments. The first argument is a set of nodes
and the second argument is a Boolean value. It filters out and returns the nodes for which
the second input value is TRUE.

Input: Filter (node set, bool)

Output: Nodes for which the second input value is true as Loop Source.

10.4.1.5 Conversion Functions

Fiorano eMapper consists of several Conversion functions to convert nhumerical from one
format to the other. These functions are covered in this section.
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Decimal

Visual representationﬁ

Description: Converts the first input value having a base that is specified by the second

input value to a decimal number.

Input: Two numbers: The first input value is the number to be converted to decimal, and

the second input value specifies the base of the first input value.
Output: Number in base 10.

Hex

Visual representation@
Description: Converts a decimal humber to a hexadecimal (base 16) humber.
Input: Decimal number
Output: Hexadecimal (base 16) number

Octal

Visual representation@
Description: Converts a decimal nhumber to an octal (base 8) number.
Input: Decimal number
Output: Octal (base 8) number

Binary

Visual representationm
Description: Converts a decimal number to a binary (base 2) number.
Input: Decimal number
Output: Binary (base 2) number

Radians

Visual representationm
Description: Converts a value in Degrees to a value in Radians.
Input: Number

Output: Number
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Degrees

Visual representation@
Description: Converts a value in Radians to a value in Degrees.
Input: Number
Output: Number

ChangeBase

Visual representationﬂ

Description: The ChangeBase function is used to change a number from one base to
another. This function accepts three arguments.

1. num- the number to be changed
2. fromBase- base of the given nhumber

3. toBase- base to which number should be converted
Input: Number

Output: Number

10.4.1.6 Advanced Functions

Fiorano eMapper provides a number of advanced functions. This section explains all these
functions.

CDATA Function

Visual representationm

Description: This function accepts a string as an argument and specifies the character
data within the string.

Input: String argument or input structure node.
Output: Input string or node text enclosed within the CDATA tag.
Example: CDATA ("string") returns <![CDATA[ string]l]l>

Position

Visual representationu

Description: This function is available for the RDBMS-Update or RDBMS-Delete Output
structures only and returns the current looping position.

Input: None

Output: The position of the element in the parent tree.
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Example: In an XML tree that has three elements, Position() returns
e 0 for the first element
e 1 for the second, and

e 2 for the third.

Format-Number

Visual representationﬂ

Description: This function converts the first argument to a string, in the format specified
by the second argument. The first argument can be a real number or an integer, and can
be positive or negative.

Input: Two values: The first input is a number, and the second, a string of special
characters that specifies the format. These special characters are listed in the following
table:

Representation Signifies Example
# a digit [0-9] #HH#
the decimal point HUuH®HH
, digit separator HHH, BHHHH
0 leading and trailing zeros 000.0000
% inserts a percentage sign at the end ###.00%
; a pattern separator #4.00;#+#.00

The format string is created by using these characters in any order.
Output: String with the number in the specified format.

Node-Name

Visual representationﬁ

Description: This function accepts an element or attribute and returns the name of the
particular element or attribute.

Input: A single element or attribute of any type
Output: A string

Count

Visual representation%

Description: This function accepts an element or attribute and returns the number of
instances of a particular element or attribute.

Input: A single element or attribute of any type

Output: A humber
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Deep-Copy

Visual representationE

Description: Copies the current node completely including the attributes and sub-
elements.

Input: An Input structure node

Output: All the contents of the Input structure node - including its attributes and sub-
elements.

Param

Visual representationH

Description: This function is used to access the runtime parameters by its name. Various
properties of Tifosi Document (such as header, message, and attachments) are available
as runtime parameters at runtime. The names of these parameters follow the convention
given below:

H r Pr rti
eade operties _TIF_HEADER_<HEADERNAME>

Message (text) TIF_BODY_TEXT

Message (byte) TIF_BODY_BYTE_

Attachment

_TIF_ATTACH_<NAME>

Input: Name of the parameter

Output: Value of the parameter specified

10.4.1.7 Date-Time Functions
Date-Time functions include:

Date

Visual representation

Description: The Date function returns the date part in the input date-time string or the
current date if no input is given. The date returned format is: CCYY-MM-DD

If no argument is given or the argument date/time specifies a time zone, then the date
string format must include a time zone, either a Z to indicate Coordinated Universal Time
or a + or - followed by the difference between the difference from UTC represented as
hh:mm. If an argument is specified and it does not specify a time zone, then the date
string format must not include a time zone.

Input: Optionally, a string that can be converted to a date (the string should have the
date specified in the following format: CCYy-mMM-DD)

Output: A date in the format: CCYY-MM-DD
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DateTime

Visual representation

Description: This function returns the current date and time as a date/time string in the
following format:

CCYY-MM-DDThh:mm:ss

Where,
e (CCis the century
e YY is the year of the century
¢ MM is the month in two digits
e DD is the day of the month in two digits
e T is the separator between the Date and Time part of the string
e hhis the hour of the day in 24-hour format
e mm is the minutes of the hour
e ssis the seconds of the minute
The output format includes a time zone, either a Z to indicate Coordinated Universal Time

or a + or - followed by the difference between the localtime from UTC represented as
hh:mm.

Input: This function has no input.

Output: The current date-time in the following format: CCYy-MM-DDThh:mm:ss as described
above.

DayAbbreviation

Visual representation. :
Description: This function returns the abbreviated day of the week from the input date
string. If no argument is given, then the current local date/time is used as the default
argument.

Input: Optionally, a date-time string

Output: The English day of the week as a three-letter abbreviation: 'Sun', 'Mon', "Tue',
'Wed', 'Thu', 'Fri', or 'Sat'.

DayInMonth

Visual representation;il

Description: This function returns the day of a date as a number. If ho argument is given,
then the current local date/time is used as the default argument.

Input: A date-time string in any of the following formats:

CCYY-MM-DDThh:mm:ss
CCYY-MM-DD
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--MM-DD

---DD

If no input is given, then the current local date/time is used.
Output: A number which is the day of the month in the input string.

DayInWeek

Visual representationii

Description: This function returns the day of the week given in a date as a number. If no
argument is given, then the current local date/time is used the default argument.

Input: A date string in any of the following formats:

CCYY-MM-DDThh:mm:ss
CCYY-MM-DD

Output: The day of the week as a number - starting with 1 for Sunday, 2 for Monday and
so on up to 7 for Saturday. If the date/time input string is not in a valid format, then NaN is

returned.

DayInYear

Visual representation L.

Description: This function returns the day of a date as a day number in a year starting
from 1.

If no argument is given, then the current local date/time, as returned by date-time is used
as the default argument.

Input: Optionally, a date string in any of the following formats:

CCYY-MM-DDThh:mm:ss
CCYY-MM-DD

Output: A number representing the day in a year.
Example: The DayInyear for 2003-01-01 returns 1, where as for 2003-02-01 it returns 32.

DayName

Visual representation;l

Description: This function returns the full day of the week for a date. If no argument is
given, then the current local date/time is used the default argument.

Input: Optionally, a date string in any of the following formats:

CCYY-MM-DDThh:mm:ss
CCYY-MM-DD

Output: An English day name: 'sunday', 'Monday', 'Tuesday', 'wednesday', 'Thursday' or
'Friday'.
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DayOfWeekInMonth

Visual representation L.

Description: This function returns the occurrence of that day of the week in a month for a
given date as a number. If no argument is given, then the current local date/time is used
as the default argument.

Input: Optionally, a date string in any of the following formats:

CCYY-MM-DDThh:mm:ss
CCYY-MM-DD

Output: A number that represents the occurrence of that day-of-the-week in a month.
Example: DayOfWeekInMonth returns 3 for the 3rd Tuesday in May.

HourInDay

Visual representation.:_‘

Description: This function returns the hour of the day as a number. If no argument is
given, then the current local date/time is used as the default argument.

Input: A date string in any one of the following formats:

CCYY-MM-DDThh:mm:ss
hh:mm:ss

If the date/time string is not in one of these formats, then NaN is returned.
Output: The hour of the day or NaN if the argument is not valid.

LeapYear

Visual representation -

Description: This function returns TRUE if the year given in a date is a leap year. If no
argument is given, then the current local date/time is used as the default argument.

Input: Date string in any of the following formats:

CCYY-MM-DDThh:mm:ss
CCYY-MM-DD

CCYY-MM

CCYy

If the date/time string is not in one of these formats, then NaN is returned.

Output: Boolean value (TRUE/FALSE)
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MinuteInHour

Visual representation L.

Description: This function returns the minute of the hour as a number. If no argument is
given, then the current local date/time is used as the default argument.

Input: Optionally, a date string in any of the following formats:

CCYY-MM-DDThh:mm:ss
hh:mm:ss

Output: The minute of the hour or NaN if the argument is not valid.

MonthAbbreviation

Visual representation'ii’”g"‘

Description: This function returns the abbreviation of the month of a date. If no
argument is given, then the current local date/time is used as the default argument.

Input: Date string in any of the following formats:

CCYY-MM-DDThh:mm:ss
CCYY-MM-DD

CCYY-Mm

__MM__

OutputThree-letter English month abbreviation: 'Jan', 'Feb', 'Mar', 'Apr', 'May', 'Jun’, 'Jul’,
'Aug', 'Sep', 'oct', 'Nov' or 'Dec'.If the date/time string argument is not in valid, then an

empty string (") is returned.

MonthInYear

Visual representation .

Description: This function returns the month of a date as a humber. The counting of the
month starts from 0. If no argument is given, the current local date/time is used as the
default argument.

Input: Date string in any of the following formats:

CCYY-MM-DDThh:mm:ss
CCYY-MM-DD

CCYY-MM

__MM__

--MM-DD

If the date/time string is not valid, then NaN is returned.
Output: A number representing the month in a year.

Example: 0 for January, 1 for February, 2 for March and so on.
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MonthName

Visual representation M

Description: This function returns the full name of the month of a date. If no argument is
given, then the current local date/time is used as the default argument.

Input: Optionally, a date string in any of the following formats:

CCYY-MM-DDThh:mm:ss
CCYY-MM-DD

CCYY-MM

R MM_ -

Output: The English month name: 'January', 'February', 'March', 'April', 'May', 'June’',
'July’, 'August’, 'September’, 'October’, 'November' or 'December'.If the date/time string is
not valid, then an empty string (") is returned.

SecondInMinute

Visual representation L

Description: This function returns the second of the minute as a number. If no argument
is given, then the current local date/time is used as the default argument.

Input: Optionally, a date string in any of the following formats:

CCYY-MM-DDThh:mm:ss
hh:mm:ss

Output: The second in a minute as a number. If the date/time string is not valid, then NaN
is returned.

Time

Visual representation

Description: This function returns the time specified in the date/time string that is passed
as an argument. If no argument is given, the current local date/time is used as the default
argument. The date/time format is basically CCYY-MM-DDThh:mm:ss.

If no argument is given or the argument date/time specifies a time zone, then the time
string format must include a time zone, either a Z to indicate Coordinated Universal Time
or a + or - followed by the difference between the difference from UTC represented as
hh:mm. If an argument is specified and it does not specify a time zone, then the time string
format must not include a time zone.

Input: Optionally, a date/time string in the following format:

CCYY-MM-DDThh:mm:ss

Output: The time from the given date/time string in the following format:

hh:mm:ss

If the argument string is not in this format, this function returns an empty string (").
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WeekInYear

Visual representation

Description: This function returns the week of the year as a number. If no argument is
given, then the current local date/time is used as the default argument. Counting follows
ISO 8601 standards for numbering: week 1 in a year is the week containing the first
Thursday of the year, with new weeks beginning on a Monday.

Input: Optionally, a date/time string in any of the following format:

CCYY-MM-DDThh:mm:ss
CCYY-MM-DD

Output: The week of the year as a number. If the date/time string is not in one of these
formats, then NaN is returned.

Year

Visual representation

Description: This function returns the year of a date as a number. If no argument is
given, then the current local date/time is used as a default argument.

Input: Optionally, a date/time string in any of the following format:

CCYY-MM-DDThh:mm:ss
CCYY-MM-DD

CCYY-MM

CCYy

Output If the date/time string is not in one of these formats, then NaN is returned.

10.4.1.8 NodeSet Functions

SUM

Visual representationJ
Description: The Sum function sums all numbers in selected nodes.
Input: A nodes that has numerical values only.

Output: The sum of all the nodes. If any of the input nodes is not valid, a NaN value is
returned.

DIFFERENCE

Visual representationJ
Description: The difference function returns the difference between the two node sets
that are, in the node set passed as the first argument and the node that are not in the

node set passed as the second argument.

Input: Two node sets
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Output: Node set

DISTINCT

Visual representationJ
Description: The distinct function returns a subset of the nodes contained in the node-set
passed as the first argument. Specifically, it selects a node N if there is no node in a given
node-set that has the same string value as N, and that precedes N in the document order.
Input: A node set

Output: A node

HAS SAME NODE

Visual representationJ
Description: The has-same-node function returns TRUE if the node set passed as the first
argument shares any nodes with the node set passed as the second argument. If there are
no nodes that are in both node sets, then it returns FALSE.
Input: Two node sets

Output: Boolean value (TRUE or FALSE)

INTERSECTION

Visual representationJ

Description The intersection function returns a node set containing the nodes that are
within both the node sets passed as arguments to it.

Input: Two node sets
Output: Node set

LEADING

Visual representationJ

Description: The leading function returns the nodes in the node set passed as the first
argument that precede, in document order, the first node in the node set passed as the
second argument. If the first node in the second node set is not contained in the first node
set, then an empty node set is returned. If the second node set is empty, then the first
node set is returned.

Input: Two node sets

Output: Node Set
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TRAILING

Visual representationJ

Description: The trailing function returns the nodes in the node set passed as the first
argument that follow, in document order, the first node in the node set passed as the
second argument. If the first node in the second node set is not contained in the first node
set, then an empty node set is returned. If the second node set is empty, then the first
node set is returned.

Input: Two node sets
Output: Node set

HIGHEST

Visual representationJ
Description: The highest function returns the nodes in the node set whose value is the
maximum (numerical) value for the node set.

e A node has this maximum value if the result of converting its string value
to a number as if by the number function is equal to the maximum value,
where the equality comparison is defined as a humerical comparison using
the = operator.

e If any of the nodes in the node set has a non-numeric value, this function
returns an empty node set.

Input: A node set
Output: A node set

LOWEST

Visual representationJ
Description: The lowest function returns the nodes in the node set whose value is the
minimum (numerical) value for the node set.

e A node has this minimum value if the result of converting its string value
to a number as if by the number function is equal to the minimum value,
where the equality comparison is defined as a numerical comparison using
the = operator.

e If any of the nodes in the node set has a non-numeric value, this function
returns an empty node set.

Input: A node set

Output: A node set
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MINIMUM

Visual representationJ
Description: The minimum function returns the node with the minimum numerical value
within the given node-set. If the node set is empty, or if any of the nodes in the node set
has a non-numeric value, then NaN is returned.
Input: A node set

Output: A numerical value

MAXIMUM

Visual representationJ
Description: The maximum function returns the node with the maximum numerical value
within the given node set. If the node set is empty, or if any of the nodes in the node set
has a non-numeric value, then NaN is returned.

Input: A node set

Output: A numerical value

10.4.1.9 Boolean functions

The following boolean (logical) functions are available in eMapper Tool:
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Symbol Function Description
= Equal True if both inputs are equal.
1= Not Equal True if both inputs are not equal
> Greater than True if the first input is greater than the second input.
< Less than True if the first input is less than the second input.
>= Greater than or True if the first input is greater than or equal to the second
Equal input.
<= Less than or True if the first input is less than or equal to the second
Equal input.
AND AND Logical AND of the two inputs (the inputs must be outputs of
logical building blocks only).
OR OR Logical OR of the two inputs (the inputs must be outputs of
logical building blocks only).
NOT NOT Logical inverse of the input (the input must be the output of
logical building block only).
BOOL boolean(object) Converts its argument to a boolean according to the XPath
specifications, as follows:
- a number is true if and only if it is neither positive or
negative zero nor NaN.
— a node-set is true if and only if it is non-empty
— astring is true if and only if its length is non-zero an
object of a type other than the four basic types is
converted to a boolean in a way that is dependent on
that type.
- — IsNumber-IsNumber( )-Returns a boolean (true/ false)
indicating if the input value is a number

AND function
Symbol: AND

Description: This function accepts two boolean expressions as arguments and performs a
logical conjunction on them. If both expressions evaluate to TRUE, the function returns
TRUE. If either or both expressions evaluate to FALSE, the function returns FALSE.

Input: AND (boolean AND boolean)
Output: Boolean value (TRUE/FALSE)
Example:

Consider the example of Chat.dtd as Input Structure and Valid.dtd as Output Structure.
Suppose we want to filter out mails that do not have a message body and the email
address is not equal to admin@nobody.com. That is, we want that the isValid node of the
Output Structure takes the value true if the length of the Message node of the Input
Structure is not equal to zero and the value of the Email node is equal to
admin@nobody.com. Therefore,

1. Load Input Structure and Output Structure.
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2. Map the Message node and Email node of Input Structure to the isValid node of
the Output Structure.

Invoke the Function Wizard by Right-clicking on the isValid node.
4. The Function Easel opens with the existing mappings.
5. Place the BOOL node on the Function Easel.

Link the output of the Message node to the input of the BOOL node, as shown in
Figure 10.4.14.

@Message 1st#)—)-- 1 g BOOL R

Figure 10.4.14: Linking Message and BOOL nodes

6. Place a Constant node on the Function Easel, and set its value equal to
admin@nobody.com.

7. Place a = node on the Function Easel.

Link the outputs of the Email node and Constant node to the inputs of the = node,
as shown in Figure 10.4.15.

=

|g admin@nobody.com | Re[»—l—, &

Figure 10.4.15: Linking the Email and Constant node outputs
8. Place an AND node on the Function Easel.
9. Link the outputs of the BOOL node and = node to the inputs of the AND node.

Also, link the output of the AND node to the input of the isValid node, as shown
in Figure 10.4.16.

e B W e B filEe ]

[&| admin@nobody.com | R 3 i
| |

Figure 10.4.16: Linking the AND and = node outputs

10. This completes the desired mappings.
BOOL
Symbol: BOOL
Description:

This function converts its argument to a boolean according to the XPath specifications
which are as follows:

- A number is TRUE if and only if it is neither positive or negative zero nor NaN.
- A node-set is TRUE if and only if it is non-empty.

- A string is TRUE if and only if its length is non-zero.
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- An object of a type other than the four basic types is converted to a boolean in a way
that is dependent on that type.

Input: BOOL (Object)
Output: Boolean value (TRUE/FALSE)
Example:

Consider the example of Chat.dtd as Input Structure and Valid.dtd as Output Structure.
Suppose we want to filter out mails that do not have message body. That is, we want that
the isMessageExist node of the Output Structure takes the value true if the length of the
Message node of the Input Structure is not equal to zero. The BOOL function returns true
for a string of length non-zero. Therefore,

1. Load Input Structure and Output Structure.

2. Map the Message node of Input Structure to the isMessageExist node of the
Output Structure.

3. Invoke the Function Wizard by right-clicking on the isMessageExist node.
4. The Function Easel opens with the existing mappings.
5. Place the BOOL node on the Function Easel.

Link the output of the Message node to the input of the BOOL node, as shown in
Figure 10.4.17.

[E]Message 1st¢»—)-- 1 |& BooL | R

Figure 10.4.17: Linking Message and BOOI nodes

Link the output of the BOOL node to the input of the isMessageExist node, as
shown in Figure 10.4.18.

[:_E_]Message 1st¢>—)-- 1 | &| BooL Ht%)—)-- 1 @isMessageEHist

Figure 10.4.18: Linking BOOL and IsMessageExist nodes

6. This completes the desired mappings.
Equal
Symbol: =
Description: This function returns TRUE if both the inputs are equal.
Input: = (Object = Object)
Output: Boolean value (TRUE/FALSE)

Example:

Consider the example of Chat.dtd as Input Structure and Valid.dtd as Output Structure.
Suppose we want to filter mails coming from a particular email address. That is, we want
that the isFromAdmin node of the Output Structure takes the value true if the Email
node of the Input Structure has the email address as admin@nobody.com. Then,

1. Load Input Structure and Output Structure.
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2. Map the Email node of Input Structure to the isFromAdmin node of the Output
Structure.

Invoke the Function Wizard by right-clicking on the isFromAdmin node.
4. The Function Easel opens with the existing mappings.

Now place a Constant building block on the Function Easel and set its value equal
to admin@nobody.com, as shown in Figure 10.4.19.

(E]Email | 1=t Tf =

#&| admin@nobody.com | R

Figure 10.4.19: Setting Constant building block value to admin@nobody.com
5. Now place a = node on the Function Easel.

6. Link the outputs of the Email node and Constant node to the inputs of the =
node.

Link the output of the = node to the input of the isFromAdmin node, as shown in
Figure 10.4.20.

[E]Email | 1stc) :
-. % | = RH 1 |[j§]i5FrumAdmin
|§ admin@nobody.com | RC})—I_,

Figure 10.4.20: Linking = and isFromAdmin node

7. This completes the desired mappings.
Less Than
Symbol: <

Description: This function returns TRUE if the first input is less than the second input
value.

Input: < (Number < Number)
Output: Boolean value (TRUE/FALSE)
Example:

Consider the example of Numbers.dtd as Input Structure and Results.dtd as Output
Structure. Suppose we want that Result node of Output Structure should have the value
true if the value of Number1 node is less than the value of the Number2 node of the
Input Structure. Then,

1. Load Input Structure and Output Structure.

2. Map the Numberl and Number2 nodes of Input Structure to the Result node of
the Output Structure.

Invoke the Function Wizard by right-clicking on the Result node.
4. The Function Easel shows the existing mappings.

Place the < node on the Function Easel, as shown in Figure 10.4.21.
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6.

ﬁz] Mumberl | 1st

[;B Mumber2 | 1zt

Figure 10.4.21: Placing a node on the Function Easel

Link the outputs of the Numberl node and Number2 node to the inputs of the <
node.

Also, link the output of the < node to the input of the Result node, as shown in
Figure 10.4.22.

@Numherl 1ﬂ¢—|—)
L1 < RH1 @Result

ﬁ_;] Mumberz? 1st¢ [

Figure 10.4.22: Linking < and Result node

This completes the desired mappings.

Greater than

Symbol: >

Description: This function returns TRUE if the first input is greater than the second input

value.

Input: > (Number > Number)

Output: Boolean value (TRUE/FALSE)

Example:

Consider the example of TotalMarks.dtd as Input Structure and Result.dtd as Output
Structure. Suppose we want that the value of the PassStatus node is true if the value of
the TotalMarks node of the Input Structure is greater than a constant value 150. Then,

1.
2.

Load Input Structure and Output Structure.

Map the TotalMarks node of Input Structure to the PassStatus node of the
Output Structure.

Invoke the Function Wizard by right-clicking on the PassStatus node.
The Function Easel opens with the existing mappings.

Now place a Constant building block on the Function Easel and set its value equal
to 150, as shown in Figure 10.4.23.

|[BTutalMarks | 1st |

Eiw [f]

Figure 10.4.23: Setting the Constant building block to 150

| 1 |E§]Passﬁtatus
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8.

Place a > node on the Function Easel.

Link the outputs of TotalMarks node and Constant node to the input of the >
node.

Also, link the output of the > node to the input of the PassStatus node, as shown
in Figure 10.4.24.

@ TotalMarks 1st#)—|_’
% % = Rc#)—)- 1 EﬂPassStatus
B 150 |r ¢—|_,

Figure 10.4.24: Linking the > and PassStatus node

This completes the desired mappings.

Greater than or Equal function

Function: >=

Input: >= (Number >= Number)

Description: True if the first input is greater than or equal to the second input.
Output: True/False

Example:

Consider the example of TotalMarks.dtd as Input Structure and Result.dtd as Output
Structure. Suppose we want that the value of the PassStatus node as true if the value of
the TotalMarks node of the Input Structure is greater than or equal to a constant value

150. Then,
1. Load Input Structure and Output Structure.
2. Map the TotalMarks node of Input Structure to the PassStatus node of the
Output Structure.
3. Invoke the Function Wizard by right-clicking on the PassStatus node.
4. The Function Easel opens with the existing mappings.
Now place a Constant building block on the Function Easel and set its value equal
to 150, as shown in Figure 10.4.25.
Ez] TotalMarks | 1=t
il @PassEtatus
& 150 | R
Figure 10.4.25: Setting the Constant building block to 150
5. Place a >= node on the Function Easel.
6. Link the outputs of TotalMarks node and Constant node to the input of the >=

node.

Also, link the output of the >= node to the input of the PassStatus node, as
shown in Figure 10.4.26.
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EijutalMarks 1stc#)—|_). -
L1 ==
& 150 [ :JT)_l_" il %)—,

Figure 10.4.26: Linking the >= and PassStatus nodes

L 1 @Passﬁtatus

7. This completes the desired mappings.
OR
Symbol: OR

Description: This function accepts two boolean expressions as arguments and performs
logical disjunction on them. If either expression evaluates to TRUE, the function returns
TRUE. If neither expression evaluates to True, the function returns FALSE.

Input: OR ( boolean OR boolean )
Output: Boolean value (TRUE/FALSE)
Example:

Consider the example of Chat.dtd as Input Structure and Valid.dtdas Output Structure.
Suppose we want to receive mails that are sent either from the address
admin@nobody.com or aryton@nobody.com that is, we want that the isValid node of the
Output Structure takes the value true if the Email node of the Input Structure has the
value admin@nobody.com or aryton@nobody.com. Then,

1. Load Input Structure and Output Structure.

2. Map the Email node of Input Structure to the isValid node of the Output
Structure.

3. Invoke the Function Wizard by right-clicking on the isValid node.
4. The Function Easel opens with the existing mappings.

5. Place a Constant node on the Function Easel and set its value equal to
admin@nobody.com.

Place another Constant node and set its value equal to aryton@nobody.com, as
shown in Figure 10.4.27.

(E]Email | 12t

g] admin@nobody.com R

g aryton@nobody.com F

Figure 10.4.27: Setting the Constant node value to aryton@nobody.com

Now place two = nodes on the Function Easel, and make links as shown in Figure
10.4.28.
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% admin@nobody.com H¢—|_,.. 3 % -
= - R

(E]Email 1ﬁ¢—k:.21 T

Q aryton@nobody.com Rc#)—l_" =

Figure 10.4.28: Placing two = nodes on the Function Easel
6. Place a OR node on the Function Easel.
7. Link the outputs of the two = nodes to the inputs of the OR node.

Also, link the output of the OR node to the input of the isValid node, as shown in
Figure 10.4.29.

#| admin@nobody.com Ftt#)—._,..1 & -
E = | R

(E]Email 1gt¢>_k::j — J-I::% & or H%—)- 1 |[E]isvalid

g aryton@nobody.com | R #)—'_’ 2

Figure 10.4.29: Linking the OR and isValid nodes

8. This completes the desired mappings.
Less Than or Equal
Symbol: <=

Description: This function returns TRUE if the first input is less than or equal to the
second input.

Input: <= (Number <= Number)
Output: Boolean value (TRUE/FALSE)
Example:

Consider the example of Numbers.dtd as Input Structure and Results.dtd as Output
Structure. Suppose we want that the Result node of Output Structure to have the value
true if the value of Numberl node is less than or equal to the value of the Number2
node of the Input Structure. Then,

1. Load Input Structure and Output Structure.

2. Map the Numberl and Number2 nodes of Input Structure to the Result node of
the Output Structure.

Invoke the Function Wizard by right-clicking on the Result node.
4. The Function Easel shows the existing mappings.

Place the <= node on the Function Easel, as shown in Figure 10.4.30:
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Numberl | 1=t

[:f_;] Mumber2 | 1t

Figure 10.4.30: Placing <= node on the Function Easel

5. Link the outputs of the Numberl node and Number2 node to the inputs of the
<= node.

Also, link the output of the <= node to the input of the Result node, as shown in
Figure 10.4.31:

(E]Numberl | 1st

i}% B <= Rc_l[)—)-- 1 @Result

Figure 10.4.31: Linking outputs of the Numberl and Number2 nodes

Esj Mumber2 | 1st

6. This completes the desired mappings.
NOT
Symbol: NOT

Description: This function accepts a boolean expression as the argument and performs
logical negation the expression. The result is a boolean value representing whether the
expression is FALSE. That is, if the expression is FALSE, the result of this function is TRUE.

Input: NOT (boolean)
Output: Boolean value (TRUE/FALSE)
Example:

Consider the example of Valid.dtd as Input and Output Structure. Suppose we want to
make mails from email address admin@nobody.com as invalid. That is, we want that if the
value of isFromAdmin node is true, then the value of isValid is set to false. Then,

1. Load Input Structure and Output Structure.

2. Map the isFromAdmin node of Input Structure to the isValid node of the Output
Structure.

3. Invoke the Function Wizard by right-clicking on the isValid node.
4. The Function Easel shows the existing mappings.

Now place a NOT node on the Function Easel, as shown in Figure 10.4.32.

isFromAdmin 1=t

1 | & NOT | R

Figure 10.4.32: placing a NOT node on the Function Easel
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5. Link the output of the isFromAdmin node to the input of the NOT node.

Also link the output of the NOT node to the input of the isValid node, as shown in
Figure 10.4.33.

[Elisfromadmin | 10—t 1 [ENoT | RO—3t 1 |(E]isvalid

Figure 10.4.33: Linking theNOT and isValid nodes

6. This completes the desired mappings.
Not Equal
Symbol ! =
Description: This function returns TRUE if both the inputs are not equal.
Input != (Object = Object)
Output: Boolean value (TRUE/FALSE)
Example:

Consider the example of Chat.dtd as Input Structure and Valid.dtd as Output Structure.
Suppose we want to filter out mails that do not have a message body. That is, we want
that the isMessageExist node of the Output Structure takes the value true if the length of
the Message node of the Input Structure is not equal to zero. Then,

1. Load Input Structure and Output Structure.

2. Map the Message node of Input Structure to the isMessageExist node of the
Output Structure.

3. Invoke the Function Wizard by Right-clicking on the isMessageExist node.
4. The Function Easel opens with the existing mappings.

5. Now place a Constant building block on the Function Easel and set its value equal
to 0.

6. Place a Length node on the Function Easel.

Link the output of the Message node to the input of the Length node, as shown
in Figure 10.4.34.

|@ Message | 1st | | str | % Length

B0 [7]

Figure 10.4.34: Linking the Message and Length nodes

num |
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7. Place a != node on the Function Easel.

8. Link the outputs of the Length node and Constant node to the inputs of the =
node.

Also, link the output of the = node to the input of the isMessageExist node, as
shown in Figure 10.4.35.

|[f_|'§] Message | '1st¢)—)+ =tr |é| Length I r-am.cj.\.].

c _)} B |£JisMessageEHist

EZlo | rRop—A
Figure 10.4.35: Linking the '=and isMessageExist nodes
9. This completes the desired mappings.
IsNumber
Symbol: IsNumber
Description: This function returns TRUE if the input value is a number.
Input: Any value

Output: Boolean value (TRUE/FALSE)

10.4.1.10 Lookup functions

The functions in this category are used to perform the lookup of keyvalue pairs in a
database and return the result in sorted fashion.

10.4.1.10.1 Lookup with Default Connection Details
DB

Description: This function accepts a table name, keyvalue pairs and column names as
arguments and does the lookup in the database and returns the result in sorted form.

Input: Table name, Key value pairs, Columns names.
Output: String containing the lookup result in sorted order.

Points to note

1. DBLookup fetches the entries from a table and stores them in local cache the first
time and it uses this cache to perform lookups for subsequent requests. This cache
will not be updated at runtime again. Therefore it should preferably be used only
for tables which are not updated once populated, that is for static data.

2. Lookup functions take key columns name value pairs as
<columnl>=<valuel>,<column2>=<value2> etc.

For Example: dvSendDept=100, dvSendCode=BLK

3. Lookup functions can return the values of multiple columns. To get multiple
columns, use the format <column3>,<column4>.
For Example: dvValueDA, dvDescription

4. Dates are expected in MM/dd/yyyy HH:mm:ss format
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Make sure the input value match the column length defined in the database. For
example, if the dvSendCode is defined as char(10) in the database, the input value
should be BLK followed by seven spaces.

Note: Spaces are not required if you are using MSSQL 2005.

Prerequisites

1.

Add required database drivers in the eMapper classpath.

For example, if the lookup tables are in HSQL, include the path of hsqldb.jar in
Test Classpath table in the Mapper Preferences page in eStudio. (Ref Section
12.2 in eStudio User Guide)

To use this function in the eMapper tool, a system property -
Dmapper.lookup.dbconfig has to be defined in
%FIORANO_HOME%/eStudio/eStudio.ini file and it should point to the path
of db.properties file which contains the url, driverName, user and password.
Sample db properties file is shown below which contains the data for oracle data
base.

#OE PORPS

#5at Jun 03 1%:26:33 15T 2006
url=jdhc:ioracle:thin:@192.168.2 .92:1521:fiorano
driverName=oracle.jdbe.driver . .OraclelDriver
user=scott

prassword=tiger

Figure 10.4.36: Sample db properties file

For use in Route transformations, mapper.lookup.dbconfig property has to be
set in {FIORANOHOME}/fps/bin/fps.conf.

For use in XSLT component, mapper.lookup.dbconfig property has to be
included in JVM_PARAMS
For example: -Dmapper.lookup.dbconfig=<path of db.properties>

10.4.1.10.2 Lookup with Connection Details

DB

Description: This function accepts a table name, keyvalue pairs, column names, url,
driver name, user name and password as arguments and does the lookup in the database
and returns the result in sorted form.

Input: Table name, Key value pairs, Columns names, URL, driver name, user name and
password.

Output: String containing the lookup result in sorted order.

Points to note

1.

DBLookup fetches the entries from a table and stores them in local cache the first
time and it uses this cache to perform lookups for subsequent requests. This cache
will not be updated at runtime again. Therefore it should preferably be used only
for tables which are not updated once populated, that is for static data.

Lookup functions take key columns name value pairs as
<columnl>=<valuel>,<column2>=<value2> etc.

For example, dvSendDept=100, dvSendCode=BLK
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Lookup functions can return value of multiple columns. To get multiple columns,
use the format <column3>,<column4>.

For example, dvValueDA, dvDescription
Dates are expected in MM/dd/yyyy HH:mm:ss format

4. Make sure the input value match the column length defined in the database. For
example, if the dvSendCode is defined as char(10) in the database,
the input value should be BLK followed by 7 spaces.

Prerequisites
1. Add required database drivers in the eMapper classpath.

For example, if the lookup tables are in HSQL, include the path of hsqldb.jar in
Test Classpath table in the Mapper Preferences page in eStudio.

10.4.1.11 JMS Message Functions

The various functions in this category extract specific information from a JMS Message and

output to the same. The input for these functions is a JMS Message. The following are the
available JMS Message Functions:

= Byte Content
= Text Content
= Header

= Attachment
10.4.1.11.1 Byte Content
Function: Byte Content
Description: The Byte Content function returns the byte content of a Fiorano document.
Output: Base64 encoded string value
10.4.1.11.2 Text Content
Function: Text Content

Description: The Text Content function returns content which is in text format from a
Fiorano document.

Output: String value
10.4.1.11.3 Header
Function: Header

Description: The Header function returns the value of the name that is passed as a
property to the function.

Output: String value
10.4.1.11.4 Attachment

Function: Attachment
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Description: The Attachment function returns any attachments attached to a Fiorano
document. The name of the attachment needs to be passed as a property to the function.

Output: Base64 encoded string value

10.4.1.12 User Defined functions
The various functions in this category are user defined and perform various functionalities.
The following User Defined functions are available:

= dateConversion

= compute

= nextMillenium

= replace
10.4.1.12.1 myExt:dateConversion
Description: Converts the date from one format to the other. For example, date can be

converted from MM-dd-yyyy to dd-MM-yy function convertDate (dateString, inFormat,
outFormat)

Field Full Form Short Form

Year yyyy (4 digits) vy (2 digits), y (2 or 4 digits)

Month MMM (name or abbr.) MM (2 digits), M (1 or 2 digits)
NNN (abbr.)

Day of Month dd (2 digits) d (1 or 2 digits)

Day of Week EE (name) E (abbr)

Hour (1-12) hh (2 digits) h (1 or 2 digits)

Hour (0-23) HH (2 digits) H (1 or 2 digits)

Hour (0-11) KK (2 digits) K (1 or 2 digits)

Hour (1-24) kk (2 digits) k (1 or 2 digits)

Minute mm (2 digits) m (1 or 2 digits)

Second ss (2 digits) s (1 or 2 digits)

AM/PM a

Input: Accepts three arguments. The first argument is the date passed as a string to the
function. The second argument is the input format and the third argument is the required
output format for the date.

Output: The date string

Examples:

MMM d, y matches: January 01, 2000, bec 1, 1900, Nov 20, 00
M/d/yy matches: 01/20/00, 9/2/00
MMM dd, yyyy hh:mm:ssa matches: January 01, 2000 12:30:45AM
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10.4.1.12.2 myExt: replace

Description: This user-defined function replaces parts of a string that match a regular
expression with another string.

string regexp:replace(string, string, string, string)

Input: The function accepts four arguments. The first argument is the string to be
matched and replaced. The second argument is a regular expression that follows the
Javascript regular expression syntax. The fourth argument is the string to replace the
matched parts of the string.

The third argument is a string consisting of character flags to be used by the match. If a
character is present then that flag is true. The flags are:

e g: global replace - all occurrences of the regular expression in the string are
replaced. If this character is not present, then only the first occurrence of the
regular expression is replaced.

e i: case insensitive - the regular expression is treated as case insensitive. If this
character is not present, then the regular expression is case sensitive.

Output: String

10.4.1.12.3 myExt:compute

Description: This user-defined function can be used to compute all mathematical
operations such as Addition, Subtraction, Multiplication and division of numbers. The
function does not compute mathematical operations such as cos, sin, etc.

Input: A valid javascript expression

Output: A nhumber

10.4.1.12.4 myExt: nextMillenium

Description: This user-defined function returns the number of days in the next millenium.

Input: There is no input for this function

Output: Number

10.5 Creating Mappings

Mappings are defined between nodes of the Input and Output structures. The Structure is
displayed in a tree form.

10.5.1 Understanding Types of Nodes
Mappings are defined between nodes of the Input and Output structures. These nodes can
be divided into four types:

1. Element Node: This type of node contains an XML element.

2. Text Node: This type of node contains an XML element only.

3. Attribute Node: This type of node contains an attribute of the XML element that
contains it.
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4. Control Node: The control node is a pseudo node that depicts the cardinality of
the elements in an XML structure. The Control node is displayed in red color and is
surrounded by square brackets.

The control node serves as a useful indicator while creating mappings between the Input
and Output Structures. For example, an Output structure node that has a cardinality of one
or more requires that at least one element should be added to that XML structure.

Control Node[ZERO-MANY]: This Control node specifies that zero to many occurrences
of a node can exist in its parent node. For example, in Figure 10.5.1 the Mail-List element
can contain zero or many Mail nodes.

B &+ - %

= <R Oukpukl

From
ko
[&] Body
= =1 [OME MANY]
[B] attachrment

Figure 10.5.1: Example of Zero to Many control node

Control Node [ONE-MANY]: This Control node specifies that one to many occurrences of
a node can exist in its parent node. For example, in Figure 10.5.2 the Mail node can
contain one or many occurrences of the Attachment node.

B & - X%

= <R Oukpukl
= [B] Mail-List

= [E] Mail
From
ko
[2] Body

2-15=1 [omE Many]
[2] Attachment

Figure 10.5.2: Example of One to Many control node

Control Node [Choice]: This Control node specifies that only one of the descendant
nodes can exist in the parent node. For example in Figure 10.5.3 TifosiService node can
have either Java node or Win32 node, but not both.
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B +~ %

= <F» Qutput2
= [g] TifosiService
el GuD
[€] DisplayName
= 0R [Choice]
[5] Java

[8] win32

Figure 10.5.3: Example of Choice Control Node

A structure can also contain optional nodes. This type of node specifies that either zero or
one occurrence of this node can exist in its parent node. For examples, in Figure 10.5.4,
Student node can have either zero or one occurrence of the Nick-Name node. An Optional
node (element/attribute) is displayed in green color.

B &= - X%
SIRG Ouiput1

= [8] STUDENT

id
= =0 [ZERD MANY]
= [&] ins
[E] STHO
[E] STNAME
(€] AREA
[&] mick-Mame

Figure 10.5.4: Example of Optional Node

10.5.2 Types of Mappings

Mappings from an Input Structure node to an Output Structure node can be singular or
iterative. Singular mappings, known as Name-to-Name mappings in Fiorano SOA Platform,
create only one output element from the first instance of the mapped element in the Input
Structure.

On the other hand, iterative mappings, known as For-Each mappings in Fiorano SOA
Platform, iterate through all instances of the mapped Input Structure element and create
corresponding Output Structure elements.

For Input Structure nodes that contain only single instances of child elements, only Name-
to-Name mappings can be defined.

10.5.2.1 Name-to-Name Mapping

Now create mapping from Name-to-Name, as shown in Figure 10.5.6.
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=l ProductDema.fnap &2

B - x B &+-x
= <F> Inputl = <R» Qukput]
=~ [€] order =[] order
= »=0 [ZERG MANY] =0 [ZERD MANY]
= [€] ManuFacturer = (€] Produck
@ name (@ name
= »=0 [ZERC MANY] [8] ManuFacturer
= [E] Product ———— [E] Discountrrice
name
[E] Cost
[€] piscount

2l2 Map View | [Z) MetaData

Figure 10.5.6: Name-to-name Mapping

The Funclet Wizard shows a link starting from the output of the name input node to name
output node. The Name-to-Name mapping defines how elements and attributes in the
Input Structure map on to elements and attributes in the Output Structure. A Name-to-
Name mapping on its own (without a For-Each mapping context) creates a single instance
of the mapped Input Structure node to the Output Structure.

If the Name-to-Name mapping exists within a For-Each mapping context and there are
multiple elements and attributes in the Input Structure then each of those elements and
attributes is mapped on to an Output Structure node.

10.5.2.2 For-Each Mapping

When an Input Structure node can have multiple instances and the user wants to define a
mapping for each one of them, then For-Each mapping should be used. A necessary
condition for this type of mapping is that the Output Structure node to which For-Each
Mapping is being defined should be of[ZERO-MANY] or [ONE-MANY] cardinality. Figure 10.5.7
shows an instance of a For-Each mapping.
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=l ProductDema.fmap 532

B +-x H +-x
= <F* Inpukl = <R Qutputl
= [&] order = [] order
= =0 [ZERD MANY] 320 [ZERO MAKY]
= [8] Manufacturer = [&] Product
name name
=l »=0 [ZERG MANY] [8] Manufacturer
= [E] DiscountPrice
@ name —————
[&] cost ———8
[€] Discaunt

=lz: Map View | %, MetaData

Figure 10.5.7: For-Each Mapping

This mapping specifies that for each Product element in the input XML, the output XML
contains a Product element. For-Each mapping can be applied only to [ZERO-MANY] or [ONE-
MANY] control nodes in the Output Structure.

To create a For-each mapping in the Funclet Wizard, you need to link the Loop output label
of the Input Structure node to a [ZERO MANY] or [ONE-MANY] control node in the Output
Structure. These control nodes signify the cardinality of contained elements and attributes.

All value mappings for the attributes and child elements of a [ZERO MANY] or [ONE-MANY]
node with For-Each mapping are carried out within the For-Each context.

So, in Figure 10.5.7 the mapping defined creates multiple instances of the Product element
from the Product elements in the Input Structure. The Output element, Product, is created
as per the mappings defined for its attributes and child elements by the respective Name-

to-Name mappings.

10.5.3 Duplicating a For-Each Mapping

There may be situations in which one may want to specify different input values for
different iterations of a For-Each loop. This can be accomplished by duplicating a [zero
Many] or [One Many] control node in the output structure.

The following example illustrates this situation. A Student DTD has two types of child
elements: male and female. These need to be mapped to the student element in the
output structure DTD, as shown in Figure 10.5.8.
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sl-3 Duplicates frnap 52 =8
. a8 1Duplicates,l'DupIicates.Fmapi . g v K
= <_R> Inputl = <_R> Qukpukl
= @ schiool = @ school
= >=1 [ONE MANY] —— 0 = 1R
LR @ male = @ skudent
5 - [B] name v [E] name
= »=1 [ONE MANY] [&] sex
= @ female B >=1 [OME MANY]
o (8] name = @ student
+- [B] name
IEI SEX
E MMap Wiew E MetaData|
Figure 10.5.8: Mapping a node to One Many control node
The same mapping has to be defined for the female elements. To do this, drag the female
node from the input structure to the output structure. A message dialog box is displayed
as shown in Figure 10.5.9.
=8

[ ouptcaes e <Y

BEN & Fiorano Mapper

D] J Duplicate the node TOME MAMY]' ?
-

B +-x B +-x
= <R* Inputl = <R Outputl
= [€] schoal = [€] schoal
= >=1 [ONE MANY] ———51 =1 [OKE MANY]
B [E male =[] student
: ‘o [] name v [E] name
= >=1 [OME MaNY] [e] sex
= @ femalg

E Map 'v'iew‘ E MetaData |

Figure 10.5.9: A shortcut menu prompts you to duplicate the node

Click OK in the message dialog box to create a duplicate node. A mapping is created as

shown in Figure 10.5.10.
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il= #Duplicate frmp 23

B &+ X B 4+
= <F> Inputl = <R> Qutputl
< [€] school = [€] school
< =1 [ONE MANY] % »1[ONE MANY]
= [E] male . = [g] student
[E] name v [E] name
= »=1 [ONE MANY] fa—— —— [e] sex
< [&] female = =1 [ONE MANY]
[E] name = [&] student
8] name
[E] sex

tlo: Map View | %, MetaData

Figure 10.5.10: The One Many Node is Duplicated

10.5.4 Linking Nodes to Define Mappings

A Mapping is defined in the Fiorano eMapper tool by visually linking the Input Structure
nodes to the Output Structure nodes. This linking can be defined using any of the following

techniques:

1. Drag and drop the node from the Input Structure Panel to the Output Structure
Panel

2. Or, create an automatic mapping between child nodes of the selected Input
Structure node and child nodes of the selected Output Structure node

3. Or, by using the Visual Expression Builder

10.5.4.1 Using the Automatic Mapping option to Define Mappings
To create automatic mappings between the selected Input and Output Structure nodes:

Select the nodes in the Input and Output Structure whose child nodes are mapped. Click
the Child to Child option in the tool bar, as shown in Figure 10.5.11.
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& Mapper Perspective - MapperDemo/MapperDemo.fmap - Eclipse Platform

File Edit Mavigate Search Project Tools Run Window Help

- [EEler%:s-0-a-:ic S B | opper Persp- |
{Er Mapper Projects 23 child ta Child Recursively apperDema.fmap &3 =0
S H &= - x H 4 -
= 1= MapperDemo
Bpfesources B <R>Inputt B <R> Outputl
32 MapperDemo Frrap =[] Adrmissions = [E] Admissions
' = 3=0 [ZERC) MANY] B =0 [ZERD MAKY]
=[] applicant = [8] applicant
name name
[e] Age [e] Age
[E] Marks [E] Marks
=12 Map View | %] MetaData
:]-l Funclet View 2 Messages T Mapper Consale =
A
| Skring Funictions R | —
| [~ Saleck — | b
- v
i 0* @)

Figure 10.5.11: Creating Automatic Mapping between child nodes

10.5.4.2 Using the Visual Expression Builder to Define Mappings

The Visual Expression Builder (VEB) is a useful feature of the eMapper tool. It allows you
to visually link nodes and insert functions to define complex mapping expressions. As an
example, we define a mapping for the DiscountPrice output node. This node should have
a value that is generated by subtracting the value of the Discount input node from the
Cost input node. To use the VEB to define the mapping perform the following steps:

1.

& Mapper Perspective - Demo/Demo.fmap - Eclipse Platform

Select the DiscountPrice output node, the Funclet View of the eMapper Perspective
is displayed as shown in Figure 10.5.12.

‘- HE

=

& Mapper Projects 53

1= Demo
(== resources
B (= schemas
D) Tnputt OTD
(0] output1.oTD
E Demo.fmap
1= MapperDemao

o Funclet Wiew 52 3| Mess

g o> o
=g

=&~

File Edit Mavigate Search Project Tools Run  Window Help

F-0-Q- i@ [ |25 Mapper Persp... |
EMapperDemn‘fman E*Demﬂ.Fman 52 =0
B +-x% B +-x%
= <R Inputl = <F> Qukput1

& [e] order = [&] Order

B30 [ZERD Mk
= [8] Manufacturer
name
- 520 [ZERO MANY]
= [E] Product
name
[&] cost

[&] Discount

- >0 [ZERG MANY]
& [&] Manufacturer
@ name
B 920 [ZERD MAk]
= [&] Product
nanme
[&] Cost
]

=152 Map View | % MetaData

ages | (] Mapper Consals

|5tr|ng Functions

v

[ Select

Concat

E Length

m Constant

~

(3

e
[¢] Discount

)|

Chapter 10: eMapper

Page 165



Fiorano eStudio User Guide

Figure 10.5.12: Selecting the Output Node for Mapping

2. The selected Output node is automatically displayed in the Function easel, as
shown in the Figure 10.5.12. To add an input structure node to the mapping, drag
it to the Funclet easel of the Visual Expression Builder. Here, drag the Cost input
node from the Input Structure Panel to the Funclet easel. The Cost input node is
added to the Funclet easel as shown in Figure 10.5.13.

ot Funclet view &2 &-| Messages | ] Mapper Consale

String Functions v

[3; select &

] Concat
S Length

[ Constant v

Figure 10.5.13: Dragging an Input node

3. To subtract the value of Discount input node, the subtract function from the
Funclet Palette can be used. The subtract function is available in the Arithmetic
functions. To add the subtract function, first select the Arithmetic function category
from the Function palette. Click on the drop-down list in the Funclet palette. The
drop-down list is displayed in the Funclet palette, as shown in Figure 10.5.14.

4. Select Arithmetic Functions from the list. The Arithmetic functions are displayed
in the Funclet palette. Drag the subtract function from the Function palette to the
Funclet easel. The subtract function is added to the Funclet easel as shown in
Figure 10.5.15.

:]-ﬂ Funclet Yiew &2 5-| Messages | 1 Mapper Console

#Adwanced Functions v

Advanced Functions -
rikhmetic Funckions

Boolean Functions
Control Functions

Conversion Funchions bt
Dreep-Copy
J Position v

Figure 10.5.14: Selecting the Arithmetic Function Category in the Funclet palette

oH Funclet view &1 2| Messages | ] Mapper Console

Arithmetic Funckions w
[ Select “ % [¢] Discount
+
J riun 1 J‘ b
J' numz
| div v

Figure 10.5.15: Adding the Subtract function
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5. Next, add the Discount input node to the Funclet easel.

:]-D Funclet Yiew &3 2-| Messages | (] Mapper Console

Arithmetic Functions w
I+ Ezm; El- [pum % [¢] Discount
J'
e .

Figure 10.5.16: Adding another input node

6. To define a mapping, links should be defined between these nodes. The Discount
output is the difference between the Cost and Discount input nodes. To achieve
this, the Cost and Discount nodes should be connected to the input pins (hum1,
num?2 respectively) of the subtract function and its output pin should be connected
to the input pin of the Discount output node.

:]-D Funclet view &5 2-| Messages | [ Mapper Consale

Arithmetic Functions w
J+ J— nurr%)—'_.H | | Discount
J B 2
= :

Figure 10.5.17: The final mapping is defined

7. The required mapping is defined as shown in Figure 10.5.17.

10.5.5 Mapping XML Formats
Mapping one XML format to another is a common requirement. The steps for mapping
XML, formats to each other are as follows:

1. Load the XML, DTD, or XSD input structure or structures.

2. Load the XML, DTD, or XSD output structure.

3. Link the Input XML Structure node(s) to the Output XML Structure node.

The following restrictions and conditions apply when mapping one XML format to another:

Nodes that do not have any content cannot be mapped. However, the child nodes of these
nodes can be mapped provided they can contain content.

The SQL and advanced function categories are not available for XML to XML mapping

10.6 Adding User XSLT

eMapper also allows the user to customize the output of the transformation by adding
custom xslt code to the generated XSLT. XSLT code snippets can be added before and
after the beginning tag<> of an element and before and after the end tag </> of an
element in the XSLT. By enabling this, eMapper allows further refinement on the auto-
generated output.
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As an example, consider a case where the eMapper generates an output that contains
elements not required by the user. In this example, the eMapper generates an output
which contains elements that is not mapped. The mapping has an output structure in
which the parent element is not mapped but the child elements are mapped, Fiorano
eMapper does not generate the 1if conditions around this unmapped parent element as a
result of which this element is generated in the output.

To avoid the generation of unmapped elements in the output, there should be an if
condition around <unmapped> element in XSLT whose condition is OR of both the child
nodes' if conditions.

Under such conditions, the User XSL feature can be used to customize the output and
avoid the generation of unmapped tags. To provide a user defined xsl

Right-click the <unmapped element> in the output structure and select the User XSL
option from the shortcut menu as shown in Figure 10.6.1.

B - %
= <F> Qukputl

= [€] Admissions
———f =0 [ZERD MANY]
ERC -ppiicanty
name £ Edit Struckure
(8] Age | = Add Structure »

[&] Mark ¥ Delete Structure

M Test x5l

2 Clear Child Maps
+| Expand Al
—| Collapse all

Figure 10.6.1: Selecting the User XSL option from the context menu
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1. A dialog box appears which contains the xslt script. The xslt script displayed in this
dialog box is partially editable. The editable regions, as shown in Figure 10.6.2, are
marked by comments </--User code starts here--> and </--User code ends here--
> at the beginning and ending respectively.

& User XSL for Applicant @

< Lisgr cole starts here —> -

<f-- Liser cadke ends here -

=hpplicant»
<f-- Liser code starts here -2

_ \A Editable
" Regions

<t Liser code endls heve -

<xsliatbribuke name="name">
«xslvalue-of select="./@name"> < xslvalus-of =
«[wslattribute >
<Marks>
«slvalue-of select=",/Marks"> <[xslvalus-of =
«Marks>
<t Liser code Ftarts here >

v
< 3

Clear User XSL] I 0K I [ Cancel

Figure 10.6.2: Editing the user xsl
As shown in Figure 10.6.2, XSL snippets can be added in the following four places:
e just above <element>
¢ just below <element>
e just above </element>
e just below </element>
2. Add the required if code snippet in these regions.

3. Click the OK button and the User XSL is saved for the element. It is denoted by
the E‘ icon next to the element/node in the structure as shown in Figure 10.6.3.

©e] Applicant

Figure 10.6.3: Node with User XSL defined

4. The XSL can be tested it using Test option as described in the section 10.9 Testing
the Transformation

10.7 Working with derived types
When a complex type in an output/input structure has derived types, either by extension
or restriction, the user can choose a derived type and the mappings can be defined using

elements of selected derived type.

This is explained with an example. Screenshot of the sample schema used is shown below.
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<?xml wersion="1.8"7>
<xsd:schema xmlns:xsd="http://www.w3.org/2001/XMLSchema”
targetNomespace="http://www.books.org"
xmlns="http://www.books.org"
elementFormDefault="qualified">
<xs5d:complexType name="Publication"»
<xsd:sequences
<xsd:element name="Title" type="xsd:string"/>
<xsd:element name="Author" type="xsd:string"/>
<xsd:element name="Date" type="xsd:gYear"/>
</xsd:sequences>
</xsd:complexType>
<xsd:element name="SamplePublication" type="Publication"/>
<xsd:complexType name="BookPublicaticn">
<xsd:complexContent>
<xsd:extension base="Publication” >
<xsd:sequences
<xsd:element nome="ISBN" type="xsd:string"/>
<xsd:element nome="Publisher"” type="xsd:string"/>
</%sd: sequences>
</usd:extension=
</%s5d: complexContents
</%sd: complexType>
<xsd:complexType name= "PaperPublication™>
ﬁxsd:complexContentﬂ
<xsd:restriction base="Publication"»
<xs5d:sequence>
<xsd:element name="Date" type="xsd:gYear"/>
<xsd:element name="Location" type="xsd:string"/>
</xsd:sequence>
</xsd:restriction>
</xsd: complexContents
</xsd: complexType>
</%5d:schema>

Figure 10.7.1: Schema with derived types

The schema provided in Figure 10.7.1 contains an element SamplePublication of type
Publication. The type Publication has two derived types: BookPublication(extension)

and PaperPublication(restriction).

When the schema is loaded in Mapper, the element SamplePublication is shown in Mapper.

L restimp 5

B - %

¥ “F* Inputl
v [&] SamplePublication
(e] Title
(2] Author
(2] Date

Figure 10.7.2: Sample Publication with default type

Since the type Publication has derived types, user can change the type of the element

SamplePublication. All the derived types will be shown when Right-clicked on the

SamplePublication element and the user can select the required derived type as shown in

Figure 10.7.3.
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i testimp 3 |

B 4+-x
v <R Inputl
samplePublica =
vE IErIn:;eu ! % Edit Structure

[E] Author < Add Structure >
[e] pare ¥ Delete Structure

) uokPuincation
%z Clear Child Maps PaperPublication
Expand All Publication

| Collapse All r!
T ———————————

Figure 10.7.3: Available derived types

1t Types

When a different type is selected, the structure will be refreshed to show the selected type.

i estimp 53

B - X

¥ <R Inputl
¥ (2] samplePublication
(€] Title
[2] Author
[2] pate
(€] 15BN
[5] publisher

Figure 10.7.1: SamplePublication element when BookPublication type is chosen

Mappings can be defined assuming that the element SamplePublication is of type
BookPublication.

Note: When derived types are used, the input/output must comply with the type used.

10.8 Create/Edit User Defined Function(s)
Custom Functions can be added to the User Defined Functions category of the Function
Palette. Functions can be created by performing the following steps.

e Go to Tools menu in the eMapper perspective and click Create/Edit User Defined
Function(s). The Extensions Dialog is shown as shown in the Figure 10.8.1.
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& Extensions Dialog E

Defined Extensions

vk
skrings

Extension Mame | myexk |

[ Ok, H Cancel ]

Figure 10.8.1 Extensions Dialog
e This dialog has a list of all extensions that are defined.

e To create a new extension, type the name of the extension to be created in the
text area provided in this dialog and click OK.

e To edit one of the existing extension, click on the extension and then press OK.

e The Script Function Wizard will appear as shown in Figure 10.8.2. The wizard
has two pages viz Script Information Page and Function Page.

Chapter 10: eMapper Page 172



Fiorano eStudio User Guide

Script Information Page:

e Extensions can be defined either in Javascript or Java language. The language of
the extension being added can be specified from the Language combo present in
the Script Information Page

e The Javascript or the qualified name of the Java class, depending on the language
of the extension, needs to be provided in this page.

e To add Javascript functions, provide the Javascript and click Next. The script will
be processed and the list of functions will be populated in the Function Page.

e To add Java Functions, provide the qualified name of the Java class and click Next.

The list in the Function Page will be populated with all the public static functions
defined in this class.

& New Script Function |Z|@ @

Script Information

Specify the script containing definition{s) of extension functionsi{s)

Script Infarmation

Mame | myext Language |javascript %

i ripk

[include jar to classpath

Twpe in the script here

function computelexpr i
return evaliexpr);

Script

Function nextMillenium(){
d=new Date() [/today's date
mill=new Date(3000, 00, 01, 00, 00, 00 ffMext millennium start date
diff = mill-d  }/difference in milliseconds
mkg = new String(diff/36400000)  /calculate davs and convert: bo string
point=mtg.indexOf"."y  }/find the decimal point
days=mtq. substring(0,point)  ffget just the whole days
return "There are only " + days + " days remaining to the start of the next millennium,";

+

function replacefinput, pattern, flags, str}d
return input. replace(new RegExpipattern, flags), str);

2) [ Mext = ” Finish H Cancel

Figure 10.8.2 Script Information Page

Function Page:

e The Function Page shows the list of functions that were defined in the Script
Information Page. The user can select the desired functions and the selected

functions will be added to the Function palette under the User Defined Functions
category.
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Function List

Select the function that needs ta appear in Function pallette

Function Type
= compute String
Expr Skring
[ nextMillenium Skring
= replace String
inpuk String
pattern Skring
flags Skring

skr String v

®@ Mext = I Finish H Cancel

Figure 10.8.3 Function Page

Note: While adding Java functions, the user has to add a .jar file containing the class
defining the functions to the classpath in order to fetch the list of functions. This can be
done through the Include jar to classpath option provided in the Script Information Page.
Click the browse button and add the required jar file. Alternatively, the user can also add
the jar to the mapper classpath by adding its path in Test Classpath table in the Mapper
preferences page. (Details in Chapter 12).

& New Script Function

Script Information

Specify the script containing definition(s) of extension functions(s)

Script Infarmation

Mame |sampleJavaExt Language

Include jar to classpath

Select jar file "%

Type in the fully classified class here

com.fiorano, ext, SampleExtension

@ < Back [ Mext > ] [ Finish l [ Cancel

Figure 10.8.4 Adding Jar to classpath
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10.9 Testing the Transformation

The transformation created in a eMapper project can be tested by performing the following
steps:

Click Tools > Test Mapping in the Fiorano eMapper's menu bar, as shown in Figure 10.9.1
or click the Test button in the tool bar

& Mapper Perspective - MapperDemo/MapperDemo.fmap - Eclipse Platfq
Toals

File Edit Mawigate Search Project Fun  Window Help

- ] c8_m g8 - | 5] ®5LT Properties
L === = |
: - ¥ yalidate Mappings
{EF Mapper Projects &5 =l
2122 Demo Test Mapping
== resources 8}‘; Create/Edit User Defined Functionis)

_ - T — EEr

Figure 10.9.1: Invoking the Test option

The Test XSL wizard is displayed, as shown in Figure 10.9.2. The Transformation can be
tested by following these steps:

Providing MetaData

e This wizard has two pages, the MetaData page and the Test Mappings
page.

e The output structure for which the transformation is being tested can be
chosen from the combo provided at the top of the MetaData page.

e The text area, by default shows the transformation generated
automatically by the eMapper for the specified output structure. This
transformation can also be modified by deselecting the Always Load
From eMapper button.

e This allows the user to modify the XSL. Specify the XSL and move to the
next page to perform the transformation.

Input XMLs

e The Test Mappings page has two tabs, Input XML tab and Output XML
tab.

e The Input XML tab, as the name suggests, is used to provide the input
XMLs. This tab in turn has sub tabs for each input structure loaded in the
eMapper.

e A sample XML can be generated from the corresponding structure by
clicking the Generate Sample XML button present in the tool bar of an
input tab.
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&= Test XSL

MetaData

Yalidation Successful

Select Gutput Structure: | Qubputl w

Blways load from Mapper

<7l version="1.0" encq
<ushistyleshest version=15 o e "walan java lxslt"
extension-element-prefixes="datetima set math dateConversion myesxt skrings”

wrnins:datetime="http: [/ewxslt, org/dates-and-times" xmins:set="http: exsk, org/sets"
srnins:math="http: f/exslt.orgimath” xmins:kxslk="http:f«ml, apache. orgyxsik”
wrnins:xalan="http:\=ml.apache.orgfxslt" xmins:dateConversion="gxt1" xmins:myext="gxz"
wrins:strings="ext3" =
<wshioutput method="xml" indent="ves" encoding="UTF-8" xalan:indent-amount="2"
armit-xmi-declaration="no"=</x«sl: output =
<wslivariable name="document" select="/"=«<xsl:variable =
<wshitemplate match="">
“0rder =
<wshifor-each select="0Order/ManufactureriProduct” =
ZProduct =
sl athribute name="nams">
“xglivalus-of select=", /@name" = </xslvalue-of =
fxsliatkribuke =
ZManufacturer =
“uglivalug-of select=",/, /@name" = <fxslvalue-of =
<iManufacturer =
<DiscountPrice =
<xslivalue-of select="concaticoncak(, jCost,'@", fDiscount)" = <fxsl value-of =
</DiscountPrice =
<[Product >
= fuslifor-each>
<IOrder =
«xslibemplate=
= fusliskyleshest =

sl esl="http: [ fww, w3 orgf 1999)0%50 Transfarm” xminsjava="http:/fxml. apache. org/xslt fjava"

X Mext = ] [ Close

Figure 10.9.2: Metadata Page

¢ The Generate Sample XML dialog box is displayed, as shown in Figure 10.9.3.
The default values are appropriate in most situations. Provide the desired values

and click OK to generate a sample XML.

& Generate Sample XML E

Root Element Srder

Generate Optional elements | always w

Generate Optional atkributes | always L
Mo. of repeatable elements to be generated

min |3

4k

M3

L
4

Fill elements and atkributes with data

O [ Cancel ]

Figure 10.9.3: Selecting the sample Input XML generation options

The sample XML is generated in the Input XML tab as shown in Figure 10.9.4.
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&= Test XSL

Test Mappings

Inpuk %ML | output #ML

CED,
B ‘( !GNI:1
<23l verTF-B"? = ~
<Order >
<Manufacturer name="nams1">
ZProduct name="name1">
< Cost=Castl </ Cost >
«Discount =Discount1 </Discount =
«/Product =
ZProduct name="namez">
< Cost=Cast2 =/ Cost >
< Discount =Discount? </Discount =
«/Product =
ZProduct name="name3">
< Cost=Cast3</Cost >
< Discount =Discount3 </Discount =
«/Product =
< [Manufackurer =
<Manufacturer name="nams2">
ZProduct name="name4" =
< Cosk=Castd =/ Cost >
< Discount =Discounts </ Discount =
«/Product =
ZProduct name="names" >
< Cost=CastS=/Cost >
< Discount =Discounts </ Discount =
«/Product = Z

D ek moarna—"marns s -

Inputl |Parameters | System Properties

[IFilker Mamespaces | Apphy Transformation

Figure 10.9.4: A Sample Input XML

e Options to load input XML from a file and validate the input XML are provided in
the tool bar. Validation errors if any will be displayed at the top of the wizard.

e The Input XML tab also contains a Parameters tab that can be used to define
parameters to be used while transformation. The required parameters can be
added to the table provided in this tab.

e System Properties, if needed, can be defined from the System Properties tab.
For example, while using Lookup Functions, a system property needs to defined
pointing to the db.properties file which holds data for oracle data base
Testing the transformation
e Click the Apply Transformations button to test the defined transformation.

e The output XML is displayed in the Output XML tab, as shown in Figure 10.9.5.
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€ Test XSL =13

Test Mappings

Transformation successful

Input XML | Output ML |

<7eml version="1,0" encoding="UTF-&"7 >
<0rder =
<Product name="name1"=>
<Manufacturer =namel </Manufacturer =
<hiscountPrice =Cost 1@Discount 1 < DiscountPrice =
«</Product >
ZProduct name="namez"=
<Manufacturer =namel <fManufacturer =
<DiscountPrice =Cost2@Discount 2 < DiscountPrice =
«</Product >
«Product name="name3">
<Manufacturer =namel </Manuf ackurer =
<DiscountPrice =Cost3@Discount 3 < fDiscountPrice =
</Product >
«Product name="name4">
<Manufackturer =namez </Manuf acturer =
<DiscountPrice =Cost4@Discount4 < DiscountPrice =
</Product >

Transformed
Output

|Ualidati0n of Input ¥MLs has completed with errors. Please refer Mapper Console For details. |

‘ Error Message .

[CIFilker Mamespaces | Apply TransFormation

Figure 10.8.5: The Output XML resulting from the Transformation

10.10 Managing Mappings

Creating mappings is as simple as dragging an input node and dropping it on a target
structure node. The eMapper also provides few other options to manage mappings.

10.10.1 Exporting eMapper Project

To export the eMapper project, right-click on the project node and select Export. Select

the destination file and the project will be exported as an archive.

10.10.2 Importing Project from the File

A eMapper project an be imported either from an existing .tmf file or from another
eMapper project.

To import the project from an existing project:

1.

Right-click on the Mapper Projects node and choose Import. The Import wizard

is shown.

Choose the zip file from which the projects are to be imported. The Import wizard
is opened with a list of all available projectsChoose the required projects and click

Finish to import the projects.

To import mappings from a .tmf file:

1.
2.

Right click on Mapper projects node and click New

In the New eMapper Project wizard, provide a valid project name and select the

Load from tmf file option.
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3. Load the tmf file using the browse button provided and click Finish.

4. The new eMapper project with the Mappings from the provided .tmf is created in
the workspace.
10.10.3 Copying functions in a Mapping

You can copy functions within a mapping project and across mapping projects. To copy a
function

Select the function in the funclet view and click Copy from the right-click menu as shown
below in Figure 10.10.1.

:]-l Funclet Yiew &5 5-| Messages | ] Mapper Console =0
Arithmetic Functions v
A
% Select 15t | (2] Applicant [Laog: o
+
JSDI‘" Lo
= ° o] Marks :]* Clear Funclet »=0 [ZERD MANY]
oo o

E ® ¥ Delete

e~
Flaoor (2) Help
=T b

Figure 10.10.1: Copying a function

Click Paste and the function is pasted in the funclet view and can be reused within or even
across mappings.

10.10.4 Clearing All Mappings

To clear all the mappings between the Input and the Output Structure,
1. Right-click on the line panel and select Clear Mappings.

2. A warning dialog box is displayed showing a confirmation message. Click Yes to
remove all the existing mappings between the input and output structures.

10.10.5 Managing XSLT Properties
You can also manage the XSLT properties of the output XSLT. To do this:

Click Tools> XSLT Properties. The XSLT Properties dialog box is displayed as shown in
Figure 10.10.2.
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_E] XSLT Properties ﬁ

XSLT Engine |Xalan | XSLT Encoding UTF-8 - Include DTD

<xshoutput> attributes
Output Method |unspecified ¥ | V] indent
Output Encoding UTF-8 - Omit XML declarations

Create empty tags for unmapped cutput elements

Suppress Optional empty Items

Add xsittype attributes to elements

Result prefixes to be excluded (space separated)

Suppress Pattern

MNamespace Prefixes

Prefix

URI

Add | | Remove | | fetch

[ 0K ] | Cancel |

=

Figure 10.10.2: Viewing XSLT Properties

This dialog box contains the following components:

1.
2.

XSLT Version: The XSLT version [1.0 / 2.0] to be used while generating the XSL.

XSLT Engine: The XSLT Transformation Engine to be used for performing the
transformation. The available implementations are Xalan, Saxon and XSLTC

XSLT Encoding: Specifies the encoding of the generated XSL.

Include DTD: Select this option to include the internal specified DTD in the
transformation output. This option is disabled by default.

<xsl output: attributes>

a. Output Method: Select the method of output after transformation from
the drop-down list. The method of output can be HTML, XML, or text.

b. Indent: Select this option to indent the output XML.
c. Output Encoding: Specifies the encoding of the generated output XSL.

d. Omit-xml-declaration: Specifies whether the output XML generated
should contain XML declarations or not.

Create empty tags for unmapped output elements: Select this option to
create empty tags for all unmapped elements of the output structure.

Add xsi:type attributes to elements: Selecting this option will add xsi:type
attribute to all the elements in the output XML.

Suppress optional empty items: Select this option for defining a mapping to an
output node, always generate the output nodes in output xml since event input
xml has no matching nodes. It is sometimes desirable not to generate optional
output nodes if no input matching node is found in input xml. This requires using
conditional mapping. You can specify such conditional mapping by using "User
XSL" feature. eMapper can generate such conditions automatically for optional
elements if this option is selected.
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9. Disable Output Escaping for xs:ANY elements in output: Selecting this option
will disable output escaping for all the xs:ANY elements in the output xml

10.11 FIX-XML Transformations

10.11.1 Loading FIX message in Mapper

An option to load FIX message is provided in the eMapper tool. A FIX message structure

can be added by choosing FIX after clicking the Add Structure button ('Jl]’) in the Input /
Output Structures panel.

A list of different FIX versions and message types is displayed where the messages to be
loaded can be chosen. Select the message types and click the Load button to load the
messages types in to the workspace. Click Finish in the Add Structure wizard and the FIX
message structure is loaded in Mapper as shown in the fig.

Input Structures B a4 v iy~ ¥
<R Inputl i
[B] Messages
[e] FIX44 =
[B] Advertisement
(] header
(] Advid [2]
[E] AdvTransType [5]
[&] AdvRefID [3]
(8] Instrument
[e] Symbol [55]

(8] SymbolSfx [65]
(] SecuritylD [48]
[e] SecuritylDSource [22]
»=1 [OME MANY]
(€] NoSecurity AIID [454]

(8] SecurityARID [455]

[e] SecurityARIDSource [456]
[€] Product [460]
[E] CFCode [461]
(8] SecurityType [167]
[B] SecuritySubType [762]
[e] MaturityMonthYear [200]
[] MaturityDate [541]
(] CoupenPaymentDate [224]
(€] IssueDate [225]
[8] RepoCollateralSecurity Type [239]

= n . - e

4 I P

Each field in a message is represented by a node. Repeating groups are represented using
a [ONE MANY] node. The first child of a [ONE MANY] node is the NumInGroup node,
representing the number of times the fields of the group are repeated, and the repeating
fields are added as children to this node. A Component type in the message is denoted by
a node with the component’s fields, groups and sub-components added as its children.
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To map FIX message fields to an XML message, load the input FIX message type in the
Input Structure and the output schema in the Output Structure panel. A mapping can be
created between two nodes by dragging the input node and dropping it on the output
node. Define mapping from the input FIX message to the output XML.

To map a repeating group to an output node that has [ZERO MANY] or [ONE MANY]
cardinality, map the NumInGroup field to the control node ([ZERO MANY] or [ONE MANY])
node and map the child nodes to their corresponding output nodes.

This generates a for-each mapping. In the example below, a for-each mapping is defined
between the Events group in the input FIX message and the item element in the output
xml message which means that for each repetition of the group fields in the input, an
output node <item> will be created.

4 =1 [ONE MANY] ——w  >=1 [ONE MANY]
4 [E] NoEvents [364] S| I 4 [E item

[] EventType [865] [&] type

[E] EventDiate [866] [E] name

[€] EventPx [867)] [] price

[€] EventText [868]

8

Similarly, while mapping XML to FIX, the repeating element in the input has to be mapped
to the [ONE MANY] node representing the group to generate a for-each mapping.

10.11.2 XSL generation

XSL is generated automatically when mappings are done. The generated XSL can be
viewed in the Metadata tab of the editor.

10.11.3 Test Mappings

To test the XSL generated, click the Test button in the toolbar ( g ), provide the input FIX
message in the space provided and click Apply Transformation. The output xml will be
generated.

Note: Since the mapper tool uses XSL to perform the transformation, and XSL does not
allow non-XML messages as input, the input FIX message is modified by adding
<Message> and </Message> tags at the beginning and ending of the message. Also, the
non-printable SOH character will be replaced by ‘" as Unicode characters are not allowed
in an XML message.

10.11.4 Mapping XML to FIX

Mappings can be defined to transform an XML message to a FIX message by loading the
XML structure in the Input panel and the FIX message type being generated in the output
panel.

If a required field in the message is not mapped to any element in the input, an error
message is shown in the Metadata Messages view.

The values for fields BeginString(8), BodyLength(9), MessageType(35) and Checksum(10)
will be generated automatically for the output FIX message. Any mappings defined for
these fields will be ignored.
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10.11.5 Defining FIX to XML or XML to FIX transformation on a Route

XML to FIX or FIX to XML transformations can also be defined on a route in an Event
Process. The following points have to be noted while using FIX-XML conversions on a

route.

Generated XSL uses java functions from the fix-xmlconverter.jar to fetch the value
of field from the input FIX message string, calculate the body length / checksum of
an output FIX message. This jar is present in the folder
$FIORANO_HOME/eStudio/plugins/com.fiorano.tools.mapper.runtime_1.0.0/jars
folder. This file needs to be added to the classpath of the peer server so that the
peer server can access the functions while performing transformations. This can be
done by adding the relative path to this file under <java.classpath> in fps.conf file
present in $FIORANO_HOME/esb/fps/bin/ folder and in server.conf file present in
$FIORANO_HOME/esb/server/bin/ folder.

As mentioned previously, the input document for an XSL should be an XML. While
defining a route transformation from FIX to XML, the input FIX message needs to
be modified by adding <Message> and </Message> tags at the beginning and
ending of the message and by replacing the non-printable SOH character with */’.
This can be achieved by adding a java-script component which gets the text body
of the IMS-Message, performs the required string operations (append and replace)
and then set the resulting string back on the JMS-Message.

Similarly for XML to FIX messages defined on a route, the output message will
contain *~’ instead of the SOH character. A Java-script component here can replace
all the occurrences of ‘A’ with the required component.
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Chapter 11: Working With Multiple
Servers And Perspectives

11.1 Active Server Node

In Online Event Process Development perspective, the user can add as many Enterprise
Servers and Log into them and create, deploy, and run Event Processes on them.

Active Enterprise Server in context of eStudio means that states of Event Processes and
other repositories will be shown corresponding to this particular server. Only one server is
shown as an active server at any point of time but user can still work on all other servers
by switching the active server. An active server switch can be made explicitly by selecting
Activate option from the Enterprise Server node context menu or an inactive server will be
automatically made active whenever the user wants to perform any action (Open Event
Process, delete Event Process, CRC, Launch, Import, Export, and so on) on the inactive
Enterprise Server.

The active server is displayed in Green color and the inactive servers are displayed in the
default black color.

For instance, in the Figure 11.1.1 the server EnterpriseServer_1 is Active and
EnterpriseServer is inactive. All other views will be in accordance to the Active Enterprise
Server (that is, EnterpriseServer_1). For example, Service repository and Service palette
will show the services present in EnterpriseServer_1.

E\ Server Explorer E@l i ¥ = O ||=g Event Process1 W
v _’f‘ EnterpriseServer
v BE Ewent Process Repository (1/19)
= Samples (1/17)
b (= User Processes (2)
p i Peer Repository 6 ©
v 3}.3 EnterpriseServer_1 Feederl
v 'EE Ewent Process Repository (20}
B = Samples (17)
b= TR
¥ [= User Processes (2)
"[E Event Process1 u
"[E Event Process2 "
p i Peer Repository v
| & —3 ERRS
@ service Repository 53 iy g~ O
» 2 Bridges m
» 2 Collaboration
o s
> DB 13
- [ T
B_., Problems @ Error Log 28 ] El Corlsole| *' Fiorano Debugger| == | Prop
= = = o
Workspace Log SIS | B X @y Conrm
type filter text Applica

Figure 11.1.1: Multiple Enterprise Server login
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If the user tries to perform any action on inactive server, a confirmation dialog is shown
(user can set a preference to avoid the dialog each and every time) saying that the active
server will be switched. When the switch happens, all the editors belonging to
EnterpriseServer_1 are closed and editors corresponding to Enterprise Server are restored.

11.2 Switching of Active Server

With multiple servers alive there can be application deployed on different Enterprise
Servers. But only event processes deployed on the Active Enterprise Server will be shown
to the user.

On changing the Active Enterprise Server, editors for all the event processes deployed on
to the previous Active Enterprise Server will be closed and these editors will be restored
when that server becomes active (when the user selects any node in that server).

The following steps describe the active server switch:

1. Login into the two servers. The Service Palette and Service Repository shows the
services present in the server to which the user has logged in recently (Enterprise
Server_1 in this case). Create some event processes in Enterprise Server_1,
and keep the created event process editors open.

E\ Server Explorer &3 l ".'- =0 "[E Event Process 1 |"[E Event Process2 ["[E Event Process3 &3 L

v jf‘_ EnterpriseServer o~
v 'EE Event Process Repository (1/19)
b = Samples (1/17)
B [= User Processes (2)
b 7i Peer Repository
h jf’_ EnterpriseServer_1
v 'KE Event Process Repository (21)
B (= samples (17)

B = TR
¥ (= User Processes (3) 1 m} @ s}
L

"[E Event Processl

"[E Event Process2 A
"[E Event Process3 ¥
& = J ERR
Q% Service Repository 52 [T i
b Pa m
P Bridges

&

» 2 Collaboration i

Figure 11.2.1: Active Enterprise Server

2. Now try to perform any action (say Open Event Process) on the inactive server
(i.e. Enterprise Server). A confirmation dialog box is shown saying that the
action requires the active server switch.
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E\ Server Explorer 3 l ".F ¥ =0 "[E Event Processl ["[2 Event Process2 &4 l"[E Event Process3

i"_ EnterpriseServer
EE Event Process Repository (1/19)
= Samples (1/17)

[ User Processes (2)
"[‘:test a o
.-[‘:tEStl Feederl

i Peer Repository
:F, EnterpriseServer_1

EE Ewvent Process Repository (21) 6 o n S S mmen
(= Samples (17)
= TKJ (L) [ This action requires switching the current active server. Do you wish to proceed?

[ User Processes (3)
"[E Event Processl
"[E Event Process2
"[E Event Process3

7i Peer Repository ( Cancel ) G—H

[4 Tl

[ Don't ask this next time for the similar kind of actions.

Figure 11.2.2: Switch Active Server

3. When the user clicks the Ok button, the editors related to Enterprise Server_1
will be closed and the editors corresponding to Enterprise Server will be opened.
Also the service palette and service repository show the services present in the
Enterprise Server. The Active server can be identified by the color green.

E\. Server Explorer E@l ".F ¥ =0 "ﬁtest P l"[ﬁtestl |

v _‘i‘f EnterpriseServer
v 'EE Event Process Repository (1719)
b (= Samples (1/17)
¥ [= User Processes (2]
=g test
'ﬁtestl
B ¢ Peer Repository
v _‘i‘f EnterpriseServer_1

k 'EE Ewvent Process Repository (21) O & o
B = Samples (17)
CBL
b= TKI(L

¥ [= User Processes (3)
"[2 Event Processl
"[2 Event Process2
"[2 Event Process3
B ¢ Peer Repository

Figure 11.2.3: Event Processes present in Enterprise Server

4. To switch back to Enterprise Server_1, perform any action on the Enterprise
Server_1 node or right-click and select the Activate option. All the editors which
are opened previously are restored and the editors corresponding to previously
active server are closed.
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[\ server Explorer I3 l

'ﬂ ¥ =0 "[':E'n.rent Processl

v &’: EnterpriseServer
v 'EE Event Process Repository (1/19)
» (= Samples (1/17)
¥ (= User Processes (2)
=g test
"[': testl
b ¢ Peer Repository
v %’: EnterpriseServer_1
v 'EE Event Process Repository (21)
b (= Samples (17)
b = TR
¥ = User Processes (3)
"[E Event Processl
"[E Event Process2
"[‘: Event Process3
B i Peer Repository

€ 3 )4

[

o

Feederl

Figure 11.2.4: Services restored in Enterprise Server_1

r———

During the active server switch, if the user tries to switch from a server containing any
unsaved editors, a dialog box containing the unsaved editors will be prompted where the

user can select the editors to be saved.

Note: The User can select appropriate option to save or discard changes in editors but

there is no option to veto the switch.

=g *Event Processl 52 l"[ﬁ *Event Process2

|"[ﬁ *Event Process3

Save..

There are a few editors with unsaved changes. Save changes before closing?

ES-Elect the editors you want to save:

E Event Processl
E Event Process2
E Event Process3

"i Close without saving :'J i

Figure 11.2.5: Unsaved editors dialog
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11.3 Switching Between Perspectives

eStudio has three perspectives; Offline Event Process development, Online Event Process
development and Mapper

To change the perspective, perform the following steps:

1. Click the Open Perspective option from Window -> Open Perspective -> Other or
from the shortcut bar on the left-hand side of the Workbench window.

%" @I{]nline Event Process Development L3 Offline Ev

&' Java I

(@ Online Event Process Development

— |

"[E Event Processl H

Figure 11.3.1: Selecting the Other.. option from perspective button

2. Select the Online Event Process Development to open the online perspective.

ene Open Perspective

ﬁfﬁ Debug
334 Java
E,J Jawa Browsing
i 'Eg‘ Java Type Hierarchy
| E Mapper
Offline Event Process Development (default)
@ Online Event Process Development
= Plug-in Development
ED Team Synchronizing

| Cancel | OK
P

Figure 11.3.2: Selecting Online Application Development perspective

The Online perspective shows all the views and editors customized for the online
application development as shown in the figure. During online application development,
application development takes place after logging in to the server.
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‘@00 eStudio P=)
|3 e FRE R A 2 [ R x| -H2EFEO -2 |HO LM
[ @ oOnline Event Process Development | (3 Offline Event Process Development
[ server Explorer 5 | W7 O|egare e eventprocessy £ = 5[ @ service Patette 52 U
v E Enterpriseserver [ select
v #8 Event Process Repositary (19) | Route
P (= Samples (17)
B [ User Processes (1) (= Bridges
v &21-7T-7oexw (= Collaboration
-{‘:APPLJ:Z (= DB
» T Peer Repository
i) —
EJBAdapterL = Flow,
(= MOMSs.
(= Performance.
. ] Tal» . Samples
Dy service Repository 52 = Script
> :Brmges (= Transformation
: 5 g;\\nbwatmn =il
» P Error (= Web.
» D File (= WebService
» O Flow
> P moms
» P performance
» O samples
» O scrint
[E Problems |©] Error Log | B Console 52 l" Fiorano Debugger Ex 5| =% B~ £+ = O|| 2 properties 2 =0
= General : Name: Event Process1
Application Context
Environment Properties Cuid: EVENT_PROCESS1
Version 10
Categories User Processes Ad
¥ Cache Component L
Description: :
i
Figure 11.3.3: Online Application Development Perspective
Now, switch to Offline perspective by clicking on the Open Perspective button on the
shortcut bar on the right-hand side of the Workbench window, select Other... from the
drop-down menu. Select the Offline Event Process Development to open the Offline
perspective. (User can also switch to different perspectives like java etc.)
The Offline perspective shows all the views and editors required for the offline application
development as shown in the figure 11.3.4. During offline application development, there
will not be any interaction with the server.
‘@06 eStudio o
Jra- G- - [H-§l- =] [ ] ®iomF -ERREMNEO L
[ @ Online Event Process Development | (3 Offline Event Process Development
B8 Event Process Repository 52 =0 w = O|[.& service Palette 22 m-=0
(=] [y Select
v #8 Event Process Repository (1) | Route
T s S
= Collaboration
(DB
L= Error
(= File.
= Flow
> MOMs.
3 ir = Performance
@5 Service Repository 58 | %5 g ¥ © O gz:‘:u
L Ee——
» P DB (= il
» P Error [ web.
b O File (= WebService
» O Flow
» 2 Moms
» P performance e
» 2 samples F
[E Problems | @] Error Log | & console 52 EIEEN =N = Properties 5 =0
Orchestration |
‘General Name: Event Processl
Application Context
Environment Properties | GUid EVENT_PROCESSL
Version 1.0
Categories User Processes Ad
[# Cache Compoanent
Description: s
A

Figure 11.3.4: Offline Application Development Perspective
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Chapter 12: Fiorano Preferences

Fiorano Preferences are available under Window > Preferences -> Fiorano.

The common preferences like security for Enterprise Server connections and JMX
connections can be provided here.

B3| Preferences |:|E]
-

| | | Fiorano =
Ank . ) .
o [— Settings for Fiorano environment:
ESE Connection Preferenc General:
Mapper Unda Redo Limits | 100
[=)- 504 Crchestration _
A Miscellaneous:
Cnline ) )
Service Edit Securiby opkions
Service Creation Remember login password
General _
Help M Conneckions
Install/Update [ 5hove expert operations
lava []shiow hidden operations
Plug-in Developrmant ) ’
[]show hidden Attributes
RunfDebug
Team
ML
< | & ’Restu:ure Defaults] [ Apply ]
[ K ] [ Cancel l

Figure 12.0: Fiorano preferences

12.0.1 Security Options

Remember login password: If this option is enabled, the password for any user logged out
of Enterprise Server(in Online Event Process Development) and any Administrative or JMX
Server (in Connection Management) is saved for the future login. The password is also
saved in case the connected server goes down or when the studio is restarted.

By default this option is deseleted and the password fields are set to blank. Hence, while
logging into an Enterprise Server for the first time or in future whenever the password field
is emptied, a dialog box is prompted to enter the password wherein this preference can be
set as well.

12.0.2 JMX Connections

By enabling the preferences under this section
e Show expert operations
e Show hidden operations

e Show hidden attributes
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The user can view the expert operations, hidden operations and hidden attributes

respectively for the JMX connection.

Various sections in Fiorano Preferences are explained in the following sections.

12.1 ESB Connection Preferences

Enterprise Server configurations can be defined here. List of Enterprise Servers can be
added and the server details such as IP address, port and security credentials can be
provided. These servers configuration is used in Offline Event Process Development
perspective for actions (export Event Process to server, import Event Process from server
etc.) that require a Server connection.

P

g] Preferences

type filter text ESB Connection Preferences =T - -
A.nt Configure Enterprise server connections.
Fiorano
ESE Connection Preferences
Mapper E] HostMame / IP:  localhost
5OA Orchestration Local Enterprise Server Part: 2047 -
Service Creation % ' x
General Username: admin
H
clp Paszwaord: [T
Install/Update
Java
Plug-in Development
Run/Debug
Team
XML
[Restore Defaults] [ Apply ]
[ 0K ] [ Cancel ]
Figure 12.1.1: Enterprise Server Configurations
Restore Defaults button is used to restore the preferences to default values.
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12.2 Mapper

Fiorano Mapper preferences are listed under this section.

E] Preferences | o ===
type filter text Mapper =K v v
J'-‘\.nt Preferences for Fiorano Mapper
Fiarano
ESB Connection Prefere Limit Tree depth in Mapper
Mapper Maximum Tree depth [ E
S0A Orchestration

Test Cl th
Service Creation € =

Classpath to be used while testing mappings generated in Ficranc Mapper using the Test XSL wizard

General
Help
Install/Update £
Java CA\Pregram Files\Ficranc\Fierano50A9.5.0\runtimedata\eMapper\jars\sample...
Plug-in Development C\Program Files\Ficrano\Fierano50A9.5.0%eStudio\pluginshcom.fiorano tools...
Run/Debug C\Program Files\Ficrano\Fierano50A9.5.0%eStudio\pluginshcom.fiorano tools... Move Up
Team CA\Pregram Files\Ficrano'\Fierano50A9.5.00extlibxalanxalan.jar
KML C:\Program Files\Fiorano\Fierano50A9.5.0\extlib\saxon'license.tet
C\Pregram Files\Fioranc\Fierano50A9.5.0%extlib\saxon\saxon8-dom jar
C\Pregram Files\Ficrano\Fierano50A9.5.00extlib\saxon\saxen8-jdom.jar
C\Program Files\Fioranc\FioranoS0A9.5.0\extlib\saxon'\saxond-sql jar
C\Program Files\Fioranc\Fiorano50A9.5.0\extlib\saxon\saxond-xom.jar
C:\Program Files\Ficrano\Fiorano5049.5.0Nextlib\saxon\saxon8-xpath jar
Ch\Program Files\Fiorano\FieranoS0A9.5.0\ extlib\ saxon\saxon8.jar
C\Program Files\Fiorano'\FieranoS0A9.5.0\extlib\saxon\version.bd
- = - - [Restore Defaults] [ Apply l
[ oK ] [ Cancel ]

Figure 12.2.1: Mapper Preferences

12.2.1 Limit Tree depth in Mapper

When loading a structure to the input or output trees in Mapper, the whole structure is
parsed in a single go and the tree is loaded with the entire structure. This can cause
mapper to load slowly and can also cause memory issues while dealing with
large/complicate structures.

Selecting the Limit Tree depth option allows the user to choose a Maximum tree depth
which represents the depth till which nodes are automatically loaded. Nodes from deeper
levels will be loaded on demand, i.e., if the user expands their parent nodes. Note: All the
nodes which have mappings defined will be loaded automatically irrespective of the
maximum level chosen.
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12.2.2 Test Classpath

Mapper allows users to test the mappings defined using the Test option (Ref: Section
10.9). If the mappings use Custom java functions, the user has to add them to the
classpath before testing the transformation. This table provides the user an option to
add/remove entries from the test classpath. Note: A few entries are added to the
classpath by default viz., external libraries for Saxon and Xalan, DB look-up functions and
jars added in %FIORANO_HOME%/runtimedata/eMapper/jars folder.

12.3 SOA Orchestration

SOA orchestration preferences are grouped into General options, Workflow options, Service
options and CPS options.

12.3.1 General Options

General Options contain preferences for Error Port and Routes Color and Route Shape. The
preference chosen here will be applied in orchestration editor.

E] Preferences | = ==
type filter text S0A Orchestration = - -
’ A-nt Settings for application orchestration. -
4 Fiorano
ESB Cannection Prefere . - - -
Mapper General Options | Workflow Options | Service Options | CPS Launch
- | S0A Orchestration General Options
Service Creation Some services will have an error plort, on which pfocessin.g EITOrs iflan}r are sent. The error port and the
General routes from the error port are distinguished by this color in the designer. =

» Help Error port and routes Color @

> Install/Update

> Java The shape of route in application designer

> Plug-in Development

- Run/Debug Route shape:
» Team
» XML Export/Import Options

Open Event Processes for editing after import.

() Always () Never @ Prompt

[7] Overwrite Event Processes and Configurations that already exist in the target repaositories,

Figure 12.3.1: SOA Orchestration Preferences

12.2.2 Workflow Options

Workflow options contain Workflow color information. Workflow Item color and Workflow
End color used in Document tracking can be configured here.
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General Options | Workflow Optiens | Service Options I CP5 Launchl

Workflow Options

WoarkFlow is a feature by which we can track the messages flowing in the process and their lifecycle, A
WorkFlow is defined by marking ports as part of a wokflow(Item) or end of it.

Workflow item color E

Waorkflow end caolar

Figure 12.3:2: Workflow options

12.2.3 Service Options

Service instance default configurations can be provided here. These default configurations
are set on a service instance when a new service instance is created.

12.2.3.1 Default JVM Configurations

JVM configurations like classpath, System properties, memory options etc. can be defined.
These options are used while launching the component in Separate Process launch mode.

These are the default configurations that are applicable to all the newly created service
instances. Service Instances can also overwrite the default configurations set on them by
making modifications in properties view.
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1

S0A Orchestration

Settings for application orchestration.

| General Options | Workflow Options | Service Options | CPS Launch

Default WM Configurations

The default WM configurations set on a service instance when a new service instance is created,

[ Classpath
Systern Properties
Mame Value
LOG_TO_STREAM true

Remowve

Move Up

Mowve Down

Endorsed Locations

Extension Packages

Debug

Memory Tuning

Additional VM Parameters

Miscellaneous Properties

Connection Factory Preferences:

The parameters used by a service instance to create a connection factory

Mame YValue
Remowve

Figure 12.3.3: Service options

Configurations defined here are set on the Service Instance in Runtime Arguments section
of the properties view. For example if the user wants to change the heap memory settings,
he can provide the values for memory tuning properties as shown in Figure 12.2.4

Maximum Heap Size [-Xmx] (256m
Initial Heap Size [-Xms] '32m
Minimum Free Heap Ratio [-XX:MinHeapFreeRatio)

Maximum Free Heap Ratio [-XX:MaxHeapFreeRatio) |

Thread Stack Size [-Xss] D

[ »

m
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Figure 12.3.4: Memory tuning options

After defining these configurations, the default values are set when a service instance is
drag-and-dropped in Orchestration editor and can be seen in Runtime Arguments section
as shown in Figure 12.2.5.

O % o =% Samples
[~ Script
DBL [~ Transformation
== Uil
[~ Web
= WebService
| Properties &4 I - = q
|
General | JVM_PARAMS: | -DLOG_TO_STREAM=true -Xmx256m -Xms32m -Xrs~ |Reset To Defau
Deployment |
B | MName Value
Log Manager |
Log Module Instances |
Runtime Arguments
I

Figure 12.3.5: Runtime Arguments

These properties are set on the JVM on which the service instance will be launched.

12.2.3.2 Connection Factory Preferences

Configurations used by service instances while creating Connection factories can be
defined here. The connection factories are created internally by using default configuration.
To overwrite the defaults, user can set the properties here.

The properties defined here are available in Execution section in service instances
properties view.

12.2.4 CPS Options

These options are used by external CPS launch components where the CPS is launched as
a separate JVM process. The following components CPS is launched in separate process
JVM: SapR3, XMLSplitter, SapR3Monitor, Aggregator, CBR, Join, CompositeBC, JMSIn:5.0,
JMSOut:5.0 and JMSRequestor:5.0.

Apart from these prebuilt components, custom components CPS will also be launched in a
separate process JVM.
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,——{ General Options | Workflow Options | Service Options

CPs Launch Preferences

The default JVM configurations used while launching the CPS of a service instance as a seperate process.

Name Value [

move

{NEE
{

Figure 12.3.6: CPS launch opfions
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12.4 SOA Orchestration Online

This section contains configurations for online Event Process orchestration.

Online -
Ank . . - .
Settings For online application orchestrakion,
[=)- Fiarano s S
ESE Connection Preferenc General Options
Ll . This option prevents a running services From being moved or dragged.
[=)- 50, Orchestration
Lock running service instances:
Service Edit
Service Creation Application Options
General Show &pplication Launch chain when Remate Instances are present in an application
Help
7 _— ) . .
TnstaljUpdate Show Application Shutdown chain when Remote Instances are present in an application
lava
Plug-in Development Options For launching services in an application.
RunfDebug Launch services when an application is launched
Team i S .
Sl Launch services when application is synchronized
Service Options
Colars of service label ko reflect the execution state of a launched service.
Handle created state: E]
Handle bound to peer state: E]
Handle bound to no peer state: @
Handle unbound state: E]
Peer Options
Colars of service border to reflect the status of the peer server on which the service is
launched.
Unknown skate: E
Dead skate: E
Live skate: E
Option bo display notifications when a Peer Server connects to Enterprise network or
disconnects From Enterprise network.
Show Peer Server availability notifications
Enterprise Server opkions
[JHide the confirmation dialog when switching between Enterprise Servers
Timeout{minutes) For relogin attempt upon HA Failover: | 6 -
P 5 lRestu:ure Defaulks ] l Apply ]
[ Ok ] l Cancel ]

Figure 12.4.1: Online Orchestration preferences

Chapter 12: Fiorano Preferences Page 198



Fiorano eStudio User Guide

12.3.1 General Options

Lock running service instances: This option prevents the service instances from being
moved or dragged when an Event Process is running.

12.3.2 Application Options

Launch Services when application is synchronized: If this option is enabled, in a running
Event Process, service instances in stopped state will be started if the user clicks the
Synchronize button in an Event process.

12.3.3 Service Options

The color of the Service Instance label name at different execution status can be
configured from here, that is, when a Service Instance is running, stopped and so on.

By default when a Service Instance is dragged and dropped the instance name color is
Black. The states and corresponding Service instance label name colors are explained
below.

¢ Handle Created State: This color is shown when the service instance handle is
created. This happens before the component is launched completely.

¢ Handle Bound to Peer state: This color is when the service instance is running.

¢ Handle Bound to no peer state: This color is shown when the peer server on
which the component is running is stopped.

¢ Handle unbound state: This color is shown when the component in a running
Event Process is stopped.

12.3.4 Peer Options

These are the colors applied to service instance border to reflect the status of the peer
server on which the service instance is configured to launch.

¢ Unknown State: The peer server configured is unknown. i.e. the peer server
configured is not running and is not present in peer repository node under
Enterprise Server node.

e Dead State: The peer server configured is not running but it is present in peer
repository node under Enterprise Server node.

e Live State: The peer server configured is present in Peer repository and is
running.

e Show Peer Server availability notifications: Whenever a peer server connects
to the Enterprise Server or disconnects from Enterprise network, a notification
dialog will be shown as shown in Figure 12.3.2.
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12.3.5 Enterprise Server Options

These are the options applicable to the Enterprise Server prior to login or relogin from the
eStudio.

Hide the confirmation switch dialog: If this option is enabled when the user is working on
multiple servers, the user is no longer prompted with a confirmation dialog to switch the
active server and an incative server will be automatically made active whenever the user
wants to perform any action (Open Event Process, delete Event Process, CRC, Launch,
Import, Export, and so on) on that Enterprise Server.

Time to relogin upon HA failover: If this time is set to a particular value when the user is
working on HA servers, the failure of the active server triggers the enterprise server node
connected to that server, to reconnect to the backup server or the same server whichever
becomes active within the specified time interval (in minutes). In case the server(s) takes
too long to switch their state(s), a message is logged on the console and the attempt to
relogin to studio is failed. It is advisable to increase the time in this case approximately to
the time taken by any of the servers to become active.

|| [~ WebService v
=l Properties £2 l =0
| - ol
Ceneral MName: Simple Chat
Application Context |
Environment Properties | GUid: SIMPLECHAT
Version: 1.0
Categories Samples ¥
E Cache Component
Description:

Long Description:
! | fps {hitp://192.168.2.149:1867}

Peer "fps’ available for Enterprise Server : EnterpriseServer

Figure 12.3.2: Peer server notification

This option is to enable or disable the notifications.
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12.5 Key Board Short Cut Preferences

Before using Key Board shortcuts Fiorano scheme has to be set in Preferences (Window ->
Preferences -> General -> Keys).

®ene Preferences
type filter text Keys [=p4 v
b Ant
b Fiorano Scheme: | Fiorano =
¥ Ceneral
P Appearance " orchestration
Compare/Patch
Content Types I i & Binding When Category User
b Editors Add Event Process 31 In Windows Orchestration Offline Ev m
Keys Check Resource And Connectivity of App Orchestration Online Ev
Perspectives Clear Logs xC In Windows Orchestration Online Ev
Search Create Service Component GIEN In Windows Orchestration Comman
» Workspace Export Event Process N¥EXE In Windows Orchestration Offline Ev Y
» Help Export Logs X In Windows Orchestration Online Ev v

Install/Update
P Java

P Plug-in Development ( Copy Command ) C Unbind Command ) ( Restore Command )
b Run/Debug
- Team
Name Export Event Process
b XML A "
Description: Conflicts:
Command When
Binding: NBXE 4
When: In Windows 3]

.\ Filters... ) K Export... y )

Figure 12.5.1: Key-binding preferences

The default Key Board shortcuts for various actions are listed below.
e HelpF1

e Rename F2

e Undo Ctrl + Z

e RedoCtrl +Y

e Add Event Process CTRL + I

e Open Event Process CTRL + O

e Import Event Process CTRL + ALT + I E

e Import Event Process (nStudio) CTRL + ALT + I N
e Import Service (from Local Disk) CTRL + ALT + IL
e Import Service (from Server) CTRL + ALT + 1S

e Export Event Process CTRL + ALT + X E

Insert
1. Service Instance CTRL + ALT + A S
2. Event Process CTRL + ALT + A E

3. Remote Service Instance CTRL + ALT + AR
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CRC ALT + Shift + C
Run Application ALT + Shift + R
Synchronize ALT + Shift + S

Stop Application ALT + Shift + K

View

1.View Debugger CTRL + ALT + VD
2.View Properties CTRL + ALT + V P
3.Logs CTRL + ALT + V L

4.View Error ports CTRL + ALT + VE

5.View Route Names CTRL + ALT + VR

Clear Logs ALT + C
Export Logs ALT + X
Toggle Lock Mode ALT + Z

Schema repository CTRL+Shift+S

Create Service component CTRL+Shift+N

The option to edit keyboard shortcuts is also available under General -> Keys section in
the preferences dialog. The list of Fiorano Orchestration commands can be viewed by
entering Orchestration in the filter box provided above the available keys. The shortcut for
any of the action/command can be changed by editing the Binding text field available

below the keys table section.
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Chapter 13: Schema Repository

Schema Repository is used to store external schemas that are referred by schemas on the

component ports. The imported schemas referred from anywhere in an Event

Process/component can be stored here so that they are resolved even when they are not

added explicitly. Hence, schemas which are imported across multiple event

processes/components can be stored in the schema repository.

To add schemas to the Schema Repository, perform the following steps.

1.

Navigate to Tools -> Schema Repository. This opens a Schema Repository
editor as shown in Figure 13.1.1 using which schemas can be added to schema

repository.

Schema Repository

URI Location

Add to Catalog

Remove

Figure 13.1.1: Schema Repository

To add schema files to the catalog, click Add to Catalog button shown in
above figure . This opens a dialog as shown in figure 13.1.2. where in after
adding schemas click ok to add them to catalog.

3]

(L] Schema Repository
Add schemas to repository:
URI Location Add
-Details
Locat

[ Cancel l I

oK

Figure 13.1.2: Adding XML files dialog
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3. To add schema files, click Add button and select the Add File(s) option as
shown in the figure 13.1.3. Folders containing multiple schemas can also be
added to the catalog using Add Folder option. Select the suitable option and
choose the required file(s) or folder from the browser window opened.

T

Add schemas to repositony:

LRI Location || Add 1
Add File(s)

Add Folder

Figure 13.1.3: Adding XML files to Catalog

4. A confirmation dialog will be opened asking if the files need to be saved to the
Catalog folder. If answered with Yes, the schema files will be saved in
<FIORANO_HOME> /xml-catalog/user folder upon clicking the OK button.
Otherwise the absolute path of the files’ original location will be used to refer
the schema.

5. The Namespace URI and Location of all the files chosen will be populated in
the table as shown in the figure 13.1.4. Selecting a particular entry will show
its details in the Details panel.

6. Any changes to the URI or File Location in Catalog can be modified from the
Details panel and the changes can be saved using the Save button.

Note: If an entry has empty URI string or if two or more entries have the same
URI, such entries will be shown in red and an error message describing the
problem with the entry will be shown in its Details.

@ Sthema Repository =

Add schemas to repository:

URI Location Add
http://www.books.org : BookStore.xsd
Remove
: NoTargetNameSpace.xsd
http://www.BookRetailers.org /home/jagan/mine/xml-sche
http:/fwww.library.org example31/Library.xsd
http:/fwww.library.org example31/LibraryEmploye|

| | >

Details

[ Cancel l I 0K ]

Figure 13.1.4: Adding schema to Schema Repository
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7. Make sure all the entries are added without any errors and click ok button to
add the schemas to Schema Repository. The schema files for which the user
chooses the Save to Catalog Folder option will be added to
<FIORANO_HOME>/xml-catalog/user directory and directories added will
be copied along with all the sub-folders and files.

8. If the Save to Catalog Folder option is not chosen, the files will be referred
from their original locations.

9. A new row specifying the URI and Location of each XSD will be added to the
table displayed at the bottom of the dialog as shown in the figure below.

Note:

e Schema files which are not saved in the catalog folder will be referred by their
absolute paths. Refer Entry 3 in the figure below.

e« If a folder is added, relative paths will be used to refer them in the catalog.
Refer entry 4 and 5.

URI Location Add to Catalog
http://www.books.org | BookStore.xsd

¥ . Remove
http://www.repository.org | SchemaRepository.xsd
http:f/www.library.org Library.xsd

http://newtaregetNameSpace NoTargetNameSpace.xsd

Figure 13.1.4: Table displaying the schema files added to catalog

10. Separate xml-catalogs are maintained for Offline, Online and Mapper
perspectives.

1. Offline Perpspective xml-catalog path :
%FIORANO_HOME%/runtimedata/eStudio/workspace/.repositories/Offl
ine/xml-catalog

2. Online Perpspective xml-catalog path:
%FIORANO_HOME%/runtimedata/eStudio/workspace/.repositories/Onl
ine/%ENTERPRISE_SERVER®%/xml-catalog

3. Mapper Perspective xml-catalog path: %FIORANO_HOME/xml-catalog
When Perspective switch is done the respective xml-catalog of the perspective will be
referred and Schema Repository Tool displays the schemas in the current perspective's
xml-catalog.

13.1 Schema Repository in Online Perspective

Fiorano Enterprise server maintains its own schema repository in
%FIORANO_HOME%/runtimedata/repository/Schemas.

When login to a server all the schemas present in server are loaded in to local online xml-
catalog and when logged out of server those are cleared.
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13.1.1 Export/Import Event Processes with Schema References in Online
perspective

1. Export Event Process: If the application being exported has schema
references, all those will be copied to %EVENT_PROCESS%.zip/userschemas
folder.

2. Import Event Process: If the application being imported has schema
references, the schema references present in
%EVENT_PROCESS%.zip/userschemas folder are added to local online schema
repository and server schema repository and then the event process is
deployed to server.

13.1.2 Component configuration with store imported schemas in Online
Perspective

If a component is configured with store imported schemas, the imported schemas are
added to local xml-catalog and only on event process save the schema references are
added to server.

13.1.3 Multiple eStudios connecting to same Enterprise Server

This feature has to be used with care when multiple eStudios are connected to the same
Enterprise Server and Event Process composition is being done from all the Studios.

Consider an example where two different eStudios are connected to an Enterprise Server
and eStudiol creates a new Event Process EP1 and deploys it to the Server. Let's assume
EP1 has a schema reference schemal.

Suppose if EP1 is not opened in eStudio2 = this Event Process is not fetched in eStudio2.
In this case if a new Event Process EP2 is created in eStudio2 having schema reference
schemal (since the Event Process is not fetched in eStudio2, it is unware that schemal is
used in EP1) and when EP2 is deployed to the Server, it renames schemal to some other
name and updates EP2 to avoid conflicts.

When this case happens eStudio2 complains that the new schema file is missing as EP2 is
updated when deployed to the server.

To avoid this situation EP1 has to be opened in eStudio2 before creating EP2. If the worst
case happens then Logout and Login to the server re-fetches the schemas and the issue
will be resolved.

13.1.4 Schemas Deletion in Online Perspective

Schemas can be removed from online schema repository by selecting a schema and
clicking remove button shown in figure 13.1.1. A warning appears as shown in figure
13.1.5.

which might lead to inconsistencies if multiple Event Processes are referring

{,fj‘ Deleting schema file "WSStubl.xsd"from here also deletes from the FES server
the same. Do you want to proceed?
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Figure 13.1.5: Online Schema Delete Warning

13.2 Schema Repository in Offline Perspective

13.2.1 Export/Import Event Processes with Schema References in Online
perspective

1.

Export Event Process: If the application being exported has schema references,
all those will be copied to %EVENT_PROCESS%.zip/userschemas folder.

Import Event Process: If the application being imported has schema
references, the schema references present in
%EVENT_PROCESS%.zip/userschemas folder are added to local offline xml-
catalog and then the event process is added offline application repository.

Export Event process to server: If the application has schema references the
schemas from local Offline xml-catalog are added to server and application
from offline repository is deployed to server.

Import Event Process From server: The schema references from server are
added to local Offline xml-catalog and event process is added to offline
repository.

13.2.2 Schemas Deletion in Offline Perspective

Schemas can be removed from online schema repository by selecting a schema and
clicking remove button shown in figure 13.1.1. A warning appears as shown in figure

13.1.6.

Confirm Delete

Deleting schema file "BookStore.xsd" might lead to inconsistencies if multiple
Event Processes are referring the same. Do you want to proceed?

Figure 13.1.4: Offline Schema Delete Warning
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Chapter 14: SCM Integration

The Event Processes developed in Fiorano environment can be shared directly into from
the version control system in eStudio. The steps below explain the processes to be
followed to configure and use the version control support in eStudio. For demonstration
purpose steps for SVN integration are mentioned.

14.1 Downloading and integrating SVN into eStudio

To integrate SVN, subclipse has to be downloaded from the eclipse update site.

1. In eStudio, navigate to Help - Install New Software. Paste the URL
http://subclipse.tigris.org/update 1.6.x in the text field beside Work With
property and click the Add button.

2. A dialog box is displayed asking to provide a Name. Provide a name and click OK.

3. All subclipse related libraries are shown. Select all libraries except the Subclipse

Integration for Mylyn 3.x option, as shown in Figure 1. Deselect the option

Contact all update sites during install to find required software (this speeds

up the installation process) and click Next.

E] Install |
Available Software
Check the items that you wish to install. \:)f
Work with:  svn - http://subclipsetigris.org/update_1.6.x - Add...

Find more software by working with the 'Available Software Sites' preferences.

type filter text
Name Version
a [ 000 Cere SVNKIt Library
Lt SVNKit Library 1.3.5.7406
a [ 000 Optional JNA Library (recommended)
Lk INA Library 327
4 [ 000 Subclipse
[¥] l CollabMet Merge Client 223
@ Subclipse (Required) 1617
‘:Eii! Subclipse Integration for Mylyn 3.x (Optional) 300
g Subwversion Client Adapter (Required) 1612
@ Subversion JavaHL Mative Library Adapter (Required) 1615
@ Subversion Revision Graph 1049
@ SVNKit Client Adapter (Mot required) 1615
Details
Show only the latest versions of available software [7] Hide items that are already installed
Group items by category What is already installed?

@mtad all update sites during install to find required software

< Back Mext > ] [ Finish J [ Cancel

Figure 1: Install the New Software wizard
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4. 1In the next page the items selected in step c are listed. Click Next.
5. In the Review Licenses page, accept the terms and click Finish.

6. Subclipse libraries will be installed. During installation a security warning will be
displayed as shown in Figure 2. Click OK.

_F] Security Waming [ = -s-:h,l

Warning: You are installing software that contains unsigned content. The authenticity
i l . orvalidity of this software cannot be established. Do you want to continue with the
installation?

oK || cancel || Details>>

L e - a

Figure 2: Security warning during installation

7. Once the installation is done, eStudio displays a prompts for a restart. Restart the
eStudio and the version control plugins are integrated and ready to be used.
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14.2 Using SVN with eStudio

Event Process can be committed to SVN either from the Event Process Repository view or
from the project explorer view Window->Show View->O0ther->General. Closed
projects cannot be shared in the version control system. Event Process should remain open

so as to be able to share then in SVN.

1. Right-click on an Event Process project and select Team—->Share Project as shown

in Figure 3.

. Server Explorer &7 _
o =

4 [= Samples (17) -

» = Financial (2)

4 [= Inventory (3)

= EI."‘[‘:E.BJDer'm Eﬂ-

oD EAI Demn E
o2 Order E Team
={p Purcha Compare With
> & Mortgage Restore from Local Histery...
» = Portals {1}
[ Retail (2) Check Resources and Connectivity
< e m—— B

Synchronize

@ Service R.. 52 E Confi

| I Stop

o Bridges =g Open

O Collaboration *E Delete

O DB S

O Error

O File Refresh

O Flow

0 MOMs i Export..

O Performance Export To File
Zl Problems 22 | €] Error L ST
) items J View Logs...
Description Export Logs...

Clear Logs

Show Configuration Usages

Delete

b

Apply Patch...
]
Share Project... |

]

Figure 3: Sharing Event Process project

/ Rejec

Rejecticn_Event
Acceptance_Event

et

Kslt 1

Location  Type
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2. Specify the SVN URL location where the project is to be stored as shown in Figure

4.

] Share Project L [E] _S;hJ

Enter Repository Location Information VN
Define the location and protocol required to connect with an existing SVN repository. %‘

Location

Url: | svni/ftoclsrepo.fstpl.com/toolsrepo/trunk/SVM_Integration_Test -

< Back Net> || Finish || Cancel

L

Figure 4: Providing svn repository URL

3. Provide additional details and Finish the wizard. A dialog will opens prompting for

a perspective change.

4. Click Yes as shown in Figure 5. Clicking Yes automatically transfers the User to

the Team Synchronizing perspective.

f o S —
_F] Confirm Open Perspective @

The Synchronize View is associated with the Teamn Synchronizing perspective,

This perspective is designed to support the synchrenization of resources in the local
waorkspace with their counterparts shared in a repository. It incorporates views for
synchronizing, browsing history and comparing resource content.

Do you want to open this perspective now?

[T Remember my decision

[

Figure 5: Dialog prompting for perspective change
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5. Right-click on the project in the Team Synchronizing view and select the Commit

option to commit the project into the repository as shown in Figure 6.

¥ Fiorano eStudio-/Cy/Program Files/Fiorano/FioranoSOA9.3.0/runtimedatale

F‘jv <::|v - é’;v

2 |[=+ eai_demo-1.0@FnternriseSercer

File Edit Mavigate Search Run Project Window Help

=< [E’D Team Synchronizing ]% SVN Repository Exploring @ Online Event

£0 synchronize &2 -2 Bl GE| %N
SVN (feal_demo-1.0@EnterpriseServer, /retail_tel..ailautomation_sportinggood

» =% retail_television| 1= Cepy

o = retailautomatio ¥ Delete
Mowve...
Rename...

Expand All

&

Team

Update

Commit...

Figure 6: Committing project to SVN

Synchronize

Remove from View

saa Show Revision Graph

Compare With
Replace With
Restore from Local History...

Create Patch...

Override and Update

Mark as Merged

Ctrl+C
Delete

Note: Perspective change mentioned in step (d) is not mandatory. Commit can also be

done by right-clicking on the Event Process.

Once the Event process is shared in the repository, all SVN related options are available

through the Event Process right-click menu, as shown in Figure 7.
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L:\ Server Explorer &3 ;| = ¥ T O||={g Database Replication #{g CompositeBC Demo

4 F, EnterpriseServer
a4 B Event Process Repository (1/18)
4 [= Samples (17)
4 [= Financial (2) -
=3 Bond Trading
o] Revenue Control Packet
4 (= Inventory (3) —

| »

g EAl Demo 52

~a[D o

{3 EAID =
{2 Order Team 3 Synchronize with Repository
o{] Purch Compare With 3 Commit...
> [= Mortgage Replace With 3 Update to HEAD
g g ::trtallgjl Restore from Local History... Update to Version...
> ai
@ Service Reposi.. 2 El Check Resources and Connectivity Create Patch.
O Run Apply Patch...
D Bridges Synchronize Branch/Tag...
0 Collaboration bl Stop ¥ Merge..
o DB Switch to another Branch/Tag/Revision...
O Error =a Open _
O File %y Delete Delete | g/  Show History
O Flow Copy B, Show Tree Conflicts
O MOMs Refrech [ Show Properties
O Performance res . .
o< | [  Show Revision Properties
amples
E ey Export.. = Show Revision Graph
[;_\ Problems ?—| ErrorLog Export To File
Orchestation Save s... Add to Version Control
[07/Apr/2011 18:14: Add to svniignore...
et Set Property...
Export Logs...
Clear Logs i
Edit conflicts...

Figure 7: The SVN option in the Event Process context menu

14.3 Checking out and Updating Event Processes

To checkout Event Processes from the SVN repository,

1. Go to the SVN Repositories View Window->Show View->0Other->SVN-> SVN

Repositories.

2. In the SVN Repositories view, right-click on the Event Process to be checked and

select Checkout option, as shown in Figure 8.

- —
E] Fiorano eStudio-/C:/Program 3.0/ runti

File Edit View Mavigate Search Toels Run  Project Window Help

i G| 80 <
< éD Team Synchronizing Eiq SVN Repositery Explering E Online Event Proce
[ SVM Repositories &2 =R | = | % 7 B |ringGoods

4 [ svni//toclsrepofstpl.com/toolsrepo/trunk/SVN_Integration_Te
> [= EstudioSvnProjects
> [= bond_trading-1.0
s |[== eai_demo-1.0@Enter---°
> [= event_processl-1.0 New ' T
s = event_process3-1.0@
s (= file_reader-1.0@Entel
» = online_syn_test-1.0@
. (= online_svn_test-1.0@ ssa Show Revision Graph
> = online-1.0@Enterpris

g Show History

Compare...

Checkout...

> = retail_television-1.0@ gcked

- [= retailautomation_spg Export...
Import...
Rename/move...
Branch/Tag...

Figure 8: Checking a project from SVN
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3. A dialog box opens asking for the project name, as shown in Figure 9. By default
the Event Process name is shown with the Enterprise Server name appended. It is
strongly advised that project names should not be changed.

- -
¥ Fiorano eStudio-/Cy/Program FIGS/FOranG/FIOraNGSOAd 3 O/runtmedata/estudio/moricpace I —

File Edit View Mavigate Search Tools Run
mig Grov[H O M
I &Y Team Synchronizing i SVN Repository Exploring

Project  Window, _Hel

¥] Checkout from SVN -‘ "L EF

[F) SVN Repositories 2 l {5 S | = | =

a [] svni//toolsrepo.fstpl.com/toolsrepo/trunk/SVM_Integrat
(= EstudioSvnProjects
> [ bond trading-1.0
(= eai_demo-1.0@EnterpriseServer
» (= event_processl-1.0
> [ event_process3-1.0@EnterpriseServer
(= file_reader-1.0@EnterpriseServer
> (= online_svn_test-1.0@EnterpriseServer
» (= online_svn_test-1.0@EnterpriseServer]l
> (= online-1.0@EnterpriseServer
» (= retail_television-1.0@EnterpriseServer
> [= retailautomation_sportinggoods-1.0@EnterpriseServi

Figure 9: Checkout As dialog

Check Out As
Select the method of check out and the revision to check out.

Choose how to check out folder eai_demo-1.0@EnterpriseServer
Check out as a project configured using the New Project Wizard
(Only available when the .projectfile does not exist in the repositong)

@) Check out as a project in the workspace

Project Name:  eai_demo-1.0@EnterpriseServer

Check out HEAD revision

Revision:
Depth: [Fully recursive -

["11gnore externals
Allow unversioned obstructions

< Back Ned> | [ Finish

] [ Cancel

Note: By default, the latest version from the repository will be checked out. To checkout
an earlier version uncheck the option Check out Head revision and click the Select
button to select the revision to be checked out.

ﬂ Checkout from SVN

Check Out As

Select the method of check out and the revision to check out.,

_F] Resource History - eai_demo-L0@EnterpriseServer

Choose how to check out folder eai_demo-1.0@Enterpris

(Only available when the project file does not exist in th

@ Check out as a project in the workspace

Project Mame:  eai_demo-1.0@EnterpriseServer

Check out as a project configured using the Mew Praj Ré...
3029 10/3/11121..
| *2—
2255 4/1/11547P...

Date Author Comment
phanikumar  v3
venkata.rao test

Initial import.

4/7/11 5:53 ..
venkata.rao

4

n

Check out HEAD revision test

Depth: [Fu\ly TECUTSive v]

Revision:

["]Ignore externals
Allow unversioned cbstructions

= ftrunk/SVMN_Integration_Test/eai_demo-1.0@EnterpriseServer [

[ ftrunk/SVN_Integration_Test/eai_demo-1.0@EnterpriseServer/s

5 .project |
5 EventProcessaxml

<

[ | b

[] Stop on Copy/Rename

[ ed)

< Back

Get All

Cancel

o J

MNext 25

Y ————————

Figure 10: Checking out a selected version
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4. Click Next button and the following page shows the workspace selection field. Use
the default workspace and click Finish to checkout the Event Process.

The Event Processes will be checked out. Refresh the Event Process Repository node to see
the newly checked out Event Process, as shown in Figure 11.

. E] Ficrane eStudic-/Cy/Program ﬁla}ﬁmpmmmhgﬂ.ﬂfmnﬁm:'{

File Edit View Mavigate Search Tools Run  Project Window H

il Gv v O -
B 5':' Teamn Synchronizing \:ﬁ SVM Repository Exploring @
E\ Server Explorer &2 = O ||={g RetailAutomation_Sporting G
BEET

4 _‘f’_ EnterpriseServer
4 B EventP I:E Add Event Process
4 = Sam
> = |
4 = 1o Open Event Process I

d['E Add 5ample Event Process 1

Import Event Process
E

s &=
s = Paste

I L
“ [&. Refresh |

of? Retail Television | | =

> [== SalesForce (1) monitorhedia
o = Trawvel (17 ProdDBE [

E &

Import Event Process (nstudic)

Figure 11: Refreshing Event Process node

Points to Note:

e During checkout, if the Event Process with the same name already exists in the
workspace, it is always advised to delete the existing project from the Event
Process Repository before checking out the project from SVN.

e Project names should not be changed during checkout unless it is required.

In Event Process project names, the name of the Enterprise Server node is used
internally. The Event Processes checked in from one Enterprise Server node cannot
be checked out in another Enterprise Server node if it does not have the same
name.

For example if there are two Enterprise Server nodes - EnterpriseServer and
EnterpriseServer2, if the user checks in an event process (say Test) from
EnterpriseServer node into a version control system, then the project
Test@EnterpriseServer is checked in into the repository.

If the user checks out the same Event Process to EnterpriseServer2, then the is
Event Process is not visible even though the checkout is successful. In eStudio
Online mode, if a project name doesn’t end with the current Enterprise Server
node name then it is ignored. So in this particular scenario user has to rename the
project name to Test@EnterpriseServer2 during checkout.
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[ Server Explorer &2 g ¥ =0
4 'F EnterpriseServer Enterprise Server node name
4 B Event Process Repository (1/18)
4 [= Samples (17)

4 = Financial (2)
&g Bond Trading
o5 Revenue Control Packet

4 [= Inventory (3) -
=g EAl Demo
ey Order Entry
o3 Purchasing System

» = Mortgage (1)

= Portals (1)

» [~ Retail (2] i

m

Figure 12: Enterprise Server node name

¢ To maintain svn information, the SVN related directories (.svn) are deployed into
the Fiorano Enterprise Server along with the other Event Process data.

e .svn folders are ignored during Event Process export into the local disk or from
Offline Perspective to Online Perspective.

e It's always a good practice to revert/commit the current changes in an Event

Process whenever trying to update it with a copy from the repository to avoid any
conflicts.
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Chapter 15: Named Configurations

Named configurations are predefined configurations which are assigned a name and stored
for later reuse. For example, if a particular routing logic (CBR component) or a
transformation (XSLT component) is reused in multiple Event Processes, each such Service
Instance has its own copy of the configuration. If a change in configuration is required at a
later point of time, then all such Service Instances have to be reconfigured. With named
configuration support, required configurations can be predefined and the name of the
predefined configuration will be associated with all Service Instances. Since the actual
configuration is stored in only one location and reused by multiple Service Instances,
making changes to the named configuration will affect all Service Instances without the
need to reconfigure them individually.

A view is provided in eStudio for managing Configurations. This view has consists of the
types of configurations sorted in alphabetical order, as shown in Figure 1.

| e |

Qs Service Reposi... ﬁ Configuration ... &3

|
Wed~eu~ B E
[= Connection Factory -
+ = Port
+ [ Resource
= Route
> = Runtime Arguments
¢ [ Selector
[ Service S
» = Transformation ...

m

Figure 1: Configuration Repository View

Configurations can be of the following types:
e Connection Factory
e Port
e Resource
¢ Runtime Arguments
e Selector
e Service
e Transformation
e  Workflow
Each configuration category further has 4 sub-categories viz, Development, Testing,

Staging and Production, referring to the four environment labels of an Event Process. For
more information, please refer to Chapter 6.

Configurations with same name can be defined for different target Environments and
corresponding configuration will be picked during configuration and run-time of an event
process based on its Environment.
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15.1 Connection Factory

To add a Connection Factory configuration, right click on Connection Factory and select
Add Configuration as shown in Figure 2.

E] Add New Configuraticn = @

Connection Factory Configuration Details

Name: TestCFI D

Environment: lDE\relopment v‘

m
o

Ned> | Finsh || Cancel

Figure 2: Connection Factory configuration details

Provide a name for the configuration in the details page. Click on Next to add Connection
factory configurations. Add the desired properties using the Add button provided in the
configuration page and click Finish to save the configuration, as shown in Figure 3.

E| Add New Configuration = @

Connection Factory Configuration: TestCF

Name Value Add
ConnectURL localhost1867

XAEnabled true m
TransportProtocol TCP Move Up

fove Down

< Back Next > [ Enish ][ concel |

Figure 3: Connection Factory Configuration

Once the configuration is saved in the repository, it can be used to provide Execution
Details of a Service Instance. To use a named configuration for the Connection Factory
properties, select a Service Instance and go to the Execution tab in the properties view.
The property Configuration lists the names of all available Connection Factory
configurations. Select the configuration to be used and the corresponding Connection
Factory properties will be fetched from the named configuration selected.

These properties can be viewed in the Connection Factory Properties table as shown in
Figure 4.
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E Properties &2 =~ =0
General Execution Type: Separate Process e
Deployment Prefer First Node: Yes %
Execution Kill Primary: Yes i

Leg Manager

Leg Meodule Instances Debug Mode: Mo i
Runtime Arguments Debug Port: 5000
Buffer Limit: 524288
Configuration: TestCF =
Connection Factory Proj<Mone» !g
Name Value Add
ConnectURL localhost:1980
XAEnabled true Bemovs
TransportProtocol TCP

Figure 4: Service Instance Execution properties

Note: When the Connection Factory named configuration is used, the properties in the
named configuration are grayed out to prevent editing. To modify these properties, edit
the configuration from the Configuration Repository view if the changes need to be
applied to all the components using that particular configuration or use the default
configuration (with the required values).

15.2 Port

In the Configuration Repository view, right click on Port and select the Add
Configuration option to define a named configuration port, as shown in Figure 5.

E] Add New Configuration |

Port Configuration Details

MName: test D
Environment: [Deve\opment ']
Type: Input -

Destination Type: [Queue ']

<Bock || Net> |[ Enish ][ Cancel

L

Figure 5: Port Configuration details

Provide details of the configuration name, environment, port type and destination type and
click Next.

Note: The configuration defined for a particular environment can be assigned to elements
in an Event Process only when the Event Process is in the same environment as that of the
configuration.
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_F] Add New Configuration o X

Input Port Configuration: test

[]1s transacted

Number of Sessions: |1 [:]
Acknowledge Mode: | Dups OK v]
Message Selector: =

Mext > [ Einish ] [ Cancel

Figure é: Input Port Configuration

Provide the port messaging configurations such as transaction details, Number of Sessions,
message selector and so on and click Finish to save the configuration as a Named
Configuration as shown in Figure 6.

Once Named Configurations are added to the repository, a User has the choice to either
define Port properties or to refer to an existing Port Named Configuration of the same
type. This option is provided in the Messaging tab of Port properties.

In Figure 7 when the input port of a component (chat2) is selected, the property
Configuration lists all the available input port Named Configurations. By default no
Named Configuration is used and the property is set to <None>.

When a configuration is selected, the configuration details are loaded and the property
fields are then grayed out to prevent further editing.

(= til
- e
= WebService
chat2
route

B Properties 2 [

General Configuration: test -

JMS Destination | Trancacted: H

Messaging Transaction Size: 0 3|
Mumber of Sessions: 1 E]
Acknowledge Mode: Dups OK -
Durable Subscription: No -
Subscription Name: E]

Figure 7: Configuration selection in port properties

15.3 Resource

The Resource Configuration points to the part of the component configuration that is
applicable to more than one component. Resources such as XSD schemas come under
Resource Configurations as well.
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For example, the Database Connection Configuration can be applied to all database
components in the Database category in the Service Palette.

To define a resource configuration, right-click on Resource in the Configuration Repository
view and the select Add Configuration option. A dialog is displayed as shown in Figure 8.

_E] Add New Configuration CIR

Resource Configuration Details

MName: testResource E]
Environment: | Development v]
Type: ConnectionCenfiguration -

ConnectionConfiquration

ConsumerConfiguration (i
DBConfigurations B
DestinationConfiguration

DoTD <

< Back Mext = Finish

[ 4

Figure 8: Resource Configuration

Provide basic details of the configuration and select the type of configuration required.
Properties are automatically updated on the next page depending upon the type of
configuration selected.

Click Next and provide configuration details that need to be filled in and click Finish to
save the configuration, as shown in Figure 9.

.
E] Add MNew Configuration L@ﬂ

ConnectionConfiguration: testResource

Component Configuration

Server URL: http://localhost:1867
Backup URLs Required [
CF lookup name: PrimaryCF
IMS username: ayrton
IMS password: ssnne
Description

Place cursor on a property to view its description

Mext = [ Finish ] [ Cancel

L

Figure 9: Connection Configuration
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The configuration type Connection Configuration is saved to the repository and can be
used by components that have Connection Configuration as part of their configuration
settings.

Open Custom Property Sheets of a component that has Connection Configuration details
could be, for example, JMS: 4.0. Click the ellipsis button against the Connection
Configuration property. This launches the dialog box shown in Figure 10.

[ E] JMSInl - ConnectionConEg —— ﬁ“
Mamed Cenfiguration
() Load from Load
) Save to

Component Configuration

Server URL: http://localhost:1856
Backup URLs Required [
CF lookup name: PrimaryCF
IMS username: ayrton
IMS password: [TYTY)
Description

Place cursor on a property to view its description

oK l [ Cancel

A

Figure 10: Connection Configuration

By default, no named configuration is used. To use a Named Configuration, select the
Load from option and type the configuration name and click the Load button to load
configuration details, as shown in Figure 11.
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P S —— —_—— |
_F] JMSIn1 - ConnectionConfig Iﬁ

Mamed Configuration

testResource

) Saveto

) Mone

Component Configuration

Server URL: http://localhost:1867
Backup URLs Required []
CF lockup name: PrirmaryCF
IM5 username: ayrten
IM5 password: [ITTT)
|
Description

Place cursor on a property to view its description

OK ] [ Cancel

e

Figure 11: Loading Configuration

Similarly, a resource configuration can also be created using the Save to option in the
Named Configuration section.

15.4 Route

A route configuration can be created using the Add Configuration option in the
Configuration Repository view. Route Configuration contains route specific properties such
as Compress Messages, Encrypt Messages and Durable Subscription.

] Add New Configuration l 5], -

Route Configuration: testRoute

[7] Compress Messages
[“] Encrypt Messages
7] Durable Subscription

Mext » [ Finish ] [ Cancel

kL

Figure 12: Route Configuration

To use a route named configuration on a route, select the route and in the route properties
move to the Messaging section. A property called Configuration lists all route named
configurations.
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Select the configuration required. The corresponding configuration properties are
automatically updated, though grayed out to prevent editing, as shown in Figure 13.

£ Properties £2 — = =g
General Configuration: testRoute =
i testRoute

Messaging Compress Messages: <Mones
Selectors

E t M : No =
Transformation nerypt Viessages

Durable: Mo =

Figure 13: Selecting Route Configuration

15.5 Runtime Arguments

To add Runtime Arguments Named Configuration, right click on Runtime Arguments in
the Configuration Repository view and select the Add Configuration option. A dialog box
is displayed as shown in Figure 14.

¥ Add New Configuration B
Runtime Arguments Configuration Details
Marne: testRuntime ]
Environment: [Development vl
Guid: a
Version: <MNone> =
< Back Net¢> || Finish || Cancel

Figure 14: Runtime Arguments Configuration

In addition to basic details such as the configuration name and environment, this page
contains the Guid and Version fields.

Few components like Sender, Receiver and so on contain component specific runtime
arguments. To provide these component specific runtime arguments the User must select
the components Guid and Version. If no Guid and Version are selected then the common
runtime arguments will be shown in the next page.

Click Next to provide values for runtime arguments and click Finish to save the
configuration, as shown in Figure 15.
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F ™
) Edit Configuration [ 5] éj
Runtime Arguments Configuration: testRuntime
Mame Yalue
{JVM_PARAMS -client -DLOG_TO_STREAM=true -Xrs
JAVA_HOME
[ Finish J [ Cancel
| -

Figure 15: Defining Runtime Arguments Configuration

To use Runtime Argument Named Configurations, select a component and in the properties
view move to Runtime Arguments section.

The property Configuration lists all available Runtime Arguments configurations. Select
the configuration. Properties corresponding to the configuration are loaded automatically.
The properties entered are grayed out to prevent further editing, as shown in Figure 16.

£ Properties 3 = < =0
General Configuration: testRuntime T
Tl JNLPARANS E_
Execution

Log Manager Other Arguments:

Log Medule Instances Mame Value

Runtime Arguments JAVA_HOME

Figure 16: Using Runtime Arguments Configuration

Chapter 15: Named Configurations Page 225



Fiorano eStudio User Guide

15.6 Selector

Message selectors on the route being used can be defined in Edit Configurations. To add a
configuration, right click on Selectors in the Configuration Repository view and select the

Add Configuration option. The required selectors can be defined and saved as a Named
Configuration using this dialog box displayed in Figure 17.

) Edit Configuration I. =] ﬁl
Selector Configuration: testSelector
Sender: chatl [:]
Ims Selector: 'PropertyMame'='PropertyValue' E]
Message Body XPath: E]
Application Context XPath: [:]
Finish ] ’ Cancel

Figure 17: Selector Configuration

To use the selector on the route being used, navigate to the Selectors tab in the Route
properties section and select the Named Configuration from the drop down menu in the
property Configuration. The fields of the properties entered are grayed, as shown in
Figure 18, so that they can not be edited. The properties entered are selected at runtime.

1 Properties i3
e Configuration:
Messaging Sender: hatl
Selectors
Transformation IS 'PropertyMame'="PropertyValue'
Message Body XPath:

Application Context XPath:

Figure 18: Using Selector Configuration on route

15.7 Service

To add a new service configuration, right click on Service in the Configuration Repository
view and select the Add Configuration option. Select the Guid and the Version of the
service. Few components like FTPGet have multiple configuration types. Select the
appropriate type and click Next, as shown in Figure 19.
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] Add New Configuration Llﬂl-'-‘:_hj

Service Configuration Details

Mame: testService E]
Environment: [Development V]
Guid: o
Version: 40 i
Type: FileReaderCenfiguration -

< Back Next > e

=

A

Figure 19: Service Configuration

To demonstrate the addition of a New Configuration, the FileReader is used as an example
and the FileReader configuration details are displayed. Click on Next and the values of
the configuration. Click Finish to save the configuration, as shown in Figure 20.

E] Add New Configuration Llﬂlﬂ_hj

FileReaderConfiguration: testService

Compoenent Configuration

Is configured for different machine 7 [

Compute Paths relative to Directory:

File name "t

Seurce Directory D:\Demo

Use Working Directory

Working directory D:hDermociwork

Process Pending Files in Working Dir

Error Directery D:\vDemcerror
Descripticn

Place cursor on a property to view its description

MNext > Finish ] [ Cancel

e

Figure 20: FileReader Configuration

To use the newly added configuration, open the Custom Property Sheet (CPS) of the
component and click on the ellipsis button against the property FileReader
Configuration, as shown in Figure 21.
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- y
T FileReadert [FileReader4.0] B

Interaction Configurations

@ Working Directory and Source Directory cannot be the same

[] Show Expert Properties
Attributes 2
Is file Binary 7 ]
FileReader Configuration Click ... te edit
Paostprocessing Action [NO_ACI'ION v]
Output 50 Click ... to edit ()
Menitoring configuration Click ... te edit ()

Figure 21: FileReader Custom Property Sheet

The FileReader Config dialog box is displayed. Select the Load from option and add the
configuration name. Click on the Load button to load the configuration details. Provide
additional configuration details for the FileReader and click on Finish to save the CPS
settings. The named configuration that is referred by the component will be used by the
component both at the time of configuration and at the runtime.

If the configuration property is a manageable property then it can be viewed from the
Environment Properties section within the Event Process properties.

| Properties 23
General Target Environment: Development -
Application Context Property Value

Environment Properties FileReaderl

Configuration Properties:

Post Processing Action MO_ACTION

Pre Processing Argurnents

Post Processing Directory

FileReaderConfiguration  Click .. to View
Instance Properties:

Modes fps

cache true

Figure 22: Event Process Environment Properties

As shown in Figure 19, clicking the ellipsis button against the property
FileReaderConfiguration launches the FileReader configuration dialog box (referred to
above).
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15.8 Transformation

The Transformation configuration can also be defined as a Named Configuration and be
used routes. To define a Transformation Configuration, right click on Transformation in
the Configuration Repository view and select Add Configuration option, as shown in
Figure 23.

F B
ﬂ Add MNew Configuration uﬂlﬂ

Transformation Configuration Details

MNarne: testTransformation E]

Envirenment: | Development vl

[ Finish ] [ Cancel

A

Figure 23: Transformation Configuration

If the Use Custom XSL option is selected, on clicking Finish a new dialog box (Custom
XSL dialog) is displayed. Provide custom XSL and other configuration details and click on
Ok to save the configuration as a Named Configuration, as shown in Figure 24.

)
_F] Custom XSL ﬂ
MetaData XSLT Engine

H5L IMS K50
ek#

<Txml version="1.0" encoding="UTF-8"7>
<xslstylesheet version="1.0" exclude-result-prefixes="xalan java hslt” extension-element-prefixes="datetime
set math dateConversion myext strings” xmlns:math:"http:_a‘_a’exslt.Drgg‘math"l
xmins:xalan="http://xml.apache.org/xslt" xmins:set="http://exslt.org/sets"
xmins:java="http://xml.apache.org/xslt/java” xminsxsi="http:/fwww.w3.org/2001/XMLSchema-instance”
xmins:lxslt="http://xml.apache.org/xslt" xmins:datetime="http://exslt.org/dates-and-times"
xmins:xsl="http://www.w3.0rg/1999/X50/ Transform” xmins:ns2="http://www.w3.org/2001/XML5chema”
wminsidateConversion="extl" xminsimyexdt="exd2" xmins:strings="ext3">
<xshoutput method="xml" indent="yes" encoding="UTF-8" lxsltindent-amount="2"
|| omit-xml-declaration="no"» </xsloutput> o
<xskvariable name="document” select="/"> < fuskvariable=
<xslvariable name="document_OUT_PORT" select="document{ OUT_PORT")"> «/xskvariable>
<xshtemnplate match="/">
< ChatMessage>»
<Sender>
<MName>
sarmlismliim mF mmlm b T A i + AT DODT Al athdmrr e m T mm A me IR mimm =" o faombinamlinm ~fe

| »

m

[ ok || Ccancel

L ——

Figure 24: Custom XSL dialog
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If the Use Custom XSL option is not selected, the Mapper project will be opened. Enter
both Input and Output schemas and save the transformation. This transformation will
then be saved as a Named Configuration.

To use the Transformation Named Configuration, right click on a route and select the
Configure Transformation > Use Named Configuration option, as shown in Figure 25.

‘ Edit v
Interceptor 4
[} Properties Ctrl+Alt+V, P L= Errar
chatl .
= File
Save Selection As... e
ow
< Undo Route creation
= MON
Redo
== Perfo
Run As 4 (= Samp
Debug As » (= Script
Team 3 (= Trans
Compare With 3 (= Util
Replace With 3 (= Web
Clear Transformation = Webs
Save Configuration As... Console 532
Configure Transformation 4 Mapper Project
(1 Custom XSL

Use Named Configuration

Figure 25: Using named configuration on route

A dialog box is displayed where the configuration to be used can be selected, as shown in
Figure 26.

© N

F) Select Configuration 2|

Configuration: testTransformation -
testTransformation

[0k lone> ,

L™ )

Figure 26: Selecting transformation configuration
Select the configuration and click on OK. The configuration selected will be applied on the

route. The route is shown in bold indicating the Transformation. The route name is shown
in bold indicating the Named Configuration used, as shown in Figure 27.

routel

chatl

Route label bold indicating named
configuration

Figure 27: Route using a named configuration
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Transformations that are already defined on a route can also be saved in the Configuration
Repository. To save a route’s transformation as a Named Configuration, right click on
the route and click on Save Configuraiton As..

_‘/,,’—"i—_l -fn: o

—|
CIJ et 3
Feederl [ Properties Ctrl+Alt+V, P

Save Selection As...

<% Undo Transfarmation

Redo

Run As 2
Debug As 3
Profile As k
Team 3
Cormpare With 2
Replace With 3

Clear Transformation
Save Configuration As... %

Configure Transformation 2

Figure 28: Saving a Route Transformation as a Named Configuration

The Save Transformation Configuration dialog is opened. Provide a name for the
configuration and save. A new Transformation Configuration will be added to the
Configuration repository and the route name will be shown in bold to indicate that a
named configuration is used

15.9 Workflow

The Workflow Configurations to be used on a component port can be defined as Named
Configurations. To define a Workflow Configuration, right click on WorkFlow in the
Configuration Repository view and select the Add Configuration option. Enter the
configuration name, select the environment and click the Next button. Enter values for
Work Flow Configuration and click Finish to save as the Named Configuration, as shown in
Figure 29.
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i B
F) Add New Configuration e )

WorkFlow Configuration: testWorkflow

Workflow: | [IEIEEIEE -

Workflow Data Type:

Select the item(s) which are applicable:

&
[[] Message Header
[¥] Message Body
[7] Attachments
[T] Application Context

Next > | Enish || Cancel

Figure 29: Workflow Configuration

To use the Workflow Named Configuration, select a component port and in the Properties
view. Select the configuration as shown in Figure 30. The configuration will be applied on

the selected port.

= Properties &2 I B Mapper Console|

—
General Mame: IN_PORT
JMS Destination Coenfiguration: testWorkflow
Messaging
| Workflow: <Maone>
Workflow Data Type: Body;

Figure 30: Using workflow configuration on port

15.10 Context Menu Options

On selecting a configuration, the following options are available in the context menu in the
Configuration Repository View, as shown in figure 31.
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By Service R 5] Configur.. 53

RS-~ @ E

= Connection Factory -

4 = Port
& = Input
4 = Development B
-—
|oe bES
# [2 Resource Export To Local Disk
4 = Developmd Export To Server
[ Connes m
= Route Save As...
= Runtime Argui Rename..
] Problems 52 | @ FII'II'..| Usages...
0 iterns Assign To...
Description Clear Usages..
Edit...
Delete

Figure 31: Context menu options

1. Export to Local Disk

Select the Export to Local Disk option to export the configuration to the local disk. The
configuration will be stored in a zip file.

2. Export to Offline

Select this option to export the Named Configuration Offline. The Export to Server
option is available in the Offline mode.

3. Save As

Save As is used to save the configuration under a different name.

4. Rename

The Rename option is to rename the configuration.

5. Find Usages

Find Usages is used to view the usage of a particular Named Configuration. The usage
of Named Configurations are listed in a tree format. A sample of configuration usage is

shown Figure 32.

-

E_] Configuration Usages

|

?

=S Simple Chat [1]
= Service Instances

4, chatl

G& Input
@ IN_PORT [test]

A

-

Figure 32: Configuration usages dialog

6. Assign To
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A Named Configuration can also be assigned from the Configuration Repository view.
To assign a configuration, right click on the configuration and select the Assign To...

option, as shown in Figure 33.

| @y Service R... E Configur... 2 = O

" I:i -
= Connection Factory
4 (= Port
4 = Input
4 = Development
[ test
4 = Resource
4 (= Developm
[& Conne
(= Route
(= Runtime Argu

1 Problems &2 |
0 tems

Description

2~ B E

Export To Local Disk
Export To Server

Save As...
Rename..
Find Usages...
Assign To...

Clear Usages..

Edit...
Delete

Figure 33: Assigning configuration from repository view

A dialog box is displayed listing all the valid entries to which the selected configuration
can be assigned, as shown in Figure 34.
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E] Assign test Configuration I&

4 [H|=g Bond Trading [15] -
4 [H| = Service Instances
4 [7]%, Convert_Isin_List
a [V 5@ Input
e IN_PORT
a [ % Generate_Price
4 [ & Input
] @ IN_PORT
[]  PRICE_ERROR_GEMERATOR_CLOCK
[[] » PRICE_GEMERATOR_CLOCK
. [T %% Isin_Price_List
. [7]%% Read_Isin_List
. [[]%%; Rfg_Boston
. [[]%% Rfg_London
. [ %% Rfg_Singapore
. [[]%% Route_Quote
> Dﬂ;, Split_Data_inte_Individual_Isin
. [7]%% Track_Price_Change
. 1% Wrong_Rfqg
- [T]=g CompositeBC Demo [2]
- []={g Database Replication [7]
. [7]={3 DB Transaction Support [17]

. []=g EAI Dema [4] 8

m

OK ] ’ Cancel

b "]

Figure 34: Assign configuration dialog
Select the entry to which the configuration is to be assigned and click on OK.
Note:

a. The Assign To... option will not list an entry if the configuration entered is
already assigned.

b. The Assign To... option is not present for the Service and the Resource
configurations since these cannot be directly assigned from this view.

c. The Assign configuration dialog only lists those Event processes that are not
running and those which have same target environment as the selected
configuration.

7. Clear Usages

The Clear Usages option clears the configurations used. On selecting this option all the
usages are displayed in a tree. Select the configuration usages to be cleared and click
on OK as shown in Figure 35.
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ﬂ Clear test Configuration Usages ﬁ

4 |73 Bond Trading [1]
4 [J][= Service Instances
4 [, Convert_Isin_List
a [V @ Input
& IMN_PORT [test]
- [C]={g Simple Chat [1]

| ok || Concel

b .

Figure 35: Clear configuration usages

Note: The Clear Usages option is not present for the Service and the Resource
configurations. The Clear Usages option clears the usage of configurations and resets
usage to the default settings.

8. Edit
The Edit option edits existing configurations.

Note: If a configuration is edited at runtime it can require that the Component or the
Event Process be restarted.

9. Delete

The Delete option deletes the configuration.
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15.11 Points to Note

1. If an Event Process uses a Named Configuration, when it is export all the
Named Configurations used by the Event Process will be listed. Users can
select the configurations that are to be included in the Event Process export, as
shown in Figure 36.

) Export Event Processes Ta Lacal Disk l . (=] ﬁj

Export location and configurations

Export To
ChUsers\phanitDesktoptsimplechat-1.0@Enterprise5erver.zip E]

Select configurations to be included in the export:

[]=g Simple Chat
test
testService
testWorkflow

Finizsh ] ’ Cancel

L

Figure 36: Export Event Process dialog

If an Event Process uses Named Configurations and if these are deleted from the
repository, then during the export of the Event Process a visual symbol indicates that the
Names Configurations are missing from the repository. Figure 37 show a configuration
called testRuntime that is missing from the repository.
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il "I
!_] Export Event Processes To Local Disk [ (=] ﬂj

Export location and configurations

Export To
I\ Users\phani\Desktop\simplechat-1.0@EnterpriseServer.zip E]

Select configurations to be included in the export:

[ =15 Simple Chat
test
testRuntime
testWorkflow

Finish l ’ Cancel

b

Figure 37: Export Event Process listing missing configurations

When an Event Process is import, all configurations present are listed. If the configurations
already exist then they will be shown in red color and the user is provided with options to
either overwrite or not import the configuration displayed.
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2. To view all the configurations used in an Event Process, right click on Event
Process and select the Show Configuration Usages option as shown in

Figure 38.
e DB Transaction Support
=g Simple Team
» i Peer Repositor i
Compare With
Restore from Local History...
Check Resources and Connectivity
Q FRun

Service Reposi...

E
= Caonnection Facto

= Port
[= Input
test
= Resource

= Route

Problems | 9] Error La
hestration

BG &

L.

Synchronize
Stop

Open
Delete
Copy
Refresh
Export...

Export To File

Save as...

View Logs...
Export Logs...
Clear Logs

Show Configuration Usages

i

Figure 38: Show configuration usages option on Event Process

All the configurations used are displayed, as shown in Figure 39.
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) Configuration Usages EIEI&J

o3 Simple Chat [3]
= Service Instances
., chatl
& Input
@ IN_PORT [Subscribertest, Workflow:testWorkflow]
4, FileReaderl
[= Configurations
Service (Development:FileReaderConfiguration) [testService]
Senvice [testSenvice]

A

Figure 39: Event Process configuration usages

3. The Undo support is present for the Assign To and Clear Configuration
actions. This option is present in the Configuration Repository view toolbar and
displayed in the toolbar only when a configuration is assigned from this view.
Please refer to Figure 40. Note: This option should be used with care.

O Service Reposi... | | Configuration .. &2 — O

i |"- b vesr @ E
[= Connection Factory -
4 = Port
4 [= Input
test
» [ Resource
[ Route
» = Runtime Arguments

m

Figure 40: Undo Assign/Clear configuration

4. A configuration defined in a particular environment can be applied to elements
in an Event Process only if the Event Process is within the same environment.
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Chapter 16: Connection
Management

The Connection Management tool is used to manage both Admin and JMX connections to a
Server. To open the Connection Management dialogue box click Window - Open
Perspective - Other and select Connection Management.

The dialogue box displayed consists of three views - the Server Connections view and the
Properties view and the Explorer view, as shown in Figure 1.

E] Fiorano eStudio-/C:/Program Files/Fiorano/FioranoSOAS.4.2/runtimedata/eStudio/workspace/ ‘ = |E = |
File Edit MNavigate Search Run Teols Project Window Help
(i SR = L Y EE= O
ﬂ Server Connections &% @ F 7 T O| B Properties &3 = :=:g> i
& FES * || Property Value o
& Clients General
@ Connection Factories Name FES
Destinations Is Alive Yes
 Queues FMQ Connections
& IMX_CONNECT_QUEUE Create Admin Connection true =
i JMK_SERVICE_QUEUE L Create IMX Connection true
& PRIMARYQUEUE JNDIInitial Context
d SECONDARYQUEUE Provider URL hitp://localhost:1847
 SYSTEM_DEADMESSAGES_QUEUE Security Principal admin
o Topics Security Credentials e —
Loggers JNDI Lookup
Security ACF PRIMARYACF
= Snooper m TCF PRIMARYTCF
L FES-IMX QCF PRIMARYQCF
& FMQ Authentication
L FMQ-IMx User admin
@] Error Log 2 | B Console - o S = . S 3
Workspace Log : B @ v
— | Explorer 2 a4~ 70
type filter text
J FES
Message Plug-in
FES
%%Connection Factories
&3 Clients
51 Destinations
Bitoggers
Securit)r
o = - %Snooper
e General 14M of 39M m

Figure 1: Connection management perspective

e Server Connections: Displays the connection nodes through which connections
(Admin/IJMX) are made to the Server.

Each Server Node displays the Shutdown and Restart options by right-clicking over the
menu.

e Actions on the View Toolbar:

o New Fiorano JMX Connection: This option is used to create a new JMX
connection Login node.

o New Fiorano Server Connection: This option is used to create a new Admin
Connection Login Node.
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e Explorer: The Explorer provides a collective view of multiple similar elements. The
view provides a birds-eye view of all the children of a selected element and their
properties. For example, if the user logs in to an Admin Connection to an Enterprise
Server, clicking the Connection Factories node under FES node will show a list of all the
connection factories and their properties in the Explorer view. (Refer figure below)

' Explorer &2 @ 4 ¥ =0

I J FES ‘b] I 4% Connection Factories'\L
1

Connection Factories MName Type XA Enabled  Connection URL Description Auto Update  *
ﬁ SECOMDARYQCF QueueConnectionFactory  false null QueueConnecti... true =
&% RT.. SERVICEPROVIDE.. TopicConnectionFactory —false http://192.168.2.31:1847 true

&2 SERVICEPROVIDERCF ~ SERVICEPROVIDE.. CommonConnectionFa... false http://192.168.2.31:1847 true

&5 PRIMARYLQCF PRIMARYLQCF QueueConnectionFactory  false null LPC QueueCon.. true

&2 FPS FPS CommenConnectionFa..  false http://192.168.152.1:1867  ESB system-cre...  true

&% PRIMARYLTCF PRIMARYLTCF TopicConnectionFactory  false null LPC TopicConn...  true il

Figure: Explorer View
The view also has Up, Back and Forward actions to facilitate easy navigation through the
nodes in the tree.

e Properties: All the properties for each administered object from the Server
connections view is displayed in this view.

e Actions on the View Toolbar:
o Show Advanced Properties: This options is used to show/hide advanced
properties if available for any selected node.

The ‘&’ icon is displayed beside the value of the property to indicate that there has been a
change from in the value of the property from its default value.

16.1 Admin Connection Management

Administrative Connection to a Fiorano Server (FMQ/FES /FPS) enables performing tasks
such as tracking clients connected to the Server, managing destinations and connection
factories, snooping messages on a queue or topic, viewing logs and so on.

1. To login into a server, select the server node and in the properties view to specify
the required connection properties, right-click on the node and select Login.

2. After Login if both the Admin and the JMX connections are successful, then six
child nodes are displayed under the Server node.

a. If only the Admin connection is successful five nodes, excluding the logger
node, will be displayed under the Server node.

b. If the JMX Connection is successful, only the Loggers node is displayed as
a child of the Server node.

Given below is the description and usage of each node under the Server node (including
FES/FPS/FMQ).

1. Clients: All the clients connected to the Server are displayed under this node.
Option Available:

a. Refresh: This option refreshes client connections. Client connections made or lost
after login are reflected in the tree diagram only when the Clients node is
refreshed.
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b. Purge: This option is used to purge or clear messages on a Topic subscribed to by
the client for messages, as shown in Figure 2. This action is useful for the durable

subscriber when it is in an inactive state.

Iﬂ Server Connections &3
=-F FES

=82 Clients

!

87 Fes
%%- Zonneckion Factories
Destinations
[E Logagets
Security
% Snooper
L FES-IM:

& FMG
Ll FMQ-2M
& FP3
I

Purge

Figure 2: Purge Messages

2.

FERE

Connection Factories: The default connection factories provided by the Server are

initially displayed under this node. [Semantic check please]

New Connection Factories can be added by selecting the Add Connection factory option
by right-clicking this node, as shown in Figure 3.

EI Create Connection Factory

Marme: ! OMMECTIONFACTORY !
Tvpe: | CueueonnectionFackory b |
=8 Enabled; |False L |

Conneckion URL: | rull |

Description: i rull

Auka Update |False W |

64 ][ Cancel ]

Figure 3: Create connection factory dialog

Right-click on the Connection Factory menu to delete the Connection Factory.

Destinations: The destinations created in the Server are displayed under this node

under Queues or Topics categories.

New Queues/Topics can be added by selecting Add > Queue /Topic and right-clicking
the Destinations node or by selecting Add Queue/Add Topic on the Queues and Topics

nodes, as shown in Figure 4.
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[i! Create Queue

Narme: | QUELE

Description: |

Skorage Type:

| Default Database

ReplicationEnabled: !‘fes

| ok

J [ Cancel

Figure 4: Create Queue dialog

Actions Associated with Queues andTopics

EditACL: This option is used to add Users to the Access Control List (ACL) where
Permissions may be edited.

For adding a new ACL Entry, click Add in the EditACL dialog box, as shown in Figure 5.

ACL
EVERYOME

Permissians

CanF.eceive, CanBrowse, Cansend

3| Add New ACL Entry
G RTION
MORYMOUS
FP51
MICHAEL
ADMIN
SCOTT
FPS
BCE
GLESTS
EVERYNODE
PRODUCTION EMNGINEER
MAINTEMNAMCE
ADMINISTRATORS
WORKFLOMW COMPOSER
TECH SUPPORT TEAM

OK, ][ Cancel J

Add...

[

Ok

_] [ Cancel

Figure 5: Edit ACL dialog

To edit a new ACL Entry, select the ACL to edit and click on Edit. The Edit Permissions
dialog box displayed, as shown in Figure 6.
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| EditacL

ACL
EVERYOMNE

Permissions
CanReceive, CanBrowse, Cansend

AYRTON

' Edit Permissions

Permissions
Send
Browse
Receive

allowy
default
allon |

default
disallow .

L Ok J [ Cancel

X

] [ Cancel

Figure é: Editing permissions

Subscribe/Receive: This option is used to subscribe or receive messages on a
destination. A dialog box is displayed, as shown in Figure 7, containing subscribed or

received messages.

B Subscri ber[PRIMARYQUEUE]

Max Buffer Size (KB): | 1024

[ Discard incaming messages when buffer overflows

Message Persistent Size JmsTimeStamp Header:
TextMessage true 103 Mon Mar 28 20:27:04 15T Prenett Yalie
TextMessage brue 105 Mon Mar 28 20: 27106 157 2L
i - Tiue 07— Thon BN | Vessage Number
JM5Messagell rull
Destination Fiorano JMS Queue | PRIMARYQUELE
Reply To rull
Priority 4
Correlation 1D null
Redelivered false
Size 107
ISTimeSkamp Mon Mar 28 20:27:09 15T 2011
Expiration Time
IMSMessageType TextMessage
Persistent true
Message Body Fiorano
€ 11l | B
£ 1[I | ¥ | Properties:
Source | Tree |
Property Yalue
Fiarana
| i J 1il | l
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Figure 7: Subscribe messages dialog

Browse Messages: This option is used to view messages on a Queue.

Produce Text Message: This option is used to send/produce messages on a Queue

or a Topic.

Delete: This option is used to delete a Queue or a Topic.

Loggers

Users that are logged in are allowed to view and manage Server logs. For example, the
node Fiorano, which is a child node, contains all the Fmqg and Esb related events to
which an Appender or a Console Appender may be added. The same functions may be

added to the Monitoring and the WebManagement nodes.

a. To add an appender right-click on the logger and select Add ->File or Console

Appender. A dialog box is displayed where New File Appender/Console

Appender properties may be added .Enter the Values and click on OK to create

the Appender.

b. To View/Clear Logs of an Appender right-click and select View Logs /Clear

Logs.

c. To delete an Appender, right-click on the appender and select Delete.
5. Security:
Groups and Users created for access control are added under this node.

a. To add a new Group, right-click on Groups and select Add Group.

b. To edit the members in a Group, right-click on a Group and select Members. A
dialog box is displayed, as shown in Figure 8, where new Users or Groups may

be added.

£ scotT

£ BoB

£ Frs

B EVERYNODE

T WORKELOW COMPOSER
£ ANONYMOLS

B MATNTENANCE

B PRODUCTION ENGINEER,
£ avrTON

£ MICHAEL

B EVERYOME

B TECH SUPPORT TEAM

£ Frs1
B cUESTS

£

Zancel

[ o4 ] [ Cancel
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Figure 8: Add members dialog
c. To add a new User, right-click on Users and select the Add Users option.

d. To change the password of a User, right-click on User and select Change
Password. A dialog box is displayed, as Shown in Figure 9, where the
password can be changed.

B3| Change Password

2ld Password | |

|
Mew Passwaord | |
|

Confirm Password |

Ok, H Cancel ]

Figure 9: Change password dialog
6. Snooper

The Snooper function enables the replication of messages under a Queue/Topic to
another Queue/Topic.

The Queue/Topic on which snooping is desired can be added by right-clicking on
Snooper/Queues/Topics nodes and selecting Add/Remove Destinations option. A dialog
box is displayed, as shown in Figure 10, where the destination list is displayed.
Destinations may be added or removed from this list.

K3 Add/Remove Destinations
Add From: Remove From:
o FES_SYSTEM_EVENT _TOPIC A B PRIMARYCQUEUE

o FES_USER_EVENTS_TOPIC
B M _COMNECT _OUELE

B MY _SERVICE_QUELE
of PEER_REQUEST_TOPIC
o PEER_RESPONSE_TOPIC
LBPRIMARYTORTC
™ REPEATER_QUERY_TOPIC
of sew_STATE_TOPIC

B SECOMDARYCLEUE
o SECONDARYTOPIC

B S5v¥STEM_DEADMESSAGES_QUELE
o SYSTEM_MESSAGESMOOPER_QUELE
o SvSTEM_MESSAGESMOOPER_TOPIC

¢ |

0k ] [ Zancel

Figure 10: Add/Remove destinations
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16.2 JMX Connection Management

The JMX Connection Management lets the User connect to a JMX complaint Server such as
FMQ-IJMX/FES-IJMX/FPS-JMX and perform tasks like browsing Server mbeans, monitoring
data, changing Server properties runtime and so on.

Changes made using JMX are applied on the Server that is running. Some Server
configurations (such as server ports, memory settings and so on) are applied only after
restarting the Server. A message dialog box instructing the Server be restarted is
displayed when required.

To log into the Server, select the JMX Server node. In the properties view specify the
required connection properties and right-click on the node and select Login.

On successful login, the JMX tree containing domains (**) and mbeans ( ¥ and IPE') is
displayed, as shown in Figure 11.

®,| Server Connections 3 ld F T T B || = properties 52
& FES “ || Property Value
L FES-IMX a Attributes
& FMQ DepthMonitoringEnabled false
il FMQ-IMX DepthMonitoringlLevels null
& FPS LoadBitSetOnStartup FALSE
4 | FPS-IMX UselnMemStatusCache TRUE
4 Eﬁh JMXCD”"TECtiDH Cleanuplnterval 60000
> °°‘; C.ontalrler IsDbCleanupEnabled FALSE
4 &% Fiorano EnableSnooper DEFAULT
> o Esh EnableDMQ DEFAULT
f clc EnableGMSQueucExpose FALSE
& Jrn InMemoryBlockingInterval 10
> &% jndi JumpDeletedFiles FALSE
» o Loggers PersistentinMemoryBufferSize 524288
4 & mq ) E InMemoryBufferSize 1048576
> ow connection-consumer MaxPushAttempts 54
a & ptp WaitBetweenAttempts 16
» o databases Enablelournaling false
» £3 PtPManager DMQExpiryTime 0
4 & Queues EnableMotificationOnDeadMessage falze

4 [ Queue
o (@ "JMSH_LMS_QUEUE"
» (@ "JMX_COMMECT_QUEUE"
> (@ "JMK_SERVICE_QUEUE"
a [@ "PRIMARYQUEUE"
@ config
. (@ "SECONDARYQUEUE"
. (@ "SYSTEM_DEADMESSAGES_QUEUE"
» &% pubsub

Figure 11: JMX Login node

Using the JMX connection a User can invoke JMX operations or change the Server
properties at runtime.

1. Invoking JMX operations
To invoke an operation, right-click on an MBean and select View Operations. The View

Operations option is present only if the MBean has one or more operations, as shown in
Figure 12.
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4 | FPS-IMX
4 ﬁ: IME Connecticn
» &% Container

4 & Fiorano

» o Esb

4 o etc
4 [ AdminService
@ Adminservics

m

» [ AuditManager View Operations

| .n':".l..ldltSENICEME S

» 3 ClientLogManal, ~
» 3 ExNamingManager

» (1 BxServiceManager

» (31 FMQConfigleader

» (3 FPSLicenselistener

- 3 JettyServer

> &% jobManagers

Figure 12: View JMX operations

A dialog box is displayed listing operations on the left and operation information on the
right, as shown in Figure 13.

-
ﬂ AdminService

P

T, addMember{grpName, userName) = W
%, addMonitor(type, timeout) Invoke Operation
%4 authenticateUser(username, passwd)
%, changePassword(username, newpasswd, oldpasswd) java.security.Principal (username  null . passwd  null
% createAdminConnectionFactory(tcfName, primaryURL, backu )
%, createCommonConnectionFactory(cfName, primaryURL, bach A
Q@ CreateGroup(name) 3
T, createlser(username, passwd)
Q@ currentUsers() flame alue
%, deleteGroup(name) Operation:

N % deleteMessagesOnServer(queueName, startindex, endIndex, p1 Name createllser
On deleteQueue{name) ~ | Description Creates User with the specified Name
% deleteTopic(name) Impact ACTION
T, deletelser(name) Return Type java.security.Principal
B destroy(adminQObjectName) username
% disconnectClient(clientlD) Description UserMame
%, elements() Type java.lang.String
T elements(type) passwd
%, gethciNames( Description Password
% getActiveServersinCluster() Type java.lang.String
%, getAllTraceComponents()

i %, getAllTransactions(type)

I %, getClientlDs()

i %, getDefaultSnooperStatusOnDestinations(destination Type)
T, getDurableSubscribersForTopic(topicName)

I 4, getGroupNames()
T getMamingManagerlmpl()
%, getMoOfActiveClientConnections()
. aetNumberOfDeliverableMessages(clientlD, subscriberdD) S

4 . | 3 d 1

Figure 13: Operation information dialog

Each operation is shown as a function along with the return type, operation name and
function parameters. The signature for this function [Semantic check please - what
signature?] is (<Return type> <Operation Name> <Parameter><Parameter Value>).
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Operations, parameters descriptions and types are shown in the dialog box. Add values for
the various parameters and click the operation name button to invoke the operation, as
shown in Figure 14.

Operation | Result

Invoke Operaticn

java.security.Principal (username TestUseq . passwd  testPassword

)

>

Figure 14: Operation signature

Click the button to invoke the operation

The result is displayed in the Result tab, as shown in Figure 15.

| Operation | Resut |

Result of operation createllser (java.security.Principal)

Itermn Value

D 18

name TESTUSER
type 0

Figure 15: Result of operation invocation
Points to note:
If the result of invoking an operation is of a complex object consisting of java bean

information, click the ellipsis button which will launches a java bean editor where all object
information is displayed. An example of this is shown in Figure 16, below.
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Operation | Result

Result of eperation listCommonCennectionFactories (java.util. HashMapg)

Item
PRIMARYLCF
PRIMARYCF

Value

[name = PRIMARYLCF , description = LPC UnifiedConnectionFactory set u...
[name = PRIMARYCF, description = UnifiedCennectionFactory set up for E]

(-
_F] PRIMARYCF

[S5S)

Itemn

CBREnabled
CSPUpdateFreque...
HTTPProxyURL
LMSEnabled
SOCKSProxyURL
TCPBatchSize
XASocketTimeout

autoDispatch
autoUpdationAllo...

batchTimeoutlnter...

batchingEnabled
clientProxyURL

compressicnMana..

Value
null
null
null
true
null
null

null

null

true

null
true
null

null

| »

m

Figure 16: Result showing bean information

ok ||

Cancel | F

If an operation parameter is a complex known object, the java bean editor will be
displayed where a User can add values required to invoke the operation. An example of
this is shown in Figure 17, below.

Operation | Result

Invoke Operation

void ’craateQueueConnectionFactory ( QueueConnectionFactoryMetaData | [name = null, description = null]] E]

<

I

| r

Name
Operation:
MName
Description
Impact
Return Type

Description
Type

{

ﬂ QueueConnectionFactoryMetaData

=

Itermn

CBREnabled

C5PUpdateFreque...

HTTPProxyURL
LMSEnabled
SOCKSProxyURL
TCPBatchSize
KASocketTimeout

autcDispatch

autolUpdationAllo..,

batchTimeoutInter...

batchingEnabled
clientProxyURL

compressionMana...

Walue
null
null
null
true
null
null

null

null

false

null
true
null

null

m
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Figure 17: Input parameter with bean editor

If an operation parameter is a complex unknown object then the parameter and the
operation invoke button are disabled and the User is not allowed to invoke the operation.
An example of this is shown in Figure 18, below.

Operation | Result

Invoke Operation

void | setDepthMonitoringlevels | ( queueMame  null . levels | ull

)

Figure 18: Operation parameter without bean editing support

By default, expert and hidden operations are not shown. To view these, change the
preferences in the JMX Connections section under Fiorano preferences (Window >
Preferences - Fiorano).

2. Changing Server Properties

Server properties can be changed at runtime. Select an MBean. In the properties view
change the value of the property that requires modification, as shown in Figure 19.

] Server Connections 2 @ F 7 T 8  E Properties i3

L FES-IMX “ || Property Value
& FMQ Attributes
@ FMQ-IMX EnableStart true
F RS MaxThreads 50
. FPS-IMX MinThreads 10
Cﬁ‘ JMX Connection LowThreads 2
o°: C.Dl'ltﬂ\l'IEf MaxldleTime 30000
& Fiorano | StatsOn false
&% Esb 3 LowResourceMaxldleTime 5000
A letty WebAppDir . Jesh/server/jetty/fps
£3 Jetty Porthlumber i 1650
(& Jetty Refreshinterval 2
@ config false

& Peer
#% Bootstrap
& Configuration
& Core

BasicAuthSupported
RealmProperties
5SLEnabled

false

Figure 19: MBean atiributes/properties

Once the property changes are made, right-click on the JMX Server and select Save
Configurations to save the changes.
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a|Lj FPS-IM™ _
oGy bogi
Y o Logout
a &k :
Duplicat
Y uplicate
Delete
Shutdown
Restart
Save Configurations

» ow Dootstrap

A Canfinoratinn

Figure 20: Saving configuration changes

Some properties are applied to Server that is running. However, some Server

configurations (such as Server ports, memory settings and so on) are applied only after
restarting the Server. When the Server requires restarting a message indicates this when
the changes are made, as shown in Figure 21.

LowResourceMaxddleTime 5000

WebAppDir . Jesh/server/jetty/fps

PortMumber ™ 1881

Refreshinter E] Warning M‘
BasicAuthSi —

RealmProp:

S5LEnabled

Changes needs to be saved and Server must be restarted to get them into effect!

N

—

Figure 21: Dialog displaying server restart warning
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Chapter 17: Profile Management

Profile Management Perspective in eStudio can be used for Offline configuration of Fiorano
profiles. The Profile Management Perspective has the following components:

e Profile Manager view
e Profile Editor
e Profile Validations Messages view

e Error Log

17.1 Profile Management Perspective

To open the Profile Management Perspective, navigate to Window - Open Perspective >
Other and select Profile Manager as shown in Figure 1.

_E| Fiorana eStudio-/C:/Pregram Files/Fiorano/FieranoSOAJ.3.0/runti feStudi e/ EI
File Edit Mavigate Search Run Project Window Help
(wi v v I | 5¢ Profile Mana... | @ Online Event ... (%) Offline Event...

5& Profile Manager % = O |5 Fes §Z§| =0
£ Profiles il

a4 g FES Properties of ConnectionManager [] Show Expert Propoerties
% FES 4 o Fiorano
» &% Esb General Properties |
> o EtC
L d e DeploymentListFile FioranchQ.Ist ']
2
d
;oo ne CompenentlnstanceProperties 2
» o Loggers L
> # Mg ObjectMame Fiuranu‘:Uck&t;'acc&ptorz‘pDrt-l:Ser-.ficET_E] 1
> o SECUrity .
4 & socketAcceptors InstanceOf ConnectionManager o
a4 & port-l Description Accepts client connections and usastheE]
> o% SocketReadHandler
> | @ ConnectionManager Compenentlnstance Configuration 2
Default
CFMameAppender E]
ReaderCacheDisabled |
TCPWindowSize 133120
HandshakelnWorkerThread
MagicTimeout 60000 -
Description
% Place the cursor on property to view its description

@) Error Log | 5 Profile Validation Messages 52 1 =8

i seMofTiM T

Figure 1: Profile Management Perspective

17.1.1 Profile Manager View

This view acts as an explorer for the profiles that are loaded onto the eStudio workspace.
To load a profile onto the workspace, right-click on the Profiles node and go to the Load
Profile sub-menu. By default all the MQ and ESB profiles are present in:

e $FIORANO_HOME/fmq/profiles
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e $FIORANO_HOME/esb/server/profiles

The profiles present are displayed in subsequent menus. Choose a profile to load it ionto
the workspace, as shown in Figure 2.

E] Fiorano eStudio-/C:/Program Files/Fiorano/Fiorano50A9.3.0/runtimedata/eStudio/warkspace/ EI@
File Edit Mavigate Search Run Project Window Help
O~ Mg [ | 5% Profile Mana... | @ Online Event .. Offline Event...
& Profile Manager 53 =08 =08
gﬂ Profiles
Load Prefile 3 Fiorano MQ »
Import Profile Fiorano S0A 3 haprofilel 3
i r
Other haprofile2
haprofile_shared 3
profilel 3 FES
profile2 3 FPS L‘\’
@] Error Log | [ Profile Validation Messages &2 =0
Fl 11} 3
nf® 13M of 40M i

Figure 2: Loading a profile

To load profiles from locations other than the default profiles directories:
1. Click on the Other option present in the Load Profile menu.

2. Select the profile directory to load the profile onto. Profiles can also be imported
from .zip files using the Import Profile option available in the right-click menu.

3. When a profile is loaded, a new child profile is added to the Profiles node with the
profile name. The new profile is opened in a profile editor.

4. A profile once loaded can be opened by double-clicking the profile node.
Note: If the profile being loaded is already present in the workspace, the User will be

presented with an option to reload the profile. If the User clicks Yes, the components of
the profile will be reloaded.

17.1.2 Profile Editor

The Profile Editor is divided into two parts - the Component tree on the left and the
Properties UI on the right.
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S FES &2 = O
a2 5% FES Properties of ConnectionManager [] Show Expert Propoerties
4 & Fiorano
» & Esb General Properties -
» o etc
. jmx DeploymentListFile FioranoMQ.lst vl
- o jndi . B
CompeonentinstanceProperties A
» &% Loggers L
> o M OhbjectMame Fic:ranc.Ec:n:Ir.eti\cceptcrs.pcrt-l:Sen-‘iceT}E] 1
» & SECUTty -
4 & sockethcceptors InstanceOf ConnectionManager [:]
4 &% port-l Description Accepts client connections and usesthesE]

> &% SocketReadHandler
- | @ ConnectionManager

Compenentlnstance Cenfiguration

”
-~

Default

CFMameAppender E]
ReaderCacheDisabled (&l

TCPWindowSize 133120

HandshakelnWorkerThread

MagicTimeout a0000 -

Description

Place the cursor on property to view its description

Figure 3: Profile Editor

17.1.2.1 Component Tree

When a profile is opened, it is presented in the form of a tree containing domain nodes (e

) and component instance nodes ( 9 ). The component instances that are part of the profile
are specified in the Deployment list files (*.Ist) present in the {PROFILE_DIR}\deploy
directory where PROFILE_DIR is the root directory of the profile.

The component tree has a node for each Component Instance in the profile. If a
component instance has any dependencies then a node called DependsOn will be added as
a child node. This node lists all the dependencies of the component instance.

The component tree in eStudio Profile Editor also has a search feature that enables the
user an easy access to any component instance. To find a component instance in the tree,
press Ctrl+F or right-click on the profile’s root node and select Search. In the text box
opened at the bottom of the tree, enter the name or a part of the name of a component
instance and click Enter to find the node.
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4 & FESHAPrimary -

4 &% Fiorano
4 & Esh

- o% Application

m

: &% Bam
> & Component
&% Configuration

&% Controller -
» e dm
> o Dm
&% Events
> % Fps
> o» Ha
4 o Jetty
@ Jetty
> o% Log -

Figure: Search in Profile Editor's Component Tree

17.1.2.2 Properties Ul

The Properties UI of a profile editor consists of property Name-Value pairs and a
description area. It displays the properties of the node selected in the Component tree.
Hovering the mouse over a property will display its description in the description area.

17.2 Using a Profile Editor to modify a Fiorano Server Profile

The profile editor can be used to modify a profile in the following ways:

17.2.1 Modify Component Instance Properties

When a component instance node is selected in the Component tree, the attributes of the
MBean represented by the selected Component Instance Node are populated as Name-
Value pairs in the Properties UI. The properties of a component instance are categorized
into different groups.

17.2.1.1 General Properties

The General properties section of the Component Instance properties contains the property
DeploymentListFile. Its value is the name of the .Ist file from which the Component
Instance is loaded. If the value is changed, upon saving the profile the service will be
added to the .Ist file specified by the User.

Chapter 17: Profile Management Page 257



Fiorano eStudio User Guide

17.2.1.2 Component Instance Properties

This section contains the properties ObjectName, InstanceOf and Description which denote
the Object Name of the MBean, Service type of the component instance and its description
respectively.

The properties ObjectName and InstanceOf are non-editable as they are greyed out.

17.2.1.3 Component Instance Configuration
The properties of the MBean corresponding to the selected Component Instance Node are
specified under this section, as shown in Figure 4.

e If the property is hidden, it is not shown in the properties UI.

e If the property is read-only, it is shown in a non-editable state.

e If the property is an expert property, it is hidden in the properties UI by default. A
User may view and edit the values of expert properties by checking the Show
Expert Properties check box at the top of the properties UI.

For all editable properties of a component instance, depending on the type of property, a
property editor is provided to help the User change the property value. Please refer to
Table 1, below, for details on Property Types and Property Editors:

Property Type Property Editor

String Simple text editor.

Boolean Check box.

Number (Integer/Float/Double) A single line text editor which accepts

only numbers as input.

Value extracted from a set of Legal Values A Combo box which allows the user the
select one value from set of legal values.

Table 1: Property Editors for different Property types
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Properties of ConnecticnManager Show Expert Propoerties

I -
General Properties l} &
DeploymentListFile ’ FioranohQ.Ist - ]

| ComponentlnstanceProperties ®
ObjectMame | Fil:lrEﬂD.SDCkEt.ﬂ.CCEFItDrS.FIDI't-l:SErE” =
InstanceQf | ConnectionManager E]|
Description | Accepts client connections and useD|

| Componentlnstance Cenfiguration by
Default
CFMamelfppender | E]|
ReaderCacheDisabled
TCPWindowSize 133120
HandshakelnWorkerThread
MagicTimeout 60000
Port 1847 A
Descripticn
Place the curser on property to view its description

Figure 4: Properties Ul

17.2.1.4 Component Instance Atiributes

If the Component Instance contains attributes, these attributes are listed under the section
Component Instance Attributes in the Properties UI, as shown in Figure 5. Editing these
attributes is similar to editing the Component Instance Configuration properties.
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Properties of PublishEventManager [] Show Expert Propoerties
Ir 7]
General Fl:?perties E
DeploymentListFile FioranohQ.lst v]
| ; |
ComponentlnstanceProperties &
ObjectMame Ficrano.jmax.notifications:Service Type=EventManager, E]
InstanceQf EventManager E]
Description Event Manager E]
|7 7
Componentlnstance Attributes y
LoggerName Ficrano.FMQ.Events. TopicPublisher E]

Description

Place the curser on property to view its description

Figure 5: Component Instance Attributes

Note: When the value of a property is changed to a value other than the default value
specified by the component MBean, the property name label will be displayed in Bold.

17.2.2 Add / Remove Component Instances

Domains/Component Instances can be added to profiles. To add a component instance,
right-click on a domain and select the Add Components option. To add a new Domain
right-click on a Domain or on profile node and select the Add Domain option.

1. Clicking the Add Components option opens the Add Components dialog box. The
Add Components dialog box contains a table with two columns. The first column
has a tree with all the components listed from which the required component can
be selected. In the second column, Instance Count, the humber of instances of the
component that need to be added to the profile need to be specified. In the
example below, as shown in Figure 6, only one instance of

2. Fiorano -> FioranoFW -> Services -> ConnectionManager is added to the domain
Fiorano.socketAcceptors.port-2.

3. Select all the instances to be added and clicking OK adds the component instances
to the component tree.
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Figure é: Adding a New Component Instance

The name of the component instances that have been added will be automatically generate

automatically using <Component><instance_count>.A component instance can be
renamed by choosing the Rename option using the right-click menu. The values of the
properties are set to the default value. Component instance properties can be configured
by providing relevant/valid values in the Properties UI.

Note:

When a new component instance is added, unresolved dependencies of the
component will be listed in the Profile Validation Messages view. Please refer to
Section 17.2.3 for further information on resolving dependencies.

If the component instance added has exclusive dependencies, a new instance of
each exclusive dependency will be added to the profile within the same domain as
the component instance. Please refer to Section 17.2.3 for further information on

exclusive dependencies.

A component instance can be deleted from a profile by selecting the Delete option
using the right-click menu. Deleting a component instance removes any exclusive
dependencies the component possesses from within the profile.
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17.2.3 Resolving Component Dependencies
The dependencies for a component are listed as a child value of the DependsOn node of a
component instance. These dependencies can be Required Dependencies, Optional

Dependencies or Exclusive Dependencies.

Required Dependencies are those dependencies that are required to configure a
component instance.

If a component in an open profile has unresolved required dependencies, error messages
will be shown in the Profile Validation Messages view, as shown in Figure 7.

,6;_—| Error Log | ©J Profile Validation Messages &2 =0

@ FES: Required Dependency MQConfigLoader for component instance Fiorano.socketAcceptors.port-2:5erviceType= ConnectionManager, Name...
@ FES: Required Dependency ObjectManager for component instance Fiorano.socketAcceptors.port-2:ServiceType=ConnectionManager, Names=...
@ FES: Required Dependency PingServiceManager for compenent instance Fiorano.socketAcceptors.port-2:ServiceType=ConnectionManager, Na...
@ FES: Required Dependency ServiceManager for component instance Fiorano.socketAcceptors. port-2:ServiceType=ConnectionManager, Name=...
3 FES: Required Dependency ThreadManager for component instance Fiorano socketAcceptors.port-2.5ocketReadHandler ServiceType=SocketR...
3 FES: Required Dependency ThreadManager for component instance Fiorano.socketAcceptors. port-2:ServiceType=ConnectionManager, Name=...

Figure 7: Profile Validation Messages

If a component has unresolved optional dependencies, warning will be logged in the
Validation message.

Exclusive Dependencies are dependencies that should not be allowed to be used with more
than one component instance within a profile.

Details about dependency instances are displayed in its properties, as shown in Figure 7.

17.2.3.1 Properties of a Component dependency

Properties of MQConfigloader [ Show Expert Propoerties
Ir
Properties of Component dependency &
I,
Instance ’Fiorano.ét%:SewiceType:FMQConﬁgLoader,Name: FMQConfigloader v]
Instance Of FMQConfigLoader E]
Exclusive
Optional
Description

Place the cursor on property to view its description

Figure 8: Properties of Component Dependency

Instance: This is the instance of a component dependency. A list of all available instances

within the profile is provided in a drop-down list. A User is able to select the required
instance.
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Where there are exclusive dependencies, the fields are grayed out so they cannot be
edited. This is because particular dependency is fixed for a given component instance.

e Instance Of: Specifies the service type of the dependency instance.
e Exclusive: Specifies if the dependency is exclusive to the component.

e Optional: Specifies if the dependency is optional to the component.

17.2.3.2 Resolving Component Dependencies

When a profile is opened, unresolved dependencies are listed in the Profile Validation
Messages view either as errors or as warnings, as shown in Figure 9. To resolve a

dependency, double click on its corresponding error message. This selects the dependency
node in the tree, displaying its properties in the Properties UI. The User may now select an

instance from the available instances displayed.

For example, in the scenario shown in Figure 9, the dependency ObjectManager is
unresolved for the instance ConnectionManagerl. To resolve this:

1. Click on the ObjectManger node.

2. In Properties, click on the combination next to the property Instance. A drop-down

list with all the available instances is displayed.

3. Click an instance to select it as the dependency instance.

5§ *FES i3
% MQConfigloader - Properties of ObjectManager [] Show Expert Pro
&2 ObjectManager
5 PingServiceManager Properties of Component dependency
% ServiceManager
&2 SocketReadHandler Instance
& ThreadManager pe=0bjectManager,Nams=(]
& por‘t-2m Instance Of Fiorano.etc.runtimeObjectManagers:ServiceType= ObjectManager,Namtasc
Exclusive

% SocketReadHandler

m

@ ConnectionManagerl Optional
&4 DependsOn
&2 MQConfigloader Description
% ObjectManager i Place the cursor on property te view its description

_6;_-| Error Log | T Profile Validation Messages 22

3 FES: Required Dependency MQConfigloader for component instance Fiorano.socketAcceptors.port-2:5ervice Type=ConnectionManager, Name...
3 FES: Required Dependency ObjectManager for component instance Fiorano.socketAcceptors.port-2:Service Type= ConnectionManager, Mame=...

Figure 9: Resolving dependencies

If a new instance is to be created:

1. Right-click on the dependency node and select the Add New Instance option. A
dialog box is displayed with all available domains.

2. By clicking OK, a new instance of the dependency is created within the selected

domain. This dependency can now be resolved by selecting the new dependency
instance and adding it to the Instance property of a component, as shown in Figure

10.

3. Once an instance is selected, the error message is removed from the Validation
Messages view indicating that the dependency has been resolved.
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i I Select 'Dun'ng\ to add Component Instance E

4 & FES
4 &% Fiorano
[ &% Esb
& Loggers
o EfC
M
& jndi
& Mg
& SECUrtY
& socketfcceptors
i+ o port-1
b | % port-2|

| ok || Ccancel

Figure 10: Selecting a domain for a new Dependency Instance

17.2.4 Add a new Variable Dependency Instance

If a component has variable dependencies, the User can add new dependencies to its

instances. To add a new variable dependency:

1. Right-click on the DependsOn node of the component. A menu is displayed with all

available variable dependencies.

a & FES
4 &% Fiorano
4 &% Esb
4 &% Application
[ o Controller
4 &% Repository
4 @ ApplicationRepository

-

m

Properties of DependsOn

4 |mEE DependsO—

o pygigy) Add-

Ad

& EventsManager
5 ServiceSecurityhManager
% UserSecurityManager

Figure 11: Choosing a Dependency type to add

%Audi‘th’la nager
Add ServiceSecurityManager

Add UserSecurityManager
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2. Click on a dependency that needs to be added, as shown in Figure 11. A dialog box
is displayed with a list of all components from which the component type of the
new dependency can be chosen.

3. Click OK to add the new dependency, as shown in Figure 12.

-

E] Add Component as Dependency @

s

Select component(s) to be added as Dependency

AclManager -
AdminService
AlertManager
AlertRepository in

m

ApplicationController
ApplicationControllerStub
ApplicationRepository
AuditEventHandler
AuditManagerProxy
AuditService
AuditstubManager

OOoOoEOCOoOOoOoOoOo

Figure 12: Choosing the component type of the Dependency

In the example below, a new dependency AuditEventHandler is added to the component
instance Application Repository, as shown in Figure 13.

& FES - Properties of AuditManager

&% Fiorano
& Esh
& Application

m

Properties of Component dependency

& Controller Instance

&% Repository Instance OF AuditEventHandler
@ ApplicationRepository

&2 DependsOn .
&7 AuditManager Optional
&2 AuditManager
% EventsManager
& ServiceSecurityManager =

Exclusive

Description

Place the cursor on property to view its description

| Error Log | £ Profile Validation Messages 22

3 FES: Required Dependency AuditManager for component instance Fiorano Esb. Application.Repository:Service Type=ApplicationRepository, Ma...

Figure 13: Newly added Variable Dependency Instance

17.2.5 Change Implementation of a Component Instance

Some components provide multiple implementations. The instances of such components
have a property Implementation under the General Properties section. This lists all the
available implementations. To change the implementation,

e Click on the combo next to the Implementation property and select the
required implementation. This will update the ObjectName, properties and
dependencies of the component instance with the new implementation.
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prLi=R=d =
“§ FES Properties of MativeFileNamingManager Show Expert Propoerties
& Ficrano
& Esb General Properties .
s etc
& jmx DeploymentListFile ’FimanoMQ.ist VI
& jndi Implementation FILE -
@ MativeFileMamingManager FILE
o Loggers ComponentinstanceProperties LDAP E
# md ObjectN e
b security jectiiame XML
[ T P, o _ CACHE
Figure 14: Modifying the implementation of a Component Instance
17.2.6 Adding attributes to a Component Instance
To add new attributes to a component instance:
1. Right-click on the instance node and click Add Attributes. A dialog box is displayed
where the name and value of the attribute can be provided.
. i ribu i i ribu
2. Specify attribute details and click OK to add the attribute to the component
instance, as shown in Figure 15.
Pl )% FES Properties of MativeFileNamingManager [] Show Expert Propoerties
a % Fiorano
b o Esh General Properties X
[ &% etc
[ o jx DeploymentListFile [FiolanoMQ.lst -
4 & jndi . -
i+ | @ MativeFileNaminaManager | Implementation [HLE ]
b & Loggers Add Attribute ComponentlnstanceProperties S
[ s mq -
I o security Rer‘noveAttrlbute.s . ObjectMame |Fiorano.jndi:Ser\riceType:NamingManager,ImpI:FILE”
» & socketAcceptors Edit Default Configuration N |Naming|\,-13nage, E]|
Find Usages
Description |This MNamingManager stores information into fioran:E]|
@ E] Add Attribute N = Compenentinstance C £
Name NewAttribute |:> AdminObjectFilename |admin.dat E]
Value | Attrvalue AdminObjectDefragFilename |admin~2.dat E]|
AdminObjectBackupFilename |admin~1.dat E]|
Path .
[ ok ][ concel | ’ | g
DefragmentationLowerThreshold 10
DefragmentaticnUpperThresheld 15
DefragmentationPercentage 20
AdminObjectFileSize 536870912
Mewhttribute Attri/alue E]|

Figure 15: Adding an Attribute fo a Component Instance
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17.2.7 Remove custom attributes from a Component Instance

To remove User-defined attributes from a component:

1. Click on Remove Attributes from the right-click menu of the component instance

node. A list of all the attributes added by the User is displayed.

2. Select the attributes to be removed and click OK to remove the attributes, as
shown in Figure 16.

4 5§ FES
4 % Fiorano
& Esb
& et
s Jrmx

A T T @
-,
b,

& jndi

| @ Nativ—

& Loggers
& mg

o SECUItY
o socketA

-
,
b,

Add Attribute
Remove Attributes%
Edit Default Configuration

Rename

Delete

Find Usages

E] Remove Attributes

Select attributes to be removed

MNewAttribute

Cancel

oy |

Figure 16: Removing user-defined atiributes
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17.2.8 Edit Default Configuration for a Component Instance

To edit the default configuration of a component instance:

1. Click Edit Default Configuration. A dialog box is displayed with all properties along
with their default values.

2. Modify the default values of the properties using their respective editors and click
OK to save the changes, as shown in Figure 17. The default values of the
component will be modified and the new values will be used as default valued at
the time of adding new instances.

| Edit Default Configration for Component ApplicationController @I
Properties of ApplicationController [] Show Expert Propoerties
ComponentConfiguration 2 -

RetrylntervalBetweenForceShutdownAtterpts 1000

MumberOfForceShutdownAttempts 5

CompenentStopWaitTime 10000

AppRestoreWaitTime 60000

ApplicationRecoveryEnabled

InitiateAppRecoverylag 1000

LogMgrncludeTimeStamp 3
LogMgrMoOfFiles 0

LogMgrMoOfLinesPerFile 1000

TimeZone E]
CountryMName E]
LogPath E]
ServerD FES 1
RepositoryMame ServiceProvider E] il
Description

Boolean determining whether to start off the Application State Recovert Thread. Which is
started when the application controller module is started and restores the state of the
application from the administered object.

[ ok ][ cancel

Figure 17: Edit Default Configuration Dialog

17.2.9 Modify a domain

Domains can be added, removed or renamed by using the right-click option.

1. Click Add Domain on the parent domain and give the name of the new domain to
be added.

2. Click OK to add the new domain.

To remove a domain:

e Right-click on the domain and click Delete. The domain and all the component
instances which are the children of the domain will be removed from the profile. If
a component instance that is being removed has an exclusive dependency, the
dependency instance will also be removed from the profile.

To rename a domain:
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1. Right-click on the domain and click Rename. A dialog box is displayed where the
user can enter the new domain name.

2. Click OK to change the name of the domain.
Note: When a domain is renamed, the ObjectNames of all the component instances which
are the children of the domain will be modified in accordance with the new value.
17.2.10 Edit Profile Metadata
Click on the profile node in the component tree. The properties of the profile such as
Profile Name, Description, Created On, Author are shown in the Properties UIL. These
values can be modified by specifying the new values in the text boxes provided, as shown

in Figure 18.

Profile properties also include the DeployedLists property which is a comma separated list
of all the .Ist files (from which the components are loaded).

i Properties of FES [ Show Expert Propoerties

»

Profile Properties

ProfileName FES L)
Description This is default FES prefile in which FioranoMQ is embedded inside the enterprise server [:]
ProfileDirectory C\Program Files\Fiorano\Fiorano50A9.3.0esb\server\profilesh profilel\FES [:]
Author [:]
CreatedCn [:]
LastModifiedOn Wed Mar 30 16:22:58 IST 2011 [:]
DeployedLists fesbootstrap.lst, FioranoMQ.lst, DefaultMQObjects. st fes.lst E]

Figure 18: Profile Metadata

17.2.11 Locate a Dependency Instance in the Component Tree

To locate the actual instance of a component dependency:

¢ Right-click on the dependency node and select the Locate Instance option. This
locates and selects the instance in the tree. The values of its properties are
automatically updated in the properties UI.

17.2.12 Find Usages of a Component Instance

To find all the function of a particular component instance, right-click on the node and
select the Find Usages option. The component tree will be filtered to show only those
component instances which use the selected component and its dependencies, as shown in
Figure 19.

The tree is returned to its previous state (displaying all the component instances) when
the close button (marked by an X) is clicked.
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Esb
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& Policy
& Manager
@ PolicyManager
5% DependsOn
&2 BlertManager
&% ApplicationRepository
&2 EventConsumer
&% EventsManager
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g PAMHandler
&2 PolicyRepository
&% TransportManager
&% RMIServerInterface
@ RMIServernterface
& Server

Figure 19: Filtered Component Tree showing the Usages of a Component Instance

17.3 Saving the Changes from Profile Editor

After the necessary actions to make changes are performed, click Save in the tool bar to
save the profile. The profile can also be saved by choosing Save by right-clicking the menu

of the profile node in the Profile Manager view.

If the profile saved has errors, the profile will not be saved and the User will be notified
about the errors, as shown in Figure 20. These errors can be resolved by clicking on the
error message in the Profile Validation Messages view.

E_] Save Error

|®I Profile Save Error

Reason:

Lo [O]fs)

Several errors have cccurred. Please check Profile Validation Messages View for more

details.

QK

| [ << Details

4

Required Dependency AuditManager for component instance Fiorano.Esb. Application.Repositol

L}

Figure 20: Error dialog shown when a profile with errors is saved

On successfully saving the profile, a message will be logged into the eStudio log view
indicating that the profile has been saved.
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17.4 Saving a Profile to a Different Location

To save a profile to a location other than the current location, use Save as.. from the tool
bar. A dialog box is displayed with the target directory to be chosen. Once the target
directory is chosen, the profile will be saved to the location specified.

This can also be done by using the File -> Save As option from the menu bar or Save as..
option by right-clicking the menu of the profile node.

17.5 Managing Profiles from the Profile Manager View

17.5.1 Configuring SBW Database

The document tracking feature is configured as part of FES to track SBW events into H2
database running within Enterprise Server. This database can be changed for a profile in
Profile Manager and database details are saved in the sbwdb.cfg file present in
FIORANO_INSTALL_DIR\esb\server\profiles\<profilename>\FES\conf. To view or configure

the database:
1. Load the profile and right-click the ‘'Open SBW Config’ menu option of the profile
node. A dialog box is displayed with all the database properties along with their
default values. Property values are editable only for inactive profile nodes.

B profile Manager 532 = O || & FES & FESHAPrimary 532
a @] Profiles
B2 g FESHAPrimary
FES
= < Fiorane
B2 rFesHaPrimany £ Esb

Open
Close

Save

SaveAs
Export Profile
Validate cceptors
Open SBW Config
Reload

FES Replicated HA
Delete

2. Select database from the dropdown in ‘Database Name’ property which loads
specific values for all the properties applicable for that database. Modify these values
and click OK to save the configured database. Values of the properties which are not
applicable for that database selected are mentioned as ‘'—NA—"' and are non editable.
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i _E) Configure SBW Database e L] )
Properties FESHAPTrimary
Database Name H2 ¥
JDBC Properties i
JDBC Driver ﬁz" ,a?chze . (=
Try Reconnect Interval H5GL
JDBC Password MS SQL 2000 2
JDEC Connection URL jdbc:h2:ESB_DEFAULT_DB_DIR/doctracking_db/s...
Max No Of Rows To Return 1000
Max No Of Rows To Fetch 200
Insert Thread Count 1
Support Master Table false
JDBC Driver Sockettimeout --MNA--
Auto Reconnect true
Representable Data Types false
JDBC Login Name sa
JDBC Driver Oracle.jdbec.readtimeout --NA--
Description
Mame of the Database -
[ QK ] [ Cancel

3. Configuration of database can be done simultaneously for more than one profile
node by right-clicking the menu option on the selected nodes. Click OK to save the
database details of all profile nodes.

B Profile Manager £ = O[5 FES | FESHAPrimary &2
Prafil i =
a ] 6“5 ] Configure SEW Database | - [E=REN=)
FES - -
P i F FESHAPT 0
ﬂ FESHAPrimary ropeties ES ESHAPTimany
Database Mame H2 Oraele
JDEBC Properties hZ_jdbe.cfg aracled_jdbc.cfg
IDBC Driver g h2 Driver graclejdbe.driver OracleDriver
Try Reconnect Interval 5 5
JDBC Fassword
IDBC Connection URL jdboh:ESE DEFAULT_DB_DIR/doctracking_dbfs.  jdbceraclethin@i6d 164128141 521:0RCL
Mai No OF Rows To Returmn 1000 1000
Insert Thread Count 1 1
Max No Of Rows To Fetch i) i)
Support Master Table false false
DB Driver Sockettimeout --hlh-- --hli--
Representable Data Types false false
Auto Reconnect true true
JDBC Login Name 3 EEl
JDBC Driver Oracle jdbc.readtimeout -~hlA-- E0000
Deseription
OK | [ Cancel
\

Note:

1. After configuring a profile to use some database, other than default database, jdbc
driver for that database needs to be added under <java.classpath> tag in server startup
configuration file (either $FIORANO_HOME/esb/server/bin/server.conf or
$FIORANO_HOME/esb/fes/bin/fes.conf, whichever is applicable) before starting Enterprise
server.
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2. The user has to use the same settings to connect to the DB when using a third party
tool. All the database queries used for retrieving workflow related data is kept in
sbwdml.sqgl file.

3. When using MS SQL for document tracking, mssql_jdbc.cfg may need to be configured
according to the database driver being used. MSSqgl 2000 driver follows SQL 99
conventions which quote the SQLState string for table not found exception as 42502. On
the other hand, MSSQL 2005 driver follows XOPEN SQLState conventions which quote the
same SQLState string as S0002. By default, all fes profiles are configured according to the
standards followed by MSSql 2000 driver. If someone uses MSSql 2005 database, or uses
MSSql 2005 driver for MSSql 2000 (2005 driver is backward compatible with 2000 driver,
so it can be used), then the file has to be reconfigured accordingly.

Important: It is strongly recommended that the user employ a commercial grade DB in a
production system.

For file-based databases like apache and HSQL, the default location is in the
ESB_USER_DIR (which is set in fiorano_vars script). The user has to give the complete
path with these variables resolved when using the JDBC URL in a third party tool.

Example

The default H2 db JDBC URL is configured as
ESB_DEFAULT_DB_DIR/doctracking_db;create=true which resolves to
ESB_USER_DIR/EnterpriseServers/<profilename>/FES/doctracking_db and further into
something like C:\Documents and Settings\All
Users\runtimedata\esb\<BUILD_NUMBER>\EnterpriseServers\FES\doctracking_db
depending on the actual settings.

17.5.2 Import / Export profiles

Profiles can be exported as zip files. Profiles can be exported and imported by using the
Export/Import options by the right-clicking the menu of a profile node.
To export a profile,

1. Right-click on the profile node in Profile Manager view and select the Export option.

2. Choose the destination directory to which the zip file is to be exported.

To import a profile,

1. Select the Import option on the Profiles node and choose the zip file and the
destination directory to which the profile needs to be imported. A confirmation
dialog box is displayed enquiring if the User wishes to load the imported profile.

2. On selecting the Yes option the imported profile is loaded.

3. On selecting the No option, no further action is performed.

17.5.3 Validate Profile

A profile can be validated by clicking Validate by using the right-click menu of the profile
node. Errors and warnings, if any, will be shown in the Profile Validation Messages view.
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17.5.4 Reload Profile

The components of a profile can be reloaded from its original directory location by using

the Reload option by the right-clicking the menu of the profile node. When the profile is

reloaded, the components of the profile are refreshed and the component tree will be re-
created.

17.5.5 Close a Profile

An opened profile can be closed by clicking the Close option bythe right-clicking the menu
of the profile node. Closing a profile will delete the profile references from the workspace.
The actual profile will remain unaffected. If the User wants to edit the profile again, the
profile must be loaded into the workspace again.

17.5.6 Delete a Profile

A profile can be deleted from its location by clicking the Delete option by right-clicking the
menu of the profile node. Deleting a profile deletes it from the Fiorano installation
directory.

17.5.7 Points to note

e Modifications to a profile cannot be performed from the Profile Editor when the
profile is running. All the configuration options will be disabled. The User will
not be able to save the profile.

e Unless the profile is open, the actions Save, Save as, Export, Validate and
Reload will be disabled and the right-clicking option the menu of the profile
node in Profile Manager View will not be functional.
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Chapter 18: Installing eStudio
Dropins In Eclipse

The programs, below, must be installed before using eStudio as a drop-in:

Eclipse Version: Eclipse 3.5 Stable Release 2 (recommended) or above.

Ensure that the dropins EMF (version 2.5.0), GEF (3.5.2) and WTP (Web Tools
Platform Version R-3.1.2) are installed in order to use eStudio as a drop-in. All the
above dependencies can be installed via their respective update sites or via drop-

n.

18.1 Installation

1.

Copy the folders features and plugins from $FIORANO_HOME/eStudio

directory and paste to the $ECLIPSE_HOME/dropins/Fiorano/eclipse

directory. Create folders Fiorano, and Eclipse if these don't already exist.

Create a folder licenses in $ECLIPSE_HOME/dropins/Fiorano directory and
place the Fiorano license file(s) in it. The directory structure is shown in Figure 1.

@Qvl . v Computer » BasicFil

es (:] » Helios » eclipse »

i e e
File Edit View Tools
Organize = Include in library - Share with - Burn Mew fold
| eclipse o Mame
; Ent ] )
] . configuration
J fiorano ]
] J dropins
. Helios
: J features
. eclipse
— - p2
. configuration .
) . plugins
. dropins
- J readme
. Fiorano
) , workspace
| eclipse )
|| .eclipseproduct
| features ]
= |=| artifacts.xml
. plugins
) PHHg = eclipse.exe
J licenses ] o
2 | eclipse.ini
, features .
. B eclipsec.exe
e ] epl-v10.htm
. plugins .
£ | notice.html
| readme

Figure 1: Fiorano dropins installed in eclipse

Open ECLIPSE_HOME/ eclipse.ini file and add the properties given below to the

end of the file:
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a. -DFIORANO_RMI_CALL_TIMEOUT=200000
b. -DFIORANO_HOME=<Fiorano installation path>

Note: Additional properties may be required SSL [Expand SSL] is used for
communication between the Servers. The properties that may need to be added
are listed, below, in Figure 2.

-Djava.endorsed.dirs=D:/Fiorano/FioranoS0AS.3.0/esb/lib/endor=ed

-DFTORANG BMI CALL TIMECGUT=200000

-DFIORANG HOME=D:/Fiorano/FioranoSORS.3.0

-DFMQ DIR=D:/Fiorana/FiorancS0R9.3.0/fmg

-Djavax.net.=zsl.trustStore=D: /Fiorano/FioranoS0RkY.3.0/fmg/profiles/FiorancH(/certs/jssecacerts
-Djava.naming.factory.initial=org.apache.naming.java.javalURLContextFactory
-Djava.naming.factory.url.pkgs=org.apache .naming

Figure 2: Fiorano related properties within the eclipse.ini file.

4. Start eclipse with the —clean option from the command line. eStudio will be
installed successfully. To verify installation, navigate to Window - Open
Perspective > Other. Fiorano specific perspectives such as Online Event
Process Development, Offline Event Process Development, Profile
Management, Connection Management and Mapper should be visible.

5. Go to Window > Preferences > General > Workspace > Local History and
change the value of the property Maximum File Size (MB) to 10. [Why?
Explain.]

6. To use Fiorano specific Key Shortcuts, go to Window->Preferences->General-
>Keys and change the scheme to Fiorano.

18.2 Uninstallation

1. Delete the properties mentioned in step 2 of the Installation section from the
eclipse.ini file.

2. Remove the Fiorano directory from the drop-in directory and restart eclipse with
the —clean option. eStudio will be successfully uninstalled.
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Chapter 19: Flat File Schema Editor

This chapter describes the Fiorano Text Schema Editor tool which is used to design XML
schemas as .tfl Text Format Layout files. These TFL files are used by the XML2Text and
Text2XML prebuilt components to facilitate data conversion of non-XML data from and to
its corresponding XML format respectively.

In case you require your composite component flow to read or write data from your data
repository which exists as text or flat-files, you can use the FileReader component to read
this flat-file and transform flat-file data into its corresponding XML using the Text2XML
component.

The opposite can be done using a combination of the XML2Text component and the
FileWriter component. But before you can transform data from flat-file format into its
corresponding XML or vice versa, you require defining a File Schema which can aid the
transformation. This File

Schema may be understood as the format meta-data that is required in both the above
mentioned instances.

The Text Schema Editor (TSE) is a tool which assists you to visually define the format and
hierarchy of the non-XML data graphically. The format structure created by this editor is
called the File schema in which the structure of the non-XML data is defined in terms of
records and fields. This format is stored using XML grammar in tfl (Text Format Layout)
files.

Note: The Schema defines the rules used to convert non-XML text to XML text and vice
versa.
Once this schema format is defined, it can be used by

e Text2XML transforms flat-file data to its corresponding XML

e XML2Text transforms XML data into its corresponding flat-file format

The following diagram shows how the FileReader component uses the transformation
components to read XML and non-XML data.
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s FROCE
B FRTHEL D

s PR,
s, PR S

Text To XML XML To Text

Figure 19.1: Using File Reader and Transformation components

The non-XML data mentioned above can be delimited, positional or both. TSE also provides
the test functionality in which the user can verify and test the schema formats created. In
the test functionality, the user can generate sample data and can also transform sample
non-XML data to XML and vice versa.

19.1 Text Format Layout Concepts

A tfl (text format layout) document is a specialized XML grammar which is used to describe
the structure of non-XML structured (delimited, positional) data. In the tfl document, the
structure of the data is defined as a hierarchical tree of records and fields in a given order.

P/ File Schema Editor

Fle Edk Tk Window Hel
GoB®da » X

[ | Senematpiorer %

Rool Node

—58 o ema
Bl <Employes_ Node
T S ——
Record ——t? =B <Employectiames
B <Employeells Fields |
®  <Employeaiges

hws chofrums i gy STV chamma with v Bkl in g secrd.

J[e> ] | e | |

Figure 19.2: Structure of a tfl document
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The schema of the structured data is added as a child node to this Root Node. This node is
called the Schema Node.
When you create a new schema in Fiorano Schema Editor, the Root Node and the Schema

Node are created automatically.

e Schema Node: In the schema structure, each opened schema file is shown as
Schema Node and is the child of the Root Node. The Schema Node corresponds to
the Root tag of the output XML which is generated from the structured non-XML
text or input XML which is to be converted to the structured non-XML text. Schema
Node can also be renamed. The properties of the Schema Node represent the
default properties which can be used during data transformation. In a Schema
Node, you can add multiple record nodes which represent the structure of
input/output data. Adding fields to the Schema Node is not allowed.

e Record: Record represents a collection of information. It can contain a set of fields
and/or other records.

e Field: Field represents items of information that are simple in nature, such as
strings and numbers.

19.2 Creating Flat File Projects

Flat file projects can be created using Flat File Schemas view in Fiorano Tools Perspective.
In the eStudio menu bar navigate to Windows -> Open Perspective -> Other, select
Fiorano Tools and click Ok. This takes to Fiorano Tools perspective where a view called Flat
File Schemas can be seen.

In this section a sample Employee Schema will be created to illustrate the usage of Flat
File Schema Editor. Let's assume a flat file containing all the Employee Records (Employee
Name, Age, Address) with each employee record in a new line where individual fields are
comma separated as shown below.

Mike, 30, University Ave
Harry, 25, Kensington Oval
Ayrton, 40, Thousand oOaks

Figure 19.3: Sample csv data

1. To define schema for this data, first create a new Flat File Project. To do this,
right-click on Flat File Schemas Node and select New File Schema Project
option.

@ Flat File Schemas &2 =8

%] Flat File Schemas
Mew File Schema Project

Import Project
Import 5ample Project
Import Closed Projects

Figure 19.4: New File Schema project

2. This launches a wizard where project details can be configured. Provide name
for Project and click Finish button. A new project will be created with project
name as root node and “"Empty Schema” as default schema node.
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Note: Load from flat file option can also be used to create flat file schemas by
loading the data from the flat file. This will be discussed in section 19.4.

3. Rename Empty Schema as Employee Schema by selecting the node and
editing the Name property in properties view. Properties like Record
Delimiter and Default Filed Delimiter can be configured. Since the
Employee records are separated by a new line provide the value for Record
Delimiter as \r\n.

"'¥] Fiorano eStudio-/Di/SourceCode/HEAD, i i — -
File Edit Navigate Search Run Project Window Help
(il o - -
% [ Fiorano Tools | B Profile Management (3 Offline Event Process Development
& Tools View 52 B = O v 2 = O || Properties &3
%2 Deployment Manager % <2xml version="1.0" encoding="UTF-8"2} - Property Value
i3t Event Manager Properties
1B M < o
e Teneas chnologies Pvt. Ltd.//DTD FileSchema 1.0//El g:s:ptm ]
- by Sohenans Comment Start Identifier
8 - Comment End Identifier
8 . Record Delimiter
< /pe="custom-delimiter® escapeCharType="Characterm>0 Escape Character Type Character
> Escape Character \u0000
B > Delimiter Type custom-delimiter
tom-delimiter" escapeCharType="Character" e: Delimiter Value \in
> Default Field Delimiter
Escape Character W
Delimiter Value .
<
[#] Flat File Schemas 52 =g
[#] Flat File Schemas
Ao ‘ "
EmptySch
B Eptychers @] EmorLog &2 | B Console -
Warksnare | on
Figure 19.5: Flat file editor
4. Right-click on Employee Schema option and select Add->Record option. Give
the record name as Employee and click OK.
Record will be added to the tree on the left hand side and the editor content is
updated accordingly.
5. Since an employee record is comma separated, select the parsing type as
Delimited and provide comma (,) as the delimiter value.
=g é’ Fiorane Tools | B Profile Management Offline Event Process Development
& Tools View 32 = w M ] = B||C Properties 53
&4 Deployment Manager <?xml version="1.0" encoding="UTF-8"2> - Property Value
GE} E.vent Manager Properties
YE License Manager B Name Employee
- Description
EmployesSchema s XML Type Element
comment-start-identifier Minimum Occurences 1
Maximum Occurences -1
="custom-delimiter"” es Parsing Type DELIMITED
Record Identifier Type MNone
Field Delimiter
tom-delimiter” es Escape Character Type Character
Escape Character w0000

Delimiter Type
Delimiter Value

[#] Flat File Schemas 52
[#] Flat File Schemas

custom-delimiter

3y o q
# EmployeeSchema
<Fg Employee

@ Error Log &2 | B Console

Figure 19.46: Configuring Flat File Schema elements

6. Right-click on Employee Record and select Add -> Fields option.
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Fields can be added one by one or comma separated values can be provided to
add multiple fields to a record. Provide Field Name as Name,Age,Address and
click Ok.

Three fields Name, Age, Address are added and the schema is updated
accordingly.

19.3 Testing Flat File Schema

1. Flat file schema generated can be tested in Test page. Click on the Test tab in
the schema editor to open the Test page.

<DataType format="">Strinc
d>
xmlType="Elesment™ staa
<DataType format="">3trinc
</Field>
= Field zmlType="Elsment" sta:
<DataType format="">S5trinc
eld>

a Flat File Schemas &1
@ Flat File Schemas
‘_3; sV
# EmployeeSchema
<R Employee
{Fr Mame
(Fr Age
(F) Address

4 m
Source

Figure 19.7: Flat file schema test

2. Sample data can be generated by clicking the Generate Sample Flat Format
button or the sample can be pasted in the Flat Format section.

@ *esw 4 =0
Flat Format:
dd,dd,ddddddd -

Mike, 30, University Ave
Harry, 25, Kensington Oval
Ayrton, 40, Thousand Oaks

Figure 19.8: Flat format sample data

3. Click the Convert Flat Format to XML button. The flat format sample will be
converted to XML and is displayed in the XML Format section.
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XML Format:

<%xml version="1.0" encoding="UTF-8"7>

<EmployeeSchemas

<Employee>

<Mame>dd</Mame>

<Age>dd</Ager

<Address> ddddddd < /Address=>

< /Employee>

<Employee>

<Mame>Mike</MName=

<Age> 30=/Age>

< Address> University Ave=/Address>

</Employee>

<Employee>

<Mame>Harry</Mame>

<fAge> 25=</Age>

<Mddress> Kensington Oval</Address>
E)

Source | Test

Figure 19.9: XML output

19.4 Generating Flat File Schema using sample data

Flat file schema can be generated by configuring flat file elements as mentioned in section
19.2. The same can be done by loading the tfl data which is detailed in this section.

The same example discussed in section 19.2 is used.

1. To define schema for this data, first create a new Flat File Project. To do this,
right-click on Flat File Schemas Node and select New File Schema Project
option.

] Flat File Schemas &2 = 0

%] Flat File Schemas
Mew File Schema Project

Import Project
Import Sample Project
Import Closed Projects

Figure 19.10: New File Schema project

This launches a wizard where project details can be configured.

2. Provide the project name and select Load From Flat File option. Select the
flat file and click Next.

3. Provide the Schema Node name, record delimiters values. Since the Employee
records are separated by a new line provide the value for Record Delimiter as
\r\n. Click Load Data button to load the data from flat file. The data is loaded
and records are displayed based on the delimiter value.
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E] Create Flat File Schema Project

Specify schema details

Provide input and click Load Data to load the flat file data

Schema Name  EmployeeSchema

Record Delimiter yp\n

Delete if there are any duplicate/repeating records in the table below. To delete, right click on a row and select Delete

- oo

Record Name Record Content
Recordl Mike, 30, University Ave
Record2 Harry, 25, Kensington Oval
Record3 MAyrton, 40, Thousand Oaks
<Back || Net> |[ Enish ]| Cancel
Figure 19.11: Schema configuration
4. Since all the data corresponds to individual employee records, duplicate rows
can be removed. To remove a row, right-click and select Delete. Duplicate
rows Record2 and Record3 can be removed.
5. Rename Recordl as Employee and click Next button.
E] Create Flat File Schema Project ] &‘

Specify schema details

Provide input and click Load Data to load the flat file data

Schema Name  EmployeeSchema

Record Delimiter yp\pn

Delete if there are any duplicate/repeating records in the table below. To delete, right click on a row and select Delete

~ | Load Data

Record Name Record Content

Employee Mike, 30, University Ave

< Back ][ Mext = ] [ FEinish

Cancel

A

Figure 19.12: Configuring Records

6. The child elements can be configured in the Schema Configuration page.

Select Employee node in the left hand tree viewer. The details of the node are

displayed.

7. Provide comma (,) as the Field delimiter value.
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E] Create Flat File Schema Project [ [ B [

Schema Configuration

Define individual records

EmployecScherna
# Employ ParsingType @ Delimited () Positional

<R3 Employee
Delimiter Value ] -
Content Configure Child Elements

Mike, 30, University Ave

Figure 19.13: Configuring Record child elements

8. Click the Configure Child Elements button. The data is parsed using the child
delimiter value and is displayed in a table. The element Name, type and data
type can be chosen in this page. Provide the details and click Ok.

s ~
_E] Record Configuration ﬁ

Record Name - Employee

Elermnent Mame Element Type Data Type Content
Name Field String Mike

Age Field String 30

Address Field String University Ave

[ ok [ Ccancel

S

Figure 19.14: Defining Record child elements

9. The individual Fields are generated. Details of each node can be seen by
selecting the node on the left hand side tree viewer. Click Finish to finish the
configuration.
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Mike, 30, University Ave

Next =

_E] Create Flat Fila Schema Project 5 | S|
Schema Configuration
Define individual records
4 EmployeeSchema N -
? <Ry im);;l\oyaa Parsing Type @ Delimited () Positional

(F) Name Delimiter Value -

® Age

(Fy Address

Content Configure Child Elements

Finish

J{

Cancel

Figure 19.15: Employee Schema configuration

10. The schema is generated and is shown in the editor. This can be tested as

described in section 19.3.

19.5 Sample Schemas

This tool is shipped with five samples that represent various schema types. These are
broadly classified under two categories, namely Delimited File Schema samples and
Positional File Schema samples. The prebuilt schema samples are given below:

1. Delimited File Schema samples
e CSV File Schema
e Nested CSV File Schema
2. Positional File Schema samples
e Positional File Schema
¢ Nested Positional File Schema

e Positional in Delimited File schema

To import the prebuilt schema samples right-click on Flat File Schemas node and select

Import Sample Project option.

[#] Flat File Schemas 52
4 |[#] Flat File Schep==-

. Ii* cov Mew File Schema Project
Import Project
Import Sample Project
Import Closed Projects

Figure 19.14: Import Sample Project
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A dialog is launched listing all the available samples. Select a sample and click ok to load it
in the editor.

-

_F) Import Sample Schemas ﬁ

Select sample project to be imported.

_:g,_Csv File 5chema

;31 Mested Csv File Schema
;&Positional File Schema

;&Nested Paositional File 5chema
;&.F’ositional in Delimited File Schema

OK l ’ Cancel

%

Figure 19.17: Select sample projects

19.6 Points to note

1.

Records can be positional or delimited. A Delimited record can contain a
positional record as a child but a positional record cannot contain a Delimited
record as a child.

Delimiters have to be provided for delimited records where as Start and End
Positions have to be provided for Positional records.

The Filed properties change based on the parent record parsing types
(Delimited/Positional)

Whenever there’s any error in the generated schema, an error badge is shown
on the corresponding element indicating the error. Place the cursor to see the
error message.

#] Flat File Schemas & = B
4 [#] Flat File Schemas

4 _:31 5w
a4 ¥¥ EmployeeSchema
4 <Rz Employes
() Nams 1.Delimiter Yalue is not specified for Record - Emple
) Age
{F) Address

Figure 19.18: Schema Errors

The order of Fields or Records can be changed. To change the order, select the
parent element and select Change Order option. A dialog is displayed where
the order can be altered.
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-

[#] Flat File Schemas 52 = B8 ¥ Change Order =
4 @ E:t File Schemas Show the fields in the order below.
4 csw
a ¥¥ EmployeeSchemna (B) Name E
4 [<Fz Employ (B Age E
{F Mar Cut Ctrl+ % :> {E) Address
{71 Age Copy Ctrl+C
{F) Add Paste Ctrl+V
Delete Delete
Change Crder
Add 3
OK l [ Cancel

Figure 19.19: Change elements order

5. A flat file schema project can be exported using the Export option available on
the context menu of the project. Similarly a project can be imported by
selecting Import Project option available on Flat File Schemas context menu.

[#] Flat File Schemas &3 - O
4 [#] Flat File Schemas [#] Flat File Schemas &3 -
4|, ot o 4 |[#] Flat File Schema ; :
- ¥ 4 Izl cov New File Schema Project
P Copy Ctrl+C 4 #¥ Employe Impoert Project

Paste Ctrl+V 4 <Fg Empl Import Sample Project

Delete Delete BN Import Closed Projects

Export ® A

Close (E) Address

Figure 19.20: Import/Export project

6. We can close a project and load them later by using Open Closed Projects
option on Flat File Schemas Node.

19.7 Flat File Element Properties

The properties associated with flat file nodes are described in this section.

19.7.1 Schema Node Properties

The Schema Nodes of all the file schemas represent the same set of properties. These
properties act as global properties of the file schema which are available to all the
descendent records and fields.

Note: If you change the Name value on the Properties panel, the name of the Root Node
in the specification tree automatically changes to match it and vice versa. The name of the
node should be a valid XML name.
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The following table lists all properties associated with the Schema Node:

Property Value

Comment An identifier which indicates the start of a comment in the source file.
Start

Identifier

Comment End

An identifier which indicates the end of a comment in the source file.

Identifier The data between the ‘Comment Start’ and ‘*Comment End’ identifier is
ignored.
Note: Comment Start and Comment End Identifiers must not be
identical.

Name This is the name of the Root Node.

Description This is the description of the specification.

Delimiter Type or select a value for the delimiter. To specify a delimiter value,

Value you must first set the Delimiter Type to Custom Delimiter. The
delimiter can be multi-character.

Escape Specifies the default value of the escape character for this Schema

Character Instance. Type or select a character value for the escape character. To

specify an escape character value, you must first set the Escape Type
to Character.

Delimiter Type

Select one of the following options to choose a delimiter for the
records/fields directly below the current record.

Default Field Delimiter Indicates that the delimiter is the value of the
Default Field Delimiter property, which is defined for the schema
instance.

Custom Delimiter Allows the user to designate a field delimiter value
for the record. If you select Custom Delimiter, you must specify a
delimiter value.
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Escape You can choose the escape character type from the following values:
Character Default Escape Character - Indicates that the escape character is the
Type value of the Default Escape Character property which is defined for the

schema instance.

Character - Allows the user to designate an escape character value. If
you select Character, you must also specify an escape value.

An escape character is useful if you have a character in your field data
that is also used as the delimiter character in the field’s parent record.

For example, if your field data is the following and you have chosen a
comma as the delimiter value of the record that contains the field, TSE
interprets the comma after "Fiorano" to be a delimiter, even if you
intend for it to be part of the field data:

Fiorano,Software,USA

Solution for this is to place an escape character directly preceding the
delimiter character that you want to include in the field data. For
example, if your escape character is specified as a backslash, you can
place a backslash directly preceding a delimiter character, as in the
following example:

Fiorano\,Software,USA

TSE interprets the comma after the backslash as field data rather than
a delimiter character.

Escape This is the escape character which is to be used as the field delimiter.
Character

Delimiter Type or select a value for the delimiter. To specify a delimiter value,
Value you must first set the Delimiter Type to Custom Delimiter. The

delimiter can be multi-character.

Escape You can choose the escape character type from the following values:
Character Default Escape Character Indicates that the escape character is the
Type value of the Default Escape Character property which is defined for the

schema instance.

CharacterAllows the user to designate an escape character value. If
you select Character, you must also specify an escape value.

An escape character is useful if you have a character in your field data
that is also used as the delimiter character in the field’s parent record.

For example, if your field data is the following and you have chosen a
comma as the delimiter value of the record that contains the field, TSE
interprets the comma after "Fiorano" to be a delimiter, even if you
intend for it to be part of the field data:

Fiorano,Software,USA

Solution for this is to place an escape character directly preceding the
delimiter character that you want to include in the field data. For
example, if your escape character is specified as a backslash, you can
place a backslash directly preceding a delimiter character, as in the
following example:

Fiorano\,Software,USA

TSE interprets the comma after the backslash as field data rather than
a delimiter character.
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Delimiter Type | This is the field delimiter of this file schema. The delimiter can be
multiple characters.

19.7.2 Record Node Properties

Every file schema is a unique entity, with a unique set of records and fields. You can create
a new schema by modifying an existing schema. To modify an existing schema, you need
to add and/or remove records. After adding records, you must specify the properties
associated with it. If you remove a record, its properties are also removed, along with all
child records and fields. In addition to adding and removing records, you can also rename
them. You can edit the name of an existing record and its properties by selecting the

record and editing it.

Following are some basic rules pertaining to records.

1. Every new record, which you create, is inserted as a descendant of the record
that you selected.

2. The name of a record or field needs to be unique. The tool will display an
exception if you specify a name that has already been assigned to an existing
record or field.

3. When you delete a record, all child records and fields are also deleted.

The following table lists all the properties associated with the record node:

Property Value

XML Type The target XML type for the field. Depending on this value, the tag in the
resultant XML is generated. Its value can either be Element (default) or None.
If 'None' is selected, then the field is NOT mapped to the resultant XML.

Minimum The minimum number of occurrences specified for a particular record. If the

Occurrences record does not occurs the specified number of times, then an exception is
thrown.

Maximum The maximum number of occurrences allowed for a specified record. After these

Occurrences many occurrences, the parser will not attempt to match the record and an

exception is thrown.

Parsing Type

Specifies whether the data input is to be considered as Positional or Delimited.
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Record Identifier
Type

Type of the Identifier to be used for identifying a record.
You can choose the Record Identifier from the following values:

Field Value Choose this option if you want to identify the record based on the
value of some child field. In this case you need to select the field value in the
Record Identifier Value property.

Child Count The record is identified based on the number of child counts. While
parsing, if the child count in the record data does not match the number of
children defined in the file schema, then parsing error is thrown.

None Record data is parsed against the record definition irrespective of the
fact that the data satisfies the complete record definition or not.

Name The name of the record. The name of the node should be a valid XML name. You
cannot provide an existing record the same name as an existing record. Sibling
record cannot have the same name.

Description The description of the record.

Escape Character
Type

You can choose the escape character type from the following values:

Default Escape Character - Indicates that the escape character is the value of
the Default Escape Character property which is defined for the schema instance.

Character - Allows the user to designate an escape character value. If you
select Character, you must also specify an escape value.

An escape character is useful if you have a character in your field data that is
also used as the delimiter character in the field’s parent record.

For example, if your field data is the following and you have chosen a comma as
the delimiter value of the record that contains the field, TSE interprets the
comma after "Fiorano" to be a delimiter, even if you intend for it to be part of
the field data:

Fiorano,Software,USA

Solution for this is to place an escape character directly preceding the delimiter
character that you want to include in the field data. For example, if your escape
character is specified as a backslash, you can place a backslash directly
preceding a delimiter character, as in the following example:

Fiorano\,Software,USA

TSE interprets the comma after the backslash as field data rather than a
delimiter character.

Delimiter Value

Type or select a value for the delimiter. To specify a delimiter value, you must
first set the Delimiter Type to Custom Delimiter. The delimiter can be multi-
character.

Delimiter Type

This is the field delimiter of this file schema. The delimiter can be multiple
characters.

Escape Character

This is the escape character which is to be used as the field delimiter.
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19.7.3 Field Node Properties

Depending on the type of file schema you are defining, you might need to add and/or
remove fields. After adding fields to any schema, you must specify their properties. If you
remove a field, its properties are also removed. You can’t add records or fields under a
field.

When you add a field, you can immediately rename the field. You can edit the name of an
existing field and its properties by selecting the field and editing it.

1. 1If you click Add > Field from the popup menu that appears after right-clicking the
mouse, the new field is inserted as a descendant of the record that you selected.

2. You cannot give an existing field the same name as an existing record.

3. You cannot provide a new field instance the same name as an existing sibling field
or record.

4. Sibling fields cannot have the same name.

Any changes to the visible properties in the table are set for the currently selected node of
the schema tree, which can be a record or field or the root node.

The following parameters are associated with the field node:

Property Value

XML Type The type for the field. This value can either be Element (default), Attribute or
None. If None is selected, then the field is NOT mapped to the resultant XML.

Data Type Represents the data type for the field data. This property can be set if you want
to validate the field data against the supported data types. Data types
supported by it include String (default), Integer, Numeric, Date, Byte, Data
Format. This can be defined if the data type for the field is either Numeric or
Date. For Numeric data type, data format can be defined based on the syntax
rules of java.text.DecimalFormat. For Date data type, data format can be
defined based on the syntax rules of java.text.SimpleDateFormat.

Minimum Length The minimum number of characters that the field can contain.

Maximum Length The maximum number of characters that the field can contain.

Default value The default value for a field. The field is matched only if it's value is the same
as the default value. Can be used to set Headers and Column Names.

Map If Null Whether or not the field should be defined in the output XML if the value for the
field in the source file is null/blank.

This property is redundant if the XML Type for the field is set to None in the
General properties set.

If the value for the field in the source data is null/blank but Default Value is
defined for the field, then the default value is set in the output XML.

This property field displays only if the structure of the parent record is
delimited.
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Wrap Character

Character used to enclose field data. This property is useful if you have a
character in your field data that is also used as the delimiter value for the field's
parent node.

For example, if your field data is the following and you have chosen a comma as
the delimiter value of the node that contains the field, TSE Parser interprets the
comma after "Fiorano" to be a delimiter, even if you intend to include it as a
part of the field data:

Fiorano,Software,USA

A solution for this is to define a value for the wrap character property and then
enclose the field data in the wrap character. For example, you can set the wrap
character property to double quotation marks for the first field and then type
your field data, as in the following example:

Fiorano, Software, USA

The comma between the double quotation marks is interpreted by TSE Parser to
be field data rather than a delimiter value.

This property field displays only if the structure of the parent record is
delimited.

If you have a field that uses a wrap character, there cannot be any data

between the wrap character and any delimiter leading or following a wrap
character.

If your field data includes characters that are also used as the wrap character,
you must enclose those characters in another set of wrap characters.

Padding character

This functionality is for the File Writer. If a certain field is smaller than the
required size (either minimum length for delimited records or field length for
positional records) then the FileWriter will pad the field with the padding
character. Fields are always padded to the right of the field.

Valid Characters

The value for this property represents the set of valid characters for the field
value. If this value is set and the field data contains any character which
doesnot belong to this list, then parsing error is thrown.

Invalid Characters

The value for this property represents the set of invalid characters for the field
value. If this value is set and the field data contains any character which
belongs to this list, then parsing error is thrown.

Trim Spaces

Whether to trim the spaces from the source field data before setting in the
output XML. You can opt for trimming the spaces from the following positions:

Both (Leading and Trailing)

Leading

Trailing

None
Name The name of the field. The name of the node should be a valid XML name.
Description The description of the field.
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Chapter 20: Fiorano Tools
Perspective

Fiorano Tools Perspective in eStudio contains ESB Tools like Event Manager, Deployment
Manager and License Manager along with Flat File Schema Tool. The default Fiorano Tools
Perspective has the following components:

e Tools View
e Flat File Schemas View
e Properties view

e Error and Console Logs.

20.1 Fiorano Tools Perspective

To open Fiorano Tools Perspective, navigate to Window -> Open Perspective -> Other and
select Fiorano Tools.

[ Fiorano eStudio-/C:/Program FilesiFiorano/FioranoS0AS.4.0fruntimedata/eStudiofworks pace/
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% Deployment Manager Property Value
f Evert Hanager
1E license Manager
[ Pt Pl schemas 11 !
[# Flat Fie Sehemas
©EnorLog 53 Bl Console g v x @v-0
‘Warkspace Log
Message Plug-n Date
i semof 4ol [

Figure 1: Fiorano Tools Perspective

20.1.1 Fiorano Tools View
The Fiorano Tools view acts as an explorer for the ESB Tools. It holds the following ESB
Tools:

e Deployment Manager

e Event Manager

e License Manager.
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20.2 Deployment Manager

Fiorano Deployment Manager allows you to control the deployment of business
components and event processes on the various nodes in Fiorano network. You can use a
combination of Labels (Development, QA, Staging and Production) and other identifiers
(GUIDs, version numbers and node names) to create comprehensive and powerful rules to
control the deployment of Event Processes.

Select Deployment Manager Node from Tools View, right-click and select Login to connect
to Enterprise Server.

L . =
= Tools Wiew &3 = 8
“
B':} Event Mal % Wiew Deployment Manager
T§ License M .
Lagin

Figure 2: Tools View

After Login, a Deployment Manager View is opened adjacent to the Tools View. All
Deployment Manager related actions like designing of new rules, modifying existing rules,
etc can be performed from this view. To explicitly open Deployment Manager View, Right
click on Deployment Manager Node and select “"View Deployment manager”.

| Fiorano eStudio-/C:/Program Files/Fiorano/FioranoSOA9.4.0/runtime data/eStudio/workspace/
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Figure 3: Fiorano Deployment Manager View

20.2.1 Using Fiorano Deployment Manager

Fiorano Deployment Manager is a fairly straightforward tool with self explanatory controls.
This section briefly describes the various actions that can be performed using this tool.
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20.2.1.1 Creating a Rule

You can set rules for the deployment of a business component in an event process(s) on a

particular node(s).

To create a new rule, perform the following steps:

e Click on New button, the New Rule dialog box is displayed.

Mame of the Rule |

() allow ) Disallow

Execution of Bussiness Component[s]
[] where business component guid contains guid
[ where business component version makches version
] where business component label contains label

A part of Event Process[s]
[ where event process guid contains guid
|:| where event process version matches version
[ where event process label matches label

On peer server[s]

[] where peer server name contains name
[ where peer server label contains label

Rule Descriptioniclick on & blue link to edit it)

Allow

Marme should not be emply

Cancel

Figure 4: New Rule Dialog

The New Rule window consists of the following controls:

1.

Allow: Select this option to create a positive rule. A positive rule is one where
a business component, event process, or peer server are allowed to perform a
task.

Disallow: Select this option to create a negative rule. A negative rule is one
where a business component, event process, or peer server are restricted from
performing a task.

Execution of business service: This field contains three check boxes for
creating business service specific rules:
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o Where business component guid contains guid: Select this option to
specify the GUID of a business service in a rule.

o Where business component version matches version: Select this option
to specify the Version of a business service in a rule.

o Where business component label contains label: Select this option to
specify the Label of a business service in a rule.

4. As part of event process(s): This field contains three check boxes for creating
event process specific rules

o Where event process guid contains guid: Select this option to specify
the GUID of an event process in a rule.

o Where event process version matches version: Select this option to
specify the Version of an event process in a rule.

o Where event process label matches label: Select this option to specify
the Label of an event process in a rule.

5. On peer server[s]:

o Where peer server name contains name: Select this option to specify
the name of a peer server in a rule.

o Where peer server label contains label: Select this option to specify the
label of a peer server in a rule.

e Select Allow or Disallow button for choosing the deployment of business service.

e Set conditions for the rule in Business component[s] panel selecting the desired check
boxes. You can specify multiple conditions for a single rule by selecting more than one
check box.

o To set the rule on the basis Business Component GUID, select Where business
component guid contains guid condition and select GUID hyperlink from “Rule
Description panel”, and select the required Business Components from the
Business Component selection dialog

E\ Business Component Selection Dialog, E]

vailable Business Components ~

S

thggregator

BeanShell
BinaryFileReader

Cache

CER

chat

ZompositeBC
Zompression

kM

csChat

DB

DEProc

DBQuery
DBQueryOnInput
Decompression
Decryption
DiskUsageManitorService
Display
DistributionService
EDIZXML a/

Selection Items

Figure 5: Business Component Selection dialog

o To set the rule on the basis of Business Component Version, select Where
business component version matches version condition and select Version
hyperlink from “Rule Description panel”, and select the required Business
Component Versions from the Business Component Version selection dialog
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B3| Business Component Version Selection Dialog E]

Avalable Business Companent Yersions
[0
[Oso
Selection Items

Figure é: Business Component version selection dialog

o To set the rule on the basis of Business Component Label, select Where
business component label matches label condition and select Label hyperlink
from “Rule Description panel”, and select the required Business Component
Label from the Business Component Label selection dialog

3| Business Component Label Selection Dialog @
Available Business Component Labels
[] ‘Development
[ production
[ A
D Staging
Selection Items

Figure 7: Business Component Version selection dialog

e Set conditions for the rule in Event Process[s] panel selecting the desired check boxes.

You can specify multiple conditions for a single rule by selecting more than one check
box.

o To set the rule on the basis of Event Process GUID, select Where event process
guid contains guid condition and select GUID hyperlink from “Rule Description

panel”, and select the required Event Processes from the Event Process
selection dialog
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B3| Event Process Selection Dialog, E|
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[] sIMPLECHAT
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[[] WORKLIST_MANAGER
Selection Ikems

Figure 1: Event Process selection dialog

o To set the rule on the basis of Event Process Version, select Where event
process version matches version condition and select Version hyperlink from
“Rule Description panel”, and select the required Event Process Versions from

the Event Process Version selection dialog

H| Event Process Version Selection Dialog E

Available Event Process Yersions

i

Selection Ikems

Select Al

Cancel

Figure 9: Event Process Version selection dialog

o To set the rule on the basis of Event Process Label, select Where event process
label matches label condition and select Label hyperlink from “Rule Description
panel”, and select the required Event process labels from the Event Process

label selection dialog
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K| Event Process Label Selection Dialog E]

Available Event Process Labels

[[] ‘Development
[ production
|:| Skaging

|:| Testing

Selection Items

Figure 10: Event Process Label selection dialog

e Set conditions for the rule in Peer Server[s] panel by selecting the desired check
boxes. You can specify multiple conditions for a single rule by selecting more than one
check box.

o To set the rule on the basis of Peer Server name, select Where peer server
name contains name condition and select name hyperlink from “Rule
Description panel”, and select the required peer servers from the Peer Server
selection dialog

EI Peer Server Selection Dialog @

Available Peer Servers

fps

4 |

Selection Ikems

fps

[Clear Selection] [ Ok ] [ Cancel

Figure 11: Peer Server selection dialog

o To set the rule on the basis of Peer Server label, select where peer server label
contains label condition and select label hyperlink from “Rule Description
panel”, and select the required peer servers from the Peer Server label
selection dialog.
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EI Peer Server Label Selection Dialog @

#Available Peer Servers Labels
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[ Praduction
0 o
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< >
Selection Items

Figure 12: Peer Server label selection dialog

e Enter the name of the rule and click Ok button to create a new rule.

20.2.1.2 Modifying a Rule

To modify a rule, perform the following steps:
1. Select a Rule in the Available Rules section.
2. Click on the Modify button. The Modify Rule dialog is opened.

3. Make the required changes and click on Ok button.

20.2.1.3 Creating a copy of a Rule

Although creating Rules using Deployment Manager is straight forward, creating variants of
complex rules can be cumbersome and repetitive. To simplify the process, the tool allows
you to create copies of a rule. In this way, you can create copies of complex rules and
tweak them to create variants. To create a copy of a rule:

1. Select a Rule in the Available Rules section.

2. Click on the Copy button. A copy of the Rule will be created with all the set conditions.
3. Make the required changes to the Rule.
4

Enter the name of the new Rule and click Ok button.

20.2.1.4 Deleting a Rule:

To delete a rule, perform the following steps:
1. Select a Rule in the Available Rules section.

2. Click on the Remove button.

20.2.1.5 Testing the Rule|s]

You can check the functionality of a Rule by testing it against the relevant parameters of a
business component, event process or peer server. To test the Rule[s], perform the
following steps:

1. Click on the Test button. The Test dialog box is opened.
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Figure 13: Test dialog
2. Select the Deployment Permission or Composition Permission option.

3. From the Business Component section, select applicable GUID from the GUID drop
down.

4. Select Version and Label from their respective drop down lists.

From the Event Process section, select applicable Event Process GUID, Version and
Label from their respective drop down lists.

6. Next, select peer server name and label from Peer Server section.

7. Click on Verify to test the Rule.

20.2.1.6 Refreshing the display of Rules

To refresh the display of Rules in the Available Rules section, click on Refresh button.

20.2.1.7 Changing the precedence of Rules:

In the Available Rules section, all the Rules starting from the top-most one are arranged in
decreasing order of priority in the Rules pane.

To change the precedence of Rules, select the Rule and click Move Up or Move Down
button.

20.3 Event Manager

Fiorano Event Manager Tool can be used to view Event Process events, normal business
service events, monitor the states of various tracked documents, or to Track the status of
an activity or document across a distributed workflow. The functionality of the tool can be
broadly categorized into one of the following:

¢ Managing Services
¢ Managing Events
e Managing Document Tracking.

1. Select Event Manager Node from Tools View, right-click and select Login to connect to
Enterprise Server.
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Figure 14: Tools View, Event Manager Node

2. After Login, an Events View is opened adjacent to the Tools View. All the Event Process
events, Business Service events, States of tracked documents, Business Components
for event processes etc can be viewed in this view. To explicitly open Events View,
Right click on Event Manager Node and select “View Fiorano Events”.

3. The Event Manager Node contains an Event Process Repository Node, System Events
Node and Security Events Node. The Event Process Repository Node in-turn contains a
tree structure of various event processes in the Enterprise server. Each Event Process
Node contains the following nodes:

e Business Components Node
e Process Events Node
e Business Component Events Node

e Tracked Documents Node
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Figure 15: Events View
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20.3.1 Managing Services

The various Business services in an Event Process and their current states can be viewed
here. Also, Output and Error logs can be viewed for each service.
To view the details of a service:

1. Click Event Process Repository -> [Event Process Name] in Tools View

2. Select Business Components Node under the Event Process Node

Each Business service contains the following details:
e Business Service Instance Name: Name of the business service instance

e Business Service GUID: GUID (Global Unique Identifier) is used to uniquely
identify the business service on the Fiorano network. This ID cannot hold any
special characters or spaces. Business service GUID represents the GUID for the
business service.

e Version: This is the version of the business service, and must be a valid floating
point number.

e Status: Represents the status of the business service. Its value is set to “"Not
running” if the business service handle does not have the value
SERVICE_HANDLE_BOUND or SERVICE_HANDLE_UNBOUND.

e Node Name: Name of the node where the business service is running.
e Launch Time: The time when the business service was launched.

¢ Kill Time: The time when the business service was killed.
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Figure 16: Business Components in Events View

To view the logs of a service:
1. Select a service in Events View

2. Right click on the service and select ‘View Logs’
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0F:17:2011 : INFO : Sending event: Status Event Properties-------------ssmmmmmmmmmmmmmnneeeee | Event ID : PAGE059635305 Protocol Yersion : 1.0 Event Time : Wed A
0F:17:2011 : INFO : Component state changed. State: Service State: STARTING; Transport Layer State: STARTED;Business Layer State: STARTING. Changed: bu
0&:17:2011 : INFO : Component state changed. State: Service State: STARTING; Transport Layer State: STARTED;Business Layer State: STARTED. Changed: bu
08:17:2011 : INFO : Component state changed. State: Service State: STARTED; T t Layer State: STARTED;Business Layer Skate: STARTED. Changed: stat
08:17:2011 : INFO : Sending event: Status Event Properties------ -Event ID : 7965129429857 Pratocol Yersion : 1.0 Event Time : Wed AL
08:17:2011 ; INFO : Received event: Command Event Properties-
08:17:2011 ; INFO : Received shutdown command from the peer server, Correlation 1D - 0

08:17:2011 : INFO : Component state changed. State: Service State: STOPPING; Transport Layer State: STARTED;Busingss Layer State: STARTED, Changed: stz
08:17:2011 : INFO : Component state changed. State: Service State: STOPPING; Transport Layer State: STARTED;Busingss Layer State: STOPPING, Changed: bi
08:17:2011 : INFO : Component state changed. State: Service State: STOPPING; Transport Layer State: STARTED;Busingss Layer State: STOPPED, Changed: bu:
08:17:2011 : INFO : Component state changed. State: Service State: STOPPING; Transport Layer State: STOPPING;Business Layer State: STOPPED, Changed: tr
08:17:2011 : INFO : Component state changed. State: Service State: STOPPING; Transport Layer State: STOPPED;Busingss Layer State: STOPPED, Changed: tra
08:17:2011 : INFO : Component state changed. State: Service State: STOPPED; Transport Layer State: STOPPED;Business Layer State: STOPPED, Changed: stat

Event ID : 8195682739645 Protocol Yersion : 1.0 Event Time ; We

< >
Clear Export... Refresh Close
[ J ) ]

Figure 172: Business Component Logs

20.3.2 Managing Events
Fiorano Event Manager allows you to log and monitor events generated by event processes
at the FES layer. The various events that are logged by the event viewer are as follows:

1. Process Events: System Events pertaining to an event process. For example, on
launching an event process APPLICATION_LAUNCH_STARTED event is generated.

To view Process Events:
e Select Event Process Repository Node -> [Event Process Name] in Tools View
e Select Process Events Node under the Event Process Node

2. Business Service Events: System Events that are related to services are Service
Events.

To view Service Events:
e Select Event Process Repository Node -> [Event Process Name] in Tools View

e Select Business Component Events Node under Event Process Node
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Figure 18: Business Component Events in Events View

Event Properties: To view the information pertaining to a specified Event, in detail:

e Select Event Process Repository Node -> [Event Process Name] -> [Events Node]
in Tools View.

e Select an Event, right-click on the event and select Properties.

B3| Event Properties f'5_<|

Event

Event ID: 108

Dake: Wed Aug 17 15:12:03 [ST 2011
Type: Information

Scope:  FIORAMNOESE

Status:  SERYICE_HAMDLE_LIMBOUMD

@) (=[]

Descripkion:
SERVICE MICHAEL HAS BEEN UNEOUMND FROM PEER. FPS,

Close

Figure 19: Event Properties dialog

20.3.3 Managing Document Tracking

The documents flowing from one Service to another in an Event Process can be tracked by
enabling Document Tracking in FEPO. All such Tracked Documents and their properties can
be viewed in Fiorano Event Manager.

To view Tracked Documents in an Event Process:

e Click Event Process Repository -> [Event Process Name] in Tools View
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e Select Tracked Documents Node under the Event Process Node
WorkFlow Information:

When you click on the Tracked Documents Node in the Tools View, a detailed table is

displayed in the Events View. This is termed as the Workflow table. It contains information
such as workflow Instance ID and the current status of the workflow. Each Event Process is
viewed as a Workflow area, within which a large number of documents and messages flow.

The Workflow table for a Tracked Document shows the following details:

e Instance ID: An Event Process can have many of its instances at the same time.
These are called as Workflow Instances. Every time a new document enters the
workflow, a new workflow instance is generated with a new Workflow Instance ID.

e Status: The current execution status of the Workflow Instance.

e Last Business Service: Represents the last business service that was tracked in
the Workflow.

e Cycle Time: Time spent by the document in traversing the Workflow.

| Fiorano eStudio-/C:/Program Files/Fiorano/FioranoS0A9.4.0/runtime datafeStudioAworkspace/

File Edt Navigats Search Run Praject Window Help

w (R
[ @ onine Event Pracess Developmert | & Fiorano Tools | (3 Offline Event Process Development
& Tools View 52 5 = O | properties | B Events i3 =0
:4 Deployment Manager # | Instance I Last Custom ID Status Lask Business Component: Cycle: Time(ms)
= fia! Event Manager fps_1313565460578_1 EXECUTING chatz
=[] Event Process Repository fps_131 EXECLITING chat!
o3 Purchasing System s 13 EXECUTING [chat | |
=548 Simpls Chat fps_t Froperties EXECUTING chat1
&P Business Companents
% Process Events
By Business Companent Evants
Tracked Documents
o8 SalesForce_Inkegration
o3 Retal Television
{3 Portal Integration
o Hospitally Service
(8 WorkList Exampls
o Reverue Cantral Packet
o{f Order Ertry
o{8 Mortgage Praperty Request Automation [
[#] Fiat File Schemas &3 =
%] Flat File Schemas
Q) Errortog &2 | B Console S X #¥ =0

Workspace Lea

Message Plug-in Date

g

aMof 49 ([ ©

Figure 20: Tracked Documents in Events View

Document Properties:
To view the information pertaining to a Specific Document like the various Document
States Traversed etc, in detail:

e Select Tracked Documents Node under the Event Process Node

e Select a Document, Right-click on the document and select properties.
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EI Document States Traversed

WiorkFlowInstancelD: Fps_131356546

0576_2

Application Peer
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State Eusiness Com...  Date User Doc I

OUT_PORT

IN_PORT chatz 17 Aug 2011 ...

Doc ID Processing Ti...

chatl SIMPLE...
chatz_SIMPLE... 0

Comment: Document was sent from port : OUT_PORT of component: chatl on Date: Wed Aug 17 15:57:59 IST 2011,

Close

Figure 21: Document Stated Traversed dialog

Document State Properties:

To view Properties of the Document States Traversed, Double-click on the Document
State. If the Tracked Document contains any file attachments, go to Attachments tab,
select the file attachment and use “Save As...” to save the attachment on the local disk.

EI Document State Properties

Message Body | Properties | Attachments | Application Conkexk

3

Properky

Application Instance I0
Comrment

Correlation ID
Dacument 10
Document is Redelivered
Docurnent Type

Entire Data Length

In Time

Is End of Service

Ot Tirne

Part

Reply Channel

Service Instance Mame
Source Node Mame
Total Time

‘Workflow Instance ID

Yalue
SIMPLECHAT

Document reached port : IN_PORT of camponent: chat? on Date: Wed Aug 17 15:5...

chatz_SIMPLECHAT _1313565460575_4
MG

General Document

913 bytes

Wwed, Aug 17, '11 at 03:57:59:171

MG

MOT SET

IN_PORT

chatz

0 msec,
fps_1313565460578_2

Figure 22: Document State Properties dialog

Close

In addition to above, the following actions can be performed with respect to Event

Manager Tool.

1. Right-click on Event Process Repository node and select Refresh to refetch all the
event processes, their components, events and tracked documents from server.

2. Select Event Process Node and right-click.

a. Select Clear EventProcess Logs to clear all the event process logs.
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b. Select Clear all Events to clear the process and component events of the
selected Event Process

c. Select Refresh to fetch Business components, Process and Component events
and tracked documents from the server.

3. Select Business components node and Right-click.

a. Select Export List to export the Business Components with their current
execution states and other details as a text file.

b. Select Refresh to fetch the business components from server.

4. Select Process Events Node \ Component Events Node \ Tracked Documents Node and
right-click

a. Select Export List to export the events or tracked documents as a text file.
b. Select Clear to clear all the events or tracked documents of the selected node.

c. Select Refresh to fetch events or tracked documents for the selected node from
server.
20.4 License Manager

The License Manager Tool enables you to manage Fiorano SOA Platform licenses. This tool
can also be used to gather machine information and request for additional licenses.

20.4.1 Fiorano Licenses Overview

Fiorano SOA Platform has been segregated into various modules. The product modules and
the license files required to enable these modules are listed below. These License files can
be managed using License Manager Tool.

Module License File

Fiorano Prebuilt Components(BCs and EDBCs) fiorano-soa9.lic
Fiorano ESB Server fiorano-soa9.lic
Fiorano MQ 9 Server fiorano-mq9.lic

The license for FioranoMQ 9 Server offered with
Fiorano SOA Platform is included in the Fiorano-soa9.lic file.

Fiorano Studio fiorano-soa9.lic
Fiorano eStudio

Fiorano Tools fiorano-soa9.lic
Fiorano Deployment Manager
Fiorano Event Manager

Fiorano Mapper

Fiorano Event Process Orchestrator
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20.4.2 Tool Environment

Select License Manager Node from Tools View, right-click and select Load to load license
files as shown in Figure 23.

iy . =
= Tools View &5 = O

%d Deplovment Manager
B‘:} Event Manager

1E view Licenses Info

Load

Figure 23: License Manager Node, Tools View

After the licenses are loaded successfully, a Licenses View is opened adjacent to the Tools
View. All the license related information can be viewed in the Licenses View. To explicitly
open Licenses View, Right click on License Manager Node and select View Licenses Info.

8| Fiorano eStudio-/C:/Program Files/Fiorano/FioranoS0A9.4.0/runtimedataleStudiofworkspace/

Fie Edit Mavigate Search Run Project Window Help

il

4 | & Fiorano Tools | (5 Offine Event Process Development

= Toals Yiew &3 = = O El properties | YZ Licenses View 2 g
Deployment Manager
4 Deply & Select License Module Mame Fram Drop Down
E} Event Manager
& {E License Manager |FE5 V‘
(] fiorano-ma@ fic
=) feranosos Customer Fiorano
Products (FES9;HA): (FPS;9;HAY: (PG 9; 1:(FE; 95 : M 9;):(EDT; 8, J:LFEPCy B3 ):CF S5 ) FHAT; 3 FEM; 9, e (M9, (DM, 9, J: DB %) (CBQuery%;): (DBProcy; 3 0. .
4 2 Type Eval
b Adapters Environment Evaluation
b Tools PU wrlirmited
Eindta amywhere
Issued date 2011-4-7
Expiration Tue Oct 04 00:00:00 15T 2011
Signature 302002141 C4a5B904CFABOAETSCE1BISAT 16262E6FC253FR021454923EB35FFE 1AA1 23E56E, 36F
[# Flat File Schemas 52 =0
[#] Fat Fie Schemas

©]EnorLog 2 | Bl Console 3 .
‘Warkspace Log

Message Plug-in Date

@ v=0
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Figure 24: Licenses View

All the Licenses present in "FIORANO_HOME\ licenses” folder are shown as License Nodes
under the License Manager Node in the Tools View. Each License Node in-turn contains
Servers, Adapters and Tools nodes. Each of these nodes on selection shows the Servers,
Adapters or Tools respectively in the drop down along with the license configuration details
in a table below.
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20.4.3 License Configuration

To view License Configuration, select a license node under the License Manager Node. The
Configuration for the selected license is shown in key-value pairs in the Licenses View. The
Configuration parameters and their respective descriptions are shown below:

Parameter Description

Customer Displays the name of the customer.

Products Displays the name of the enabled product modules.
Type Displays the type of license used.

Environment

Displays the environment where the product is used.

CPU

Displays the number of CPUs supported by the installed license

Bind To

Displays whether the license is bound to the Host Name of your system or
to the IP address of your system.

Issued Date

Displays the issue date of the installed license

Expiration

Displays the expiry date of the installed license

Signature

Displays the encrypted signature of the installation.

20.4.4 Managing Fiorano Licenses

This section describes the following tasks that enable you to manage Fiorano licenses using
the License Manager Tool:

e Viewing and saving system Information

e Acquiring, Validating and Adding a license.

e Removing a license.

Viewing and saving Information:

The following steps enable you to view license specific information:

1. Right-click on License Manager Node and select Machine Info. A machine
information pop-up appears and displays license specific machine information as
name-value pairs

2. Save the displayed information by clicking in the Save button on the top right hand
corner on the machine pop-up.
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Parameter Walue

Java Runtime vendor Sun Micrasystems Inc,

Java Runtime Marne JavalTM) 2 Runtime Environment, Skand. ..
IF Address 01 192.168.2.20

Q5 Version .1

Mo, OF Processars 4

Java Runtime Yersion 1.5.0_22-b03

25 Mame Windows XP

Hosk Marne: snehil-7ad1427a

Figure 25: Machine Info dialog

Acquiring, Validating and Adding a License:

To acquire a new License:

1.

Right-click on License Manager Node and select Request new. This redirects you to
Fiorano License Portal so that a new license request can be registered with us.

You will receive the requested license(s) after successful execution of your license
request. These licenses will be delivered to you in as Fiorano<product_name>.lic
files which can be imported, validated and added to the Fiorano SOA Platform
using the License Manager Tool.

To import, validate and add a license:

1.

Right-click on License Manager Node -> select Import, to import a new License File
into the License Manager tool. The imported license will be added as a License
Node under the License Manager Node.

Right-click on any License Node -> select Validate to validate the license with
respect to your Fiorano SOA Platform.

Upon importing a license from the License Manager tool, the license is successfully
added to the Fiorano SOA Platform.

Removing a License:

1.

Right-click on a License Node -> select Delete to delete the selected license file
from Fiorano SOA Platform

To delete all licenses, right-click on License Manager Node -> select Delete All. All
license files are deleted from Fiorano SOA Platform.

In addition to above, the following actions can be performed with respect to License
Manager Node:

Select the License Manager Node and right-click:

View Fiorano Licenses: Opens the Licenses View. All the license related information
can be viewed here.

Load: Load licenses present in "FIORANO_HOME\licenses” folder.

Close: Close all previously loaded licenses.
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Chapter 21: Frequently Asked
Questions

Question 1: Launching multiple eStudio instances in the same machine

Multiple eStudio instances can be run from the same machine. The following steps have to
be followed to launch a new instance of eStudio in a machine where another eStudio
instance is already running.

1. During eStudio launch the Workspace Selection dialog is shown prompting for
the workspace directory. A new workspace directory (one which is not already
in use) has to be selected.

B3| Workspace Selection ['5—<|

Pick Workspace
@ \Warkspace selected is already in use by anather eStudio.

Workspace Directory : | Z:\Program Files'\FioranoiFioranoS0A9, 4, 2 runtimedata/eStudi v| [Brawse... ]

[ Iremember workspace

Clone I [ 0K, l [ Cancel

When a new workspace location is selected for the first time, a message dialog is
prompted asking for confirmation to create a workspace in the specified location.
Click Ok to create a new workspace in the specified location.

& New Workspace [5_(|

The directory ' \Documents and

e Settingslsnehil\Deskiop! Temp_\Warkspace!.our_rcp_warkspace' is nak sek ko
be a workspace, Do noke thak files will be created direckly under the specified
direckory and it is suggested wou create a directory that has a name that
represents your workspace,

Would wou like to create a workspace in the selected location?

[ ok | [ Cancel

N

eStudio uses an RMI port to listen to the events sent by the Enterprise Server.
Events Port has to be changed in the second instance of eStudio to avoid any

bind exceptions. To change the Events Port, select the Enterprise Server node
and in the Properties view hover to RMI Connection tab and edit the value.
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For example, if the events port of the previous eStudio instance in 9713, set the
events port of the Enterprise Server node in the new eStudio instance to 9714.
Also the user has to make sure the port is open and is not used by any other
process.

Note: It is always better to add a new Enterprise Server in the same eStudio instance to
work with multiple Enterprise Servers instead of launching multiple instances of eStudio for
easier manageability.

Question 2: Preliminary steps to login into a Fire-Walled Environment

To Login to an Enterprise Server present in a fire-walled environment from eStudio:

e If the Firewall is installed in a Windows machine, it is recommended to turn off
the Firewall. If this is not a viable option for the risk of Intrusion\ Viruses, It
must be made sure that the Fire-walled environment allows connections to
Server RMI port and the Events Port.

To do that, open Windows Firewall Settings and add the Server RMI Port and
the Events Port to the list of exceptions, so that these ports can be opened
through the Firewall when logging in to the Enterprise Server.

e If the machine in which eStudio instance is running has multiple IP’s, In
eStudio.ini file, provide the primary IP of the system using

-Djava.rmi.server.hostname option.

The eStudio.ini file is present in $FIORANO_HOME/eStudio.

Chapter 21: Frequently Asked Questions Page 314



Fiorano eStudio User Guide

e In Enterprise Server Node Configuration, Correct Hostname/IP should be
specified. To change the Hostname/IP,

Select Enterprise Server Node -> Properties View -> RMI Connection Tab ->
Change Hostname/IP.
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